Pinnacle Studio™ 23 User Guide

Including Pinnacle Studio™ Plus and
Pinnacle Studio™ Ultimate
# Contents

## Before you start

- Abbreviations and conventions ............................................. 1
- Buttons, menus, dialog boxes and windows .......................... 2
- Help and Tooltips ............................................................... 2
- Finding your version information ....................................... 3
- Upgrading ........................................................................... 3

## Using Pinnacle Studio ................................................................. 5

- The Welcome tab ................................................................. 5
- The Import tab ..................................................................... 5
- The Export tab .................................................................. 6
- The Edit tab ....................................................................... 7
- Creating your first movie in Edit ....................................... 8
- Editing media and assets .................................................... 9
- Pinnacle Studio Projects .................................................... 10

## The Library .................................................................................. 13

- What can you find in the Library? ...................................... 14
- Instant gratification: SmartMovie ....................................... 15
- Understanding the Library ................................................ 15
- The Navigator ...................................................................... 17
- Project Bins ......................................................................... 18
- Projects ............................................................................... 18
- Collections ......................................................................... 18
- Favorites ............................................................................. 20
- Managing Library assets .................................................... 21
- The Browser ........................................................................ 22
- Thumbnails and details ...................................................... 23
- Optional indicators and controls ......................................... 25
- The Library preview ............................................................ 27
- Choosing what to display in the Library ............................ 29
- Tags .................................................................................... 31
Video scene detection ......................................................... 33
Correcting media .............................................................. 35
SmartMovie ................................................................. 35

**Edit** ............................................................................. 39
Edit tab components ....................................................... 40
The Editor panel .............................................................. 41
Previewing edits in the Player .............................................. 43
The Project Timeline .......................................................... 46
The Timeline toolbar ........................................................ 50
3-point and 4-point editing ............................................... 57
The timeline track header ................................................... 60
Editing Movies ............................................................... 62
Title Editors, ScoreFitter, voice-over ......................... 66
Deleting clips ................................................................. 67
Clip operations ............................................................... 67
Rotating video ............................................................... 68
Trimming ...................................................................... 69
Using Slip, Slide, Roll, or Stretch tools on the Timeline ......... 77
Using the Clipboard ......................................................... 79
Controlling speed with Time Remapping ....................... 80
Using Time Freeze to freeze frames ................................. 83
Movies within movies (nested projects) ......................... 84
Picture-in-Picture (PIP) ..................................................... 85
Track Transparency ........................................................ 86
Transitions ................................................................ 87
Morph Transitions .......................................................... 92
Seamless Transitions (Ultimate) ...................................... 92
Clip effects .................................................................. 94
Clip context menus ........................................................ 95

**Corrections** .................................................................. 97
Correcting Library media .................................................. 98
Correcting timeline media ........................................................................................................ 98
Photo editing tools .................................................................................................................. 101
Correcting photos .................................................................................................................. 102
Red-eye .................................................................................................................................. 106
Correcting video ..................................................................................................................... 106
Video tools ............................................................................................................................. 107
Video corrections .................................................................................................................... 110
Stabilize .................................................................................................................................. 111
Wide-angle Lens Correction ................................................................................................... 112
Correcting audio ..................................................................................................................... 112
Effects ..................................................................................................................................... 113
Corrections vs. effects .............................................................................................................. 114
About effects ............................................................................................................................ 114
Effect compositions ................................................................................................................ 115
Real-time vs. rendered effects .................................................................................................. 116
The Settings .............................................................................................................................. 116
Video and photo effects .......................................................................................................... 118
Green screen chroma key effects ............................................................................................ 121
Selective Color ......................................................................................................................... 121
Transition In and Transition Out ............................................................................................. 123
Pan-and-zoom .......................................................................................................................... 123
360 Video .................................................................................................................................. 126
Masks and Motion Tracking .................................................................................................... 131
Understanding masks in Pinnacle Studio .............................................................................. 131
Shape masks ............................................................................................................................. 131
Using a Shape mask to edit specific areas ............................................................................. 132
Using a mask panel to create a 3D effect ................................................................................. 134
Motion Tracking ....................................................................................................................... 135
Montages and Templates ........................................................................................................ 139
Template basics ....................................................................................................................... 139
Montage templates .................................................................................................................. 140
Montage clips on the timeline ......................................................... 141
Anatomy of a montage template .................................................. 142
Montage editing ................................................................. 142
Using the Montage Editor ...................................................... 143
Split screen video templates .................................................. 145
My Templates: Saving a movie as a template .......................... 147

The Title Editor ............................................................... 151

Title Editor components ...................................................... 152
Accessing the Title Editor ..................................................... 153
The Library in the Title Editor ................................................. 154
The Presets Selector .......................................................... 155
Preset Looks ................................................................. 155
Preset Motions ............................................................... 156
Creating and editing titles .................................................. 158
Background settings .......................................................... 159
Look settings ................................................................. 160
The Edit window ............................................................ 163
Text and text settings ...................................................... 165
Titles and stereoscopic 3D ................................................ 169
The Layer List ............................................................... 170
Working with the Layer List ............................................... 170
Working with layer groups .................................................. 174

Sound and music ............................................................ 177

Audio features of Pinnacle Studio ........................................... 177
Editing audio ................................................................. 178
Channel mixer ............................................................... 179
Audio Corrections ............................................................. 181
Audio effects ................................................................. 184
Audio on the timeline ..................................................... 185
Timeline audio functions .................................................. 186
ScoreFitter background music ............................................ 189
The Voice-over tool .......................................................... 190
Using Audio Ducking to automatically adjust volume ............... 191

Disc projects ............................................................... 193

MyDVD disc projects ......................................................... 193
Author tab (legacy) ......................................................... 194
Menu templates (legacy Author tab) ..................................... 195
Disc menus (legacy Author tab) ........................................... 195
Adding disc menus (legacy Author tab) ................................ 198
Previewing disc menus (legacy Author tab) ............................. 199
Menu editing on the timeline .............................................. 200
Timeline menu markers (legacy Author tab) ............................. 201
Authoring tools (legacy Author tab) ...................................... 201
The Chapter Wizard (legacy Author tab) ................................ 203
The Menu Editor (legacy Author tab) ...................................... 205
Menu buttons (legacy Author tab) ........................................ 206
The Disc Simulator (legacy Author tab) ................................... 207

The Importer ................................................................. 209

Using the Importer .......................................................... 209
Import sources ............................................................. 211
The Mode area ............................................................... 214
Compression settings for Capture Video .................................. 215
Scene detection settings for Capture Video ............................... 216
File name for imported files ............................................... 217
Selecting assets for import ................................................ 217
Selecting files for Import .................................................. 217
Customizing the browser .................................................. 220
Scan for assets .............................................................. 221
Import from DV or HDV camera (Capture Video) ....................... 221
Import from analog sources ............................................... 224
Import from DVD or Blu-ray Disc ......................................... 225
Import from digital cameras ................................................. 226
Stop motion ................................................................. 226
Snapshot ................................................................. 230
MultiCam Capture .................................................... 232

The Exporter .............................................................. 233
Exporting your project ................................................ 233
Export options and settings ........................................ 235
Output to disc or memory card .................................... 235
Output to file (Format or Extension) ............................ 236
Output to Web ........................................................... 239
Output to a device ...................................................... 240
Output to MyDVD ....................................................... 241
Export to animated GIF .............................................. 242
Exporting movies with transparency to alpha channel video ................................................ 244

Setup ................................................................. 247
Legacy Options ....................................................... 248
Audio device .......................................................... 248
Event logging ............................................................ 249
Export and Preview ................................................... 249
Import settings in the Control Panel ......................... 251
Keyboard settings in the Control Panel ...................... 251
Project settings ........................................................ 252
Startup Page ........................................................... 253
Storage locations ...................................................... 253
Resetting Pinnacle Studio ......................................... 254
Restore purchase ....................................................... 254

MultiCam Capture Lite ............................................. 255
Starting a screen capture project ................................. 255
Recording your screen .............................................. 256

Multi-Camera Editing ............................................ 259
The Multi-Camera Editor workspace ........................... 259
Basic steps in multi-camera editing ............................................. 261
Importing video and audio clips into the Multi-Camera Editor .......... 262
Synchronizing video and audio clips in multi-camera projects ........... 262
Choosing an audio source for your multi-camera project ................. 263
Editing multiple clips to create a multi-camera compilation ............. 264
Adding picture-in-picture (PIP) in the Multi-Camera Editor ............... 266
Managing multi-camera source files ........................................... 267
Saving and exporting your multi-camera project ......................... 268
Using Smart Proxy for a faster, smoother editing experience ........... 268

3D Title Editor ................................................................. 271
3D Title Editor workspace ...................................................... 271
Creating and editing 3D titles .................................................. 272
3D objects .............................................................................. 273

Color correction and color grading .......................................... 275
Using the Color controls ......................................................... 275
Tone Curve ............................................................................. 276
HSL Tuning ............................................................................ 277
Color Wheel ........................................................................... 278
Video scopes ......................................................................... 278

Appendix A: Troubleshooting .................................................. 283
Contacting support .................................................................. 283
Forums ................................................................................. 284
Compatibility with past content ............................................... 284
Capture hardware compatibility .............................................. 284
Serial number information ..................................................... 285

Appendix B: Videography ......................................................... 287
Creating a shooting plan ......................................................... 287
Editing a video project ........................................................... 288
Rules of thumb for video editing .............................................. 290
Soundtrack production ........................................................... 292
Giving your project a title ................................................................. 293

Appendix C: Glossary ................................................................. 295

Appendix D: Keyboard shortcuts ................................................. 307
  General shortcuts ................................................................. 307
  Library shortcuts ................................................................. 307
  Playing and transport shortcuts .............................................. 308
  Importer shortcuts ............................................................... 308
  Edit tab shortcuts ............................................................... 309
  Editor shortcuts ................................................................. 310
  Title Editor shortcuts ......................................................... 310

Appendix E: The installation manager ........................................ 311
  Before you begin installing .................................................. 311
  Upgrade Installation ........................................................... 312
  Launching the Installation Manager ....................................... 312
  Registration ........................................................................... 312
  Supporting installations ........................................................ 312
  The installation Welcome Screen ......................................... 312
  Common controls ................................................................. 312
  Installing plugs-ins and bonus content .................................. 313
  System requirements ......................................................... 313
Before you start

Thank you for purchasing Pinnacle Studio™23. We hope you enjoy using the software. If you have not used Pinnacle Studio before, we recommend that you keep the user guide handy for reference even if you don’t actually read it all the way through.

*Note: Not all features described in the user guide are included in all versions of Pinnacle Studio. For more information, please visit www.pinnaclesys.com and refer to the Compare table.*

This section contains the following topics:

- Abbreviations and conventions
- Buttons, menus, dialog boxes and windows
- Help and Tooltips
- Finding your version information
- Upgrading

### Abbreviations and conventions

This guide uses the following conventions to help organize the material.

#### Common terms

**360**: 360 video is an interactive type of video that lets the viewer look in any direction by changing the viewing angle during playback. 360-degree videos are captured on special cameras or cameras attached to multi-directional mounts.

**4K**: A video resolution that is approximately 4,000 pixels in width. It is also known as Ultra High-Definition or Ultra HD. The term is used to refer to all screen standards that are at least 3840 x 1080 pixels.

**AVCHD**: A video data format used by some high-definition camcorders, and for creating DVD discs that can be read on Blu-ray players.

**DV**: This term refers to DV and Digital8 camcorders, VCRs and tapes.

**HDV**: A ‘high-definition video’ format that allows video in frame sizes of 1280x720 or 1440x1080 to be recorded in MPEG-2 format on DV media.

**1394**: The term ‘1394’ applies to OHCI-compliant IEEE-1394, FireWire, DV or i.LINK interfaces, ports and cables.
**Analog:** The term ‘analog’ applies to 8mm, Hi8, VHS, SVHS, VHS-C or SVHS-C camcorders, VCRs and tapes, and to Composite/RCA and S-Video cables and connectors.

**Buttons, menus, dialog boxes and windows**
Names of buttons, menus and related user interface items are written in **bold** to distinguish them from the surrounding text.

**Choosing menu commands**
The right arrowhead symbol (>) denotes the path for hierarchical menu items. For example:

- Select **File > Burn Disc Image**.

**Context menus**
A ‘context menu’ is a pop-up list of commands that appears when you click with the right mouse-button on certain areas of the application interface. Depending where you click, a context menu may pertain either to an editable object (like a clip on an editing timeline), to a window, or to a zone such as a control panel. Once open, context menus behave just like the ones on the main menu bar.

Context menus are available in most parts of the Pinnacle Studio interface. Our documentation generally takes for granted that you know how to open and use them.

**Mouse clicks**
When a mouse click is required, the default is always a left-click unless otherwise specified, or unless the click is to open a context menu:

Right-click and select **Title Editor**. (Or, one might say, “Select **Title Editor** from the context menu.”)

**Key names**
Key names are spelled with an initial capital and are underlined. A plus sign denotes a key combination. For example:

Press **Ctrl+A** to select all the clips on the Timeline.

Please refer to **Appendix D: Keyboard shortcuts** for a comprehensive table of available shortcuts.

**Help and Tooltips**
Immediate help is available while you are working in Pinnacle Studio via the Help menu.
Help

The Help menu lets you access a variety of learning resources. Click the Help button > User Manual to access the Learning Center page with links to video tutorials, the Pinnacle Studio 23 User Guide PDF, and other community and support links.

The Help button is located on the Menu bar.

Video tutorials

You can access video tutorials from the Learning Center page (Help > User Manual) or by visiting the following sites directly:

- **YouTube** — http://www.youtube.com/user/pinnaclestudiolife
- **StudioBacklot.tv** — http://www.studiobacklot.tv/studio23

First-time StudioBacklot.tv users get a 10-day, all-access pass to StudioBacklot.tv, featuring brand-new Pinnacle Studio 23 content, loads of other training and a royalty-free stock library. (Training is available in English and French.)

Tool tips

To find out what a button or other Studio control does, pause your mouse pointer over it. A ‘tool tip’ pops up to explain the control’s function.

Finding your version information

Whether you are considering upgrading your software or looking for support, it’s good to know your version information. To check the version of Pinnacle Studio that you have, click the Help button > About.

Upgrading

There are different versions of Pinnacle Studio and features vary depending on the version you have. For more information, please visit www.pinnaclesys.com and refer to the Compare table.

For information about upgrading your software, check the Welcome tab or click the Help button > Online Offers & News > Software Offers.
Using Pinnacle Studio

For a simple outline of the digital movie-making process, you don’t have to look any further than the central tab group of Pinnacle Studio’s main window. The same steps apply to any type of production, from an unpretentious slideshow with dissolves between each frame to a 3D extravaganza containing hundreds of carefully-arranged clips and effects.

![Main control bar](image)

*Pinnacle Studio’s main control bar summarizes the movie-making process.*

This section contains the following topics:
- The Welcome tab
- The Import tab
- The Export tab
- The Edit tab
- Creating your first movie in Edit
- Editing media and assets
- Pinnacle Studio Projects

### The Welcome tab

The Welcome tab provides learning tools, offers, and important information about your product.

*The Welcome tab has a house icon on it. Think of it as the home page for your application.*

### The Import tab

**Import** is a preparatory step. It involves procedures like ‘capturing’ video from your video camera, bringing in photos from a digital camera, and copying media files to your local hard drive from a network location.

The Pinnacle Studio Importer provides tools for these tasks, along with a Snapshot feature for grabbing frames from video files, and a Stop motion tool for building up video frame-by-frame. See “The Importer” on page 209 for details.
File menu import commands: Choosing **Import** from the file menu has the same effect as clicking the **Import** tab: it opens the **Importer**. The menu provides other import-related choices as well. Each of these opens a Windows file dialog to permit import of files from a hard drive or other local storage.

- **Import previous Pinnacle Studio Projects** lets you load movie projects created with earlier versions of Studio.
- **Import Studio for iPad App Projects** lets you bring in projects exported from Studio’s companion app for the iPad.

*Studio Importer*

### The Export tab

At the other end of the movie-making process is **Export**. By the time you get to this stage, the hard part of the task is behind you. The creative energy that went into making your movie has paid off in a production that now lacks only one ingredient—an audience.
Using Pinnacle Studio

The Pinnacle Studio **Exporter** helps you over that last hurdle with tools for taking your movie to its viewers, whoever and wherever they might be. Create a digital movie file in the format of your choice or upload directly to destinations in the Cloud like YouTube and Vimeo, or to your personal Cloud-based storage area.

See “The Exporter” on page 233 to learn more.

**The Edit tab**

The **Edit** tab lets you access Pinnacle Studio’s main editing features for digital movie creation. It brings together four main components: the **Library** panel, the **Editor** panel, the **Timeline** panel, and the **Player** panel. For more information, see “Edit” on page 39.

**The Library**

The Library is a cataloging and management tool for all the file-based resources – or assets – that you can draw on when authoring. Almost all of the materials of your movie – video footage, music and audio files, and many specialized resources such as transitions and effects – originate as assets in the Library. Many Library assets are supplied with Pinnacle Studio, and are available for royalty-free use. These include professionally-designed titles, DVD menus, sound effects and more. For more information about the Library, see “The Library” on page 13.

When you click **Library**, the **Library** panel displays assets that can be brought into a movie or disc project by drag-and-drop.
The Editor

Accessible from the Edit tab, the Editor panel lets you access and edit properties for the currently selected media or content. The Editor panel shares a space with the Library panel.

For more information about the editing, see Edit.

The Player

The Player is a viewer that works for all media types handled by the application. The Player can be used to view Source media from the Library, or your Timeline content. For more information, see “Previewing edits in the Player” on page 43.

In each window or context in which it is used, the Player exhibits somewhat different controls. For an introduction to the Player and its basic controls, please see “The Library preview” on page 27. For the use of the Player in trim mode on the timeline, see “Clip operations” on page 67. For information on using the Player with Montage, see “Using the Montage Editor” on page 143. For the use of the Player in editing disc menus, see “Previewing disc menus (legacy Author tab)” on page 199.

Creating your first movie in Edit

The next step, once you know your way around the Library and have made any changes needed to the default set-up, is to start creating a movie. There are two ways to go about this.

The usual way

If you want to exert detailed control over the way media assets are used in your production, you will usually start building your movie or disc project from scratch by using the features available from the Edit tab.
**The easiest way**

For ultra-quick results, click **SmartMovie** at the bottom of the Library panel. Select some visual media assets to serve as the basis of the project, choose music for a soundtrack, and make a handful of other customizations. Then the software takes over, automatically generating a full-scale Pinnacle Studio project containing the media and options requested. For more information, see “Instant gratification: SmartMovie” on page 15.

**Back to the usual way**

After you have imported and identified your materials in the **Library** panel, it’s time to get to work on a video or a slideshow by dragging the media to the Timeline, editing the media, previewing in the Player panel as you work, and exporting your final product.

If you are working on a disc production specifically, you can use the **Disc Editor** mode in the Timeline and export to MyDVD. For more information, see “Disc projects” on page 193.

![Multitrack timeline](image)

*A multitrack timeline occupies the lower part of the display. Most of the ‘clips’ on the timeline come from the Library; a few types, like automatic background music, are generated with special tools.*

The **preview type** control above the Player lets you switch between viewing the current Library asset (**Source**) and the current timeline clip (**Timeline**).

For more information about Timeline editing, a central activity in project authoring, see “Edit” on page 39.

**Editing media and assets**

In addition to the **Editor** panel, a number of other specialized editing windows are available. In general, you can open an editor appropriate to any asset or clip by double-clicking the item or right-clicking and choosing an option from the context menu.

When you double-click a media asset in the timeline, you open the **Editor** panel. Edits apply to the clip in the project.

For information about applying corrections directly to Library media, see “Correcting Library media” on page 98.
Adding transitions, effects, titles, and other assets

You can enhance your video project by adding transitions, effects, titles, a sound track or other assets, including photos.

Transitions let you punctuate the passage of one clip to the next with anything from a barely perceptible dissolve to an audience-awakening flare. For more information, see “Transitions” on page 87.

Effects range from the practical (Brightness and contrast) to the theatrical (Fractal fire). Effects can be animated with keyframed parameter changes to any degree of complexity. They provide innumerable ways to add creative interest to your productions. Some effects are particularly designed for 3D material.

Photos

Photos can be resized, cropped, corrected, and you can add a pan-and-zoom effect. Like the effects just discussed, pan-and-zoom can be animated with keyframes to create any desired combination of simulated pan and zoom camera moves within the boundaries of a single photo.

For more information about Correction tools and editing media, see “Corrections” on page 97 and “Effects” on page 113.

Pinnacle Studio Projects

The movies and discs that you create in Pinnacle Studio are distilled from the projects that you build on the timeline.

To manage projects, Studio must keep track of everything that goes onto your timeline, and all the editing decisions you make with regard to trimming, adding effects, and much more. Much of this information is stored in the project file, which is in axp (Studio Movie) format. For Stop Motion, projects are saved in the axps format.

In order to conserve hard drive space when dealing with files that can be very large, the project file does not include the media items in your movie. For these, only their location is stored.

The axp project file is the default file format for the File > Open, File > Save and File > Save As menu commands. It may be the only one you need.

Sometimes, however, it is convenient to have all the resources recruited for a project gathered into a single, manageable unit for hassle-free archiving, file transfer or upload. This is the purpose of an alternative file format, the axx (Studio Project Package), which contains in a single file all the materials your project uses, including media items. Of necessity, files in this format are considerably larger than standard project files.
Although it is not possible to directly edit a project in the package format, Pinnacle Studio lets you open a project package with **File > Open** by selecting axx in the file extension box. Studio seamlessly unpacks the project, creates a new Library entry for the unpacked version, and opens it for editing.

If you create a multi-camera project in the Multi-Camera Editor, the project is saved as a **mcam** file. When you add an **mcam** file to the timeline, it is added as a nested project by default. You can expand it by double-clicking the file in the timeline and editing it in the corresponding timeline tab. All edits are saved to the main project.
The Library

The Pinnacle Studio Library is a cataloging and management tool for all the file-based resources you can draw on when authoring. It is displayed as a panel and accessible from the Edit tab. Its purpose is to let you choose and use the video segments, photos, sound bites, transition effects, titles and other ‘assets’ (as they are often called) for your movies as easily, rapidly and intuitively as possible.

The Library consists of navigation controls for exploring media assets (icons along left edge) and a browser for examining and selecting assets (right).

This section contains the following topics:
• What can you find in the Library?
• Instant gratification: SmartMovie
• Understanding the Library
• The Navigator
• Project Bins
• Projects
• Collections
• Favorites
• Managing Library assets
• The Browser
• Thumbnails and details
• Optional indicators and controls
What can you find in the Library?

The Library contains the following media and content categories:

- **Project Bins** — Project bins are virtual folders for your assets. They are created automatically during import and you can create them manually to organize your assets according to your needs (for example, by project). For more information, see “Project Bins” on page 18.

- **Projects** — A virtual folder that automatically lists your Pinnacle movie and disc projects. For more information, see “Projects” on page 18.

- **Collections** — Fully flexible virtual folders that you can create for any reason. Unlike project bins, collections are not created automatically, so you have full control of collections. For more information, see “Collections” on page 18.

- **Effects** — ‘Effects’ is an umbrella term taking in a wide range of software tools for manipulating your media. Effects range from the practical (**Brightness and contrast**) to the theatrical (**Fractal fire**). They provide innumerable ways to add creative interest to your productions. For more information, see “Effects” on page 113.

- **Transitions** — A transition is a specialized animated effect for easing – or emphasizing – the passage from one clip to the next. Fades, wipes and dissolves are common types of transition. For more information, see “Transitions” on page 87.

- **Sound Effects** — From slamming doors, crashing cars, and barking dogs, Sound Effects provides you with a wide range of sounds for your creative projects. For more information, see “Sound and music” on page 177.

- **Titles** — Titles let you add text and more to your projects. From a creative, animated opening title in 2D or 3D, to a rolling list of credits at the end, titles can entertain and inform your audience. For more information, see “The Title Editor” on page 151.

- **Montages and Templates** — Numerous professionally designed sequences are available to give your productions instant impact. For more information, see “Montages and Templates” on page 139.

- **SoundStage** — A collection of Scorefitter music that you can use for soundtracks. For more information, see “Sound and music” on page 177.

- **Triple Scoop Music** — A collection of premium music for soundtracks that you can purchase for your projects.
• **Disc Menus** — These disc menu templates can be used only if you enable the legacy **Author** tab for disc projects. For more information, see “Disc projects” on page 193.

Assets are displayed either as icons or text records within collapsible and expandable sections. Folders may correspond either to real directories in your computer’s file system, or to virtual groupings based on ratings, file type, creation date, or membership in a user-defined Collection.

You can also use watchfolders to automatically monitor and import media files that are added to the folders you choose to “watch”. For information about activating watchfolders, see “Watchfolders” on page 248. When you use watchfolders, a **Library Media** branch is added to the Asset Tree in the Library. You will also see a **Library Media** branch if Pinnacle Studio detects a library from a previous version of Pinnacle Studio (you must enable watchfolders if you want to continue populating this branch).

### To open the Library

1. From the **Edit** tab, do one of the following:
   - Click **Library** (under the menu bar), and use the Navigation bar to choose a media or content category that you want to browse.
   - On the Navigation bar, click a category that you want to browse. This automatically switches focus to the Library panel.

### Instant gratification: SmartMovie

In addition to the core functions mentioned so far, the Library offers a matching pair of tools for automatically constructing a complete project using media resources you specify. Just select some photos or video sequences, enter a few settings, and start. You can output the project Studio generates without further modification, or refine it with manual editing as you prefer. For more information, see “SmartMovie” on page 35.

### Understanding the Library

It’s important to understand how Library assets and the information about them are stored.

### Storage of Library assets

Every asset in the Library – every clip, sound, transition, and so on – corresponds to a file somewhere in the local storage of your computer system. The Library doesn’t ‘own’ these files, and never modifies them unless specifically requested to do so. Rather, it keeps track of their names, locations and properties in an internal database. The information stored also includes any tags and ratings with which you have annotated particular items.
The database

The files that make up the Library database are stored in a folder with single-user rather than shared access rights under Microsoft Windows. If Pinnacle Studio is used on your computer by multiple users with individual log-ins, a separate Library will be created for each.

Missing media

Operations like adding, removing and renaming a Library asset are database operations that have no effect on the media file itself. When you remove an asset from the Library, an option on the confirmation dialog box does let you go one step further and delete the actual file as well, but the option is off by default – you have to specifically request the action.

By the same token, when you delete or move an asset file in Windows Explorer or another application outside of Pinnacle Studio, the database record of the file continues to exist. Since the Library can’t actually access the file, however, an error graphic is added to the file’s listing. If the file still exists, but has simply been moved to another folder or device, relinking it to the Library is easy. Double-click the item to pop up a standard File Open dialog with which you can point the way to the file’s new location.

Incidentally, to check if there are missing media anywhere in the Library, look in the special subsection All media >Missing media of the Asset Tree.

Library Media

The Library Media category appears only if you enable Watchfolders or if your current version of Pinnacle Studio detects a previous library (see “Watchfolders” on page 248). In most cases, Project Bins can be used instead of the Library Media branch.

The Library Media branch contains the standard media files on your system in subsections named Photos, Video, and Audio. Many standard file types are supported. The purpose of the fourth subsection, Missing media, is described below.

Location tabs

Editing a video project involves coordinating the various media and other assets at your disposal. As you proceed, it’s likely that you’ll find yourself browsing repeatedly in various
parts of the Library that are relevant to the project. No doubt you will also change your viewing and filtering options from time to time, depending on the material you’re reviewing. Like a web browser that uses a row of tabs to allow flipping effortlessly amongst multiple open web sites, the Library lets you create and configure location tabs as you work. The tabs provide direct access to each of the various locations in which you are currently working.

Here three tabs give access to media required by different parts of a disc project. The mouse pointer is poised to create a new tab. To close a tab, click the x icon to the right of the tab caption.

To set the location of the current tab, click a name in the Asset Tree. Changes you make to viewing and filtering options while the tab is active are retained between accesses.

The Navigator

The entire gamut of Library assets is organized into an asset tree whose folder-style structure and general usage should be familiar from file-system tools like Windows Explorer. When you select a location in the Navigator, the folder name appears on the caption of the active location tab, and its contents are displayed in the neighboring Browser.

In the Library panel, when you hover the pointer over the Navigator bar (left), it opens the list of categories in an asset tree.
**Project Bins**

Project bins are virtual folders for your assets. They are created automatically during import and you can create them manually to organize your assets according to your needs (for example, by project).

By default, the folders are labeled according to import date, but you can right-click a folder to rename it and you can click the **Create new project bin** button to add a new bin.

**To create a project bin**

1. In the **Project Bins** branch of the Library Asset tree, click the **Create a new project bin** button.
2. Type a name for your bin and click **OK**. The bin is added to the end of the project bin list.

**To rename a project bin**

1. In the **Project Bins** branch of the Library Asset tree, right-click a project bin, and choose **Rename**.
   - The current name appears highlighted
2. Type a new name for the bin.

**To remove a bin**

- In the **Project Bins** branch of the Library Asset tree, right-click a project bin, and choose **Remove Project Bin**.

**Projects**

The **Projects** category contains your own Pinnacle Studio movie and disc projects. You can open a project right from the Library and begin editing it, or you can add it to the timeline of another project to serve as an ordinary clip.

**Collections**

Similar to project bins, collections are virtual folders. However, collections are not created automatically (there are two exceptions). This means that you have full flexibility to create and delete them for any purpose. From the Library’s point of view, a Collection is just an arbitrary grouping of assets – a set of Library items with no organizing principle. You may well have a good reason for gathering certain files into a particular collection, but the Library doesn’t have to know what it is.
One special Collection, with the name Latest import, is automatically updated after each import operation to display the media added. Immediately after importing, you can turn to this Collection and start working with the new material.

Another automatically-generated Collection is Latest Smart Creation, which stores the media you selected for your most recent SmartMovie production.

Hierarchically-organized Collections are also supported. The top-level Collections in the hierarchy are used as subsections of the Collections branch.

To create a new collection

1. Click the icon in the header line of the Collections branch and enter a name in the provided text field.
2. Complete the process by pressing Enter.
   
   **Tip:** Alternatively, choose Add to collection > Create new collection from any asset’s context menu.

To manage collections

1. Right-click a collection and choose a command for renaming or deleting the collection, or for creating a subcollection that has the current Collection as its parent ‘folder’.

To organize a collection

- Drag and drop a collection in the Navigator with the mouse. A dragged Collection becomes a subcollection when dropped upon another.

Displaying collected assets

Clicking the name of a Collection causes it to be displayed in the Browser. As your mouse pointer passes over any listed asset, the Collections to which the asset belongs ‘light up’ in the Navigator.

Operations on collected assets

These operations can be performed from the context menu of any Collection item. To act on a group of items, first select them with the mouse (using Ctrl-click and Shift-click for multiple selections as needed) or by dragging out a frame around the items. Then right-click within the selection to access the context menu.
To add to a collection

• Choose a target Collection on the Add to collection submenu to add the selected item or items.
  Tip: Alternatively, drag the selection onto the target Collection.

To remove items from a collection

• Click the Remove command to remove the item (or items) from the Collection. As usual with the Library, the underlying media items involved are not affected, so removing a video or other item from a Collection in the Library does not delete it from other Library locations.

Favorites

Using Favorites is a quick way to mark and find your preferred content, such as your favorite effects, transitions, and titles.

To mark content as Favorite

1 In the Navigation panel of the Library, and click a category.
2 In the browser area of the Library, right-click a thumbnail and choose Add to Favorites. The command appears only if the category supports favorites.

Content marked as Favorites appears at the top of the Library in a Favorites folder (when the content is organized by folder). Each type of content has its own Favorites folder that can be accessed from the corresponding category in the Navigator panel.
Managing Library assets

Media and other assets find their way into the Library in several ways. For instance, content that is provided with Pinnacle Studio, such as templates, titles, transitions, and effects, are added to the Library when you install the application.

If you enable Watchfolders, the Library automatically discovers some assets on your system by regularly scanning Windows-standard media locations. You can add your own watchfolders (see below), and they will be automatically updated, too.

Finally, you can import media manually by any of several methods.

Watchfolders

You can turn on Watchfolders to monitor directories on your computer. If you add media files such as video clips to a watchfolder, or one of its subfolders, the files automatically become part of a Media Library branch in the Asset Tree. Updating occurs each time the application is launched and while the application is running.

Watchfolders are set up on the Watchfolders page of the Setup control panel. For each folder that you add, you can specify that either one particular supported media type will be ‘watched for’, or all of them. Please see “Setup” on page 247 for more information.

Importing

If you need to import a large amount or variety of media, or to import from analog media such as VHS tape, click the Import button near the top of the application window to open the Importer. See “The Importer” on page 209 for full information.

Quick import: The Quick Import button at the top left of the Library opens a Windows file dialog for fast import of files from a hard drive or other local storage. New folders in the corresponding media categories (photos, video, audio and projects) are created for the files specified. In addition, the imported items are included in the Last Import Collection.
Direct import via drag and drop: To select and import items in one step, use drag-and-drop from Windows Explorer or the desktop into the Browser. The new items are immediately displayed in the Collection 'Latest Import', which is created for the occasion if necessary.

Exporting directly from the Library

Any photo, video, audio file or project in the Library panel can be directly exported “as is”, using the context menu commands described below, to either a Cloud-based storage service or a disc. For other exporting options, choose Export from the context menu. See “The Exporter” on page 233 for full information.

To store a Library asset on a disc, select Burn Disc Image on the context menu. You can burn just the file, or a disc image if you have made one. If you select multiple assets, and then select Burn Disc Image, all of the assets will appear on the Burn files to disc dialog. More assets can be added by clicking the File icon and browsing. You can also delete files from the list before burning.

Removing items from the Library

To remove an item from the Library, or a selection containing multiple items, choose Delete selected from the context menu or press the Delete key. A confirmation dialog lets you approve the list of media files to be removed from the Library database. By default, the files themselves will not be affected, but the Remove from library and delete option lets you delete the files too, if desired. Be careful, as this command works on all kinds of Library assets, including your Pinnacle Studio projects if any of those are selected.

When all the files in a folder are removed, the Library hides the folder as well.

The Browser

This is the area in which the Library displays its media assets – the videos, photos, audio, projects, collections and ‘content’ that are available for you to use in your movie and disc projects. The items are displayed either as a list of text records or as a grid of icons. Visual asset types use thumbnail images for their icons; other types use graphic symbols.

The Library would not be much help if the Browser displayed all its assets at once. It therefore has several controls that help you screen out items that aren’t relevant to your purpose. See “Choosing what to display” below for details.

Controlling the Browser display

A group of controls in the Library’s footer bar provides general functions for managing the way assets are presented in the Browser.

The scenes view button activates a mode in which the Browser displays a separate icon or text record for each scene in the video file. (As explained under Video scene detection, a scene in the most general sense is just any portion of a video file.)
For more information about video scenes in the Library see “Video scene detection” on page 33.

The **thumbnails view** button switches to viewing assets as thumbnails rather than as text lines. A pop-up checklist associated with the button lets you select the readouts and controls that will appear beside thumbnails in the Browser.

The **details view** button switches to the alternative viewing mode, in which each asset appears as a text listing. The pop-up checklist with this button selects the text fields to be displayed.

The **zoom** slider lets you magnify the thumbnails to get a closer look, or pull back for a wider view. This slider is always found at the right-hand end of the footer bar.

** Thumbnails and details**

Each asset is displayed in the Library Browser in one of two formats, depending on the view selected.

Because the icons of thumbnails view and the text records of details view represent the same assets, they have certain features in common. For instance, the context menu for assets is the same regardless of which representation is used.

Similarly, standard media assets (video, photo and audio), open an appropriate media editor when double-clicked. The corrections tools are also available when a media editor is invoked from the timeline, but when applied to a Library asset the corrections are carried forward into any future project that includes it. See “Correcting timeline media” on page 98 for more information.

**Details**

In **details view**, each asset is presented as one line in a list of text records. In **thumbnails view**, it appears as a thumbnail image (for visual media types) or graphic icon.

To switch the Browser to details view, click the icon on the **details view** button at the bottom of the Library. The arrow beside the button pops up a panel listing the optional columns available to be included in the text records (one column, Caption, is always present). Check the boxes beside any of these – File size, File type, Date, Tags, Rating and Duration – you wish to be shown.
In Details view, each asset is displayed as a one-line text record. A pop-up checklist beside the Details view button lets you select which columns to show.

**Thumbnails**

The **thumbnails view** button to the left of the details view button selects thumbnails view, in which assets are represented in the Browser by icons rather than text. The arrow alongside the button opens a pop-up checklist on which you can choose additional data to be shown with each icon. The options are **Rating**, **Stereoscopic**, **Information**, **Correction**, **Collection**, **Tag**, **Used Media**, **Caption** and **Shortcut**.

At the bottom center of most asset icons a preview button, a standard triangular play icon, is displayed when the mouse pointer is over the asset. The preview is shown on the **Source** tab of the **Player panel**.

In either version of the Library, Alt-clicking the preview button will give you a mini-preview on the asset icon itself. With video and audio media, you can control the mini-preview manually by means of a scrubber that appears below the thumbnail whenever the mouse is over the icon.

If the asset is a photo, a pop-up preview button replaces the standard play symbol. Clicking it will display the photo in the **Player panel**.

When the Browser is in thumbnails view, a slider is available to control the size of the icons. You will find the slider in the bottom right corner of the Library. The icons can also be resized with the scroll wheel when Ctrl is pressed and the mouse pointer is positioned over the Browser pane.

**Locked content indicator:** Some of the Disc Menus, Titles, Montages, and other creative elements in the Library are locked to indicate that you do not own a license to distribute them freely. This status is indicated by the lock indicator.
Even though locked, the content can still be handled as usual. A project containing locked content can be saved, put on a disc and exported. However, a translucent ‘watermark’ logo will appear on the locked content.

To purchase and unlock the content, use one of the following options:
• In the Library, click the lock symbol on the icon.
• During export of a project with locked content, a dialog will appear prompting you to click the lock symbol.
• When editing effects in one of the media editors, click the lock symbol on the Settings panel. For more information, see “The Settings” on page 126.

Optional indicators and controls

The optional indicators and buttons on an asset icon in the Library Browser let you access and in some cases modify information about the asset without having to burrow deeper. Use the pop-up checklist on the thumbnails view button to determine which indicators and buttons are displayed.

Caption: The caption below the icon is the Library alias for the asset, which you can set with the Edit caption context menu command for any asset. It is not necessarily the name of the underlying asset file (which is shown in the tooltip).
Shortcut: The presence of this indicator in the extreme upper left of a thumbnail shows that the asset is a shortcut rather than an independent media file. Shortcuts, which consist of a reference to an existing media item along with a package of Corrections settings, can be created from the File menu of the media editor for any Library asset. Thereafter, they behave like ordinary assets, and are available for use in your productions.

Tag indicator: The bottommost of the three symbols at the right of the thumbnail is shown if the asset has any tags assigned to it. Hover the mouse pointer over the indicator to bring up a menu on which the existing tags for the asset are shown. As you pass the pointer over a tag name on this menu, a remove button appears. Click it to unset the tag. Click remove all at the bottom of the menu to clear all tags from the asset. The creation and application of tags is discussed in “Tags” on page 31.

Collection indicator: Just above the tag indicator, the presence of this symbol indicates that you have included the asset in one or more Collections. To see which ones, hover the mouse over the symbol. As with the tag indicator menu, a remove button is shown as you position the mouse on each Collection name; click it to remove the asset from the Collection. The remove all command removes the asset from all Collections of which it is a member.

Ratings: The row of stars above the top left of the icon lets you set the asset rating. If no stars are lit, the asset is said to be unrated. To set the rating of one asset or a selection of assets, either click the corresponding star on the indicator (click the first star twice to make the asset unrated again) or choose the setting on the Apply rating context submenu.

Ratings control appears at the left above the asset thumbnail. At top right is the Info button. The Corrections indicator is also at upper right, just above the Collection indicator.

3D indicator: Assets whose content is designed for stereoscopic 3D viewing carry a 3D indicator. The indicator appears when video and photo assets are automatically detected as stereoscopic while importing them the Library, and when an asset has been manually set as stereoscopic in corrections.
**Used media indicator:** A check mark is displayed to the right of the ratings indicator if the asset represented by the thumbnail is currently to be found in an open timeline within your project. The check mark is rendered in green if the asset is used in the currently visible project; otherwise it is gray. The used media indicator applies only to photo, video and audio assets.

**Information indicator:** Clicking the information indicator opens the information panel where you can edit the asset’s rating, title, and tags as well as view all its properties. Like most of the other indicators, the information indicator can be turned on and off using the thumbnails view pop-up.

**Multi-Camera indicator:** Projects created in the Multi-Camera Editor have a four-pane square icon in the upper right corner of the thumbnail.

---

**The Library preview**

Most types of Library asset support previewing in the Library Browser. The capability is indicated by a preview button on the asset icon, and the presence of a **Preview** command on its context menu. Remember too that most asset types can be previewed on the icon itself with an Alt-click on the play button.

Clicking the preview button in the center of the asset icon loads the item into the **Player** panel for viewing. In some cases, for example when you choose Edit scenes, a pop-up player window appears.
**3D viewing mode switcher**

When stereoscopic 3D content is being shown, the 3D viewing mode switcher will appear. On opening the Player, the default mode from the preview settings in the Control Panel is used for photos, videos, and projects. The icon for the current mode is displayed beside a dropdown arrow used for switching modes. The available modes are:

- **Left eye, Right eye:** The preview for stereoscopic content can be set to show only its left or right eye view. This helps keep things simple at times when a stereoscopic preview is unnecessary. Editing in these views is carried out as for a 2D movie.

- **Side by side:** This mode displays the frames for both eyes horizontally adjacent to each other, with the left eye on the left and the right eye on right. When editing, no stereoscopic equipment is needed.

- **Differential:** Differential mode is good for detecting the ‘depth’ of an image more easily, and especially for revealing areas of ‘zero depth’. Differential mode show a 50% gray for areas where identical information is being presented to both eyes; a color difference is shown if the areas are not identical. If 2D material is added to a stereoscopic 3D timeline in differential mode, since the same content is shown to both eyes, the image will be a uniform gray.

- **Checkerboard:** Checkerboard mode breaks the image up into a 16 x 9 checkerboard pattern. The ‘white’ squares of the checkerboard contain the view from one eye, the ‘black’ squares the other. Checkerboard mode provides a quick check on the ways the left and right frames differ across the whole image.

- **3D TV (Side by Side):** Use this mode to preview stereoscopic content on a 3D TV display or with a 3D projector by connecting it as a second monitor. This obviates the need for a special graphics card or additional hardware. Configure the second display to operate in its native resolution, and to extend your desktop, not just mirror it. Make sure the input format is side-by-side.

In the Control Panel Preview settings, choose Second Monitor from the “Show external preview on” dropdown menu. Set up Studio with a 16x9 stereoscopic timeline. Finally, on the Player, click the Full Screen button. Please see “Export and Preview” on page 249, and “Timeline settings” on page 51 for help with these configurations.

- **Anaglyph:** An Anaglyph stereoscopic preview is suitable for viewing with red-cyan stereoscopic glasses, with no additional hardware support required. Pinnacle Studio’s anaglyphic display works well even for images with a lot of red, thanks to a method very similar to the ‘optimized anaglyphs’ technique.

- **3D Vision:** This stereoscopic mode is available with many NVidia graphics cards after the 3D Vision feature has been
enabled in your NVidia configuration utility. The type of 3D display
offered depends on the hardware available. At the basic ‘Discover’ level, the 3D Vision
display is anaglyphic.

Choosing what to display in the Library

The Library is much more than a passive storehouse of material for your Pinnacle Studio
productions.

The Library Browser has several features for decluttering your view by hiding assets that
aren’t relevant to your purpose. No matter how numerous your media files, the combined
power of these techniques can greatly speed your browsing.

Location tabs

Most importantly, each location tab corresponds to a different selection on the Navigator.
Like web browser tabs, location tabs are readily defined (click the ‘+’ icon at the right end of
the tab list), and come in handy for keeping track of multiple things simultaneously.

Clicking within the Navigator sets the location for the current tab; conversely, clicking
another tab transfers you to its saved location on the tree. Only the assets within the chosen
location are displayed in the Browser. If the location has subfolders, however, their contents
will be included. To keep things simple, choose a location as near the bottom of the folder
hierarchy as possible.

Other controls let you restrict the display further by filtering out some of the assets in the
chosen location. Each location tab maintains its own set of filters, so any change of filtering
settings affects the current tab only.

Filter by rating

The Filter by rating control at the top of the Library hides all assets that don’t have at least
the specified rating from one to five stars (zero stars means ‘unrated’). To use the filter, simply
click on the star that represents the minimum rating you want to bother with. The default
filter setting is to show all assets regardless of rating.

See “Inadvertent filtering” on page 30 for instructions on switching off all filters at once. To
deactivate just the rating filter click the last selected star or double-click any star.

In this close-up, three stars are highlighted, meaning that only assets with ratings of
three stars or better are on display.
Filter by stereoscopic 3D

To display only stereoscopic 3D content, click 3D at the top of the Library. To return to viewing 2D assets as well, click 3D again.

Filter by tags

Another way to narrow the field of displayed assets is with filtering by tags. Tags are keywords that you can assign to assets as you work. Once tags have been defined, you can use them in several ways to control which assets are displayed by the Browser. See “Tags” on page 31 for detailed information.

Search

At the top right of the Library is a search field that gives one further way to filter the display. As you begin entering your search term, the Browser continually updates the view to include only those assets with text that matches your search term.

Even when multiple terms are separated by spaces, partial-word as well as whole-word matches are allowed in each term. A dropdown list lets you choose whether the search will be satisfied if even a single search term matches the asset text, or if all terms must match for the asset to be accepted.

Inadvertent filtering

The various filtering methods can be combined at will. Should you leave any of the filtering types switched on when you don’t need it, it’s likely that some assets will be hidden that should be displayed. When an item is unexpectedly missing in the Browser, verify that filters are inactive.

The Browser guards against the possibility of inadvertent filtering by displaying a ‘filter alert’ that remains visible as long as any filter is in use.
A filter alert (orange bar) like the one shown here is displayed at the top of the Browser whenever filtering is in force. Click the x icon at the right-hand end to clear all filtering at once.

Tags

The Library is capable of handling a great number of asset files, sometimes far more in even a single folder than can be viewed conveniently. The Browser therefore provides a number of methods of winnowing out irrelevant assets from the display.

One method of streamlining the display of assets in the Browser is filtering by tags. A tag is simply a word or short phrase that you think would be useful as a search term. It is up to you whether you assign tags to your media, but if you do, they provide a powerful way of selecting assets to display.

Tag management and filtering

Management of tags, and filtering by tags, are handled in a panel that appears when the Tags button at the top of the Library is clicked. The panel can also be invoked by choosing Apply tag > Create new tag from any asset’s context menu.

The tags panel, with existing tags listed alphabetically.

At the top of the tags panel is a text box for entering new tag names. The panel also lists all the tags you have defined so far, lets you delete or rename them, and lets you choose which assets you want displayed in the Library.
Creating, renaming and deleting tags

To create a new tag, click in the text box at the top of the tags panel and type in your tag. Select the media that you want to tag, make sure the Apply the tag to selected media box is checked, and click the Create new tag button beside the text box. There is no limit to the number of tags you can create. However, if you try to apply a name that isn’t new, you will be notified that the name already exists, and it will not be added to the selected media.

To apply an existing tag to all currently-selected assets in the Browser, click the tag name. Selecting multiple assets to tag makes the process much more efficient than if you could tag only one item at a time.

Hovering over a tag reveals the Rename and Delete buttons. Clicking the tag itself applies it to any currently-selected assets.

Hovering the mouse over a tag reveals the controls for renaming or deleting the tag. To rename, click the Rename icon, type in the new name, and press Enter. Click the Trashcan icon to delete the tag. To delete all tags at once, use the Delete all tags button at the bottom of the panel. If you are deleting a tag that is in use, you will be given a chance to back out of the operation.

Sorting tags

In the middle of the tags panel is the Sort by dropdown, offering just two choices: ‘Abc’, in which the tags are sorted alphabetically, or ‘Relevance’, which sorts them in descending order of their popularity in the set of assets currently on display. Under the second choice, you will see the tags being resorted each time one is checked or unchecked.

Filtering with tags

Beside each tag name listed in the panel is a Filter icon that you can use to narrow the set of items displayed in the Browser. As you check and uncheck the tags, the view updates automatically.

The exact effect of your selections depends on another control, the Match dropdown just above the tags. The list provides three options.

None displays only assets that have none of your check-marked tags. In a tagged set of animal photos, checking both the ‘dog’ and ‘cat’ tags, then selecting ‘None’, should hide most of the pet pictures.
Partial selects assets with any of your tags, which happens to be exactly those hidden by ‘No match’. If you leave ‘dog’ and ‘cat’ checked, but switch to ‘Partial’, all the dogs and cats will be displayed, including the handful of photos in which both animals appear. Photos with neither tag will be hidden.

Full selects only the assets that have all your tags. Now with the same boxes checked you should see only those photos in which at least one cat and one dog appear. Notice that under ‘Partial’ you will see more assets displayed as you check more tags, but with ‘Full’ you will see fewer.

Turning off tag filtering

When tags are set to filter the contents of the Library, an orange bar at the top of the Browser lists which tags are being used. To turn off filtering by an individual tag, bring up the tag panel and uncheck the tag’s Filter icon. To turn off all filtering at once, click the x button at the right hand end of the orange bar.

The art of tagging

There is no prescribed way of using tags. The best way to use them – if you do – is the way that works best for you. Consistency is important, however. The more faithful and systematic you are about assigning tags to your media, the more useful they will be.

Since the idea is to locate an asset quickly when you need it, tags should be chosen to work well as search terms. With family photos, your tags might include the names of the people in each shot. For vacation video scenes, tags naming the locations visited would probably be useful.

Video graphic terms (‘two-shot’, ‘silhouette’, ’exterior’) can also serve as good tags by making it easier to find assets that fulfill particular structural or creative requirements.

Video scene detection

Using the Library’s automatic scene detection function, video footage can be split into multiple scenes either automatically or manually. Dividing raw files into scene-length portions can make some editing tasks much less cumbersome than they would be otherwise.

The time required for scene detection varies depending on the length of the clip and the detection method selected. A progress bar keeps you informed of the status.

To initiate scene detection, select one of the methods on the Detect scenes context menu command for video assets.

By date and time: This option often results in logical scene boundaries that reflect your intention while shooting. In many digital recording formats, such as DV and HDV, a
discontinuity in the recorded timecode data occurs whenever the camera is restarted after being stopped. These shooting breaks are treated as scene breaks under the option.

**By content:** Under this option, the scene detection tool analyzes the image content of the material frame by frame, and establishes a new scene whenever there is an abrupt change in content. However, a quick pan or rapid movement across the frame may produce some unneeded breaks.

**By time interval:** In this variant you define the length of the scenes to be created. A small editing window opens for entering the desired value in hours, minutes, seconds and milliseconds. The scene duration has a one second minimum. Press Enter to confirm your input.

To manually split scenes in a clip

1. In the Library panel, right-click a clip, and choose **Edit scenes** in the context menu. The Library panel switches to Scenes View and a pop-up player window displays.
2. In the pop-up player window, use the playback controls to pause where you want to split the scene.
3. Click the **Split Scene** button to create a scene indicator thumbnail that appears in Scenes View.
4. When you have set all the scenes you want, close the pop-up player window.

**Note:** You must turn off Scenes View before you can access the Detect scenes and Edit scenes commands in the context menu.

**Show the scenes**

To show the catalog of scenes for a particular video file, either select Show scenes from its context menu; or select the clip, then click the Scenes view button that appears at the bottom of the Library panel.

Scene view is a temporary viewing mode. The orange bar at the top of the Browser alerts you that scene view is active. At the right hand end of the bar is an x button you can use to terminate the mode. Clicking the Scenes view button again has the same effect.

A single video file can contain many scenes. This makes the footage easier to manipulate during editing than if it were treated as a single segment.
During editing, scene clips behave identically to other video clips.

## Removing scenes

To empty the entire list of scenes for a video file, select **Scene detection > Remove scenes** on the asset’s context menu.

To remove individual scenes, select one or more scenes then press **Delete**.

## Correcting media

You can apply corrections to media in the Library. The file underlying the corrected asset is not modified: instead, the correction parameters are stored in the Library database and reapplied whenever the item is displayed or used. For more information, see “Correcting timeline media” on page 98.

## SmartMovie

SmartMovie is a built-in project generator that allows you to create a slideshow or movie production automatically based on media you supply. The production will include animated transitions, a full music soundtrack and eye-catching image effects.

At the bottom of the Library, just click **SmartMovie**.

To begin, select from the Library a series of photos or video files. Your music might come from digital audio assets already in the Library, or you can cook up a soundtrack on the spot with the **ScoreFitter** tool.

That might be all it takes, though you can work on the project further with manual editing if you wish. Once you have a final product you like, it takes only a few clicks to burn it onto a disc or save it as a file for other uses, such as upload to the web.

The **SmartMovie** panel that slides up into the window from below contains three subs. The leftmost of these presents information about SmartMovie, and advice on how many files to include. The center sub is a storage area with bins for photos and other images (top) and audio. The right sub contains controls for customizing the show.
Adding media

To add media to the production, drag them from the Browser into the upper bin in the storage area. Drag thumbnails within the storage area to get the order you want. Continue adding further images until you are satisfied.

To add music, drag one or more sound files to the lower bin in the storage area. Alternatively you can click the clef button in the bottom left corner of the audio bin to create a music soundtrack in ScoreFitter.

As media are added, the total running time of the source material is displayed in the top-left corner of the bin. This is not necessarily the length of the resulting movie.

Preview, edit and export

Once your media are in place, click the Preview button on the footer bar below the tool. The project is created and presented in a preview window. If necessary, you can return to the settings to modify your media selections.

When you click the Preview button, the media you have chosen are automatically saved in a Collection named Latest Smart Creation. If you expect to make further use of this grouping of assets, rename the Collection to prevent it being overwritten the next time you look at a SmartMovie preview.

The analysis phase of generating a SmartMovie may take some time to complete the first time the material is analyzed. Full rendering of the project, with progress indicated by shading on the time-ruler of the Player, may introduce an additional delay before a fully-detailed preview is available.

The Edit button brings your production to the Movie Editor timeline for detailed editing. It’s a good idea to check that the timeline video settings match your requirements for the show. The video settings button on the settings panel provides access to these. Also see “The Project Timeline” on page 46.

When the presentation is the way you want it, click Export to burn a disc or create a file for upload.
The storage area

The photos in the upper bin are displayed as icons, while the music and sound files in the lower bin appear as text lines giving the file name and duration of each asset. Both bins support multiple selection, drag-and-drop reordering, and a context menu with just two commands:

**Delete selected:** The selected media are removed from the SmartMovie production. They remain available in the Library for other uses. (Shortcut: Delete.)

**Open editor:** This command opens the Corrections tool of the Photo or Audio Editor. Any modifications you make to the media apply only within this SmartMovie production. (Shortcut: double-click.)

SmartMovie Settings

The settings on this sub customize the SmartMovie production.

![](image)

The settings entered will be used the next time the production is generated. The video settings button lets you set up the timeline options that will apply if you take the production into the Movie Editor. The clear project button removes all media from the project and returns to default settings.

**Title:** Enter a caption to be used as the main title of the movie.

**Clip lengths:** The visual tempo of your movie increases as the clip length is shortened. Maximum uses the original length of the asset.

**Pan and zoom:** Checking this option enlivens your presentation with simulated camera moves.

**Fit image:** Check this option to enlarge material that is too small for the frame format of your project.

**Video Track Volume:** Set the volume of the original audio in the video segments. For a soundtrack of background music only, set to zero.
The **Edit** tab lets you access Pinnacle Studio’s main editing features for digital movie creation.

This section contains the following topics:
- Edit tab components
- The Editor panel
- Previewing edits in the Player
- The Project Timeline
- The Timeline toolbar
- 3-point and 4-point editing
- The timeline track header
- Editing Movies
- Title Editors, ScoreFitter, voice-over
- Deleting clips
- Clip operations
- Rotating video
- Trimming
- Using Slip, Slide, Roll, or Stretch tools on the Timeline
- Using the Clipboard
- Controlling speed with Time Remapping
- Using Time Freeze to freeze frames
- Movies within movies (nested projects)
- Picture-in-Picture (PIP)
- Track Transparency
- Transitions
- Morph Transitions
- Seamless Transitions (Ultimate)
- Clip effects
- Clip context menus
Edit tab components

The **Edit** tab brings together four main components:

The **Library** panel provides the assets available to your project. For more information about the Library, see “The Library” on page 13.

The **Editor** panel lets you access and edit properties for the currently selected media or asset.

The **Timeline** lets you organize the assets as clips within a schematic representation of your production.

The **Player** panel lets you preview Library assets before adding them to your project. It also lets you view – on a frame-by-frame basis if you like – how any part of the production will actually appear to your audience when you export it, whether you save it as a file, burn it to a disc, transfer it to a device, or upload it to the Internet.

The **Edit** tab includes the Library/Editor panel (Editor showing, upper left), the Player panel (upper right), and the Timeline (lower panel).

Along with the **Library**, the **Editor**, the **Timeline** of your project, and the **Player**, the **Edit** tab lets you access a variety of tools and techniques for creating and editing titles, adding effects, and other purposes.

The editing process often starts by dragging assets from the **Library** panel to the timeline. From there, you can make some edits in the timeline itself, or you can right-click an asset in the timeline to access additional editing tools. You can also double-click an asset to activate the **Editor** panel or an alternative editing window (such as the **Title Editor** or **3D Title Editor**).
The Editor panel

Accessible from the Edit tab, the Editor panel shares a space with the Library panel.

The Editor panel gives you global and keyframe control over the properties for the media or asset selected in the timeline, without leaving the Edit tab.

In the timeline, select the media you want to work with, and open the Editor panel to view the properties or other settings.

For example, if you select a clip with an effect applied in the timeline, you can see the properties for the clip.

To see the settings for the effect applied to the clip, click Effect along the top of the Editor panel.

Not only can you edit the effects or corrections applied to the selected clip, but you can also add an effect or correction to the selected clip from within the Editor panel.
Effect is the active section for the asset selected in the timeline.

To apply a consistent setting to the entire media or asset, adjust the settings (no keyframes active).

**Using keyframes**

To use keyframes to vary the settings, drag the scrubber on the right side of the Editor panel to the position you want, and click the **Turn on/off keyframing** button (diamond) to the right of the control you want to adjust. You can add as many keyframes as you need to get the results you want. The scrubber in the Editor panel is synchronized with the scrubber in the timeline and the Player panel, so you can use any of these s to find the frame you want.

To add a keyframe, click the white **Add/Remove Keyframe** button (diamond) next to the control you want to set. Then adjust the control, using the preview in the Player window as a reference.

To select a keyframe, click the arrow buttons (triangles) on either side of the **Add/Remove Keyframe** button.

To delete a keyframe, select the keyframe (using the arrow buttons) and click the **Add/Remove Keyframe** button (icon changes when in “Remove” mode).

To move a keyframe along the keyframe line (and thus along the timeline), click it and drag.

**Caution:** If you turn off keyframing (by clicking the **Turn on/off keyframing** button), you will lose all keyframes for that control (keyframes are not hidden--they are removed). If you click the **Turn on/off keyframing** button in a title bar for a section, all keyframes for all controls will be removed.
The \textit{Turn on/off keyframing} button in a title bar will add or remove keyframes for all controls within that section.

In this example, the scrubber is aligned with two selected keyframes. You can remove a selected keyframe by clicking the Add/Remove Keyframe button (diamond with line through it) that appears to the right of the control.

\textbf{Previewing edits in the Player}

You can operate the \textbf{Player} panel either in single or dual preview mode. Click the \textbf{Preview Mode} button in the upper right corner of the Player to toggle between them.

\textit{The Player in single mode. You can choose to view either ‘Source’ (Library) or timeline material.}

Single mode conserves screen space by providing only one Player preview. The \textbf{Source} and \textbf{Timeline} tabs above the Player indicate whether Library or timeline material is being viewed, and allow you to switch from one to the other.
In dual mode, **Source** (Library) material is shown in the left-hand preview, and timeline material in the right-hand preview, each with its own set of transport controls. The dual view makes it easier to locate Library assets that fit well with your movie by making both the existing and the prospective material visible simultaneously.

**Common preview controls:**
The following controls are available at the bottom of both the **Timeline** preview and **Source** preview:

- **Playback Speed** bar: Set to 1x playback speed by default, drag to the right to increase the playback speed. To decrease playback speed, drag to the left, not passing the narrow middle area. To reverse playback, drag to the left side of the bar (the **Play** button flips when playback is set to reverse). You can also choose a playback speed from the dropdown list to the right of the bar. Click the dot above the bar to reset playback to 1x speed.

- **Playback** controls: Standard playback controls let you navigate your project on the Timeline: **Loop**, **Go to start**, **Jump backward**, **Step one frame backward**, **Play/Pause**, **Step one frame forward**, **Jump forward**, **Go to end**.

- **Duration** and **Timecode** (TC): These indicator appear at the top of the preview areas. In the case of the Source clip, the total trimmed length is displayed. For the Timeline, the total project length is displayed. The TC (Timecode) indicator displays the current scrubber position for each preview.

- **Show full screen**: Lets you preview in fullscreen mode. Press ESC to exit.
• **Dock/Undock**: Lets you undock the preview so that you can position anywhere on your screen or on a second screen.

**Timeline preview controls**

The following controls are available for the Timeline preview:

- **Zoom Level** box: Choose Fit to fill the preview area, or choose a zoom level from 10% to 400%.
- **System Volume and Mute**: Controls the volume for any audio on the Timeline. Clicking the Volume to toggle Mute on or off. Click the Volume arrow and drag the slider to increase or decrease the audio volume. For more control over audio, use the controls in the Timeline.
- **PIP controls**: Picture-in-Picture (PIP) controls let you scale or crop a clip. For more information, see “Picture-in-Picture (PIP)” on page 85.

**Source preview controls**

- **Video stream active** and **Audio stream active** buttons: These buttons let you toggle between including both the video and audio during playback, or including audio only in order to preview an audio waveform of the clip audio.

- **Send to Timeline**: Click to send the source clip that you’ve previewed to the Timeline. The clip is inserted at the scrubber position or according to markers indicating an in-point or out-point.
- **Mark In, Mark Out, Clear mark in/mark out**: Markers let you trim the source clip before you add it to the Timeline. Markers can be used for 3-point editing and 4-point editing. For more information, see “Clip operations” on page 67 and “3-point and 4-point editing” on page 57.

**Disc editing**

You can prepare a project that you want to export to MyDVD by enabling the **Disc Editor** button in the timeline toolbar.

Pinnacle Studio lets you smoothly transition a movie to a disc project at any time during development, so it’s all right to start in the Movie Editor even if you end up targeting DVD for output instead of or as well as the other options.

For more information about disc editing, see “Disc projects” on page 193.
Slideshow productions

In addition to all types of video productions, you can create complex slideshows and presentations from still images. The same editing techniques apply in both cases.

The Project Timeline

The timeline is where you create your movie, by adding video, photo and audio assets from the Library, by editing and trimming these core media, and by enlivening them with transitions, effects, and other enhancements.

Timeline fundamentals

The timeline consists of multiple tracks – as many as you require – in a vertical stack. Tracks nearer the top of the stack are positioned towards the front when viewed, their opaque parts obscuring the tracks below.

The basic action of movie authoring is to drag an asset from the Library to a timeline track, where it is called a clip. With a little practice, you can lay out a rough edit of a movie very quickly just by adding its main media assets at their approximate timeline positions.

At the left end of the timeline are track headers with several controls per track: a lock button, the track name, and monitoring buttons for the track’s video and audio.

The track header: To the left of each track is a header area that provides access to functions such as disabling video or audio monitoring for the track.

The default track: One track is highlighted with lighter background color, and is also marked with an orange bar to the left of the track header. This is the default track. It has a special role in certain editing procedures; for instance, it is the target track for pastes. To make another track the default track, click in its header.

Your current position on the timeline corresponds to the video frame shown in the Player panel. The current position is indicated by a vertical red line, at the bottom of which is a draggable scrubber handle. Another vertical line marks the same position in the Editor panel (in the keyframe area).
The toolbar

Above the tracks, the timeline toolbar provides several clusters of editing-related tools.

The Navigator

The space just under the toolbar can be occupied by the Navigator or the Storyboard, or by neither. The Navigation tool selector is located near the left end of the timeline toolbar. It includes a dropdown that lets you select which tool you want displayed in that area.

The Navigator is an auxiliary navigation panel that can be revealed or hidden by clicking its icon on the Navigation tool selector near the left end of the timeline toolbar.

The full-width strip appears just below the toolbar. It gives a bird’s-eye view of your whole project at a reduced scale. In the Navigator, the bars representing clips have the same colors as they do on the timeline, except that the bar representing the selected clip is drawn in orange. Clicking in the Navigator allows you to speedily access any timeline location.

A portion of the Navigator strip, showing the current position (vertical line, left) and the translucent draggable view window.

The gray rectangle that encloses a portion of the Navigator display – the view window – indicates the section of your movie currently visible on the timeline tracks.

To change which part of the movie is in view, click and drag horizontally within the view window. The timeline scrolls in parallel as you drag. Since your timeline position does not change, this may take the scrubber out of view.
The Storyboard

Assembling a movie can involve juggling a large number of photos and video clips, as well as deciding where to place titles, Montages and the like. In the Storyboard, the clips on one track of your movie are presented as a sequence of icons, so you can see at a glance what is included and where. To choose which track to view in the Storyboard, use the Storyboard link button in the track header.

Any of the photos, video, audio, projects, templates and titles in the Library can be added to your movie by dragging and dropping them onto the Storyboard. Once there they can be rearranged, or removed altogether if you change your mind.

Different types of clips are represented in the Storyboard with different colors. For example, photos and videos have a blue frame, and projects have a gray frame. As in the timeline, clips that have had effects applied appear with a magenta line on the top, and clips with corrections have a green line. A colored band connects the Storyboard icon with the position of its clip on the timeline; a gap in the timeline is reflected in a gap in the Storyboard. Once you become familiar with the color coding, it will help you quickly visualize the structure of your movie.

The space just below the toolbar where the Storyboard appears is also used by the Navigator (and in the Disc Editor by the Menu List). Which tools is visible, if any, is controlled by the Navigation tool selector near the left end of the timeline toolbar.
Navigating in the Storyboard

To scroll to a part of the Storyboard that is not in view, hover with the mouse over the Storyboard until a hand cursor appears. Now click the left button and drag the Storyboard. If you drag the mouse quickly and release the mouse button, the Storyboard will briefly continue scrolling, thus creating a ‘swiping’ behavior.

Alternatively you can hover over the Storyboard and use the mouse wheel to scroll, or use the arrows at each end of the Storyboard.

Editing with the Storyboard

Although most editing takes place on the timeline tracks, the Storyboard has some editing capability. For instance, effects can be added directly to a clip on the Storyboard by dragging and dropping the effect onto the clip. The clip’s context menu offers the same set of commands here as on the timeline. Any editing that takes place on the Storyboard is immediately reflected in the timeline, and vice versa.

**Adding clips:** Any photo, video, audio clip, project, template or title can be added to your project by simply dragging it from the Library to the Storyboard. An insertion line appears to indicate where the new clip will be placed. You can select multiple clips to add them all at once.

**Inserting or replacing clips:** If you are inserting material between clips already on the Storyboard, drag the new clip so that it overlaps the right side of the clip that will precede it. When the insertion line appears and a space opens up, drop the new clip into the gap.

To replace a clip, drag the new one onto the clip to be replaced. The insertion line will appear, and the old clip will highlight to indicate proper placement. The new clip must be the same type as the old. A video clip cannot be replaced by a photo or audio clip, for example.

**Selecting clips:** To select a clip, click on its icon; an orange frame around the clip indicates selection. The timeline scrubber will jump to the beginning of the selected clip, and a connecting band of color will link the Storyboard clip with its timeline counterpart. If the timeline position of the selected clip is currently off-screen, it will be brought into view.

You can select multiple clips using the Shift and Ctrl keys according to the usual Windows conventions.

**Reordering clips:** To pick up a clip and move it, click on it until it is selected, and then drag it to its new location. If necessary, the Storyboard will scroll until you reach the desired position.
Zoom level of the timeline

To change the zoom level of the timeline, either click and drag horizontally in the time-ruler along the bottom of the timeline, or drag the sides of the view window. The first method has the advantage that it always leaves the screen position of the playhead undisturbed, which may make it easier to orient yourself after the zoom.

To change the zoom of the Navigator itself, use the plus and minus buttons immediately to its right.

Double-clicking on the view window adjusts the zoom of both the Navigator and the timeline such that your entire movie fits within the Movie Editor window.

Resizing panels

The height of the timeline panel, along with the relative proportions of the Library/Editor panel and the Player panel, can be adjusted with the sizing grip in the form of an inverted T in the middle of the screen.

Resizing tracks

To adjust the height of individual timeline tracks, grab and adjust the separator lines between the track headers on the left. If the vertical size of all tracks exceeds the available viewing area, a scroll bar at the right will allow you to select which tracks are in view.

Set the height of the Storyboard (when it is visible) by vertically dragging the horizontal separator along the Storyboard’s bottom edge.

The Timeline toolbar

The toolbar above the timeline offers various settings, tools and functions that apply to the timeline and timeline editing. These are described in order from left to right.

Customizing the toolbar

The timeline toolbar can accommodate numerous buttons to help editing go more smoothly. One set of buttons is available for the Movie Editor and a somewhat larger set for the Disc Editor. The Customize toolbar button at the far left of the toolbar lets you choose which subset of the available buttons you wish to display.

Clicking the button brings up a panel upon which all the other toolbar buttons can be individually set as visible or hidden. The gray check marks beside the Timeline settings button and a few others indicate that these buttons are not optional and will be displayed
as a matter of course. Check or uncheck the boxes for the optional buttons until the toolbar has been configured to your liking, or check the Select all box to display all of the buttons. Some of the commands invoked by buttons also have keyboard shortcuts. These work whether the button is displayed or not. (See “Appendix D: Keyboard shortcuts” on page 307 for more information.)

**Timeline settings**

By default your timeline settings are copied from the first video clip you add to the timeline. If that will give the right result, you won’t have to alter them.

If you do need to change these basic image properties of your project, click the Gear button to open the timeline settings panel and configure the four settings provided.

**Aspect:** Choose between a 4x3 and a 16x9 display.

**Imaging:** Choose between Regular (2D) and Stereoscopic (3D).

**Size:** Choose amongst the HD and SD pixel resolutions available for the given aspect ratio.

**Frame rate:** Choose from a selection of frame rates consistent with the other settings.

These settings can be changed at any time during the development of your movie, but you should be aware that a change of the frame rate can cause a slight shifting of clips on the timeline as they adjust to new frame boundaries.

Video material that is not in compliance with the chosen project settings will be converted automatically on being added to the timeline. If you are making a stereoscopic movie, 2D material may be used but it will still look two dimensional, as both the right eye and left eye views will be the same. 3D material can be used on a 2D timeline, but only the left eye channel will be shown.

If you want to choose a video standard for your projects explicitly, rather than relying on inheriting the format from the first clip added, open the Project settings page of the application settings. See “Project settings” on page 252.

**Disc Editor**

You can prepare a project that you want to export to MyDVD by enabling the Open Author toolbar button in the timeline toolbar.

For more information about disc editing, see “Disc projects” on page 193.
**Audio mixer**

This button opens the enhanced audio control area with volume adjustment tools and access to the Panner, a surround panning control.

**ScoreFitter**

ScoreFitter is the integrated music generator of Pinnacle Studio, providing you with custom-composed, royalty-free music exactly adjusted to the duration required for your movie. See “ScoreFitter background music” on page 189.

**Title**

The Title button opens the Title Editor. If none of the many supplied titles answers your need, why not author one of your own? See “The Title Editor” on page 151.

**3D Title Editor**

The 3D Title Editor lets you edit preset 3D titles and create your own 3D titles. You can also create 3D objects.

**Voice-over**

The voice-over tool lets you record commentary or other audio content live while viewing your movie. See “The Voice-over tool” on page 190.

**Audio Ducking**

**Audio Ducking** is used to automatically lower the volume of one track so that you can hear another track better. For more information, see “Using Audio Ducking to automatically adjust volume” on page 191.

**Multi-Camera Editor**

The **Multi-Camera Editor** is a workspace that lets you create professional-looking video compilations from footage of events that have been captured on different cameras, from different angles. For more information, see “Multi-Camera Editing” on page 259.
**Track Transparency**

Track Transparency provides precise transparency control in the Timeline by opening a mode that makes it easy to set keyframes and adjust transparency level by keyframe. For more information, see “Track Transparency” on page 86.

**Motion Tracking**

You can track the motion of elements in your videos and add masks or objects that follow the same motion. For more information, see “Motion Tracking” on page 135.

**Split Screen**

You can easily create a split screen video in Pinnacle Studio to play multiple videos in a preset or customized template. For more information, see “Split screen video templates” on page 145.

**Mark In, Mark Out, Clear**

- **Mark In** lets you set the start point for a trimming action.
- **Mark Out** lets you set the end point for a trimming action.
- **Clear Mark In/Mark Out** lets you remove all trim markers.

**Razor blade (Split Clips)**

To split one or more clips at the playhead position, click the razor blade button. No material is deleted by this operation, but each affected clip becomes two clips that can be handled separately with respect to trimming, moving, adding effects and so on.

If there are selected clips at the playhead on any track, only those clips will be split. Both parts of those clips remain selected after the split.

If there are no selected clips at the playhead line, all clips intersected by it will be split and the right-hand parts will be selected to facilitate easy removal in case that is desired.

Locked tracks are exempt from the split operation.

**Trashcan**

Click the trashcan button to delete all selected items from the timeline. See “Deleting clips” on page 67 for details on how other timeline clips may be affected by the deletion.
Snapshot

If, while previewing video on the timeline, you see a frame that you would like to capture as a still image, click the Snapshot button. This creates a photo of the image currently being previewed, and puts it in the Snapshot folder under Photos in the Library.

Using the Snapshot button on the timeline is a quick way to grab a frame; for more control, use the Snapshot tool in the Video Editor. Please see “Snapshot” on page 111 for more about the Snapshot tool.

Markers

The marker functions available here are identical to those provided in the media editors for video and audio. Please see “Markers” on page 109.

Instead of being attached to a particular clip, however, timeline markers are considered to belong to the video composite at the marked point. Only if there is a clip selection embracing all tracks at the marked point, and only if no track is locked, will the markers change positions during timeline editing.

Selection tool

This default tool lets you select clips in the Timeline. It is one of five tools that let you adjust clips in the Timeline.

Slip tool

Lets you drag in the Timeline to change what frames you see (content) without affecting the “window” (duration) for the clip, essentially moving the trim markers for the source clip. For more information, see “Using Slip, Slide, Roll, or Stretch tools on the Timeline” on page 77.

Slide tool

Lets you move the clip “window” along the timeline without changing duration, essentially moving the trim markers in the Timeline to reveal different content. For more information, see “Using Slip, Slide, Roll, or Stretch tools on the Timeline” on page 77.
**Roll tool**

- Lets you adjust the size of the clip “window”, affecting the duration of the selected clip and the adjacent clip. For more information, see “Using Slip, Slide, Roll, or Stretch tools on the Timeline” on page 77.

**Stretch tool**

- Lets you adjust the size of the clip “window”, thus changing the duration on the Timeline, expanding or contracting the content (adjusting the speed) in order to fit the new duration without changing which frames are shown. For more information, see “Using Slip, Slide, Roll, or Stretch tools on the Timeline” on page 77.

**Trim mode**

- To open a trim point, place the timeline scrubber near the cut to be trimmed and click the trim mode button. Click it again to close trim mode. Please see “Trimming” on page 69 for more details.

**Dynamic length transitions**

- Ordinarily when a transition is added to the timeline, it is given the default length you have configured in Setup. Click this button if you would like to override the default length. When the button is highlighted, the transition durations can be set by dragging the mouse to the right or left while placing the transition onto a clip. For more about transitions, please see “Transitions” on page 87.

**Magnetic snapping**

- Magnet mode simplifies the insertion of clips during dragging. While the mode is active, clips are ‘magnetically’ drawn to other items on the timeline when they approach within a critical distance. This makes it easy to avoid the unnecessary – though often indiscernibly small – gaps between items that are otherwise apt to arise during editing. If you want to deliberately create such a gap, however, simply turn off the mode to allow the preferred placement.
Audio scrubbing

By default, the audio portion of a project can be heard only during playback in the preview. The audio scrubbing button on the timeline toolbar provides an audio preview even while just ‘scrubbing’ through your movie by dragging the timeline scrubber control. The shuttle wheel of the Player also provides audio scrubbing.

Editing mode

The editing mode selector at the right-hand end of the timeline toolbar determines the behavior of other clips when editing changes are made.

Five choices of editing mode are available: **Smart Editing**, **Insert** and **Overwrite**, **3-4 Point Edit**, **Replace**. The default is **Smart Editing**, in which Pinnacle Studio selects from insert, overwrite and sometimes more complex strategies in the context of each editing operation.

**Smart Editing Mode** is designed to maintain synchronization between timeline tracks as far as possible. In a multitrack editing situation, clips typically have vertical as well as horizontal relationships. When you have carefully placed your cuts to coincide with the beats of a music track, for example, you don’t want to disrupt everything when you make additional edits.

**Insert Mode** is always non-destructive: it moves other clips on the track out of the way before inserting new material. It will also automatically close gaps created by removing material. Only the target track is affected. Any prior synchronization with other tracks from the edit point rightwards is lost.

**Insert Mode** is most useful in the early stages of a project, when you are collecting and arranging clips on the timeline. It ensures that no material will be lost, and makes it very easy to reorder clips and sequences of clips.

In the later stages, when the structure of your project is approaching its final state and you have started carefully synchronizing material on different tracks, insert mode is less helpful. The very properties that favor its use for the early stages (the ‘ripple’ behavior) count against it when finalizing. This is where overwrite comes into play.

**Overwrite Mode** directly affects only the clips you select. Changing the length or position of a clip in overwrite mode will overwrite neighboring clips (if you lengthen) or leave gaps (if you shorten). It will never affect the synchronization between tracks.

**3-4 Point Edit Mode** offers a quick and precise way to add clips to a sequence on the Timeline. You can use **3-4 Point Edit Mode** for any project, but it works particularly well for
projects where you want align clips precisely, such as matching illustrative clips to narration or matching the clips to specific parts of a soundtrack. For more information, see “3-point and 4-point editing” on page 57.

Replace Mode lets you replace one clip by another while retaining its duration, effects and other properties. It is particularly useful when working with templates. See “Replacing a clip” on page 65 for details.

Using the Alt key to override the editing mode

To change insert to overwrite behavior, or overwrite to insert, hold down the Alt key while carrying out your edit as usual. You can press (or release) Alt as you please while setting up the edit: what counts is the state of the key at the instant the operation is finally enacted, such as when you drop dragged items onto the timeline.

3-point and 4-point editing

You can use the 3-4 Point Edit Mode in Pinnacle Studio to trim and add source clips to a sequence in the Timeline. 3-point and 4-point editing offers a quick and precise way to add clips. You can use 3-4 Point editing mode for any project, but it works particularly well for projects where you want align clips precisely, such as matching illustrative clips to narration or matching the clips to specific parts of a soundtrack.

“Points” refers to the “in point” (Mark In) and “out point” (Mark Out) markers that you add to the source clip and the Timeline. In most cases, you will likely use 3-point editing because it lets you edit precisely without adjusting the speed of clips. 4-point editing, in most cases, results in adjusting the speed of the clip so that it precisely fits a defined time in the Timeline.

How does it work?

In the Timeline, you can identify where you want to add a source clip by adding an in-point marker (for where you want the clip to start), an out-point marker (for where you want the clip to end), or both. The same is true for your source clip. You can add an in-point marker, an out-point marker, or both. The source clip will be trimmed according to these markers when you add it to the Timeline and overwrite any underlying content in the Timeline (non-destructive, the original files are protected). If you decide to set all 4 points, in most cases, the duration set in the Timeline will not match the duration of the trimmed clip. This means you need to alter the speed of the clip to fill the time defined in the Timeline, or, you can choose which 3 points are the priority, and allow the clip to run at its original speed.

Example of a 3-point edit

If you want to match a narrator’s description of a bear to a clip of a bear, in the Timeline you can set your in-point and out-point markers for the narration, and then evaluate your source
clip that has the bear. Set either an in-point marker or an out-point marker, depending on your preference and the overall impact. If you use an in-point marker, when you drag the clip from the Library to the Timeline, it will automatically align the source and Timeline in-point markers and trim the source clip at the out-point marker set in the Timeline.

**Fit Clip options**

When you add clips to the Timeline in **3-4 Point Edit Mode**, a **Fit Clip** message window appears. The windows provides you with a number of options that let you determine exactly how the clip will interact with the content in the Timeline. The options presented depend on the points set and the length of the clip in relation to the length of the gap on the Timeline.

*In this example, the Fit Clip window offers two options: Trim Source Clip, which means it will use a soft marker (gray marker) as a Timeline trim marker for the source clip because it represents the end of the current track. Or, Overwrite Timeline, which means the two points set for the Source clip will be respected and the source clip will extend beyond the end of the clip currently in the Timeline.*

**Note:** When you trim clips in the Library, your trim markers are saved with the clip. You can use the trimmed clip with the next project or clear and reset the markers at any time.

**Tip:** **3-4 Point Edit Mode** always overwrites any underlying content to protect track synchronization in multi-track projects. To insert clips, rather than overwrite, from the editing mode drop-down, choose **Insert Mode**.

**To add clips by using 3-point editing**

1. In the Timeline, click the **3-4 Point Edit Mode** button in the editing mode drop-down.
The 3-4 Point Edit Mode button is located in the drop-down at the right end of the Timeline toolbar.

2 With one or more clips already in the Timeline, drag the scrubber to the position you want, and do one of the following:
   • To set an in point, click the Mark In button on the Timeline toolbar, or press I.
   • To set an out point, click the Mark Out button on the Timeline toolbar or press O.
   **Note:** To clear a marker, click the corresponding button a second time. To clear both markers, click the Clear Mark In/Mark Out button.

3 If you are setting two points in the Timeline, repeat step 2.

4 In the Library, select the source clip you want, and in the Player panel, ensure the Source view is displayed (click the Source tab).

5 Using the controls below the preview, move the scrubber to the position you want, and do one of the following:
   • To set an in point, click the Mark In button or press I.
   • To set an out point, click the Mark Out button or press O.

6 If you are setting two points for your source, repeat step 2, but the total points for the Timeline plus the source should be 3.

7 In the Timeline, select the track where you want to add the source clip, and do one of the following:
   • Below the Preview, click the Keep Speed button.
   • From the Library, drag the source clip to the track.

8 When the Fit Clip window appears, choose the option you want from the message window.
The clip is added to the Timeline according to the points set.

To add clips by using 4-point editing

1. In the Timeline, click the **3-4 Point Edit Mode** button in the editing mode dropdown.
2. With one or more clips already in the Timeline, drag the scrubber to the in-point position you want, and click the **Mark In** button on the Timeline toolbar.
3. In the Timeline, drag the scrubber to the out-point position you want, and click the **Mark Out** button on the Timeline toolbar.
4. In the **Library**, select the source clip you want, and in the **Player** panel, ensure the **Source** view is displayed (click the **Source** tab).
5. Using the controls below the preview, move the scrubber to the in-point position you want, and click the **Mark In** button or press **I**.
6. Move the scrubber to the out-point position you want, and click the **Mark Out** button or press **O**.
7. In the Timeline, select the track where you want to add the clip.
8. Below the preview, click the **Fit to Duration** button.

   **Note:** The speed of the clip will be adjusted to fit the duration between the in and out points in the Timeline. Unless the clip duration and Timeline duration are exactly the same, a yellow dashed line appears across the top of the clip to indicate that the original speed has been modified. If your clip includes audio, the quality of the audio will be affected and sped up or slowed down to correspond with the new clip duration.

   ![Clip in Timeline](IMG1944.mov)

   **Note:** A **Fit Clip** window displays when you add the clip to the Timeline. Accept the default option to maintain a 4-point edit. If you decide to override a point (to essentially use a 3-point edit), click another option in the window.

### The timeline track header

In the header area of the timeline are a number of controls affecting the arrangement and organization of the timeline tracks. These are covered here, while the audio functions controlled from the timeline header, such as track volume, are described in the topic “Audio on the timeline” on page 185.

The all tracks area above the track headers offers controls similar to those found on each track header but with global effect: they apply to all tracks simultaneously, overruling the individual settings.
Default track

The orange vertical line to the left of the track header, together with a lighter background shade, identifies the default track. It provides a destination track for certain functions, including send to and paste. Newly-created titles and ScoreFitter songs are also added on this track. For more information see “Sending to the timeline” on page 66, “Using the Clipboard” on page 79, “The Title Editor” on page 151 and “ScoreFitter background music” on page 189.

To make another track the default track, simply click anywhere within the track header other than on a button or other control.

Locking

Click the padlock buttons to protect a track from unintended edits. The same button in the all tracks area confers this protection on the whole project.

Storyboard link

The Storyboard is an alternative representation of a timeline track. A small storyboard link button appears beneath the padlock button on all track headers when the Storyboard is open. Click the button to select a given track as the one linked to the Storyboard display.

Track name

To edit the name of a track, click the name once to access the in-place editor, or select Edit track name from the track header context menu. Confirm your edit with Enter, or cancel it with Esc.

Video and audio monitoring

The video and audio buttons in the track header control whether this track contributes its video and audio to the composite output of the project. They support the many editing situations in which it is advantageous to block the output of one or more tracks in order to simplify the preview. The same buttons in the all tracks area toggle audio and video monitoring for the entire project.
Additional track functions

The following functions are available in the track-header context menu or by manipulating the tracks:

**Insert New Track:** You can insert a new track either above or below the existing track.

**Delete track:** Delete a track and all clips on it.

**Move track:** Drag the track header up or down to a new layer position. As you drag, a bright horizontal line appears at valid placements.

**Copy track:** Keeping the Ctrl key pressed while moving a track will copy the track instead of move it.

**Track size:** The context menu contains four fixed track sizes (Small, Medium, Large, Very large). For custom sizing, drag the separator line between the track headers to seamlessly adjust the height.

**View waveforms:** Toggle the waveform view for audio clips.

Please see “Audio on the timeline” on page 185 for coverage of Timeline audio functions.

---

**Editing Movies**

The first step in any movie editing session is to start or open a movie project.

**To launch a new production:** Choose File > New > Movie from the main menu. Before adding your first clip, make sure that the timeline video format will be right for the project (see below).

**To edit an existing movie:** Select a recent project from the File > Recent menu; click File > Open to browse for a movie project to open; or locate the movie you want to open in the Projects folder of the Library, and double-click the thumbnail.

If your movie has been stored as a project package, it must be unpacked before editing. Find your project in the Studio Projects group in the Library, and use the Unpack project package command on the thumbnail’s context menu.

Alternatively, you can click File > Open and find the project package in Explorer by choosing Studio Project Package (axx) in the file extension box.

When unpacking is finished, the unpacked project is added to the Library and opened on the project editor timeline, where it can be edited as usual.

**To open a Studio project:** Choose File > Import previous Pinnacle Studio projects. Please note that some features of projects created with a previous version of Studio may not be supported in the current version.

**To import a Studio for iPad project:** Choose File > Import Studio for iPad App projects.
Project settings

To start editing a new project, verify that the video format settings of your project – aspect ratio, 2D or 3D, frame-size and playback speed – are as you want them. See “Project settings” on page 252 for configuring the automatic feature, and “Timeline settings” on page 51 for instructions on entering project settings manually.

Depending on your timeline settings, clips in some formats might not be instantly playable. Such content will automatically be rendered in an appropriate format.

Establishing tracks

With only minor exceptions, timeline tracks in Pinnacle Studio do not have specialized roles. Any clip can be placed on any track. As your projects become more complex, however, you will find it increasingly helpful to give some thought to the organization of tracks, and rename them according to their function in the movie. For information on track properties and how to edit them, please see “The timeline track header” on page 60.

Adding clips to the timeline

Most types of Library asset can be brought onto the timeline as independent clips. The types include video and audio clips, photos, graphics, ScoreFitter songs, templates and titles. You can even add your other movie projects as container clips that work just like video clips in your project. Disc projects, however, cannot be added as container clips to a timeline, since they require a capability – user interactivity – that timeline clips don’t have.

Drag-and-drop

Drag-and-drop is the commonest and usually the most convenient method of adding material to a project. Click any asset in the Library panel and drag it wherever you like on the timeline.

When crossing into the timeline area during the drag and continuing to the target track, watch for the appearance of a vertical line under the mouse pointer. The line indicates where the first frame of the clip would be inserted if dropped immediately. The line is drawn in green if the drop would be valid, and red if it would not be possible to insert a clip where indicated (because the track is protected, for example).

It is possible to insert multiple clips into the timeline at the same time. Simply select the desired Library assets, then drag any one of them to the timeline. The sequence in which the clips appear on the track corresponds to their ordering in the Library (not the order in which you selected them).
**Magnet mode:** By default, magnet mode is switched on. This makes it easier to insert clips so that their edges meet exactly. The new clip snaps to certain positions, like the ends of clips or the positions of markers, as if drawn by a magnet once the mouse pointer gets close to the potential target.

On the other hand, don’t worry about whether the first clip is right at the start of the timeline. Not every movie starts with a hard cut to the first scene!

---

**Live editing preview**

In order to eliminate the confusion created by complex editing situations, Pinnacle Studio provides a full dynamic preview of the results of editing operations as you drag clips around on the timeline. If things seem to jump around a bit more than you’re used to during timeline editing, this is the cause. Don’t worry: you will quickly get used to and learn to take advantage of the extra information provided. Take it slowly at first. Watch the changes on the timeline as you hover the dragged item over various possible landing places, and complete the drop when you see the result you want.

If it turns out that drag-and-drop isn’t working the way you want, either press **Esc** or move the mouse pointer out of the timeline area and release the button. Either of these abandons the drag-and-drop operation. To call back a drag-and-drop after it’s complete, press **Ctrl+Z** or click the undo button.

Don’t forget that you can vary many timeline editing operations with alternative mode: just press and hold **Alt** while dragging or trimming. In a one-for-one clip replacement, **Shift** is also significant.

---

**Advanced drag-and-drop**

After you have assembled an assortment of clips on a timeline track, it’s only matter of time before you want to start changing things around. For instance, you might want to:

- Fill a gap with clips.
- Insert some clips before a specific clip.
- Replace a clip already on the timeline with a different one.

The smart editing mode helps you achieve these goals with ease.

---

**Filling a gap**

Smart mode makes it simple to fill a particular timeline gap with new material, for example. Rather than having to painstakingly pre-trim the new material to the space available, you simply drag items into the gap. Any clips that are not needed for filling the gap will be
dropped, and the last clip used will automatically be trimmed to the appropriate length. No clips already on the timeline are affected, so no synchronization problems can result.

**Inserting clips**

Suppose that your goal is to add new material to the timeline at a point where there is an existing clip. You don’t want the clip already there to be overwritten, however; you just want it (and any clips to its right) to move rightwards far enough to make room for the new material.

Here again, smart editing provides a painless answer. Simply drag the new material to the start of the clip that is in the way, rather than into a gap. The clip moves aside exactly as far as necessary.

**Inserting with split**

If you drop an item onto the middle of an existing clip, rather than at a cut, the clip will be split. The new material is inserted at the point you specified, and is followed immediately by the displaced portion of the original clip.

In smart mode, synchronization of the target track with all other tracks is maintained by inserting in each of them a gap of length equal to the new clip. To avoid affecting the other tracks in this way, use insert instead of smart mode. Alternatively, pressing Alt as you drop the new material will cause it to overwrite a portion of the existing clip. A third approach is to lock any track that should not be modified, although this will affect the synchronization of clips on locked tracks with those on unlocked tracks.

**Replacing a clip**

To replace a clip, drag a single Library asset onto the clip you want to replace while holding down Shift. The replacement clip will inherit any effects and transitions that were applied to the original clip. Corrections are not inherited, however, since they are usually meant to address the issues of a particular media item.

In smart mode, the replace operation will succeed only if the Library clip is long enough to cover the full length of the clip being replaced. In other modes a Library clip of insufficient length will be extended using over-trimming. The direction and amount of the extension is based on your mouse position as you drag. For information on over-trimming, please see “Trimming” on page 69.

If the Library asset is longer than needed, it will be truncated to the same length as the clip being replaced.
Sending to the timeline

In addition to dragging a clip to the timeline, you can ‘send’ it to the default track at the position of the playhead. The operation is equivalent to drag-and-drop, so smart mode is applied accordingly when deciding how other clips will be affected. The **Send to timeline** command is found on the context menu of an individual asset or multiple selection in the compact view of the Library.

Sending from the Player

There is also a second ‘send’ method that provides greater control.

If you click on a Library asset, the Player switches to Source mode for previewing. For trimmable media (video and audio), the Player also provides trim calipers for cutting out a starting or ending portion of the asset.

![Clicking the Send To Timeline button in the Player after trimming a Library video asset.](image)

After previewing the asset and trimming it if required, use the send to timeline button at the bottom left of the Player. As usual, the asset is added to the project on the default track and at the playhead. A useful variation is to click anywhere within the Player screen and drag the asset onto any desired timeline track. The asset is added at the drop point rather than at the playhead.

**Title Editors, ScoreFitter, voice-over**

These four functions add new clips to the project’s timeline, clips that are not underpinned by any Library asset. Instead, they are created from settings and other actions you take during editing.

Once your editing is complete, both titles and ScoreFitter clips will be sent to the default track on the timeline using the Send to timeline function, while voice-over clips will go to the special voice-over track instead. For details please see “The Title Editor” on page 151, “ScoreFitter background music” on page 189 and “The Voice-over tool” on page 190.
Deleting clips

To delete one or more clips, first select them, then press **Delete**. Alternatively, click the trashcan icon on the timeline toolbar, or choose Delete from the selection’s context menu.

In smart mode, if the deletion produces a gap that spans all tracks, it is closed by shifting material to the right of the gap leftwards. This lets you avoid accidentally creating empty sections in your movie, while still ensuring that synchronization between tracks is maintained.

If the **Alt** key is held down when deleting, any gaps produced will be left unclosed.

In insert mode, gaps on the tracks from which clips are deleted will also be closed, but other tracks will be unaffected. No effort is made to preserve synchronization to the right of the deletion.

With regard to synchronization, the safest editing mode for deletion is overwrite, which will simply remove the clips and leave everything else unchanged.

Clip operations

The timeline of your project provides comprehensive support for selecting, adjusting, trimming, moving and copying clips.

Selecting

Select clips in preparation for performing editing operations upon them. A selected clip receives an orange frame in the timeline and in the Storyboard, and is displayed as solid orange in the Navigator.

To select one clip, click it with the mouse. Any previous selections are removed. For a fast multiple selection, click in an open timeline area then drag out a selection frame that intersects the clips of interest. To select all clips with one command, press **Ctrl+A**.

To clear a selection click into any gap area of the timeline.

Multiple selection with keyboard and mouse

To create more complex multiple selections, left-click while pressing **Shift, Ctrl** or both together.

To select a series of clips: Click on the first and **Shift**-click on the last. The two clips together define a bounding rectangle, or selection frame, within which all clips are selected.

Toggle selection of one clip: Use **Ctrl**-click to reverse the selection state of a single clip without affecting any of the others.
Select rest of track: Press Ctrl+Shift-click to select all clips that start at or after the start position of the clicked clip. This function is particularly useful if you quickly want to get the rest of your timeline ‘out-of-the-way’ for inserting new material, or to manually ripple left to close timeline gaps.

**Grouping and ungrouping clips**

You can select and group multiple clips so that you can move the clips together. To **group or ungroup clips**:

1. In the timeline, select two or more clips.
2. Right-click one of the selected clips and choose Group > Group.
   - To ungroup the selection, right-click a group and choose Group > Ungroup.
   - **Note**: You can also Group as Project to save the group as their own movie. For more information, see

**Adjusting**

As you move your mouse pointer slowly over the clips on your timeline, you will notice that it changes to an arrow symbol while crossing the sides of each clip, an indication that you can click and drag to adjust the clip boundary.

Adjusting changes the length of a single clip on the timeline in overwrite mode (since insert mode would cause synchronization issues). If you drag the start of a clip to the right, a gap will be opened on the left side. If there is a clip to the immediate left of the clip being adjusted, dragging to the left overwrites it.

The adjustment pointer also appears when the mouse hovers at the ends of a gap – an empty space on a timeline track with at least one clip to its right.

It turns out that adjusting gaps in overwrite mode, as we do for clips, is not especially helpful. However, gaps do come in handy when you’re editing in smart mode if you want to ripple an individual track left or right, ignoring any resulting synchronization issues. Adjusting gaps therefore occurs in insert mode.

Even if no gap is available, incidentally, you can get the same result by holding Alt while adjusting the sides of a clip.

**Rotating video**

You can rotate video clips that you add to the Timeline. You can rotate a video clip by 90 degrees increments (right or left), or choose a custom rotation.
To rotate a video clip by 90 degree increments

1. In the Timeline, right-click the video clip that you want to rotate.
2. Choose Rotation from the context menu, and choose one of the following options:
   - Rotate Right: Rotates the clip to the right by 90 degrees.
   - Rotate Left: Rotates the clip to the left by 90 degrees

To rotate a video clip by any degree

1. In the Timeline, select the video clip that you want to rotate.
2. Open the Editor panel.
3. In the Properties list for the clip, type a value in the Rotation box or drag the slider to set the degree of rotation you want.
   Note: You can use keyframes to set different rotation values for the clip.

Trimming

Changing the length of clips or gaps on the timeline is called ‘trimming’.

Multitrack trimming is a valuable editing skill. By trimming multiple tracks at once, you can assure that the clips coming later on the timeline maintain their relative synchronization.

Trimming clips without consideration for content later on the timeline can disrupt the synchronization of your project. Soundtracks that don’t match the action and badly-timed titles are the kinds of problem that may result.

Multiple track trimming

A rule for staying in sync

Pinnacle Studio has powerful trimming tools to allow you to perform multitrack trimming without risk. Fortunately, there is a simple rule for safeguarding synchronization even on a
complex timeline: open exactly one trim point on every track. Whether the trim point is attached to a clip or a gap, and at which end, are up to you.

**Opening trim points**

To open a trim point on the active timeline track, position the timeline scrubber near the cut you want to trim, then click the trim mode button on the timeline toolbar. To open one trim point on each non-empty track simultaneously, Shift-click the trim mode button.

Once in trim mode, you can open trim points with the mouse pointer at the beginning or end of a clip. Notice that the trim pointer faces left at the start of the clip and right at the end. While the trim pointer is showing, click once at the point you want to trim. Then continue to open trim points on other tracks if required.

You can open two trim points per track by holding down the Ctrl key to create the second point. This feature is useful for the trim both, slip trim, and slide trim operations, all described below.

![Trim Editor in dual mode. The yellow rectangle shows the currently selected trim point at the start of a clip; the left side shows the final frame of the outgoing clip.](image)

When a trim point is opened several things happen:

- The left or right edge of the clip is highlighted with a yellow bar, showing that it is currently selected. Trim points that are not currently selected are shown with an orange bar.
- The Trim Editor opens, with the Player in dual preview mode.
- The transport controls under the Player become trim adjustment tools.
- The preview with the currently active trim point is outlined in yellow.
The Trim Editor

In dual preview mode, the Trim Editor shows two frames from the timeline. The currently selected trim point is always shown and has a yellow rectangle around it. If the trim point is at the beginning of the clip, the first frame of the clip is shown; at the end of the clip, the last frame. You can switch the selected trim point by clicking in the other preview window, or by pressing Tab.

![The Trim Editor in a slip trim operation. The left preview shows the currently selected trim point; the right preview shows the second trim point.](image)

Which frame is shown in the second preview window depends on which trim mode is being used. In a slip or slide trim, the second trim point of the operation is displayed, surrounded by an orange rectangle. In other cases, the second preview window shows the frame on the other side of the cut at the selected trim point.

Above each preview window, the number of frames that have been trimmed is displayed. If you think of the original cut point position as zero, the number indicates how many frames the new position of the cut point has moved.

The Trim Editor is by default in solo mode. The clip that has the trim point is shown without the tracks above it and without any transitions applied to it. This preview mode is most suitable for determining the exact frame to trim. The default display of adjacent frames are a complete composition of all the timeline tracks. You can toggle the display behavior with the Solo button in the lower right corner of the Trim Editor. When solo mode is deactivated, the preview shows trim points in their timeline context.
The Trim Editor in single preview mode.

The Trim Editor opens in dual preview mode. To switch to single preview, click the preview mode button in the upper right corner of the preview area.

**Closing trim mode:** Trim mode can be closed by clicking the trim mode button.

### Editing modes for trimming

The current editing mode – smart, overwrite, insert, or replace – determines how trimming will affect other clips on the timeline. Select the mode from the dropdown list at the far right of the timeline toolbar.

**Insert mode:** Clips to the right of a trimmed clip and on the same track will shift left or right to accommodate the new length of the clip. Synchronization with other tracks may be lost, but no clips are overwritten.

**Overwrite mode:** Only the clips you are trimming, and any neighboring clips they happen to overwrite, are altered in this mode. Synchronization across tracks is not affected.

**Smart mode:** For trimming, smart mode is equivalent to insert mode.

**Replace mode:** Dragging a new clip over an existing clip in the timeline will replace the existing clip.
Trimming the beginning of a clip

Prepare to trim the beginning of a clip (the ‘mark-in’ point) by clicking at the left-hand edge of the clip while the trim pointer is visible. With a trim point thus established, you can add or remove frames from the beginning of the clip.

To trim on the clip, drag the trim point to the left or right.

To trim on the Player, use the trim buttons to trim one or ten frames either forwards or backwards. Click the loop play button for a looping preview of the trim region.

The position of the playhead relative to the trim point helps distinguish the in-point of a clip (left) from the out-point of the previous clip (right).

Trimming the end of the clip

To trim the end of the clip (or ‘mark-out’ point), open a trim point by clicking at the right-hand edge of a clip when the mouse pointer changes to a rightward-pointing arrow. Now you can add or remove frames from the end of your clip.

Once again you can trim directly on the clip by dragging the trim point, or on the Player while it remains in trim mode.

Trimming gaps

The project’s timeline lets you trim not just the clips upon it but also the gaps between them. Trimming gaps might not sound terribly useful at first, but is in fact handy. For instance, the easiest way to insert or delete space on a single timeline track is to trim the right-hand edge of a gap. All clips to the right of the gap are shifted as a block when this is done.

Also, when you need to open a trim point on each track in order to maintain synchronization while trimming, you may often choose to trim the duration of a gap rather than that of a clip. (Remember the rule: one trim point on every track is required for keeping in sync.)

Trimming a gap, whether at the start or the end, is accomplished in exactly the same way described above for trimming a clip.
Two gaps and an audio out point have been selected for trimming. Because one trip point has been created on each track, the entire production stays in sync when trimmed.

Trim both

In this operation, two adjacent clips (or a clip and an adjacent gap) are trimmed simultaneously. Any frames added to the left-hand item are taken away from the one on the right, and vice versa, as long as space and material are available. All you are moving is the cut-point where the items meet. One application for this technique is adjusting visual cuts to the beat of a music soundtrack.

To start, click at the end of the left-hand clip to open the first trim point, then Ctrl-click at the beginning of the right-hand clip to open the second.

When positioned over the adjacent trim points you just opened, the mouse pointer should be a horizontal two-headed arrow. Drag left or right to move the clip boundary, or use the Player in trim mode.

Trim both: Adjacent out and in trim points have been selected. Dragging the trim points affects the timing of the hand-off from the outgoing clip to the incoming one, but does not disrupt the timeline.
Over-trimming

Over-trimming occurs when you try to extend the duration of a clip beyond the limits of its source material, a situation you typically want to avoid.

Notice that if you have over-trimmed your clip the invalid parts are shown in pink.

Overtrimmed clip: The first and last frames will be frozen in the over-trimmed sections.

Over-trimming is not a crisis situation. You do not need to take action immediately. Pinnacle Studio will simply extend the clip as specified by ‘freezing’ the first and last frames of the clip into the over-trimmed areas.

Depending on the duration of the over-trim, and the context, this simple approach may be all you need. A brief freeze-frame can even be visually effective in its own right.

The freeze-frame method will probably not give satisfactory results if it happens during a sequence involving rapid motion, however. In such exacting cases you might consider supplementing or replacing the clip, or prolonging it by changing the speed. (See “Controlling speed with Time Remapping” on page 80.)

Slip trim

To change the starting frame of a clip within the source material, but leave its duration unchanged, open one trim point at the start of a clip, and another at the end of either the same clip or one later on its timeline track.

Drag either trim point horizontally or use the Player trim controls to reposition the clip within its source.

Slip trim: With the in and out trim-points of a clip selected, dragging the clip changes its in and out points relative to the original material, but doesn’t affect its start time or duration on the timeline.
Slide trim

A slide trim is an extended version of the trim both technique described above. In this case you open trim-points at the end of one clip and the beginning of another later on the timeline. Instead of sliding a single clip boundary along the timeline, as in trim both, you are sliding two that move together. All clips between the two trim points are repositioned earlier or later on the timeline.

Slide trim: An out-point has been opened for trimming on the first clip, and an in-point on the third. Dragging either point moves the center clip – or multiple clips, if more are present – along the track while other clips remain stationary.

Both slip trimming and slide trimming can be useful for synchronizing clip contents to material on other tracks.

Monitoring trim points

When you are trimming with multiple trim points, it is helpful to switch the preview from one trim location to another to make sure that each is properly set. Selecting a trim point for monitoring makes it the source for audio and video during preview.

Monitoring is enabled for a trim point when it is created. When multiple trim points are created in succession, you can fine tune each one as you go. To select an existing trim point for monitoring, Ctrl- click it. While trim mode is active, use Tab or Shift + Tab to cycle through the open points.

After using Ctrl- click to monitor a trim point, trimming can be controlled with the Left and Right arrow keys. Trim one frame using the keys unshifted; add the Shift key to trim in 10-frame steps.

Moving and copying

To move a selection of one or more clips, place the mouse pointer on any selected clip and watch for it to change to a hand symbol. When it does, start dragging the clip to the desired position.
Move can be thought of as a two-step process. First, the selection is deleted from the current timeline, according to the rules of the current edit mode. Second, the selection is moved to the desired end position, where it is inserted in a left-to-right fashion per track. The relative position of all selected clips on all tracks is retained.

Moving a ‘sparse selection’ (a selection in which some clips per track are selected while others in the same region are not) is possible, but may be confusing unless executed in overwrite mode. Moving either single clips or a complete timeline cross-section is more straightforward and should be preferred when possible.

Holding down the Alt key while moving clips allows you to toggle between insert and overwrite modes. Standard smart operation is the same as insert, since the most frequent use of horizontal moves is to reorder the playback sequence.

**Copying clips:** Holding down the Ctrl key while moving a selection of clips will copy the clips instead of moving them.

### Using Slip, Slide, Roll, or Stretch tools on the Timeline

You can adjust a clip in the Timeline in a number of different ways—especially if you are using trimmed clips. Trimmed clips have hidden *head frames* (frames trimmed from the beginning of a clip) and *tail frames* (frames trimmed from the end of a clip).

It’s helpful to think of the clips in the Timeline as consisting of two elements: a *window* (the duration for a clip, defined by the start and end points for each clip that you see on the Timeline), and the *content* (all the frames included in the full, pre-trimmed clip, whether they are hidden by a trim action or not).

This example shows a sequence in the Timeline, with a clip selected (orange box “window”). The Slip tool is active and as you drag, the full, pre-trimmed length of the clip is revealed (green box “content”). You can then see which frames will appear in the “window” that is defined on the Timeline.

The following tools let you adjust clips on the Timeline.

- **Slip:** Lets you drag in the Timeline to change what frames you see (content) without affecting the “window” (duration) for the clip, essentially moving the trim markers for the source clip.
- **Slide:** Lets you move the clip “window” along the timeline without changing duration, essentially moving the trim markers in the Timeline to reveal different content.
- **Roll:** Lets you adjust the length of the clip “window”, affecting the duration of the selected clip and the adjacent clip.
• **Stretch**: Lets you adjust the size of the clip “window”, thus changing the duration on the Timeline, expanding or contracting the content (adjusting the speed) in order to fit the new duration without changing which frames are shown.

The full pre-trimmed length of the clip determines the limits for your adjustments. For some changes, the pre-trimmed length of the adjacent clip is also a limiting factor. For example, if you use the Roll tool to decrease the Timeline duration of a selected clip, the Roll tool will stop at the point where the adjacent clip (which is increasing in duration) has run out of frames.

![In the Player panel, you can view the in point and out point for your selected clip when the Slip, Slide, or Roll tools are active.](image)

**To use the Slip tool to adjust clips in the Timeline**

1. In the Timeline, select a trimmed clip that is part of a sequence.
2. On the Timeline toolbar, click the **Slip** tool.
3. Drag in the Timeline to change which frames will display in the Timeline.

   The **Player** panel displays a dual pane view of the **In** frame and **Out** frame to help you set the position of your clip in the Timeline.

**To use the Slide tool to adjust clips in the Timeline**

1. In the Timeline, select a trimmed clip that is part of a sequence.
2. On the Timeline toolbar, click the **Slide** tool.
3. Drag in the Timeline to adjust the position of the clip and to change which frames are displayed.

   The duration of the selected clip is not affected, but the duration of adjacent clips is affected.

   **Note**: A gap can result if the adjacent clip is not long enough to fill the area left by the moved clip.
To use the Roll tool to adjust clips in the Timeline

1. In the Timeline, select a trimmed clip that is part of a sequence.
2. On the Timeline toolbar, click the Roll tool.
3. In the Timeline, drag an edge of the selected clip to change the duration of the clip.
   The duration of the adjacent clip is also affected.

To use the Stretch tool to adjust clips in the Timeline

1. In the Timeline, select a clip that is part of a sequence.
2. On the Timeline toolbar, click the Stretch tool.
3. In the Timeline, drag an edge of the selected clip to change the duration.
   Although the content of the selected clip remains the same, the speed changes (as indicated by a yellow dashed line across the top of the clip) to fit the new duration.
   The duration of the adjacent clip is also affected.

Using the Clipboard

Although drag-and-drop operations provide somewhat greater power when dealing with clips, the timeline does support the standard Clipboard operations cut, copy and paste, with the usual shortcut keys. The Clipboard also provides the only method for moving and copying transitions and effects between clips.

From the Library

After selecting one or more clips in the Library, select Copy from the selection’s context menu or press Ctrl+C to put the selection on the application’s Clipboard. (Cut, the other usual command for adding to the Clipboard, is not available in the Library.)

On the timeline, position the playhead at the point where the paste operation should begin, and select the desired track by clicking in its header.

Now press Ctrl+V to insert the clips from the Clipboard onto the given track, starting at the playhead.

If you select Paste from the timeline’s context menu rather than pressing Ctrl+V, the clips will be pasted at the mouse pointer position on the default track, not at the playhead.

You can repeat the paste operation with the same set of clips as often as desired.
From the timeline

Select one or more clips on the timeline, then click either Copy or Cut on the selection’s context menu, or press Ctrl+C (copy) or Ctrl+X (cut). Both commands add the clips to the Clipboard; Cut removes the original clips from the project, while Copy leaves them in place.

Paste the Clipboard contents onto the timeline as described above. The clips paste onto the same tracks as they originally occupied; and with the same horizontal spacing. Unlike drag-and-drop, the Clipboard does not support moving clips between tracks.

Effects on the Clipboard

Clips to which effects have been added have a magenta line along the upper edge. Right-click on the clip, or right-click the line, to access the Effect context menu, which provides Cut all and Copy all commands for transferring or sharing a set of effects between clips. Select one or more target clips, then press Ctrl+V or click Paste on the timeline context menu.

The effects stack will be pasted to all selected clips. The target clips retain any effects they may already have had. The pasted effects stack will be placed on top of the existing effects.

Transitions on the Clipboard

Right-click in the transition area in the upper corner at the start or end of a clip to access the Transition context menu. Select Cut or Copy to put the transition on the Clipboard.

As with effects, transitions can be pasted to one or more target clips, but any existing transition of the type (start or end) being pasted will be overwritten. The paste fails if the duration of the transition on the Clipboard is longer than the target clip.

Controlling speed with Time Remapping

You can adjust the speed for your video clips. You can apply a slow motion or fast motion effect to the entire clip, or you can use keyframes to speed up some scenes in a clip, while slowing down other scenes. For example, you might speed up the section of a clip showing the approach to a ski jump, and slow down the section with the aerial part of the jump.

Clips with speed changes applied are identified in the Timeline by a yellow dashed line across the top of the clip.
A yellow dashed line across the top of a clip indicates that the speed has been changed.

The following controls and options are available for the **Time Remapping** feature:

- **Anchor**: An anchor serves as a fixed point in the Timeline around which the speed changes occur. You can choose between **First frame**, **Last frame**, or **Current frame** (as indicated by the current position of the playhead). This can be useful for coordinating action between the speed-affected clip and material such as background music on other tracks.

- **Stretch**: Under this option, the first and last frames of the clip as currently trimmed will remain locked when the clip is trimmed on the timeline. Shortening the clip, instead of trimming material from the end, speeds it up just enough so that it finishes at the same frame as before. Lengthening the clip by trimming its end rightwards slows it down rather than exposing any trimmed material.

- **Reverse Clip**: Reverses the direction of playback (backwards) for the entire clip without affecting the speed. Synchronous audio, if any, is suppressed with this option, since it is generally undesirable to play sound backwards. If you want to reverse one section of a clip, you must split the clip to isolate the section that you want to reverse.

- **Smooth Motion**: This option applies a special transition technique to achieve maximum fluidity of movement from frame to frame.

- **Hold Pitch**: This option maintains the original pitch of the recorded audio even when it is played back accelerated or slowed. The function becomes less effective the more the speed is changed. Beyond certain limits, it is switched off completely.

For information about working with keyframes, see “Using keyframes” on page 42.

**To vary the speed of a video by using Time Remapping**

1. In the Timeline, select the clip you want to adjust.
2. Open the **Editor** panel, click **Time Remapping** (appears towards the end of the **Editor** categories bar, you might need to use the scroll arrow to reveal it).
3. Click the **Anchor Frame** option.
4. In the **Anchor** area, choose one of the following anchor frames:
   - **First frame**
• Current frame
• Last frame

The anchor frame appears as a red marker in the Keyframe view and serves as a fixed point around which the speed adjustments will occur.

5 In the Keyframe view, position the scrubber where you want to add a keyframe and click the Add/Remove Keyframe button, and drag the corresponding node on the yellow speed line up (to increase the speed) or down (to decrease the speed). You can also set the speed for a keyframe by adjusting the Speed slider or by typing a precise value in the Speed box and pressing Enter.

For more information about using keyframes, see “Using keyframes” on page 42.

6 Apply as many keyframes and speed changes to the clip as you want.

To change the speed of an entire clip by using Time Remapping

1 In the Timeline, select the clip you want to adjust.

2 Open the Editor panel, click Time Remapping (appears towards the end of the Editor categories bar, you might need to use the scroll arrow to reveal it).

3 Click the Stretch option.

4 In the Timeline, position the cursor along the inside edge of the clip end that you want to adjust, and drag to increase or decrease the length of the clip.
The speed of the clip is adjusted accordingly.

To reverse a clip by using Time Remapping

1. In the Timeline, select the clip you want to adjust.
2. Open the Editor panel, click Time Remapping (appears towards the end of the Editor categories bar, you might need to use the scroll arrow to reveal it).
3. In the Video area, enable the Reverse Clip check box.

Using Time Freeze to freeze frames

You can create a freeze frame effect by using Time Freeze to hold a selected frame in a video clip for a specified duration. The “frozen” frame essentially functions as a still image for the duration you set. You can remove the freeze frame effect at any time.

To create a freeze frame effect by using Time Freeze

1. In the Timeline, select a clip and drag the scrubber so that the frame you want to freeze displays in the Player panel.
2. Right-click the clip and choose Time Freeze > Insert.
3. Type a value in the Duration box to specify the number of seconds that you want to freeze the frame, and click OK.

   The freeze frame is indicated by a pink area on the Timeline clip.

   *The pink area in the middle of the clip indicates the freeze frame section.*

To delete a freeze frame

1. In the Timeline, right-click a clip that has a freeze frame that has been created with Time Freeze.
2. Choose Time Freeze > Delete.
Movies within movies (nested projects)

All the movie projects that you create in Pinnacle Studio appear as assets in the Projects category of the Library panel. But the purpose of Library assets is to serve as the ingredients of movies. What will happen if you try to drag Movie Project A onto the timeline of Movie Project B?

The answer is simple enough: As with most types of assets, Project A becomes a single clip on Project B’s timeline. From the standpoint of timeline editing, it behaves just like any of your other video assets. You can trim it, move it around, apply effects and transitions, and so on. (The same is not true of disc projects. These cannot be used as clips in another project.)

The nested project remains intact inside this container clip, along with all of the project’s clips, effects, titles and other components. Double-clicking the clip in the timeline opens the project in a new timeline tab. Any modifications you make affect only the copy of the project inside the container clip, not the original.

The length of the container clip on the timeline of the main project is not tied to the length of the nested clip on its own timeline. You need to manually trim the container clip if you want it to match the duration of the nested project.

To create a nested project from clips in the Timeline

1 Hold down Ctrl, and in the Timeline, select the clips that you want to save as a nested project.
2 Right-click a selected clip and choose Group > Save Group as Project.
3 Type a name for the project.
   The group is saved as a project in the Library and now appears in the Timeline as a single container clip (gray color).

To edit a nested project in the Timeline

1 In the Timeline, double-click a nested project (gray color indicates a nested project).
2 A new tabbed page opens on the Timeline (the name of the nested project appears on the tab).
3 Make the edits you want to the nested project.
4 To return to the main project, click the corresponding Timeline tab (name of main project appears on tab).
To add a project from the Library to the current project

1 With the main project open in the Timeline, drag a project file from the Library to the Timeline.

The project is automatically added to the Timeline as a nested project (gray color indicates a nested project).

Tip: If at any time you want to move elements between a nested project and the main project, you can use the context menu to copy and paste the elements you want to move.

Picture-in-Picture (PIP)

You can easily create a picture-in-picture (PIP) effect with media that you have added to the Timeline. PIP lets you play a video in one area of the screen while the main video plays in the background. You can also use PIP with images. You can adjust the PIP media by resizing, rotating, or cropping it, and then positioning it where you want it to display on the background.

To scale or crop a video clip for a picture-in-picture (PIP) effect

1 In the Edit workspace, ensure that the clip you want to use for PIP is added to the Timeline in the track above your background video.

2 Select the clip, and choose one of the following PIP options below the Player preview window:

- **Scale mode** — lets you resize the selected clip by dragging the sizing nodes that appear in the preview window. To rotate the clip, drag the rotation handle (node that extends above the sizing rectangle).

- **Crop mode** — lets you crop the selected clip by dragging the orange cropping handles that appear along the edges of the clip.
Track Transparency

You can use Track Transparency mode to set the transparency for the entire track, or to precisely control the transparency across individual clips in the Timeline. Setting the transparency for clips in Track Transparency mode is an alternative to setting the Opacity for the clips in the Editor panel. Track Transparency can be used to create a superimposed effect or to create a fade in and fade out effect.

Note: When you use the Track Transparency slider in the track head, the transparency setting for the track affects all clips on the track and sets the baseline for any keyframe-based Opacity/Transparency settings for individual clips. For example if the Track Transparency slider is set to 50%, this will be used as the maximum opacity value for any clips on the track. This means a clip keyframe setting of 100% Opacity will present as 50% opacity when the clip is added to that track.

You can create a superimposed effect or fade with Track Transparency

To use Track Transparency mode

1. In the Edit workspace, select a track in the Timeline, and on the Timeline toolbar, click the Track Transparency button.
2. In the Timeline, do one of the following
• To adjust the transparency for the entire track, in the track head area, drag the **Track Transparency** slider to set the value you want or type a value in the box at the end of the slider.

![Image of Track Transparency slider]

• To vary the transparency, on a clip, click the yellow transparency line to add as many keyframe nodes as you need. Drag the nodes down to increase transparency. If you want to delete keyframes, right-click a keyframe node and choose the corresponding command.

3 Click the **Track Transparency** button to exit Track Transparency mode.

**Transitions**

A transition is a specialized animated effect for easing – or emphasizing – the passage from one clip to the next. Fades, wipes and dissolves are common types of transition. Others are more exotic, and many employ sophisticated 3D geometry to calculate the animated sequences.

![Image of Transition]

*Creating a default fade-in transition by ‘folding back’ a clip’s upper left corner.*

Two transitions can be assigned to any clip, one at each end. A clip newly created on the timeline has neither. When a new clip starts, it does so with a hard cut to the first frame. When it ends, it switches to the next clip (or black) with equal abruptness.

Pinnacle Studio offers a wide variety of transitions for softening, dressing up or dramatizing the change from one clip to another.

**Creating a transition**

The most straightforward method of creating a transition is to click in the top left corner of the clip on the timeline and ‘fold back’ the corner. This creates a dissolve from the previous clip, if there is one, or a fade-in if there is not. The wider you make the fold, the longer it will take the transition to complete. Folding back the top right corner of the clip results in either a dissolve to the following clip or a fade-out.
More elaborate transitions can be added to the timeline from their section of the Library. When you find one you want, drag it onto one end or the other of a timeline clip. The length of the transition will be determined by the default duration defined in the Pinnacle Studio Control Panel > Project settings (one second by default). If the clip already has a transition at the chosen end, the new one replaces it. See “Project settings” on page 252 for details.

If you are trying to add the transition to a clip which is shorter than the default transition length, the transition will not be applied. One way to avoid this problem is by making sure the dynamic length transitions button on the timeline toolbar is active. While it is, you can control the length of a new transition by dragging to the left or right as you place it on the clip. You will see the corner of the clip fold back as you drag. If the time-ruler is zoomed out enough, you will see the duration of the transition numerically displayed; clicking in this readout lets you edit it directly.

Another way to apply a transition uses the Send to timeline context menu command for assets in the Library, or the Send-to timeline button in the Player when in Source mode. The transition is added to the clip on the default track at the cut nearest the playhead.

The context menu of a clip on the timeline lets you add a transition by choosing either **In transition > Add** or **Out transition > Add**.

A fade-out transition is applied in ripple (or insert) mode, which creates an overlap by shifting the right-hand clip and all its neighbors somewhat to the left. This behavior saves the left-hand clip from having to be extended rightwards to create the transition, which might produce over-trimming. However, shifting the rightward clips causes a break in the synchronization with other tracks that may have to be worked around.

A fade-in transition is added in overwrite fashion. No synchronization issue will result, but over-trimming may be produced in the left-hand clip.

To invert the fade-in and fade-out behaviors, press the **Alt** key during dragging and trimming.
To apply a transition to multiple selected clips, hold down the **Shift** key while dragging a transition from the Library onto one of the selected clips. The position at which you drop the transition on that clip determines whether it will be placed at the beginning of each selected clip, or the end. The transition will not be applied to any clips that are shorter than the transition’s duration.

When the Dynamic length transition button is activated, the duration you drag out for the transition on the target clip is used for all the transitions created.

To keep tracks synchronized when inserting transitions in the out position, use this multiple-apply feature to add the same transition once on each track. Since each track will be affected in the same way, they will all remain synchronized.

When a fade-in follows a fade-out, the result is termed a ‘fade through black’. The left-hand clip fades all the way out, then the right-hand clip fades all the way in. It is not necessary to leave a one-frame gap between the clips.

**Transitions in the Editor panel**

Transitions can also be added by using the **Editor** panel by selecting a clip in the timeline, and in the **Editor** panel, clicking **Transition In** or **Transition Out**. Click a numbered transition category, and click a transition from the thumbnail bar. You can then choose the settings for the transition.

Choosing a transition in the Editor panel. The same transitions and controls apply to both in and out transitions.

**Rippling transitions**

The ripple transition command is especially useful for creating a quick slideshow from a set of still images, or a video pictorial from a set of short clips. Such a presentation is more interesting if you connect each pair of clips with a transition, which can be done quickly and easily by using ripple transition.

Begin with a set of clips on the timeline, then add a transition of the desired type to one of the clips. Select all the clips in the set, bring up the context menu on the clip with the transition, and choose the ripple transition command. This will apply the original transition to all the selected clips. If the original clip had both an In transition and an Out transition, you can choose either one to be rippled.
Any of the selected clips that already have a transition in place, or that are too short for the new transition, will not be altered.

**Removing multiple transitions**

To remove transitions from several clips at once, select the clips, right-click on one of them, and use the remove transitions command in the context menu. All the transitions, both in and out will be removed from the selected clips.

**Replacing a transition**

Select the transition you want and simply drag it onto an existing transition. This replaces the transition animation while retaining the original type (in or out) and duration.

Alternatively, you can choose **Replace by** on either the transition’s context menu or the clip’s context menu. You will be offered a selection of transitions to use.

**Adjusting transitions**

The durations of transitions can be adjusted just like those of clips. Notice the adjustment pointer when the mouse is positioned near the vertical side of the transition rectangle. Use this to change the duration of your transition.

As usual, fade-out transitions use insert mode during adjustment, whereas fade-in is done in overwrite mode. Hold down **Alt** while adjusting to invert this behavior.

You can adjust a transition so that its duration is zero, effectively deleting it. Alternatively, use **Transition > Remove** on the transition’s context menu. Once again, ripple mode is used for fade-out, and overwrite for fade-in, with the **Alt** key available to reverse the default.

To set the duration of a transition numerically, click the duration field that appears when the mouse pointer is above the transition rectangle. (Zoom the timeline in to enlarge the screen width of the transition ‘fold’ if the field does not appear.) Clicking the field activates in-place editing, allowing you to enter a duration via the keyboard.

**Transition context menu**

**Find in Library:** This command opens the Library Browser at the folder containing the transition.

**Edit:** This command invokes a pop-up window, the basic transition editor, where the transition duration can be set.
If the transition is one that offers a custom editor for configuring special properties, the Edit button in the basic transition editor provides access.

A Reverse check box is available with some transitions for reversing the transition animation.

![Basic transition editor](image)

**Copy:** This command puts the transition on the Clipboard, together with its type (fade-in, fade-out) and its duration. These properties will be retained by the transition when pasted. It is therefore not possible to paste a fade-in as a fade-out or vice versa.

To paste the transition to a particular clip, select **Paste** on its context menu. To paste it to all selected clips, select **Paste** from the context menu of an empty timeline area or any selected clip; or press **Ctrl+V**.

![Replace By submenu](image)

**Replace by:** A selection of transitions is offered: two standard dissolves, the six transitions most recently used, and all transitions with a 5-star rating.
**Morph Transitions**

The **Morph Transition** creates a fun metamorphosis effect by analyzing the content in one clip and blending it into the content of the next clip.

The **Morph Transition Editor** lets you set a guide line for each clip to help determine the area of focus for the transition, such as a horizon line. You can then preview the transition and make adjustments to the guide line and length (duration) of the transition. The guide line determines how the transition will be applied, so feel free to experiment with the positioning until you achieve a result you like.

Morph transitions work best between clips that have similar reference points.

**To edit a Morph Transition**

1. Add the **Morph Transition** to the timeline using your method of choice.
2. In the timeline, double-click the transition to open the **Morph Transition** dialog box.
3. Click **Edit** to open the **Morph Transition Editor**.

4. In the **Start** area and **End** area, drag to set the nodes for the guide line that will be used as a reference point. You can add nodes by clicking the guide line.
   **Note:** You can undo or redo actions by using the **Undo** and **Redo** buttons at the top of the window.

5. In the **Preview** area, use the playback controls to preview the transition.
   **Note:** You can drag the vertical bar on the timeline below the preview to adjust the length (duration) of the transition.

6. If required, adjust the guide lines to fine tune the transformation.
7. Click **OK** to exit the editor.

**Seamless Transitions (Ultimate)**

The Seamless Transitions category consists of motion-based animated effects that blur the passage from one clip to the next, creating what is sometimes known as an invisible cut. Whether the motion is up, down, or to the side, the result is similar to a whip pan effect. Some
transitions include rotation and you can edit the transitions to control the zoom level, position, edge softness, and rotation settings. For example, you can zoom in and align the sky in the first clip with a similarly colored sky in the second clip, ensuring that the transition is as seamless as possible.

To apply a Seamless Transition

1. In the Timeline, choose where you want to place your Seamless Transition. Ensure that the clips are trimmed to the frames that have content you can use for aligning the transition.

2. From the Edit tab, click the Navigation bar for the Library panel, and choose Transitions.

3. Navigate to the Seamless Transitions category, and click a transition thumbnail. You can preview the transition in the Player panel.

4. Drag the transition to the Timeline, placing it between two clips, at the start of the second clip.

5. Preview the result in the Player panel. You can stop here if you like the results.

6. To edit the transition, right-click the transition in the Timeline and choose Transition > Edit.

   The Editor panel opens with the settings for the Seamless Transition. In the Player panel, an interactive area lets you align the two clips.

7. Adjust any of the following settings:
   - Duration: Sets the overall length of time for the transition.
   - Transition Type > Select: Switches Seamless Transition presets.
   - Clip A Position/Clip B Position: Lets you use sliders instead of the interactive Hand icon to set the position of the clips.
• **Clip A Size/Clip B Size**: Zooms in or out of a specific area of your clip by adjusting the size of the clip. This helps you isolate areas that match in each clip.

• **Edge Softness**: Adjust the softness of the edge along the transition line for the clips.

• **Rotate Direction**: If you choose a preset that includes rotation, you can choose between a **Clockwise** or **Counterclockwise** motion.

8 To align the clips, in the interactive area of the Seamless Transition panel, position your pointer over the clip you want to reposition, and when the hand icon appears, drag the clip. Position the area where you want the transition to occur within the yellow rectangle. Do the same for the other clip, ensuring the clips overlap along the transition line of the two rectangles.

![Image showing overlay of two clips with a transition line]

*The Up & Rotation preset was used to align the sky areas. Clip A is on the bottom and the Size has been increased to choose an area of the sky that matches the sky in Clip B (top).*

**Note:** The yellow rectangles must be completely filled by each clip. A blank area will result in harsh lines.

9 In the Player panel, click **Play** to preview the transition.

10 Fine tune the controls until you get the results you want.

---

### Clip effects

Clip effects (also called filters or video effects) operate on one clip at a time. Effects are of many kinds, and vary widely in purpose. With keyframing, effect parameters can be arbitrarily varied throughout the clip.

To apply a specific effect to a clip, either locate it in the Effects section of the Library and drag it to the clip you want to enhance, or double-click the clip and select the effect from those offered under the Effects tab of the clip’s media editor.

Multiple effects can be applied to a clip using either or both of these methods. By default, multiple effects are processed for playback in the order they were added.

On the timeline, the upper border of any clip to which an effect has been applied is drawn in magenta. This clip effect indicator has its own context menu, which provides the Clipboard commands for cutting and copying effects between clips. See “Using the Clipboard” on page 79 for more information.
Double-clicking any clip opens it in its media editor, where effects may be added, removed or configured. Please see “Effects” on page 113 for detailed information.

Clip context menus

Right-clicking a clip opens a context menu with commands appropriate to the item type. A video clip has a different menu than a title clip, for example. Some commands are shared between most or all types however. Differences of applicability are noted in the following descriptions.

Edit movie: Available only for movie (container) clips, this command opens the container in its own movie editor. The nested editor offers the same functions and areas as the primary one.

Edit title: For titles only, this opens the Title Editor. (See “The Title Editor” on page 151.)

Edit music: This command is for editing ScoreFitter clips. (See “ScoreFitter background music” on page 189.)

Edit Montage: Edit a Montage clip in the Montage Editor. (See “Using the Montage Editor” on page 143.)

Open effects editor: Opens the media editor for the clip, whatever its type, with the Effects tab selected. Montage, title and container clips are treated in the same manner as ordinary video clips.

Speed: This command opens the Speed Control dialog, where you can apply fast and slow motion effects to selected clips. This option is not available for containers. See “Controlling speed with Time Remapping” on page 80.

Scaling: The first two options affect the treatment of clips that are not in conformance with the current timeline format when brought into the project. See “The Timeline toolbar” on page 50.

• Fit displays the image at its correct aspect ratio, and scaled as large as possible without cropping. Unused parts of the frame are treated as transparent.

• Fill also maintains the aspect ratio of the image, but scales it such that there are no unused parts of the screen. Portions of the image will be cropped if the aspect ratios do not match.

To further fine-tune the scaling behavior of a clip, try pan-and- zoom.

• Keep alpha, Remove alpha, Generate alpha: These commands apply to content with an alpha channel (specifying transparency pixel by pixel). Such alpha information can conflict with Pinnacle Studio effects. The command isn’t available for pure audio clips.

Active streams: This command is available for disabling individual streams in clips containing both video and audio. It is typically used as an easy way to discard unneeded camera audio.
**Adjust duration:** Enter a duration numerically in the pop-up window. All selected clips will be trimmed to the duration requested by adjusting their out points.

**Detach audio:** In clips with both video and audio, this command detaches the audio stream into a separate clip on a separate track, allowing advanced editing operations like L-cuts.

**Find in Library:** This command opens the Library Browser at the folder containing the asset that is the source of the video, photo or audio clip.

**Cut, Copy, Paste:** Move or copy a selection of clips using Clipboard commands instead of drag-and-drop.

**Group:** You can group multiple clips so that you can move the clips together. When you no longer need the group or want to create a different grouping, you can **Ungroup** the clips.

**In Transition, Out Transition:** These provide access to a set of operations for managing transitions, including **Add, Replace, Edit, Copy,** and **Remove.** For more information, see “Transitions” on page 87.

**Delete:** Delete the selected clip or clips.

**Display information:** Display properties of the clip and underlying media files in textual form.
Corrections

Pinnacle Studio lets you correct three main media types: video, photos (and other images), and audio. The usual way to access one of these editors is by double-clicking media on your project’s timeline.

In the Editor panel, click Corrections and click a numbered category to view the correction filters available to you.

The numbered groups appear under the Corrections tab

The tools in the Corrections family are designed to fix imperfections in the video, photos and other media that you use in your projects. The defects addressed by the tools are those most frequently encountered in recorded media. You can straighten a photo with a tilted horizon, improve the clarity of a muffled music track, or correct the ‘white balance’ of a video scene, to name just a few possibilities.

The application of Corrections does not modify your media files themselves.

This section contains the following topics:
• Correcting Library media
• Correcting timeline media
• Photo editing tools
• Correcting photos
• Red-eye
• Correcting video
• Video tools
• Video corrections
• Stabilize
• Wide-angle Lens Correction
• Correcting audio
Correcting Library media

You can apply corrections to media in the Library. The file underlying the corrected asset is not modified: instead, the correction parameters are stored in the Library database and reapplied whenever the item is displayed or used. You can make further corrections on the timeline, if you want, but they will have no effect on the Library asset.

To apply corrections to Library media

1  In the Library panel, do one of the following:
   •  Right-click a media thumbnail (video, photo, or audio file), and choose Open in Corrections.
   •  Double-click a media thumbnail
2  In the Corrections window, apply the changes you want and click OK to return to the Library.

   The corrected media file can now be added to projects. All future projects get the benefit of the correction.

To remove corrections from Library media

1  In the Library panel, right-click a media thumbnail that has corrections applied, and choose Revert to original.

Correcting timeline media

Corrections made to content in the timeline are saved with the project (and therefore apply to the project only).

To remove corrections from media, select the clip in the timeline, and in the Editor panel, open the corrections you applied and from the Select preset dropdown, choose Default.

For details on correcting particular media, please see “Correcting photos” on page 102; “Correcting video” on page 106; or “Correcting audio” on page 112.

The Navigator

The Navigator strip at the bottom of all media editor windows gives you an opportunity to load other Library items or other timeline clips.
When called from the Library, the Navigator at the bottom of the media editor accesses other assets displayed in the Library Browser.

The current item is highlighted. You can switch to editing a different item by clicking a different element in the Navigator, using the arrows at right and left to assist scrolling if required. When you do so, any changes made to the currently-loaded item are automatically saved, as though you had clicked the OK button.

You can hide the Navigator by clicking its button at the bottom of the media editor window.

View options

Sharing the bottom toolbar with the Navigator button is a series of view-related buttons.

The Solo button gives access to a menu of options for previewing underlying tracks in the media editor as well as the current one, and for including the clip's transitions, if any, in the preview.

Solo: This button is available only if the media editor is selected from the timeline. While it is highlighted, the current clip in the Navigator is shown in isolation when previewed, without taking into account the effect of any clips either above or below it on the timeline. While the button is not highlighted, all timeline tracks can contribute to the preview.

Before-and-after view: This button appears for photo media only. For details, see “Before-and-after” on page 101.

Full screen: When active, this button scales the preview image to the size of the current monitor and removes other tools from view. To exit the full screen mode, press Esc, or use the close (X) button at the top right of the window. The full-screen view includes its own small overlay panel of transport controls.
**Preview zoom options:** Fit window adjusts the size of the preview so that the height and width of the image do not exceed the available space even when all tools are open. Set to actual size displays the image at the original size of the source.

**Zoom:** The scroll bar at the far right of the toolbar provides continuous scaling of the preview image.

---

**Moving the preview in the window**

The preview image can be dragged with the mouse anywhere within the working area. This is useful for scanning the image while it is zoomed in. The wave visualization in the Audio Editor is not draggable, however.

**Info and captions**

The Info button at the bottom left of any media editor opens a window with information about the current file.

The Caption field, which is available only when you invoke the media editor from the Library, allows you to rename the current asset.

**The settings**

When you select an effect or tool that has adjustable settings, a panel appears in the upper-right section of the window. Named presets are available in the Select preset dropdown menu near the top of the panel; these provide prepared combinations of settings that you can adapt or use directly.

**Setting numeric values:** Numeric settings fields have a gray slider bar within a darker gray field. Click once within this field to put it into numeric input mode, where you can type the desired value for the parameter. Alternatively, drag the slider bar to the left or right using the mouse. Double-clicking restores the default value.

**Comparing parameter sets:** A highlighted (orange) dot appears to the right of the field when the value of a setting is changed from the default. Thereafter, clicking the dot toggles between the default and the most recent non-default values. The dot to the right of the effect or correction name toggles between the default and custom values of all parameters.

**Linked parameters:** Some parameters are configured to change in lock-step. The presence of a lock symbol indicates this. Click the symbol to toggle the link.
The settings panel lets you adjust the available settings for a correction or effect. Here the settings for the Enhance group of photo corrections are displayed.

**Photo editing tools**

These tools are located on the bottom bar of the Photo Editor. They are available for photos and other graphic images loaded from the Library only. Images opened from the timeline do not have access to them.

**Image rotation**

Two rotary arrow icons are located to the left below the image preview. Click the icons to rotate a Library image either clockwise or counterclockwise in 90-degree increments.

Rotation is only available in the Photo Editor when a photo is opened from the Library. Clips opened from a project’s timeline can be rotated using the 2D Editor effect.

**Before-and-after**

When editing photos you can directly compare the original against the corrected version. The three available views can be accessed by the arrow at the right of the button.
Split image: The lower half of the preview displays the corrections. You can adjust the vertical position of the dividing line by dragging the center portion of the line up or down with the mouse. You can also divide the image diagonally by grabbing the line on either side and rotating.

Full image side-by-side: The right image shows the corrections.

Full image above and below: The lower image shows the corrections.

Correcting photos

The five corrections available within the Photo Editor are Enhance, Adjustments, Crop, Straighten and Red-Eye. The first two are controlled by means of s that open in the upper-right corner of the Photo Editor; the other three are controlled interactively on the image preview.

Enhance (photos)

This correction opens the Image Correction CPU panel of tools for fixing problems to do with color and illumination. The tools can also be used creatively to achieve custom looks or stylistic effects that extend, not just repair, the original material. They are presented in the groups described below.

Automatics

The two special tools in this group adjust the image automatically after analyzing its brightness spectrum. You can change the tool settings further by hand to customize the adjustment if required.

White Balance: When you check the White Balance box, a color temperature setting for the image is computed, and the Temperature bias slider is displayed. Use the slider to customize the setting interactively as you preview.

Levels: Checking this box activates an automatic illumination adjustment, and opens a set of three controls. The first is Optimization, a dropdown list that lets you set the overall behavior of the tool by choosing either “Contrast” (optimization of contrast only) or “Full” (general lighting optimization).

The Brightness and Vibrance sliders can take on values ranging from −10 to +10. A zero setting represents no change to the automatically-chosen value. Brightness provides a general boost or cut in brightness that is applied equally across the whole image. Vibrance,
which is designed primarily for use with images of people, is similar to a saturation control, but minimizes the unnatural appearance characteristic of oversaturated skin tones.

**Fundamentals**

This group of controls allows you to adjust the general lighting properties of your image.

**Brightness:** This control provides an overall brightness adjustment that impacts the light and dark areas of the image equally. For finer control in brightness editing, use the Selective Brightness tool instead (see below).

**Contrast:** This control increases the difference between the light and dark areas of an image. Boosting the contrast may enliven a dull photograph, although at the risk of losing definition in areas that are already very bright or very dark.

**Temperature:** The color temperature control changes the color composition of an image to make it seem ‘warmer’ or ‘cooler’. Indoor lighting such as a tungsten bulb or candlelight is perceived as warm, while daylight, especially shade, is perceived as cold. Using the temperature control primarily changes the yellow and blue values in an image, with little effect on green and magenta.

**Saturation:** This control regulates the color intensity of an image. Increasing the value pumps up the colors, making them more vivid, or even lurid. Decreasing the value drains the image of color until at zero only shades of gray remain. For finer control of saturation, use Selective Saturation instead. A related adjustment is Vibrance, which is often preferred in portraits because it preserves skin tones.

**Clarity:** Increasing Clarity boosts contrast in the midtones, tending to sharpen edges in an image. A small increase in Clarity often improves a picture’s overall appearance.

**Haze:** Increasing Haze lightens the image by compressing its dynamic range upwards. What was originally black becomes gray; lighter tones are also brightened, but to a diminishing degree. This produces a simultaneous lightening and softening effect. The opposite result, darkening and detailing, is achieved by setting negative values of Haze. This drops the brightness floor of the image, sharpening the highlights and midtones by a downward expansion of the dynamic range.

**White balance**

If the white or gray areas of an image bear a slight tint or color cast, the controls in this group can help restore a natural appearance.

**Gray-scale picker:** Activate the picker then click in a nominally white or gray area of the image, where no coloration ought to be present. The image white balance will be automatically adjusted so as to remove the unwanted tint.
**Color circle:** Browse the color field by moving the control point away from the center until a natural image appearance is achieved.

**Selective brightness**

To enable you to edit particular brightness zones in an image without impacting others, five separate brightness controls are provided:

**Blacks:** This slider affects only the darkest areas in the image. For best results, leave editing both Blacks and Whites until last.

**Fill light:** Increasing this slider may produce better detail in shadowy (but not black) areas of a full-contrast photograph.

**MidRange:** The zone impacted by this slider includes the entire medium range of illumination.

**Highlights:** This slider affects the bright locations in the image. It can be used to mute areas overexposed due to flashes, reflections or brilliant sunshine.

**Whites:** This slider impacts the parts of the image that are considered ‘white’. Edit Whites and Blacks last.

**Selective saturation**

Whereas the standard **Saturation** correction increases color saturation equally across the entire spectrum, **Selective saturation** allows for individually boosting or suppressing the primary and secondary colors. For example, if blue appears to be too strong, it can be turned down while other colors retain their intensity.

**Adjustments**

During import, Studio automatically detects certain parameters, but a variety of factors can lead to the occasional incorrect identification. Adjustments allows any of these basic image properties to be changed, if needed.

**Alpha**

Your photo may have an Alpha channel, an 8-bit grayscale image plane that defines the transparency level of each pixel in your photo. If you wish to remove the alpha channel, choose the Ignore Alpha option.
**Interlacing**
If the Interlacing options on the image were misidentified on import, use this dropdown to impose the correct setting.

**Stereoscopic 3D**
If the format of a 3D image file was wrongly identified on import, set the correct stereoscopic layout with this dropdown list.

**Crop**
Use this tool to emphasize a specific section in an image, or to remove undesired components.

![Cropping an image.](image)

**Bounding box (cropping frame):** After you select the cropping tool, a resizable frame is placed over the image. Drag the sides and corners of the frame to crop the image, or drag the center of the bounding box after cropping to adjust its position.

**Aspect ratio:** The Aspect ratio dropdown on the control bar can be used to ensure that the crop rectangle maintains a desired standard proportion while being resized. Standard (4:3) and wide (16:9) frame aspect ratios are supported.

**Preview:** This function displays the cropped image without the surrounding material. Press Esc or click the image to return to the editing view.

**Clear, Cancel and Apply:** Clear returns the bounding box to its original dimensions; Cancel closes without saving any edits made; Apply saves the changed image without exiting the editor.

**Straighten**
This correction enables you to straighten an image in which elements that should be exactly horizontal or vertical are visibly tilted. Unless you have cropped the image, it dynamically resizes as you rotate to keep the corners from being visibly cut off. With a cropped image,
no resizing takes place as long as there is sufficient excess material to fill in the empty corners.

![Image](image.png)

*Ready to straighten an image (with crosshairs).*

Several functions pertaining to Straighten are provided on the toolbar below the preview.

**Guide line options:** The two buttons at the far left of the toolbar set the mode for the lines that are superimposed on the preview as a guide to straightening. Selecting either button deselects the other. The **Crosshairs** (leftmost) button adds a pair of crossed lines that can be dragged with the mouse to serve as a reference for true vertical and horizontal alignment anywhere in the image. The **Grid** button produces a fixed, repeating grid pattern over the entire image.

**Set angle:** To set the degree of rotation you can either use the slider on the toolbar below the image, or click and hold the left mouse button while dragging over the image. Rotations up to 20 degrees in either direction are supported.

**Clear, Cancel and Apply:** Clear sets the image back to its original state; Cancel closes without saving any edits made; Apply saves the changed image without exiting the editor.

### Red-eye

This tool corrects the red-eye effect that often occurs in flash photography when the subject’s gaze is towards the camera. Mark the area around both red eyes with the mouse. Extreme precision shouldn’t be necessary, but you can experiment with changing the area slightly if you are dissatisfied with the correction.

**Clear, Cancel and Apply:** Clear sets the image back to its original state; Cancel closes without saving any edits made; Apply saves the changed image without exiting the editor.

### Correcting video

Like the other media editors, the Video Editor has a central preview display, and an area at right for correction and effect settings. If the video includes an audio track, floating s for audio management will also appear. These are positioned originally at upper left, but you can drag them to new docking positions on either side of the window.
For information about opening the Video Editor to access the correction tools, along with general functions of the media editors, please see “Correcting timeline media” on page 98. For details on the controls available when the Audio tab is selected, please see “Editing audio” on page 178.

**Video / audio switch**

If an audio track is present, a tab is provided at the top left of the screen for switching to the Audio Editor.

**Waveform display**

This floating panel shows a section of the audio volume graph over the span of the video. The region of the waveform that is shown is centered on the current playback position.

When you switch to the Audio Editor, you will see a video preview panel at the same screen location.

**Video tools**

These tools are located on the toolbar below the Video Editor preview. Just below the tools is a time-ruler with a scrubber for moving through the video. At the left are the marker controls. For more information, see “Markers” on page 109.

The remaining controls are devoted to previewing and trimming the media. Many of the controls are also to be found in the Audio Editor. Unless otherwise noted, the descriptions here apply to both. (Please see “Editing audio” on page 178, for further information.)

**Stereoscopic 3D:** The icon and dropdown arrow to the left of the loop play button let you choose amongst several modes for viewing 3D material. The icon has a different appearance for each mode.

If your video is in 3D, but the dropdown arrow does not appear, go to Adjustments to choose the correct 3D setting. See “Adjustments” on page 104 for more information.
Shuttle: The shuttle wheel provides smooth, bidirectional control over a range of speeds when browsing video or audio. Both media types can be viewed at a reduced speed. Shortcuts J (reverse), K (pause), L (forward), and each of these in combination with the Shift key (for slow play), allow easy scrubbing and shuttling from the keyboard also.

Transport controls: The oval arrow icon activates looping playback. The remaining controls are (from left to right): Jump backward, Frame backward, Play, Frame forward, Jump forward.

Audio monitor: The loudspeaker icon sets the system playback volume but does not affect the recorded audio level. Click once on the loudspeaker to mute, or click on the slider to the right of the icon to adjust monitoring volume. To set the playback level of the clip itself, use the channel mixer. See “Channel mixer” on page 179.

Time-code displays: The left field indicates the duration of the media as trimmed. The right field displays the current play position. For a Library asset, the play position is relative to the start of the media. For a timeline clip, the play position within the project is given.

Setting the position numerically: Click the right-hand time-code field for the position and enter a position in ‘hh:mm:ss.xxx’ format. When you press Enter, the playhead jumps to the specified location if that position is present on the clip. Press Esc to undo the change and exit the input mode.

Asset trimming: For Library assets, the orange calipers at either end of the time-ruler let you choose your own entry and exit points for playback. Doing so establishes the clip endpoints when the asset is used in a project.

Ruler: The time-ruler displays a scale whose gradations depend on the current zoom factor. If you click anywhere on this ruler, the playhead (see below) jumps to this position.

Playhead: This red line, with its handle the scrubber, is synchronized with the image currently displayed (for video) and also with the red line shown on the waveform display (for audio). You can position it arbitrarily by clicking and dragging the scrubber, or by dragging within the waveform.

Scroll bar and zoom: By dragging the double lines at the end of the scroll bar to the right and left, you change the zoom level of the display. When the bar becomes smaller, the scroll bar can be moved back and forth as a whole, enabling you to zoom into an audio clip’s waveform or scrub with extra precision. Double-click the scroll bar to return it to the full width of the clip. You can also zoom in and out by dragging left and right on the ruler area.
Markers

Markers are visual reference points that can be set on the time-ruler to identify changes of scene or other editing cues.

Setting and moving markers: Position the playhead at the location where the marker should be set. Click the toggle marker button at the left of the toolbar, or press M. Only one marker may be set per frame.

To move a marker: Ctrl-click and drag left or right.

Deleting the marker: Click the marker to move the playhead to that position, then either press M or click the toggle marker button.

You can also delete markers using the list on the Marker panel, which opens when you double-click a marker on the ruler, or click the down-arrow next to the toggle marker button.

The Marker panel shows the markers that have been set within the media currently on view, in ascending order, with color code, name, and position. Most of the available commands apply to the currently-selected marker. The exception is the Delete all markers button at the bottom of the panel.

Clicking a marker in the list selects it for editing. At the same time, the playhead jumps to the marker position.

Edit name: The name field lets you enter a distinctive name for the currently-selected marker if desired. The left and right arrows beside the name provide another way of moving through the marker list.

Position: Edit the position of a marker directly here as time-code.

Marker color: Set the color of the current marker (and markers subsequently created), by clicking one of the available color buttons.

Trashcan: The trashcan icon on each row of the marker list lets you delete individual markers.
Video corrections

The correction tools within the Video Editor are **Enhance**, **Adjustments**, **Snapshot** and **Stabilize**.

**Enhance (videos)**

The Enhance corrections for video are the same as those for photos and other images. See “Enhance (photos)” on page 102.

**Adjustments**

During import, Studio automatically detects certain parameters, but a variety of factors can lead to the occasional incorrect identification. Adjustments allows any of these basic image properties to be changed, if needed.

**Alpha**

If your video has an Alpha channel and you wish to remove it, choose the **Ignore Alpha** option.

**Aspect ratio**

If the aspect ratio of a video asset was not recognized correctly on import, or if the frame proportions must be manually changed for another reason, use this dropdown menu to select the desired setting. The adjustment does not change the amount of the image on display. Instead, visible area is stretched (or shrunk) independently in width and height to make it fit the desired frame boundaries.

**Interlacing**

If the Interlacing options on the image were misidentified on import, use this dropdown to impose the correct setting.

**Stereoscopic 3D**

If the format of a 3D image file was wrongly identified on import, set the correct stereoscopic layout with this dropdown list.
Corrections 111

Correcting the stereoscopic 3D properties of a Library asset.

Snapshot

The snapshot tool enables you to acquire a single frame from a video, crop it, and save it as a photo. Its controls are similar to those for the Crop correction for photos.

Selection Frame and Aspect Ratio: The frame for selecting an image cutout can be resized by grabbing its sides and corners, or dragged within the preview by grabbing it in the center.

Preview: Preview shows the selected cropped image without the snapshot tools. Press Esc or click once on the image to view the tools again.

Apply: This command exports the cropped image as a JPEG file, and switches off the snapshot editing mode in the preview. Snapshots are stored in the library under My Pictures > Images. Locate the new item by returning to the Library and clicking the special find added item button that is displayed temporarily on the Library footer bar. The new media file itself is created in:

[Registered User]\My Documents\My Pictures\Images

Clear and Cancel: Clear sets the selection frame back to its original setting (whole image), while Cancel exits snapshot editing without creating any new media.

Stabilize

Similar to the electronic stabilization in digital camcorders, this tool minimizes shake and jitter caused by inadvertent camera movement. When using this effect, the outer areas of the image are removed and a varying portion of the image is enlarged up to 20 percent in order to fill the frame.

After Stabilize has been applied, the video must be rendered to preview accurately. Instead of using the Play control on the toolbar, click the Render & Play button on the Stabilize panel to preview.
Wide-angle Lens Correction

Wide-angle lenses, often used in video action cameras, are great for capturing a wide scene, but they cause distortion in the video footage. **Wide-angle Lens Correction** has presets (for some GoPro cameras, for example) and manual controls that let you reduce distortion.

![Distortion reduction](image)

*Distortion (left) can be reduced (right) by using Wide-angle Lens Correction.*

**To correct wide-angle lens distortion**

1. In the timeline, double-click a clip with lens distortion, and in the **Editor** panel, click **Corrections > Wide-angle Lens Correction**.
2. In the **Select preset** drop-down menu, choose a preset.
   - By default, the preview of the correction applies to the entire clip. To toggle the preview on or off, click the square **Disable/Enable** button to the right of the **Wide-angle Lens Correction** title.
   - Advanced users can manually adjust the settings to correct distortion

**Correcting audio**

The Audio Editor can be used both for audio-only media such as .wav files and for video with an included (‘original’ or ‘synchronous’) audio track.

For information about opening the Audio Editor to access the correction tools, along with general functions of the media editors, please see “Correcting timeline media” on page 98.

For an overview of audio-related information, please see “Sound and music” on page 177. For coverage of the Audio Editor, see “Editing audio” on page 178. Please see “Audio Corrections” on page 181 for descriptions of the individual correction tools.
Effects

Pinnacle Studio lets you apply effects to video, photos and audio. ‘Effects’ is an umbrella term taking in a wide range of software tools for manipulating your media—‘effects’ is not limited to the effects in the Library. It includes presentational tools like 2D Editor, 360 Video, Motion Tracking, atmospheric transformations like Old film, and some theatrical touches like Fractal fire that you may find are too much fun not to use.

The available options and controls depend on what type of media you are working with.

The Editor panel lets you access the effects available for your media. In this example, the Oil Painting effect is applied.

Audio corrections and effects are described in "Sound and music" on page 177.

This section contains the following topics:
- Corrections vs. effects
- About effects
- Effect compositions
- Real-time vs. rendered effects
- The Settings
- Video and photo effects
- Green screen chroma key effects
- Selective Color
- Transition In and Transition Out
Corrections vs. effects

Effects and corrections are applied and edited in a similar way, but the Corrections family is meant primarily for remedying the imperfections that are often encountered in actual media files – poor white balance in photos, wind noise in soundtracks, and so on. Please see “Corrections” on page 97 for details about Corrections and how to use them.

About effects

Like other resources for your project, effects are stored in the Library. As with other types of Library resources, you can use all the usual features – Collections, ratings, tags, and so on – to help you organize the many effects available.

Modifications that you make in the Editor panel are saved automatically. See “The Settings” on page 116 for further information.

In the timeline, clips to which an effect has been added are indicated by a brightly-colored upper border. Both this clip effect indicator and the clip itself provide useful context menu commands for effect management.

To choose and apply an effect

1. From the Edit tab, click the Navigation bar for the Library panel, and choose Effects.
2. Navigate to the category you want, and in the library, click an effect thumbnail.
   You can preview the effect in the Player panel.
3. Drag the effect that you want to apply to a media clip in the timeline.
   A pink line appears above the clip to indicate that an effect has been applied.
4. To edit the settings for the effect, click the Editor panel, choose Effect, and adjust the settings for the effect, adding keyframes if you want to vary the settings. At any point, you can return to the original settings by choosing Default from the Select preset dropdown menu for the effect.
   If the effect controls are not displayed (collapsed), click the bar with the name of the effect in the Editor panel to display the controls area.
You can also apply an effect for a clip selected in the timeline by clicking the Editor panel > Effect, clicking one of the numbered categories, and choosing an effect from the thumbnail bar that displays.

To remove effects

- In the timeline, right-click a clip that has effects applied and do one of the following:
  - To remove one effect, choose Effect > Delete, and choose the effect that you want to remove.
  - To remove all effects, choose Effect > Delete All

Effect compositions

Achieving a desired look, behavior or sound can take a combination of several effects, applied in a particular order. Both video and audio effects may be needed. For each effect, parameters must be adjusted to get the results you are looking for. Once you have found the right combination, the set of effects can be saved as a special type of asset— an effect composition.

They are stored in the Effects category of the Library under My FX Compositions and can be used in the same way as ordinary effects.

You can access saved FX Compositions from the Library panel.

To save a combination of effects as an FX Composition

1. In the timeline, apply two or more effects to a clip.
2. Right-click the clip and choose Effect > Save As FX Composition.
3. In the FX Composition window, enable the check marks for the effects that you want to include, and type a name for the composition.
4 Click Save.

The composition is saved in the Effects category of the Library under My FX Compositions.

Real-time vs. rendered effects

Adding effects to a clip increases the amount of computation Pinnacle Studio must do to give you a smooth preview. Depending on your computer’s hardware, the ‘rendering’ process for a clip can easily require more computing time than can be managed in real time; that is, while the preview is actually running.

In this circumstance, some ‘pre-rendering’ will be required before the clip can preview acceptably. Rendering progress is shown on the time-ruler by yellow (‘to be rendered’) and green (‘now being rendered’) shading. The shading is removed as soon as pre-rendering is complete.

Options for rendering are set in the Preview page of the Pinnacle Studio Control Panel. (See “Export and Preview” on page 249).

If effects are not playing back smoothly, try increasing the Optimization Threshold value. This will increase the amount of pre-rendering time while improving the preview quality. If rendering is taking too long, on the other hand, the Optimization Threshold value can be decreased, or rendering can be turned off by altogether by setting it to zero. Other factors that affect playback and rendering time are the format, size and frame rate selected for the project. These can be changed in Timeline settings. Please see “Timeline settings” on page 51.

The Settings

Settings for an effect are available from the list of effects that have been assigned to the current clip. Click an effect name in the list to select it; this causes its settings to be displayed for inspection and editing in the parameters area below the list. Most effects also offer a dropdown list of preset parameter combinations.

When a clip has multiple effects, they are applied in the order they were added, which is the reverse of the order in which they are listed (new effects are added at the top of the list, not the bottom). To change the order, drag the effect header up or down in the list.
The right-hand end of the effect header has four buttons for operations related to that effect. From left to right they are:

**Diamond**: Toggle keyframing for parameters of the effect. See “Working with keyframes for effect settings” on page 117.

**Expand All Settings**: All the groups of settings for the effect can be expanded for editing or closed with one click.

**Trashcan**: Remove the effect from the clip.

**Dot**: Toggle the effect on and off. You can switch the effect off for comparison purposes without deleting it and losing your settings.

**Drag handle**: Use either this zone or the name area for dragging the effect up or down in the effect list when the clip uses multiple effects. As mentioned above, effects are applied in bottom-up order. In some cases, changing the order can dramatically affect the cumulative result.

### Modifying parameters

Parameters are organized into named groups of related controls. Click the expand/collapse triangle on the group header to open the group and access its parameters, or close it and conserve screen space.

Numeric parameters are controlled by horizontal sliders, with a bar that you can drag horizontally to change the value. For more precise control, use the Left or Right arrow. Double-click the bar to reset a particular parameter to its default value.

Most effects furnish a dropdown list of preset parameter combinations for fast selection of variants. Once a preset has been selected, you can customize it by editing the parameters if desired.

Changes to the settings in the **Editor** panel are saved automatically.

### Working with keyframes for effect settings

The normal use of some types of effect is to transform the source material in a uniform way from beginning to end. Atmospheric effects like **Old film**, and effects that change only the coloration of the clip, are among those in this category. Their parameters are generally set once and for all at the start of the clip. This is the static use of an effect.

Other effects, such as **Water drop**, depend on a sense of motion. They are likely to be effective only when their parameters are allowed to vary throughout the clip. The easiest method is to use a preset that has animation built in, like most of those for **Water drop**. In this kind of keyframe animation, one or more parameters of the effect has a different value...
at the end of the clip than it did at the beginning. On playback, the parameters are updated after every frame to move smoothly from the start value to the end value.

Keyframing isn’t limited to just the start and end frames of a clip. Keyframes can be defined with particular values of effect parameters at any point in the clip to produce effect animations of arbitrary complexity. If, for example, you would like an image to reduce to half-size by the middle of the clip and return to full size by the end, you would need to add at least a third keyframe.

For information about using keyframes, see “Using keyframes” on page 42.

**Video and photo effects**

The effects provided for use with video also work with photos, and vice versa. Many Pinnacle Studio-supplied effects are described here. For third-party plug-in effects, please consult the manufacturers’ documentation.

**Blur:** Adding **Blur** to your video produces a result similar to shooting out of focus. The **Blur** effect allows you to add separate intensities of horizontal and vertical blurring over the whole frame or any rectangular region within it. You can easily blur out only a selected portion of the image, such as a person’s face, an effect familiar from TV news coverage.

**Emboss:** This specialized effect simulates the look of an embossed or bas-relief sculpture. The strength of the effect is controlled by the **Amount** slider.

**Old film:** Old movies have a number of traits that are usually considered undesirable: grainy images caused by early photographic development processes, spots and streaks from dust and lint adhering to the film, and intermittent vertical lines where the film has been scratched during projection. The effect lets you simulate these ‘blemishes’ to give your footage an antique look.

**Soften:** The **Soften** effect applies a gentle blurring to your video. This can be helpful for anything from adding a romantic haze to minimizing wrinkles. A slider controls the strength of the effect.

**Bevel crystal:** This effect simulates viewing the video through a pane of irregular polygons arranged into a mosaic. Sliders let you control the average dimensions of the polygonal ‘tiles’ in the image and the width of the dark edging between neighboring tiles from zero (no edging) to the maximum value.

**2D Editor:** Use this effect to enlarge the image and set which portion of it will be displayed, or to shrink the image and optionally add a border and shadow.

**Earthquake:** The Pinnacle Studio **Earthquake** effect jiggles the video frame to simulate a seismic event, whose severity you control with sliders for speed and intensity.

**Lens flare:** This effect simulates the flaring seen when direct bright light overexposes an area of a film or video image. You can set the orientation, size and glow-type of the main light.
Magnify: This effect lets you apply a virtual magnifying lens to a selected portion of the video frame. You can position the lens in three dimensions, moving it horizontally and vertically within the frame, and nearer to or further from the image.

Motion blur: This effect simulates the blurring that results when a camera is moved rapidly during exposure. Both the angle and the amount of blurring can be set.

Water drop: This effect simulates the impact of a drop falling onto the surface of water, producing expanding, concentric ripples.

Water wave: This effect adds distortion to simulate a series of ocean waves passing across the video frame as the clip progresses. Parameters allow you to adjust the number, spacing, direction and depth of the waves.

Black and white: This effect subtracts some or all of the color information from the source video, with results ranging from partly desaturated (the ‘Faded’ preset) to fully monochrome (‘Black and white’). The Amount slider controls the strength of the effect.

Color correction: The four sliders in the parameters panel for this effect control the coloration of the current clip in terms of:

- **Brightness**: The intensity of light.
- **Contrast**: The range of light and dark values.
- **Hue**: The location of light on the spectrum.
- **Saturation**: The quantity of pure color, from gray to fully saturated.

Color map: This effect colorizes an image using a pair of blend ramps, or color maps. Stylize your footage with bold color treatments, add duotone and tritone style colorization, or create striking editorial transitions. The effect can be used for anything from fine control of monochrome images to psychedelic color transformations.

Invert: Despite its name, the Invert effect doesn’t turn the display upside-down. Rather than the image itself, it is the color values in the image that are inverted: each pixel is redrawn in its complementary light intensity and/or color, producing a readily recognizable but recolored image.

This effect uses the YCrCb color model, which has one channel for luminance (brightness information) and two channels for chrominance (color information). The YCrCb model is often used in digital video applications.

Lighting: The Lighting tool enables correction and enhancement of existing video that was shot with poor or insufficient lighting. It is particularly suitable for fixing backlit outdoor sequences in which the subject’s features are in shadow.

Posterize: This Pinnacle Studio effect lets you control the number of colors used to render each frame of the clip, all the way from the full original palette down to two colors (black and white) as you drag the Amount slider from left to right. Regions of similar color are coalesced into larger flat areas as the palette shrinks.
RGB color balance: RGB Color Balance serves a dual role in Pinnacle Studio. On the one hand, you can use it to correct video that suffers from unwanted coloration. On the other hand, it allows you to apply a color bias to achieve a particular effect. For example, a night scene can often be heightened by adding blue and slightly reducing overall brightness. You can even make video shot in daylight look like a night scene.

Sepia: This Pinnacle Studio effect imparts the appearance of antique photography to the clip by rendering it in sepia tones rather than full color. The strength of the effect is controlled by the Amount slider.

White balance: Most video cameras have a ‘white balance’ option for automatically adjusting their color response to ambient lighting conditions. If this option is switched off or not fully effective, the coloration of the video image will suffer.

The White balance effect corrects the problem by allowing you to specify which color should be taken as ‘white’ in this image. The adjustment needed to make that reference color white is then applied to every pixel of the image. If the reference white is well chosen, this can make the coloration seem more natural.

Effects and stereoscopic 3D

Some video and photo effects have features designed for 3D media. For instance, some of the provided effects offer a stereoscopic mode that is activated by a check box in the effect parameters. Meanwhile, the effects in the Stereoscopic group itself let you modify the 3D properties of your material. The group includes:

The S3D Depth Control: This effect allows you to adjust the parallax of stereoscopic footage. By default, the effect is presented in Standard mode, in which a single Depth slider lets you control the amount of divergence between the left and right frames, whether to correct or match source material, or as a special effect.

The advanced mode offers separate Shift and Zoom control groups, each containing a Horizontal and a Vertical slider. The Shift sliders let you control the divergence between the left and right frames, while the Zoom sliders control their magnification. Both properties can be controlled independently in the horizontal and vertical dimensions, but by default the Zoom aspect ratio is locked. Click the lock icon to adjust the horizontal and vertical zoom independently.

S3D Eye Selector: The Eye Selector effect is presented in two variations; one for left eye, and the other for right; it is used for uniting left and right eye video streams on a 3D timeline.

A pair of clips at the same timeline index, one for left eye and the other for right eye, can be combined to produce stereoscopic output by applying the eye selector effect to the upper clip.
The effect can also be employed to extract either the left or right stream from a 3D clip by setting the **Source** to Left Eye or Right Eye, and direct it to either eye using the **Mapping** dropdown.

---

**Green screen chroma key effects**

The **StudioChromaKeyer** effect lets you choose any color in your video footage and make it transparent so that an underlying video clip (on another track) can be seen. For example, weather reporters are often recorded in front of a green screen, then the green screen is substituted with a video clip of a weather map. Sometimes referred to as chroma keying, this is a popular special effect technique. Best results are achieved when the background color that you want to remove is consistent and good lighting has been used to capture the subject.

**To create a chroma key effect**

1. In the Timeline, double-click a clip that has a background color that you want to remove. Tip: It works best if the clip that you want to use as the underlying background is already placed in the track below the selected clip.
2. In the **Editor** panel, click **Effect > Keyers > StudioChromaKeyer**.
3. In the **Settings** area, click the **Key Color** eyedropper tool.
4. In the **Player** panel, click the color that you want to become transparent.
5. Adjust any of the other settings to fine-tune the color selection, using the preview area and playback controls to review the chroma key results.

---

**Selective Color**

Selective Color is an effect that lets you fully or partially desaturate a video or photo while preserving one or more focal colors. For example, you can preserve the bright yellow of a taxicab while making everything else in the scene black-and-white.
Selective Color lets you preserve one or more focal colors.

To apply the Selective Color effect

1. In the Timeline, select a clip.
2. Open the Editor panel, click Effect > Color, and click the Selective Color thumbnail.
   
   **Note:** An arrow appears when you position your pointer over the bar of effect thumbnails. This lets you scroll through the available effects.

3. Click the Eyedropper tool and in the Player panel, do one of the following:
   - Click a color that you want to preserve—all other colors will be desaturated (based on the Desaturation slider setting).
   - Drag across an area to set a rectangular sample area—all other colors will be desaturated.

   To add to your color selection, hold the CTRL key while you click or drag the Eyedropper tool.

   To clear all color selections, choose Default from the Select preset dropdown menu.

   **Note:** Enable the Reverse checkbox if the area you want to desaturate has less color variation (such as a lawn, sky, or water) than the area that you want to preserve.
The Reverse check box was enabled in this case, making it easy to click the lawn and leave the subject in color.

4 To adjust the results, do any of the following:
   • To adjust the selected color, click the Edit button beside the Eyedropper tool and in the Hue Color Picker, drag a top arrow to move to a new color. Drag the bottom arrows to adjust the range for a selected color. Use the Add Color and Remove Color buttons to change colors using the Hue Color Picker.
   • Drag the Desaturation slider from 100 to a lower value if you don’t want a full black-and-white effect in unselected areas.
   • Drag the Edge Softness slider to a higher value if you want a softer edge transition between the areas of color and the desaturated areas.

5 Preview your entire clip to ensure your settings achieve the results you want. Adjust any settings as required.

**Transition In and Transition Out**

Transition In and Transition Out are two options available in the Editor panel that let you apply a specialized animated effect for easing – or emphasizing – the passage from one clip to the next. Fades, wipes and dissolves are common types of transition. Others are more exotic, and many employ sophisticated 3D geometry to calculate the animated sequences. For more information, see “Transitions” on page 87.

**Pan-and-zoom**

The pan-and-zoom tool is available for videos and images when they are opened from the timeline.

With pan-and-zoom, an area from within the image or video is used to fill the whole video frame. The area can be of any size and shape. On playback, it will be enlarged sufficiently to fill the video frame without empty areas.

If you define two or more areas, pan-and-zoom animates your presentation of the image by zooming in and out while traversing it with simulated camera movements as it moves smoothly from one area to another. You can also rotate while panning and zooming.
The pan-and-zoom tool utilizes the full available resolution so you will not forfeit detail by zooming in.

**Adding pan-and-zoom**

To apply pan-and-zoom to a selected clip on the timeline, in the timeline, right-click the image or video, and choose Pan-and-Zoom or in the Editor panel, click Pan-and-Zoom. The Player panel displays Pan & Zoom Source (left) and Pan & Zoom View (right). The selection frame can be set on the source side of the panel.

![Pan & Zoom Source and View](image)

*In this illustration the Pan-and-zoom tab has been selected and remains set to the default Static mode. The selection frame, defines a region of the image that will be magnified to fill the entire frame, as shown on the right.*

Pan-and-zoom has two alternative Edit Modes: **Static** and **Animated**. In the **Static** mode, a single unchanging image region is shown throughout duration of the clip. In the **Animated** mode, separate regions are defined for the first and last frame of the clip; on playback, a smooth ‘camera move’ from one to the other is shown. **Animated** mode also allows keyframing, in which any number of additional defined regions can be added to the pan-and-zoom camera path.

**Static mode**

In **Static** mode, a gray selection frame with round control points is displayed over the image. You can enlarge, reduce, and move this frame, but you cannot change its proportions (aspect ratio). You can use the Source and Timeline windows in the Player panel to preview. The zoom and position can also be controlled numerically using sliders in the Editor panel. Double-click the sliders to reset the values, or single click to enter a numeric value.
Animated mode

When Animated mode is set, the image is automatically analyzed and an initial size and position both for the start and end is automatically set. The generated animation begins zoomed in slightly, then pulls back to the full size available. If an image has a different aspect ratio than the video frame, enough zoom is applied throughout to prevent blank areas from appearing.

To support the extra functionality of Animated mode, the color of the selection frame is used to indicate its place in the animated sequence. The start frame is green, and the end frame is red. Frames at any intermediate point are drawn in white.

When multiple frames are visible, you can drag the frames as needed by positioning your mouse over either the edge of the frame or the center dot. Moving the white frame will automatically add a keyframe at the current position.

Keyframing Pan-and-Zoom

With keyframing, you can create a customized pan-and-zoom animation of arbitrary complexity, though simple sequences of a few steps may be all you ever need.

Switch to Animated mode as described above, and note that two frames have been added to the preview. These special start and end keyframes, which as mentioned above are drawn in green and red respectively.

If you don’t require intermediate keyframes, positioning the start and end frames completes your session.

For a more complex animation, however, position the scrubber where a change of camera motion should occur. To create a new keyframe, simply set the white selection frame to the desired size and position. The new keyframe is represented by a lozenge-shaped gray icon in the keyframe line below the clip timeline and in the Editor panel. Adjust the selection frames interactively in the source view or use the controls in the Editor panel.

Add as many keyframes as necessary. Settings in the Editor panel are saved automatically.
For more information about keyframes, see “Using keyframes” on page 42.

The Settings

The following controls are available for Pan-and-Zoom:

- **Preset:** Choose from a number of static and animated presets.
- **Zoom, Horizontal,** and **Vertical** display the numerical values of the current frame. Double-click the sliders to reset the values.
- **Rotation** lets you rotate the view from 0 to 360 degrees.
- **Low pass** filters out small-scale movements to achieve a smooth, optimized animation.
- **Motion:** Lets you choose from **Ease In, Ease Out, Smooth,** and **Linear** to determine the style of the movement. For example, **Smooth** provides a gentle braking when approaching a direction change in the keyframe animation path.

360 Video

360 video is an interactive type of video that lets the viewer look in any direction by changing the viewing angle during playback. The viewing angle can be controlled by using a touchscreen, onscreen controls, or by moving the viewing device, such as a smartphone or tablet, in different directions. 360 video requires a special 360 video player (for example, YouTube and Facebook have 360 video players).

Editing 360 video

Pinnacle Studio lets you edit equirectangular, single fisheye, and dual fisheye 360 video footage (check the instructions for your 360 video camera for more information). For example, you can trim the video or add titles or objects. Please note that not all effects can be applied to 360 videos. You can also convert fisheye to equirectangular.

Converting 360 video to standard video

You can also convert 360 video to standard video in Pinnacle Studio. As you play the 360 video, you can set the viewing angle for your audience, similar in effect to a person turning their head to look in different directions. You can then export the edited video as a standard file—no special player is required for the video (not interactive).
Effects 127

When converting a 360 video source to a standard video, the dual preview window makes it easy to select and adjust the view by adjusting the View Tracker.

Tiny planet and rabbit hole video effects

You can use the Equirectangular to Spherical Panorama effect to create tiny planet-style videos, rabbit hole-style videos, or anything in between.

If you have a fisheye or dual-fisheye 360 video, you can convert the file to equirectangular and export the 360 file. You can then apply the Equirectangular to Spherical Panorama effect.

When you apply the effect, the video is converted to a standard format, with a square aspect ratio.

You can confirm the settings for your spherical panorama video by clicking the Timeline Settings button.

You can use keyframes to adjust the panorama effect as the video plays.

To edit and export a 360 video

1. In the Edit workspace, drag a 360 video from the Library to the Timeline.
   If you want to convert fisheye 360 to equirectangular, right-click the clip in the Timeline, choose 360 Video, and click Single Fisheye to Equirectangular or Double Fisheye to Equirectangular.

2. In the Timeline, click the Timeline Settings button, and set the following:
   • Aspect — choose 360 Video (2:1)
• **Size** — for best results, choose the highest resolution possible

3 Edit the video in Pinnacle Studio. For example, you can do the following:
   • Trim the video
   • Add a title or object
   • Create a freeze frame effect (**Time Freeze**)

**Note:** When you apply a title or object to a 360 video, right-click the item in the Timeline, and choose **360 Video > Insert as 360** to convert the media to 360.

4 When you are finished editing, save your file and click **Export**.

5 From the **Export** tab, ensure that the **Same as Timeline** check box is marked (check mark appears) in the **Settings** area.

6 Click **Start Export**.

---

**To edit a 360 video and convert it to a standard video**

1 In the **Edit** workspace, drag an imported 360 video from the Library to the Timeline.

2 In the Timeline, right-click the video, choose **360 Video**, and click one of the following:
   • **Equirectangular to Standard**
   • **Single Fisheye to Standard**
   • **Double Fisheye to Standard**

   A duel preview mode opens with the **360 Source** video on the left and the **360 Preview** on the right.

3 In the **360 Source** pane, adjust the View Tracker to select a direction. The **360 Preview** pane updates to display the view.

   ![](image)

   *The View Tracker appears onscreen as a red square-shaped marker with a crosshair at the center.*

4 Click **Play** to start the video playback. At any time, you can adjust the angle of the view by dragging the View Tracker to a new position.

   Keyframes are added when you adjust the View Tracker. You can fine-tune the keyframes with the controls below the preview pane.
Keyframes appear below the preview panes just below the scrubber. Keyframe controls let you go to the previous keyframe, delete a keyframe, go to the next keyframe, and adjust the settings for the transition between keyframes.

5 Make any additional edits to the video project, and save.
6 Click Export, and choose the settings you want in the Studio Exporter, and click Start Export.

To apply a tiny planet or rabbit hole effect to a 360 video

1 In the Timeline, right-click a 360 video that is in the equirectangular format, and from the context menu choose 360 Video > 360 Video Conversion > Equirectangular to Spherical Panorama.
   The Editor panel opens with the Equirectangular to Spherical Panorama controls.

2 In the Player pane, display the Timeline view, and scrub to a scene that you can use as a starting point.

   ![Equirectangular to Spherical Panorama settings](image)

   If you will be using keyframes, you can add them in the Editor panel. For more information, see “Using keyframes” on page 42.

3 In the Editor panel, drag the Zoom slider to set the field of view.
4 Adjust the Tiny Planet/Rabbit Hole dial or type a value in the corresponding box.
• **Tiny Planet**: A value of 180 creates a sphere using the bottom edge of the video as the center.

• **Rabbit Hole**: A value of 360 creates a sphere using the top edge of the video as the center.

You can experiment and set values between 0-360 and use keyframes to control the transition.

5 Adjust the **Rotation** dial or type a value to rotate the video to the position you want.

6 Play your video, using the **Timeline** view to evaluate your settings. Make any adjustments to the settings or to your keyframes.

**Note**: To reset all controls, from the **Select preset** menu, choose **Default**.
Pinnacle Studio includes masking features that let you selectively edit one or more areas of a video clip or track. For example, you can make an area of a video clip transparent so that an underlying video clip shows through. You can apply effects to specified areas, allowing you to add a Black and White effect to a specific area, or color correct a specific area. You can also create a 2D mask panel that has 3D motion.

Motion tracking lets you apply a blur or element, such as text, to a moving object in a video, tracking the movement frame-by-frame.

This section contains the following topics:
- Understanding masks in Pinnacle Studio
- Shape masks
- Using a Shape mask to edit specific areas
- Using a mask panel to create a 3D effect
- Motion Tracking

Understanding masks in Pinnacle Studio

The masking process starts by adding a dedicated Mask track above the clip or track that you want to mask. From there, you can choose between two types of masks:
- **Shape** mask: To change the opacity, add a border, or edit specific areas for color or other filters, use a Shape mask.
- **Panel** mask: Lets you import assets to a 2D mask object and apply 3D motion to the object.

Layering masks

You can apply only one function or filter to a Shape mask (and its corresponding Matte area). You can create new mask tracks to layer masks. You can also layer Panel masks.

Shape masks

You can draw a shape in the mask preview window using a variety of tools:
- **Selection tool**: Lets you interact with the selected shape in the Mask preview area (size, position, rotation).
- **Rectangle** tool: Lets you draw rectangular and square shapes.
Circle tool: Lets you draw circular shapes.

Pen tool: Lets you draw an enclosed shape by setting nodes connected by straight lines.

Brush tool: Lets you apply freehand brushstrokes. Adjust the brush Radius to change the size of the brush.

Magic Wand tool: Lets you select all areas of a specified color by clicking a color in the preview window. Adjust the Tolerance value to increase or decrease the range of similarly colored pixels that are included in the mask.

Eraser tool: Lets you erase brushstrokes that you have added with the Brush tool.

Text tool: Lets create a text-based mask.

Import: Lets you import a media file to use as a mask.

Mask groups and shape interaction
You can use one or more shape tools to create a mask. Each time you use a shape tool, it adds a new shape to the current group. The Brush and the Eraser are the exception to this rule (all brushstrokes are added to the same shape until you switch to another shape tool). The shapes within the group can interact in three different ways, according to the Transform setting:

- Merge: Overlapping shapes are additive (increase the area of the mask).
- Subtract: The shape is subtractive for any underlying masked area.
- Intersect: Areas where shapes overlap are subtractive. Where shapes don’t overlap, the shape adds to the mask.

You can add a new group to help organize elements of your mask.

Editing mask shapes
You can edit the shapes you use to create your mask by adjusting Position (X, Y), Size (X, Y), or Rotate (value in degrees). Keyframes can be used to adjust the properties of the shapes throughout the video to create dynamic masks.

Mask and Matte
Pinnacle Studio Shape masks let you apply distinct functions or filters to the Mask (the selected area that has the ruby-colored overlay) and the Matte (the “unselected” area).

Using a Shape mask to edit specific areas
You can use a Shape mask to complete many editing and creative tasks by setting the Mask Properties and Matte Properties you want.

Functions include:

- Opacity: Create transparent areas based on shapes, text, brushstrokes, or color selected with the Magic Wand.
• **Color Correction**: Selectively brighten an area or desaturate all but one element, boost color in specific areas and more.

• **Invert Color**: Invert colors in the selected area.

• **Replace Color**: Select and change one color for another color.

• **Black and White**: Create a Black and White film effect, leaving some areas in color.

• **Zoom and Loupe**: Create magnification effects in selected areas.

**Filters** include:

• **High Pass**
• **Low Pass**
• **Dichroic**
• **Color**

The **Mask** panel (left) and the **Mask** preview in the **Player** panel (right) let you create, view, set properties, and edit masks.

### To create a Shape mask

1. Do one of the following:
   - In the Timeline, select a clip that you want to mask, and click **Mask** to display the **Mask** panel (shares a space with **Library** and **Editor** panel). Click **Create Mask** to add a **Mask Track** above the clip and automatically create a mask (yellow bar) that matches the length of the selected clip.
   - In the Timeline, right-click a track head above which you want to add a mask, and choose **Insert New Track > Mask Track**. Hold down **Ctrl** and drag along the mask track to set the length of the mask (yellow bar).
2 In the Mask panel, click Create Shape.
3 Choose one of the shape tools along the left edge of the Mask preview, and create one or more shapes.
4 In the Mask panel, adjust the properties for the shape, including the Transform mode to determine the interaction between shapes.
5 If you want to create a dynamic mask, use the key frames in the Mask panel to adjust the properties over time.
6 If you need to organize the shapes, for more complex masks, click Add a New Group (bottom of Mask panel). Add as many shapes and groups as you need.
7 In the Mask panel, click Function (near the top of the panel).
8 From the Mask Properties area and the Matte Properties area, from the drop-down menu choose Function or Filter, and choose a function or filter from the corresponding drop-down menu.
9 Adjust the settings to get the effect you want.
   If you want to remove an effect, choose None from the drop-down menu.
10 To create a dynamic mask, use key frames to change the mask properties over time.

Using a mask panel to create a 3D effect

Mask panels are 2D objects to which you can apply a photo or video. The objects can then be assigned 3D motion properties.
Panels have only one group, but you can use multiple shapes to create your panel. For example, you can merge several shapes to create a panel shaped like a cat’s head or a cloud. You can also apply media assets to individual shapes, such as three circles, each with different media, spinning and moving independently.

To create a Panel mask

1 Do one of the following:
   • In the Timeline, select a clip that you want to mask, and click Mask to display the Mask panel (shares a space with Library and Editor panel). Click Create Mask to add a Mask Track above the clip and automatically create a mask (yellow bar) that matches the length of the selected clip.
   • In the Timeline, right-click a track head above which you want to add a mask, and choose Insert New Track > Mask Track. Hold down Ctrl and drag along the mask track to set the length of the mask (yellow bar).
2 In the Mask panel, click Create Panel.
3 Choose one of the available shape tools along the left edge of the Mask preview, and create one or more shapes.
4 In the **Mask** panel, adjust the properties for the shape, including the **Transform** mode to determine the interaction between shapes.

5 In the **Mask** panel, click **Asset** (near the top of the panel).

6 Click **Select Media**, and navigate to the photo or video clip that you want to apply to the panel.

7 In the **Link** drop-down, select the **Group** or **Shape** to which you want to apply the media.

8 Set the properties you want, and repeat the process for any additional shapes.

9 In the **Mask** panel, click **3D** (near the top of the panel).

10 Set the 3D properties that you want, using key frames to make the element dynamic.

---

**Motion Tracking**

You can track the motion of elements in your videos and add masks or objects that follow the same motion. For example, you can apply a mask to obscure a face, license plate, or trademarked logo that is visible in your video.

You can also track the motion of an element so that you can follow it with a title or other object. For example, you can add a name label to follow a player in a video of a sporting event.

---

**To track and mask an element in a video**

1 In the **Edit** workspace, select a video clip in the Timeline that you want to track, and do one of the following:
   - On the timeline toolbar, click the **Motion Tracking** button  
   - Right-click the clip and choose **Motion Tracking** from the context menu.

2 In the **Mask Object** area of the **Motion Tracking Editor**, click a **Shape** icon.

3 Drag in the preview window to apply the shape to the area that you want to cover. Fine-tune the mask by dragging the orange mask nodes.
4 In the Mosaic or Blur area, choose the settings you want to apply to obscure the selected area.

Mosaic effect (left). Blur effect (right)

5 Track the selected area of the video by clicking one of the following Analyze buttons:
   - **Track selected mask backward all frames** — tracks the selected area backward from the current time point until it is not detected onscreen.
   - **Track selected mask backward by 1 frame** — tracks the selected area back one frame from the current time point. Good for short tracking segments that are not easily tracked.
   - **Track selected mask** — tracks the selected area (back and forward of the current time point) until it is no longer detected onscreen.
   - **Track selected mask forward by 1 frame** — tracks the selected area forward by one frame from the current time point. Good for short tracking segments that are not easily tracked.
   - **Track selected mask forward all frames** — tracks the selected area forward from the current time point until it is not detected onscreen.

6 Check the tracking analysis by playing the video using the navigation controls below the preview.
   Pause the video if you notice points where the mask doesn’t fully cover the selected area, and readjust the nodes in the preview area. You can change the shape of the mask by clicking the orange mask outline to add a node (pointer displays a plus sign), or by clicking a node (selected node is white) and pressing **Delete** to remove the node.

7 Click **OK** when you are satisfied with the mask and to return to the **Edit** workspace.
   The **Mask Object** is added to the Timeline above the corresponding video.
To track an element in a video with a title or object

1 In the Edit workspace, select a video clip in the Timeline that you want to track, and do one of the following:
   • On the timeline toolbar, click the Motion Tracking button.
   • Right-click the clip and choose Motion Tracking from the context menu.

2 Click the Follow Object tab.

3 In the Follow Object area, click the Tracker icon.

4 In the preview area, click the element that you want to track. Choosing an area that has distinct color and contrast works best.

5 Track the selected element of the video by clicking one of the following Analyze buttons:
   • Track backward all frames — tracks the selected area backward from the current time point until it is not detected onscreen
   • Track backward by 1 frame — tracks the selected area back one frame from the current time point. Good for short tracking segments that are not easily tracked.
   • Track — tracks the selected area (back and forward of the current time point) until it is no longer detected onscreen
   • Track forward by 1 frame — tracks the selected area forward by one frame from the current time point. Good for short tracking segments that are not easily tracked.
   • Track forward all frames — tracks the selected area forward from the current time point until it is not detected onscreen.

6 Check the tracking analysis by playing the video using the navigation controls below the preview.
   If the tracking is lost at any point, find the point where the tracker is lost, and reapply the tracker.

7 Drag the title or object that you want to apply to the tracking path to the drop zone (thumbnail area).
   The title or object that you selected appears in the preview area.
8 To adjust the position of the title or object, in the Offset area, adjust the Horizontal and Vertical settings.

9 To scale the title or object, drag the corner handle for the title or object in the preview area or in the Size area type Width and Height values.

10 Play the video to check the positioning of title or object.

11 Click OK when you are satisfied with the tracking to return to the Edit workspace. A new track is inserted in the Timeline, above the tracked video.

    Tips:
    You can’t edit titles in the Motion Tracking editor, so it’s best to create and save a title in advance. This will let you see the text in the Motion Tracking context.
    To delete a tracking object, right click the thumbnail in drop zone, and choose Delete.
    To rename a tracking object, right click the thumbnail in the drop zone and choose Rename. Type the name you want.
    To replace a tracking object, drag a new title or object to an existing thumbnail.
Montages and Templates

Pinnacle Studio has different types of templates

- Montages are pre-defined multimedia templates that include professionally designed sequences to give your productions instant impact. Organized under Themes, montages are grouped according to technical sophistication and look.
- Split Screen Templates let you play multiple video clips at one time. You can use an existing template or create and save your own split screen template.
- My Templates are custom templates that you create from a project (Save Movie As Template). Custom split screen templates are also saved under My Templates.

This section contains the following topics:

- Template basics
- Montage templates
- Montage clips on the timeline
- Anatomy of a montage template
- Montage editing
- Using the Montage Editor
- Split screen video templates
- My Templates: Saving a movie as a template

Template basics

Below is a basic procedure for choosing and filling a template. For details, see the section for each type of template.

To use a template

1. From the Edit tab, click the Navigation bar for the Library panel, and choose Montages and Templates.
2. Navigate to the category you want, and in the library, click the thumbnail for the template you want to use.
   You can preview the template in the Player panel.
3. Drag the template you want to use to the timeline.
4. To add media to a template, do one of the following:
• **Montage** templates (Themes)—double-click the template in the timeline to open the Montage Editor.
• **Split Screen Templates**—right-click and choose Open in Sub Editor
• **My Templates**—right-click and choose Open in Sub Editor

5 Add or edit the content you want and click OK to return to the main application window.

## Montage templates

Montage templates are located under Themes in the Montages and Templates category of the Library panel. The templates are pre-defined (limited editing) designed to enhance your movies with off-the-shelf slideshow, animation and multitrack editing effects. Montage templates have slots that can contain several types of custom data, including video, text captions, photos and more. You can fill in a slot just by dragging a suitable asset to the corresponding displayed drop zone.

![Montages and Templates panel](image)

**Montage templates are located under Themes in the Library.**

Within each theme, the available templates are designed to complement one another when used in the same project.

For instance, most themes provide an Opening template and a matching Ending template. Many themes also provide one or more Segue templates you can use when transitioning from one video or image clip to another.

## Montage in your project

The first step in using a chosen template is to drop it onto your project’s timeline. Once there, the Montage template is treated as an ordinary, self-contained video clip. To customize the clip by filling in the template’s blanks, you will double-click the Montage clip to open the Montage Editor. For more information, see “Using the Montage Editor” on page 143.

Each template defines a video or graphic sequence with blanks to be filled in by you. The available customizations can take several forms. For instance, most templates provide one or
more slots, or ‘drop zones’, for video or image clips. Many let you supply text captions for titles, and some have additional parameters for other special properties.

**Montage backgrounds**

Some templates have built-in graphical backgrounds, a selectable background color, or both. Many of these also provide a **Background** check box in the Montage Editor; leave the box unchecked if you want a transparent background. This allows the Montage to be used on an upper timeline track over a background of the video or photo material on the tracks below.

**Montage clips on the timeline**

Montage clips behave like ordinary video clips when it comes to operations on the timeline of a movie or disc project, such as adding transitions, trimming and positioning.

A Montage template dropped onto the timeline is added by one of three methods: insert, overwrite and replace. When the editing mode button on the toolbar is set to **Smart Editing Mode**, the replace method is chosen automatically. The default length of the clip varies from one template to another. For more information about editing modes, see “Editing mode” on page 56.

**Trimming Montage clips**

Although trimming operations on the timeline are the same for Montage clips as for video clips, the actual result produced by trimming may vary depending on the nature of the template.

In an all-animated template, such as a fancy rolled title, the animation always runs to completion. The animation speed therefore depends on the clip duration. Shortening the clip causes the animation to run faster, but does not truncate the sequence.

Clips that include video, in contrast, can be trimmed in the usual way. Many themes include a variable-length video subclip. When one of these is present, the clip can be expanded as far as the length of the subclip will allow – indefinitely, if the subclip happens to be a still image.

**Transitions and effects**

Transitions can be used at the beginning and end of Montage clips in the same way as with other clip types.
Video and audio effects can also be added to Montage clips as usual, and apply to all the content the clip embodies. However, a few effects, such as Speed, are not available for use with Montage clips.

**Anatomy of a montage template**

For examples of how themes work, let’s examine the included ‘50s Modern’ theme, which contains five templates: Opening, Segue A, Segue B, Segue C, Ending.

All the templates in this particular theme use the same backdrop design – an abstract, scrolling pattern. It is continuously visible except during full-frame video segments. The coloring of the pattern is set using a parameter control available for each of these templates in the Montage Editor.

Let’s take a closer look at one of the templates: **Opening**.

**Opening:** An Opening template usually starts with some sort of animation, including titles, and ends with full frame video. Our ‘50s Modern’ example follows that pattern.

The scrolling background animation runs through most of this sequence. Within the animation, two customizable captions are displayed. They are represented in the diagram below by lines on the Animation bar. Both captions are flown into and out of the frame (dark line color), with a one and a half second pause for stationary display (light line color) in between.

![Schematic representation of the Opening template in the ‘50s Modern’ theme, at its default length of about 14 seconds.](image)

Just as the second caption is leaving the frame, an animated panel containing the running video subclip is launched. The video zooms to full frame by 11:18 in the template clip, and remains so through to the end (the white portion of the ‘Video’ bar in the diagram).

By default, the length of this template clip is 14:00. The embedded video clip starts at a fixed offset of 7:03 and runs to the end; its length is therefore 6:27. If your video subclip is long enough, you can lengthen the overall clip, extending the full-frame video portion. This capability is indicated in the diagram above by the arrow at the end of the ‘Video’ bar.

**Montage editing**

Studio’s main tool for customizing a Montage clip is the Montage Editor, which allows you to interact with all the settings a Montage provides. Using the editor, you can add content from
the Library, change the background, and edit any text in the Montage. The editor can be
invoked from a Montage clip on the timeline of a project by double-clicking the clip or with
Edit Montage on its context menu.

A useful trick lets you add timeline clips directly to a Montage clip via the Clipboard. Copy
the chosen clip using the Copy command on its context menu or Ctrl+C. Then right-click the
Montage clip to open its context menu. Choose Paste to Drop Zone, then choose from the
graphical submenu of all the available slots in the Montage to select one as the destination.

Using the Montage Editor

Each Montage template has its own set of slots for video and photo content, represented by
drop zones in the Montage Editor. Most templates have at least one slot; the most is six.
Some also provide text captions and other parameters to customize special features. You can
set a default method for how content is scaled to fit the montage templates (fit, crop, or no
scaling). For more information, see “Project settings” on page 252 (Montage scaling).

The Montage Editor lets you specify template elements such as video or image clips,
property settings, and text captions. Clips are added by dragging them from the editor’s
Compact Library to drop zones below the Player.

The Montage Editor is split into five parts:

1. On the left, the compact version of the Library provides access to your videos and
   photos.

2. On the right is a customization panel including any text fields or other controls required
   by template parameters.

3. The Player shows you the results of your changes.

4. Below the Preview are the drop zones for your video and images.

5. A timeline provides handles for adjusting the lead-in and lead-out times.
Interior trimming of Montage clips

When a Montage template begins or ends with a user-settable amount of full-frame video, as many do, the Montage Editor timeline provides handles for adjusting the lead-in and lead-out times – the durations of the full-frame portions. Click a handle and drag left or right to adjust either duration separately. The duration of the center part of the clip – the animated part – will shorten or lengthen accordingly. If you want to balance the lead-in and lead-out without affecting the duration of the center portion, click between the handles and drag.

For a detailed explanation of the template structure, see “Anatomy of a montage template” on page 142.

Working with drop zones

Clearing drop zones: To delete a subclip from its drop zone, right-click the zone and select Remove Media from the context menu.

Muting subclip audio: Some drop zones are marked with an audio symbol, indicating that the audio portion of any video in that zone will be included in the Montage clip’s audio. If you don’t want the audio to be used, click the symbol to mute the subclip.

Choosing the start of your subclip: Video in a drop zone can be adjusted to start from an offset in the subclip. Click and drag the start of clip slider located under the drop zone to adjust the start frame. The keyboard left and right arrow keys are handy for making fine adjustments.

If the drop zone you are working with is active at that time index, the preview will reflect any changes to the start frame. When you are fine tuning the start frame of a subclip, it’s a good idea to set the scrubber position to the location where the Player preview will be of the greatest assistance.
Using the start of clip slider changes neither the position of the subclip within the template nor its duration, but only which excerpt of the subclip is used. If you set the start of the subclip so late that the video runs out while its zone is still active, the subclip’s last frame will be frozen to fill the allocated time.

**Adding effects within drop zones:** It is possible to apply video or audio effects directly to a Montage subclip by dragging the effect to the drop zone. As usual, a magenta stripe on the top of the clip signals that effects have been applied.

![Image showing effects application](image)

**Removing effects within drop zones:** Look under Effects the zone’s context menu for the **Delete all** command, or for the Delete submenu on which you can select the effect to be deleted.

**Note:** If you remove or replace the media in a drop zone, all the effects applied to that media are removed, too.

### Split screen video templates

You can easily create a split screen video in Pinnacle Studio to play multiple videos in a preset or customized template. Custom templates can include dynamic changes and 3D motion.

![Image showing split screen video](image)

*You can use a template to create a split screen video project or create your own split screen template.*

### Before you start

- Ensure that the video clips you want to use are imported to the Library and easy to access from a project bin or collection.
-Preview the video clips you want to use so that you have an idea what shapes will suit the content that you want to focus on. For example, if the main action is vertical, it won’t fit a horizontal shape very well.
To choose and fill a split screen template

1 From the Library navigation bar, choose Montages and Templates > Templates > Split Screen Templates.

2 Drag the thumbnail for the template that you want to use into the timeline.

3 In the timeline, right-click the template and choose Open in Sub Editor.

   The template expands into separate tracks in the Sub Editor window. A track is added for each area of the template (tracks visually indicate which area they correspond to).

4 From the Sub Editor Library panel, drag a video clip onto each track.

5 To adjust the clip within the template area, click a track, and in the Player panel, click the PIP Scale Mode button.

   A semi-transparent view of the clip displays over the template base.

6 In the Player panel, do any of the following:
   • Resize the selected clip by dragging the sizing nodes (orange dots) that appear in the preview window.
   • Position the clip by dragging it to fill the corresponding area of the template.
   • Rotate the clip by dragging the rotation handle (node that extends above the sizing rectangle).

7 In the timeline, click another track to adjust the other clips in the template.

8 When you are finished, click OK to exit the Sub Editor and collapse the split screen elements onto a single track in the timeline.

To create a split screen template

1 In the Timeline, click the Split Screen Template Creator button.

   In the Montage/Template Editor, choose a tool from the Shape Tools palette, and drag in the editor window to split the area into different clip zones. A number appears in each clip zone.
2 To adjust the lines and shapes, in the **Shape Tools** palette, choose the **Select** tool. You can drag the lines and shapes to reposition them and resize them. You can also adjust the **Rotation**, and **Border** (*Width, Color, Opacity*), and apply **3D Effect** options (*Swivel* and *Tilt*).

3 If you want to add dynamic changes or 3D motion to your template, for each object, you can add keyframes along the timeline at the bottom of the template window. You can then choose the settings you want to apply to a keyframe, and press **Enter**.

4 If you want to save content with your template (for example, an image or video that will be part of the template), navigate to the content you want to add and drag the corresponding thumbnail to the number you want in the drop zone. You can adjust the properties for a template video by setting values for any of the properties in the **Video Properties** area.
   **Note:** To remove the content, right-click it in the drop zone, and choose **Remove Media**.

5 When your template is complete, click **Save As** to save your template to the **Library** (*Montages and Templates > Templates > My Templates*).

6 Click **OK** to go to the **Sub Editor**.

7 Add and edit the clips as you would with an existing template.

8 When you are finished, click **OK** to exit the **Sub Editor** and collapse the split screen elements onto a single track in the timeline.

---

**My Templates: Saving a movie as a template**

You can save your movies as templates and add them to the **Library** (*Montages and Templates > My Templates*). When you convert a movie project to a template, you choose which elements of the movie will be replaced with placeholders. Saving a movie as a template...

---
Pinnacle Studio does not lock the non-placeholder content—all elements of the template are editable in the Sub Editor. Placeholders simply make it easy to identify content that is meant to be replaced.

**Note:** Custom split screen templates are also saved to My Templates. For information on using split screen templates, see “To choose and fill a split screen template” on page 146.

### To convert a movie project to a template

1. With the movie you want to use as a template open in the timeline, click **File** menu > **Save Movie As Template**.
2. In the upper left panel of the template window, mark the check boxes beside the media (videos, audio, or pictures) that you want to replace with placeholders.
3. Click **Replace With Placeholder**. 
   Orange numbered panels are used as placeholders.
4. Review the template and click **Save Template** when finished.
5. Type a file name for the template, and click **Save** to return to the main application window.
   The template is saved to the Library in **Montages and Templates > My Templates**.

### To choose and fill a movie template from My Templates

1. Drag a template from the **Montages and Templates > My Templates** section of the **Library** to the timeline.
   The template is added to a single track.
2. Right-click the template and choose **Open Sub Editor**.
The template expands to multiple tracks (if originally a multi-track movie).

3 In the **Sub Editor**, replace the placeholders by dragging the content you want to use from the **Library** over the placeholders.

4 Make any other edits you want in the **Sub Editor**.

5 Click **OK** when you want to return to the main application window.
Pinnacle Studio’s Title Editor is a powerful tool for creating and editing animated titles and graphics. Its extensive suite of text and image effects and tools provides innumerable possibilities for the visual design of your movie.

For information about creating and editing 3D titles, see “3D Title Editor” on page 271. This section contains the following topics:

- Title Editor components
- Accessing the Title Editor
- The Library in the Title Editor
- The Presets Selector
- Preset Looks
- Preset Motions
- Creating and editing titles
- Background settings
- Look settings
- The Edit window
- Text and text settings
- Titles and stereoscopic 3D
- The Layer List
- Working with the Layer List
- Working with layer groups
Title Editor components

Areas of the Title Editor: 1. Presets Selector; 2. Library panel; 3. Edit Window; 4. Settings panel; 5. Toolbar; 6. Layer List

These are the main areas of the Title Editor display, numbered as in the illustration above:

1 The **Presets Selector** provides tabs for **Look** and **Motion** presets, with the presets organized by style within each tab. A Look is a visual styling of a text or shape layer in your title; a Motion is an animation routine that can be assigned to any layer but is most often applied to text. See “Preset Looks” on page 155 and “Preset Motions” on page 156 for further information.

   Hover your mouse over any preset to see how it will affect your title. A single click applies the preset to the current layer. After being applied, Looks can be customized using the Settings panel.

2 The **Library** provides resources for building your titles. The tabs across the top provide access to all available media and content. For information about the **Library** panel, see “The Library” on page 13.

3 The **Edit Window** is your main work area when authoring or editing a title. It provides a scrubbable preview of your title with hands-on editing. See “The Edit window” on page 163 for details.

4 The **Settings** panel has separate collapsible subs for each of three settings categories: **Text settings**, governing the style and size of text captions; **Look settings**, for the configuration of faces, edges and shadows; and **Background settings**, which pertain to the title’s background layer.

5 The **Toolbar** has four control groups. From left to right: the add text and add shape tools; a set of layer manipulation controls; a full set of transport controls including a loop button; and a pair of counter readouts showing the duration of the title and the current playback position.
6 The **Layer List**: Each graphical or textual element constitutes a layer in the title, which is a stack of such layers. The opaque parts of each layer obscure the layers below; the bottommost layer can obscure only the background.

In addition to listing each layer by name, the Layer List includes an animation timeline showing the time span during which each layer is active, and the Motions that have been assigned to it. These properties can be adjusted by dragging.

The process of building up an image in layers is called ‘compositing’. Because the information in each layer is maintained separately, to be combined only when the image is output, it is possible to return to the composition at any time and add new layers, and to adjust, reorder, remove or replace existing ones.

![Building up an image in layers starting with an empty frame (top left). The checkerboard pattern indicates transparency. Although backgrounds can have transparent or translucent areas, here we add an opaque background (0) for clarity, followed by successive layers with some opaque content (1, 2, 3). In the final composition (bottom right), upper layers obscure those below.](image)

**Accessing the Title Editor**

The Title Editor can be invoked in two ways: by double-clicking any title in the Library or on your project’s timeline; or by clicking the Title button on the toolbar of the timeline.

**Keywords in title names**

Some of the provided titles in the Library have transparent areas through which the content of underlying tracks will be visible. The names of these titles all contain the keyword ‘overlay’.

‘Full-screen’ titles have no transparent areas: they fully occupy the video frame. Their names contain the keyword ‘fullscreen’.

In the Library, you can easily view only the titles of one or the other type by searching on the appropriate keyword.

**Tip:** Other search keywords to try out with titles in the Library are ‘roll’, ‘crawl’, ‘name’ and ‘title’.
Saving the title

Use **Save Title** as in the **File** menu in the Title Editor to store titles to your computer’s file system. From there, titles can be exported to other computers, and shared with other Pinnacle Studio users. If you save to a watchfolder, the edited title will appear in your Library automatically.

Closing the Title Editor

To close the Title Editor, use any of the following methods:

- Click the **OK** button at the bottom of the Title Editor. If you opened the title from the Library, you will be prompted to save any changes to the title under a new name. If you opened the title from a timeline, your new or updated title becomes part of the current project.
- Click on the **Cancel** button at the bottom of the Title Editor. Any changes you have made are discarded.
- Click the Cancel button (X) at the top right of the window. This is equivalent to clicking **Cancel**, except that if you have made changes you will be given an opportunity to save before closing.

The Library in the Title Editor

The Library appears in the Title Editor as a tabbed panel on the left side of the window. The tabs across the top give access to all the available media and content.

Adding Library media to a title

To add a video or photo to the title, drag it from the Library into the Edit Window. The new element is created at a default size where you drop it in the Edit Window. You can then move, resize or rotate it as you like.

To add a video or photo as a full-screen background for your title, drop it onto the background drop-zone of the Background Settings sub. See "Background settings" on page 159 for details.

You can also use a video or photo as the fill for the face, border or shadow of your text. To do so, first add a face, border, or shadow to your Look Settings using the add buttons. Then drop your photo or video into the drop zone to the right of the **Fill**.
The Presets Selector

Quickly setting up an attractive title is easy with the Title Editor’s Presets Selector. After entering your text, and with the text layer still selected, apply any of the preset Looks to it with a single mouse-click. To make it even easier, as you hover the mouse over any Look icon, the Edit Window previews the effect on your title of applying the Look to the current layer.

Even if you can’t find exactly the Look you want among the presets, you can often save time by starting with one that’s almost what you want, then tweaking it in the Look Settings sub.

To give your title some visual impact, there’s nothing like a bit of animation. Click the Motions tab of the Presets Selector. The three groups of presets available correspond to phases in the life of a layer.

As with Looks, Motions can be previewed as they will appear in your title by hovering the mouse over any of the preset icons. Once your mind is made up, you can apply the chosen Motion with a single click.

Preset Looks

The Looks tab of the Title Editor Presets Selector provides visual styles that can be applied to the text and shape layers in your title.

Previewing Looks

To preview a particular Look on a particular layer, first select the layer, then open the Looks tab of the Presets Selector and hover your mouse over the thumbnails. As you hover, the Edit Window previews your title as it would appear with the selected Look applied. This lets you immediately gauge its effect in context.
Applying a Look

To apply a preset Look to a text or vector graphics layer, first select the layer with the mouse by clicking in the Edit Window or the Layer List. You can also affect more than one such layer simultaneously using multiple selection or a layer group.

To begin using Looks, select a family of presets: Standard, Shadow, Beveled or Outlined. Hover over thumbnails to preview presets; click the thumbnail to apply one to the current layer.

Having selected the layer or layers to change, use one of the following methods to apply a Look:
• Click its thumbnail in the Presets Selector.
• Drag the thumbnail from the Presets Selector onto the layer in the Edit Window.
• Drag the thumbnail from the Presets Selector onto any of the layers or grouped layers in the Layer List header.

Preset Motions

The Motions tab of the Presets Selector contains the animation routines that give the Title Editor much of its power. These Motions are assigned to and operate on single layers in your title. The Motions are divided into three classes based on the portion of the layer’s lifespan they affect: enter, emphasis and exit.
• An enter Motion controls the arrival of the layer – its first appearance within the running title.
• An emphasis Motion maintains audience focus on the content of a layer by giving it an attention-getting action during its time on-screen.
• An exit Motion takes the layer off-stage again, completing its life cycle.
Each layer is allowed to have one Motion of each type. All Motions are optional, however, and it’s also quite possible to have a title with no Motions at all.

The Motions collection

In each of the three types of Motion, most of the animations can be grouped into several standard classes based on their mode of action.
Letter-based Motions operate at the level of individual letters in a text caption (other kinds of layer are treated as consisting of a single ‘letter’). For instance, in the enter Motion ‘Letters turn’, the letters in the text layer are first seen edge on, then rotate in place one by one until all are in their normal orientation.

Word-based Motions work similarly, but with words as the smallest unit of animation. In the enter Motion ‘Words from bottom’, the words in the layer float up into position one by one from below the frame.

Line-based Motions are meant for layers with multiple lines of text, each of which is processed in turn. In the enter Motion ‘Lines from behind’, each line of text is brought onto the screen along a perspective track as though it originated from behind the viewer’s own position.

Page-based Motions affect the entire layer simultaneously. One example is the enter Motion Barrel roll, which ‘rolls’ the layer into position from above as though it were painted on the side of an invisible rolling barrel.

Matching the enter and exit Motions

Most enter Motions have a corresponding exit Motion with which they can be paired if visual consistency is desired. For example, a layer that enters with the ‘Words from infinity’ Motion could be configured to exit with ‘Words to infinity’. However, this kind of consistency is only an option, not a requirement, and you can mix and match Motions of the three types in any way you choose.

The Presets Selector offers Enter, Emphasis and Exit Motions. Each layer in a title can use one Motion of each type.

Previewing Motions

To preview a particular Motion on a particular layer, first select the layer, then open the Motions tab of the Presets Selector and hover your mouse over the thumbnail of interest. As you hover, a looping preview of the title animation will begin to run in the Edit Window so that you can immediately see the effect.
Adding Motions

To add a particular Motion to a particular layer, first select the layer, then do one of the following:
• Click the Motion’s thumbnail in the Presets Selector.
• Drag the Motion’s thumbnail from the Presets Selector to an accessible layer (one not
  masked by other layers) in the Edit Window.
• Drag the Motion’s thumbnail from the Presets Selector onto any of the layers or grouped
  layers in the Layer List header.

Upon using any of these methods, the Motion will be added to the layer, replacing the
existing Motion of the same type on that layer, if any. See “The Layer List” on page 170 for
details on working with Motions in the Layer List.

Creating and editing titles

A title in Pinnacle Studio’s Title Editor is built from elements of four types:

The background layer: By default, the background is fully transparent. For overlay titles, this
is normally what you want. For special purposes, or for full-screen titles, you can choose a
color, a gradient, an image, or video for the background. For additional flexibility, the
Background Settings also include an opacity control. See “Background settings” on page 159.

Video and image layers: The resources that make up these layers originate in the Videos,
Photos and Movie Projects sections of the Library. The layers support the same operations
as text and shape layers except for the application of Looks.

Text and shape layers: These are ‘vector-based’ layers, meaning that they are stored not as
bitmapped images like video and photo files, but as a kind of ‘recipe’ for recreating the
images from straight and curved line segments to which properties (e.g. color) and special
effects (e.g. blur) can be applied. Like video and image layers, these vector-based layers can
be dragged, resized, rotated and grouped, and you can apply Motions to them. Unlike the
other layers, however, they can also be customized with Looks from the Looks section of the
Presets Selector. See “Preset Looks” on page 155 for details.

Motions: Motions are animation routines that can be applied to any layer in the title
composition except the background. Motions are selected and applied from the Motions tab
of the Presets Selector. Once a Motion has been applied to a layer, its timing can be adjusted
in the Layer List timeline. See “Preset Motions” on page 156 and “The Layer List” on page 170
for further information.
Creating text and shape layers

To create a text layer, either click the add text button in the header bar of the Layer List timeline, or simply double-click an empty area of the Edit Window. A new layer containing default text will appear. The text is automatically selected, and will be replaced if you now begin to type.

To create a shape layer, click the add shape button (to the right of add text), then make a selection on the pop-up menu. The available choices include circle, square, ellipse, rectangle, horizontal and vertical ‘pill’ shapes, and triangle. Upon selection, a new layer of the given shape and a default size appears in the center of the Edit Window.

Editing layers

The remainder of this chapter provides details on editing the background and layers in the Title Editor.

- To learn about customizing the Background layer, see “Background settings” on page 159.
- For information on moving, resizing, rotating and rearranging all types of foreground layers, see “The Edit window” on page 163 and “The Layer List” on page 170.
- To learn about editing text and setting text properties, see “Text and text settings” on page 165.
- For working with stereoscopic titles, see “Titles and stereoscopic 3D” on page 169.
- Multiple selection and grouping is covered under “Working with layer groups” on page 174.
- Finally, to learn about Motion editing in the Layer List timeline, refer to “The Layer List” on page 170.

Background settings

Unlike the foreground layers in a title, the special background layer does not appear in the Layer List, and is not modifiable in the Edit Window. Instead, the background is controlled from the Background Settings panel.
The Background Settings panel lets you create the background of a title. The small preview area serves as a Color Selector button, and also as a drop target for videos or images from the Library. Here the Aspect Ratio menu has been opened by clicking the button just above.

The default background for a title is fully transparent. If your title appears on an upper track in your project's timeline, any video or other imagery on the tracks below will be visible behind the title foreground.

**To create a solid or gradient background**, click the background preview area. This brings up a color selection dialog, and also provides an eyedropper that allows you to pick up a color from anywhere within the Title Editor window.

You may choose to have a gradient background by choosing the **Gradients** tab at the top of the color palette. Additional gradient markers can be set by single-clicking below the gradient bar. Gradient markers can be removed by dragging them vertically out of the bar area.

**To use video or a still image** as your background, drag the item down from the Videos or Photos sections of the Library to the background preview, which also serves as a drop zone.

**To make the background translucent**, position the **opacity** slider anywhere between fully transparent (all the way to the left) and fully opaque. Double-clicking the slider returns it to full opacity.

**To reset the background** to its default state (with no background), click the **trashcan** button.

## Look settings

The **Settings** panel provides access to the Look Settings, where you can examine, modify, add or delete the individual detail layers that are overlaid to generate a particular Look.
Click the ‘Look Settings’ arrow on the Settings panel to open a sub where the Look of a layer can be edited. Under the name of the currently-selected preset (‘Blue Bevel’) are three buttons for creating new detail layers. The edit panel for the Face detail is open.

There are three types of detail layer: **face** (surface), **edge** and **shadow**. The three types differ not in the settings they support, but in the default position at which they will be inserted in the layer stack. Unless explicitly dragged out of position, face details always appear at the top of the stack, followed by edges, and finally shadows. After a detail has been created, however, it can be dragged up or down in the layer stack as desired.

![Diagram showing face, edge, and shadow layers]

**Face, Edge and Shadow:** A new face detail (left, top) is added above the uppermost existing face layer; new edge and shadow details are added below the bottommost layer of their respective types.

The properties of individual detail layers can be modified by means of controls on collapsible sections in the Looks Editor.

The following detail properties are available:

---

**The Title Editor**
• **Offset X, Offset Y**: These sliders set the position of the detail layer relative to the nominal position of the text or graphic to which the Look is applied. The range of offset is -1.0 (left, or bottom) to +1.0 (right, or top). The maximum offsets represent one eighth the width and one eighth the height of the Edit Window work area.

  ![ABC ABC ABC](image)

  *In this example, a Look with three detail layers has been applied to a single text layer. The detail layers are configured identically except for their offset values, as follows: top left (-1.0, 1.0); center (0, 0); bottom right (1.0, -1.0).*

• **Size**: This slider sets the thickness of the segments used to draw the text or graphic, from zero to 2, where 1 represents the default thickness.

  ![AAA AAA AAA](image)

  *This example includes three detail layers with varying size values. From left to right: 0.90, 1.0, 1.20. The visual effect of varying the size depends on the default thickness of the strokes in the layer. In a text layer, this depends on the font family and size chosen.*

• **Blur**: As this slider increases in value from 0 to 1, the detail layer affected becomes increasingly ghostly and indistinct.

  ![AAA AAA AAA](image)

  *The detail layers in this example differ only in their blur settings. From left to right: 0.15, 0, 0.40.*

• **Opacity**: This slider sets the opacity of the detail layer from 0 (transparent) to 1 (opaque).

• **Fill**: Click the color swatch button to open a color picker in which the fill color of the detail layer can be set. The color picker includes an eyedropper button to pick up a color from anywhere in the Title Editor. To set a gradient background, choose the Gradients button at the top of the color palette. Additional gradient markers can be set by single-
clicking below the gradient bar. Gradient markers can be removed by dragging them vertically out of the bar area.

**Working with detail layers**

In addition to setting the properties of existing detail layers, you can add details of any of the three types, delete details, and reorder the detail layer stack.

**To add a detail layer**, click one of the three small buttons at the top right of the Look Settings. From left to right, these create a new face, edge and shadow layer respectively. The placement of the new detail layer in the layer stack is determined by its type, as explained above.

**To delete a detail layer**, click the trashcan button in the header bar of the detail’s edit panel.

**To rename a detail layer**, double-click its name, type the name you want, and press **Enter**.

**To temporarily hide a detail layer**, click the dot-shaped visibility toggle icon in the detail’s header.

**To close down or open up the edit panel** of a detail layer, click the arrow button at the left-hand end its header bar.

**To reorder detail layers**, drag the header bar of the edit panel to its new location. If the Look you are editing contains more than two or three layers, it can be easier to follow the action if you close down the s first so that the whole stack is visible at once.

**Saving a custom Look**

Once you have finished editing a custom Look, you can save it to the ‘My Looks’ presets group by clicking the **save look** button in the header bar of the Look settings. Before saving, it’s a good idea to rename the Look. To do so, double-click the current name in the settings, type a descriptive name for the Look, and press **Enter**.

Once the Look is saved you can retrieve it at will through the Presets Selector, under ‘My Looks’.

**The Edit window**

The Edit Window is the main preview and editing area of the Title Editor. This is where you rearrange, resize and rotate the foreground layers of your title.

A necessary first step for most kinds of editing is to select the layer or layers your want to affect. Selected layers are drawn within a frame having eight control points for sizing and a rotation handle at the top for rotating the selection in one-degree increments. Most types of
layer can be ‘grabbed’ for dragging to a new position by clicking directly on the control frame.

![Image](image.png)

*Rotating a shape object within the Edit Window. The smaller dot at the top center of the control frame is the rotation handle for the layer. To rotate a layer, click down on its rotation handle and drag. When you are over the rotation handle, the mouse pointer will show as a circular arrow.*

With text and shape layers, some of the layer content may appear outside the control frame. This occurs if one of the ‘details’ within the Look is defined with a horizontal or vertical offset that moves the detail away from the nominal location of the layer. See “Applying a Look” on page 156 for more information.

### Layer operations in the Edit Window

The operations described here are for a single layer, but can be extended to work with multiple layers simultaneously. See “Working with layer groups” on page 174 for more information.

**To select a layer in the Edit Window**, click in the layer rectangle with the mouse. This causes the layer’s control frame to appear, ready for editing.

Layers respond to mouse clicks anywhere within their containing rectangle (the rectangle shown by their control frame when selected). This means that you may not be able to manipulate a layer that is visible only because it lies beneath a transparent area within the rectangle of another layer. To perform any editing with the mouse in such cases, you should first hide the upper layer(s) as described under “The Layer List”. See page 181 for details.

**To move any non-text layer**, click down anywhere within its rectangle and drag to the new position.

**To move a text layer**, position the mouse near the edge of the layer’s control frame until you see the drag pointer (four-way arrows) appear, then click and drag normally. Clicking inside the frame, as you would do a non-text layer, would instead activate text-edit mode. See “Text and text settings” on page 165 for detailed information.
To resize a layer but retain its proportions, click down on a corner point of the control frame and drag outwards or inwards until the desired size is achieved.

To resize a layer and modify its proportions, click a side point of the control frame and drag. By resizing with the center control point on two adjacent sides in succession, you can produce any desired size and proportion.

To rotate a layer, click down on its rotation handle and drag. For finer control over the rotation, move the mouse pointer away from the center of rotation while dragging. The extra distance makes it possible to define smaller angles between one mouse position and the next.

To change the stacking position of a layer, right-click the layer, and select from its context menu one of the commands on the Order submenu: Send to Back, Send Backward, Bring to Front, Bring Forward. Convenient keyboard shortcuts are available for all four operations; respectively, Ctrl+Minus, Alt+Minus, Ctrl+Plus and Alt+Plus.

Another approach to reordering layers, which may be more convenient in titles where several layers overlap, is to use the Layer List. For more information, see “The Layer List” on page 170.

To delete a layer, select the control frame or select it in the Layer List, then press Delete. Alternatively, you can use the context menu command Delete Layer. If the layer is a text layer in text-edit mode, the Delete command (and the Delete key) apply to the layer’s text only, not the layer itself.

Text and text settings

For all the graphical sophistication of the Title Editor, in many instances the primary reason for using titles is the text they contain. The editor therefore provides several specialized options to help you ensure that you can get your text looking exactly the way you want. The text operations we will look at below include:

- Editing the text
- Changing fonts, font sizes and styles
- Setting text justification and flow
- Copying and pasting text properties

The areas of the Title Editor of most interest in text work are the Edit Window and the Text Settings panel. For styling a text layer, the Looks section of the Presets Selector and the Look
settings panel also come into play. See “Preset Looks” on page 155 and “Look settings” on page 160.

**Text-edit mode**

As described elsewhere, when dragging a text layer you have to be careful to click at the edge of the control frame, rather than anywhere within it, to avoid accidentally putting the layer into text-edit mode. For the operations described here, however, text-edit mode is exactly what we want. In a newly-created text layer, text-edit mode is already enabled: you can begin to type immediately and the default text will be replaced.

**To activate editing for an existing text layer**, click anywhere inside the control frame. Text-edit mode becomes active and – to save you an often-required step – all existing text in the layer is automatically selected. As usual, selected text is indicated by highlighting.

![A text layer with all text selected.](image)

A text layer with all text selected. From left to right, the text editing controls in the header bar above govern letter styling (bold, italic, underline); text alignment and text flow; and font name and size. In text-edit mode, the mouse pointer over the layer has the 'I-beam' shape as shown here.

**To modify the text itself**, simply start typing. The highlighted text disappears and the text you type takes its place. As you type, the current insertion point (the place in the text where new letters are inserted) is indicated by a vertical line.

If you want to add new text without losing what was already there, click at the desired insertion point after putting the layer in text-edit mode, or use the arrow keys to maneuver the insertion point as desired.

You can also highlight (and thus replace) only part of the text before typing: drag across the letters with the mouse, or hold down Shift while using the arrow keys. You may also triple click to select all of the text in the layer or double click on a word to select just that word.

Lastly, if you want to select all the text in the layer again, you can use the mouse or arrow keys as just described, or give the standard shortcut **Ctrl+A**.
The Text Settings

The topmost Settings sub is this group of controls for editing and styling the content of the current text layer.

Using the text field

In cases where text in the Edit Window is difficult or impossible to access for editing, the text field in the panel provides another convenient way to select and edit your text. This is the approach to take if the text is off-screen at the scrubber position, which can happen when Motions are involved. The text field expands to provide up to three lines as you type, then adds a scroll bar if further lines are entered.

Styling highlighted text

Most of the Title Editor text controls are probably quite familiar to you from using similar controls in other applications. Those that apply to the highlighted text only are these:

Font styling: To set or unset the bold, italic or underline properties of the selected text, use the toggle buttons in the header bar, or the standard keyboard shortcuts Ctrl+B, Ctrl+I and Ctrl+U. The buttons light up when their respective style options are active.

Font name: Your titles are the perfect place to experiment with fancy display fonts, so you'll likely be accessing this dropdown list quite often. If you have many fonts on your system, the list can be quite long. For ease of navigation, pressing the first letter of a font name will take you instantly to the corresponding alphabetical location in the list. Click the font you want, or move to the name using the up and down arrow keys and press Enter.

To select a font, open the dropdown list and click the one you want. The font is applied to the currently-highlighted text only.
**Font size:** The Title Editor provides several methods of setting the font size. You can enter a new value directly into the font-size edit field (up to 360), or use the neighboring dropdown arrow to display a list of sizes. Further to the right, the shrink font and enlarge font buttons change the size in intervals that widen as the font size increases.

**Copying and pasting text styles**

With both text and shape layers, the **Copy Attributes** and **Paste Attributes** context menu items, found by right clicking on a the control frame in the Edit Window, let you copy Looks from one layer to another without having to open the Looks section of the Presets Selector. With text, this operation also replicates the font name, size and style from one text layer to another, and also works on partial selections within text layers.

**Text alignment**

For titles with multiple lines of text, the Title Editor provides a standard menu of justification options. The default for new text layers is center justification (Align Center on the dropdown list), in which each separate line is horizontally centered in the available space. The additional options provide for **Align Left, Align Right** and **Justify**.

**Text flow**

To accommodate the various conventions of different languages with regard to the direction in which lines of text are written, and for maximum graphical design flexibility, the Title Editor offers a menu of eight text flow options. These options, which work in concert with the justification options just discussed, affect not just the way the text is displayed but also the meaning of standard keys like **Home** and **End**.

**Styling with Looks**

As explained in the topic “Preset Looks” on page 155, the appearance of text and shape layers can be transformed by the application of Looks from the Presets Selector. In a partially-highlighted text layer, applying a Look affects only the highlighted text. In principle, each of individual character in your title could be given its own Look.
If you are working on a stereoscopic 3D project, you don’t have to settle for a 2D title. The Library includes many titles identified as 3D, but any title at all can make use of stereoscopic text.

To set a 2D title as stereoscopic, select a text layer, then check the Stereoscopic box on the Stereoscopic Settings sub. Now the Text Depth setting becomes available; it allows you to change the apparent distance between the text and the viewer. If you save the title to a watchfolder, its Library thumbnail will carry the 3D indicator.

A stereoscopic title that has been opened from the Library or a 3D timeline will provide a stereoscopic preview. A stereoscopic title on a 2D timeline will preview in 2D only; the timeline settings must be changed to 3D in order to get stereoscopic playback.

**Text depth**: To change the depth of a text layer – its apparent distance from the viewer – select the layer and open the Stereoscopic Settings sub. Make sure the Stereoscopic box has an orange checkmark displayed. As you increase the value in the Text Depth slider, the text recedes from view; decreasing the value brings the text closer.

As you adjust the depth of the text, you may have to adjust the font size as well. Moving the text into the distance can decrease its apparent size to the point of unreadability, while bringing the text closer can make it too large to fit in the title frame.
The Layer List

The Layer List, which occupies most of the bottom part of the Title Editor display, has two columns: one of layer headers, and one of timeline tracks. In each row, the header contains the name of the layer, and a visibility button. To the right of the header, the timeline track serves as a graphical editor for controlling the lifespan of the layer within that of the title as a whole, and the durations of any Motions that have been assigned to the layer.

![Layer List](image)

*The left-hand portion of the Layer List contains the layer headers; to the right is an animation timeline where the timing of each layer, and of any Motions applied to them, is displayed and can be modified. (Only the leftmost portion of the timeline is shown here.)*

If the title you are editing was opened from the Movie Editor or the Disc Editor, the Layer List timeline represent the current length of the clip. To modify it, return to the timeline of your project and trim the title there.

If the title was opened from the Library, and so is not bound to a clip in the project, its length can be edited in the Title Editor. Set the desired duration by entering a value directly into the duration counter at the right side of the toolbar. All layers will be adjusted relative to the new duration.

The Layer List toolbar is home to several important groups of controls (see “The toolbar” on page 172).

Working with the Layer List

The Layer List is a multitrack timeline very similar in conception to the timeline of the project itself in the Movie Editor or Disc Editor. Some operations, such as those to do with Motions, are particular to the Title Editor, however.

Layer operations

The procedures described here are all carried out in the header area of the Layer List.

Selecting layers

Clicking a header in the Layer List has the same effect as selecting the layer in the Edit Window (and vice versa). The layer name highlights, and the layer’s control frame appears.
Multiple selection is also allowed, using the standard Windows mouse and keyboard combinations `Shift`-click (extend selection), `Ctrl`-click (toggle selection of one item), and `Shift+Ctrl`-click (extend selection from last item clicked). See “Working with layer groups” on page 174 for information on how to use multiple selections.

Layer names and renaming

When you create a new layer, the Title Editor gives it a default name based on the resource name or file name. Since the default names are often not very descriptive of the layer contents, it may be helpful in a title with a number of layers to give them custom names that make it easier to tell at a glance which name goes with which layer.

The name of a new text layer is the same as its default text (“Your text here”). Unless you give the layer a custom name, its default name will continue to match whatever text you type into the layer. Once you do rename a text layer, further changes to the text are no longer reflected in the layer name. The default behavior can be restored by setting a blank name, however.

To rename the primary layer, click its name. An edit field opens with the existing name selected. Type the new name, then press Enter or click outside the edit field to finish.

Reordering layers

As we saw in the topic “Layer operations in the Edit Window” on page 164, the position of a layer in the layer stack can be altered by means of commands on the Layer context submenu, or by keyboard shortcuts such as `Ctrl`+`Plus` (Layer > Bring to Front).

The Layer List offers a more direct approach: simply drag the layer header to a new position in the list. This is particularly handy in situations where overlapping layers make mouse selection difficult. As you drag the layer, an insertion line shows where the layer will appear in the list when dropped.

Using multiple selection (see “Selecting layers” on page 170) you can drag several layers at once to a new position.
Hiding and locking layers

A complex title can get crowded very quickly as you add layers to the composition, and Motions to the layers. The visibility button at the right-hand end of the layer header is handy for simplifying such situations.

Click the eye-shaped visibility button to temporarily remove a layer from the Edit Window. The layer’s information and settings are preserved, but you will be able to work on other layers for the time being without the hidden layer obscuring either your view or your mouse actions. Click again to restore the layer to visibility.

The toolbar

The controls and readouts on this header bar are in groups. From left to right:

- The add text and add shape buttons allow you to create new ‘vector-based’ layers to which Looks from the Presets Selector can be applied. Clicking add text adds a new text layer with a default Look and caption. As a shortcut for add text, you can simply double-click any unused area of the Edit Window. Clicking add shape opens a pop-up menu from which you can select a particular shape as the contents of the new layer.

- Each of the align, group and order buttons opens a pop-up menu of commands that can affect multiple layers. These commands are covered under “Working with layer groups” on page 174.

- The 3D viewing mode switcher appears if you are editing a stereoscopic 3D title. Please see the “3D viewing mode switcher” on page 28 for information on the available formats.

- The transport buttons allow you to preview your title without leaving the Title Editor. From left to right, the functions of the buttons are: loop play, jump to start, go back one frame, play/pause, advance one frame, and jump to end.
The loop play button loops continuously once started; to halt it, click anywhere on the Edit Window, or click loop play again. As usual, pressing Space provides a convenient shortcut for stopping and starting playback.

- The **System Volume and Mute** button allows you to adjust the speaker volume of your system. It does not change the audio level of any clips on your timeline.

- The counters show the duration of the title and the current position of the Layer List timeline scrubber in the usual hours, minutes, seconds and frames format. For titles that come from your project rather than the Library, the scrubber position shown is relative to the start of your project’s timeline, not the start of the clip.

## Editing layers and Motions

When a layer is created, its duration is set to the full span of the title of which it is a part. To delay the first appearance of a layer in the running title, or to banish one layer while continuing others, drag the ends of the layer along the timeline in the same fashion as clip editing on the timeline of your project.

A title is like a stage on which the layers are actors who come on for their big scene and then depart. Trimming the layers in the Layer List timeline allows you to control precisely the timing of their entrances and exits.

Up to three Motions – one of each type – are allowed to each layer. These are also displayed on the timeline, where their durations too can be adjusted. Enter and exit Motions are each anchored to their respective ends of the layer lifespan, but the end of the enter Motion and the start of the exit Motion can be freely edited with the mouse.

If the layer has an emphasis Motion, it occupies whatever unused duration remains (up to the whole length of the title).
Three layers with Motions. The top layer has only an Emphasis Motion (solid line), which therefore uses the full duration. The bottom layer has Enter and Exit Motions, and a static interval between them. The center layer has Motions of all three types. The Enter Motion is being trimmed (note the horizontal arrow cursor); as its length changes, the Emphasis Motion self-adjusts to consume fully any unused time.

To replace one of the Motions used by a layer, simply add the new Motion as usual: an existing one of the same type will be overwritten.

To delete a Motion without replacing it, select the layer and click the small ‘x’ in the center of the Motion’s timeline graph.

**Working with layer groups**

The Title Editor Layer List allows you to group layers on either a temporary or a permanent basis.

**To create a temporary group**, you will use standard multiple selection techniques whether in the Edit Window or on the Layer List. You can then make changes, such as applying a Look, to all the members of the group simultaneously. The group remains whole only until you click another layer or an empty area of the Edit Window, whereupon the layers resume their individual existences. In a temporary group, the control frames of each member are all visible at once.

**To create a permanent group**, you first create a temporary group, then click the group button on the Layer List toolbar (or use the Group command from any member’s Grouping context submenu).

Once created, the group stays together until you explicitly disband it with the ungroup button or menu command, or by dragging the member layers out of the group in the Layer List. One further command, **regroup**, automatically reconstitutes the last group to have been ungrouped.

When a permanent group is selected, it has a shared control frame that encloses all its members. The control frames of the individual members are not visible.

Permanent groups have their own header entries and timeline track in the Layer List. The group header can be expanded or collapsed to reveal or hide the headers for the member layers. When the group is open, its member layers are indented with respect to the group header.
Temporary groups and permanent groups respond differently to many commands as detailed below.

**Note:** Even when a layer belongs to a permanent group, it can still be individually selected, either in the Edit Window (unless the group itself is currently selected) or the Layer List. A member layer can even be added to a temporary group with other layers inside or outside the permanent one.

### Multiple selection of layers

The first step in making a group is to select the multiple objects that will comprise it. In the Edit Window, this can be accomplished in two ways:

- By clicking and dragging with the mouse to mark out a selection rectangle (a ‘marquee’) that intersects all the objects you want to group.
- By clicking the first object you want to group, then Ctrl-clicking each of the others.

Another approach to multiple selection uses the Layer List. For more information, see “Working with the Layer List” on page 170.

### Edit Window operations on the group

Both temporary and permanent groups can be repositioned, resized and rotated.

**To reposition any group,** drag it to the new position as though it were an individual layer.

**To rotate a permanent group,** drag the rotation handle of the shared control frame. All members of the group revolve about their common center like planets revolving around the Sun.

**To rotate a temporary group,** drag the rotation handle of any member. All members of the group rotate about their own centers like planets rotating on their axes.
**To resize a permanent group**, drag any control point of the shared frame. The size of the whole group changes as though you were stretching a rubber sheet with all the layers painted on it.

**To resize a temporary group**, drag any control point of any member’s control frame. Each layer is affected individually, expanding or contracting in place about its own center.

In resizing operations on groups, as with individual layers, dragging by a corner control point preserves the aspect ratio of the layer, whereas dragging by a side control point allows the proportions to be altered.

### Applying properties to a group

Once a temporary group is selected, any property settings you make will affect every member to which the property is applicable:

- **If you apply a Look**, any text or shape member will receive it.
- **If you add a Motion** by right-clicking a Motion icon and choosing Add to selected layer(s), the result will be the same as if you had added it to each member individually.
- **If you select a font**, or change any other text styling attribute, every text member of the temporary group will be updated.

Except in the first case, permanent groups have their own rules for these operations:

- **If you apply a Look**, it works the same as with a temporary group: all text and shape layers in the group are affected.
- **If you add a Motion to a permanent group**, the group is treated for the purposes of animation as a single graphic object, without regard to the letters, words or lines its members may contain. However, the individual Motions of its members continue to run along with that of the group as a whole.
- **Text stylings** cannot be applied to a permanent group.

### Aligning layers in temporary groups

The final type of group operation, one that applies to temporary groups only, is provided by the **group align** button on the Layer List toolbar. The commands, of which there are three for horizontal and three for vertical alignment, affect all the members of the group except for the first selected, which sets the position for the others.
Sound and music

Video may be thought of as primarily a visual medium, but the role of sound in your movies is often no less important than that of the images on the screen.

Feature film and television productions include numerous types of audio, beginning with the dialog and other sounds created during live action. In your movies, that raw soundtrack – the original or synchronous audio – is imported along with the video, and remains bound to it unless you explicitly separate them.

Most commercial productions also require sound effects – slamming doors, crashing cars, barking dogs – and incidental music, which may consist of music created especially for the production, songs taken from recordings, or both. With the ScoreFitter tool, you can even create a full-length musical background track at the press of a button. Voice-overs and other types of customized audio are also often needed.

This section contains the following topics:
• Audio features of Pinnacle Studio
• Editing audio
• Channel mixer
• Audio Corrections
• Audio effects
• Audio on the timeline
• Timeline audio functions
• ScoreFitter background music
• The Voice-over tool
• Using Audio Ducking to automatically adjust volume

Audio features of Pinnacle Studio

On the timeline of your movie or disc project, audio clips behave very similarly to clips of other types, but the timeline also has some features just for audio.

In this group of timeline toolbar buttons, the highlighted buttons are audio-related: Audio Mixer, Create Song, Voice Over, and Audio Ducking.
At the right-hand end of the toolbar, this button activates audio scrubbing.

For instance, the timeline toolbar includes a button for a pop-up audio mixer that lets you control clip dynamics with keyframes. One button lets you create a ScoreFitter background music clip; another lets you record a voice-over, and another lets you apply audio ducking. Further along on the toolbar is a toggle button for audio scrubbing; which allows you to monitor audio in brief snatches as you drag the scrubber along the timeline.

The Library

Audio and music clips enter your productions via the Library, which handles audio files in wav, mp3 and other standard formats. When you want to add audio files to your production, you can do so by dragging the desired asset from the Library Browser directly onto the timeline of your project.

Audio corrections

When you select an audio clip in the timeline and open the Editor panel > Corrections, you can apply various repairs and customizations, including noise reduction, compression and equalization. Unlike effects (discussed next), these tools can also be applied to audio assets in the Library. When you later use the asset in a project, the corrections will come with it; you can modify them further from the timeline if you choose. Corrections are non-destructive, meaning that the corrected audio file is not modified in any way.

Audio effects

When you select an audio clip in the timeline and open the Editor panel > Effect, you’ll find a number of ways of enhancing, transforming or having fun with sound clips. Unlike the correction tools just discussed, effects can’t be applied directly to Library assets, but only within a project. The effects come with preset parameter combinations that you can further edit according to your needs.

Editing audio

The audio editing features in the Editor panel provide tools for previewing, analyzing and manipulating digital audio from wav, mp3 and other file types. This includes special features for the original or synchronous audio track created during video recording.
The audio features (Corrections > Noise Reduction selected) in the Editor panel.

The Editor panel provides tools for different purposes, including Channel Mixer, Corrections, and Effect. Corrections are available both for Library assets and for clips on your timeline of your movie or disc project. Effects are available for timeline clips only.

**Synchronous video**

If synchronous video exists for the currently-selected audio (for example, if you used Detach Audio in the timeline context menu to create an audio track from the a video clip), the video displays in the Player panel while you review and edit the audio in the Editor panel.

**Channel mixer**

The channel mixer allows you to make level adjustments and redirect audio signals from their original channel assignments to new ones. For instance, you can use the mixer to condense separate stereo channels to a left or right mono channel.

If you need functions the channel mixer does not provide, consider applying the Channel Tool effect to the clip. See “Audio effects” on page 184 for information about the Channel Tool.

**Level adjustment:** Click on the slider under the level meters to set the playback level of the clip. The level you set will be used whenever this clip is played or used in a timeline. The red area on the meters represents overmodulation of the sound and should be avoided if possible. To determine the maximum level you can safely use, click the Normalize button [ ].

**Stereo:** This dropdown list contains all options for redirecting audio signals, such as a channel exchange (left interchanges with right, for example), or combining a two-channel stereo signal onto one mono channel.
The Stereo drop-down menu with the channel routing options.

**Normalize button**: The normalize button examines the audio samples in the loaded sound to determine the amount of uniform increase that can be applied without overmodulation (harsh digital clipping) of any sample. Unlike compression and limiting, which modify the dynamics of audio material, normalization preserves dynamics by uniformly increasing (or decreasing) amplitude.

**Waveform graph and frequency spectrum**

The waveform graph of the audio shows statically how the amplitude of the sound changes with time.

*The waveform graph shows the change in audio levels over time. For stereo recordings, the graph is horizontally divided as shown here, with the left channel uppermost.*

An alternative, dynamic view of the same audio material is given by the frequency spectrum display, which shows the changing spectral composition of the sound as it plays back.

*The frequency spectrum breaks down the audio signals by frequency bands, showing the sound level in each band. Lower frequencies are on the left. Peak levels are shown as a small box above each main bar for which a peak has been detected in the past few seconds.*
Audio Corrections

The correction features in the Editor panel are Equalize, Adjustments, Compressor, Expander, De-esser and Noise Reduction. Corrections can be applied both to Library assets and to timeline clips. Many controls for Corrections are shared between different features.

Equalize

Equalizers are similar in principle to the treble and bass controls of an audio system, but with finer adjustment capabilities. This equalizer divides the audio spectrum into five frequency bands, each centered on a specified frequency and with a settable amount of gain.

The controls for the Equalize correction feature. The dials let you set Gain and Frequency and the HiCut and LoCut settings.

Select preset: A number of fixed presets can be selected from the dropdown list; for example, you can select a ‘telephone voice’ effect.

Gain: Using the Gain parameter, you can determine the amount that the respective frequency band contributes to the overall sound (from -18 to +18).

Frequency: Using the Frequency parameter you can specify the center frequency of each band.

LoCut and HiCut: These controllers completely eliminate frequencies below or above a set value. The default values allow all frequencies.

Adjustments

The only parameter available under the Adjustment tool the is LFE (Subwoofer), which lets you either activate or deactivate the Subwoofer channel for a particular clip, or to stay with the Library’s setting, determined on import.
Compressor

A compressor smooths the dynamics instant by instant in an audio signal, scaling back the loud sections while typically boosting the overall sound. This gives the impression of a stronger signal, even though the level peaks are not higher after compression than before. Light compression is very commonly applied in audio mastering of music tracks. Compression can also be used creatively in numerous ways depending on the material.

Select preset: Choose from a number of premade parameter sets for the compression filter.

Ratio: This control sets the compression ratio, which is the amount of compression applied to sections of the input signal that exceed the Threshold setting. For example, a 2:1 compression ratio means that a 2 dB increase of source level above the threshold produces only a 1 db increase in the output level. The allowed range is from 1:1 (no compression) up to 100:1 (hard limiting).

Threshold: All levels above this setting are attenuated by the value set in Ratio. You can apply an overall boost with the Gain controller to compensate for the level lost.

Attack and Release: Attack governs how quickly the compressor responds to an audio signal that has crossed the threshold. Larger values delay the onset of compression, allowing (for example) the brief attack of a piano note to remain distinct, while applying compression as usual for sustained sounds. Release controls the speed with which compression is switched off when the signal falls back below the threshold.

Gain: It is best to make adjustments to the gain after it has already been compressed.

Knee: A higher knee value causes compression to take hold gradually as the threshold sound level is approached and departed from, rather than switching on all at once. This changes the tonal qualities of the compressed sound.

Expander

The Expander decreases the gain of signals that fall below a chosen threshold. Expanders provide a gentler way of reducing noisy low-level signals than the abrupt cut-off of a gate.

Select preset: Choose from a number of premade parameter sets.

Ratio, Threshold, Attack, Release: These parameters have the same meanings as in the Compressor (see above).

Range: This controls the maximum gain reduction (attenuation).

Hold: This determines how long the expander remains active after the initial attack. Increasing this value is useful when, between louder signals, there are small pauses or much quieter passages that should not be amplified. In this use, the expander works like a noise gate.
De-esser

This audio filter inconspicuously removes distracting sibilance from recorded speech. The available parameters allow individualized fine adjustment of the effect.

**Select preset:** Choose from a number of premade parameter sets.

**Frequency:** This knob sets the frequency above which the De-esser is deployed.

**Range:** This knob controls the maximum attenuation that will be applied to the detected sibilance.

![De-esser settings](image)

*Setting and presets for the De-esser and Noise Reduction audio corrections.*

Noise reduction

Using the noise reduction filter you can reduce or eliminate undesirable background noise. The filter reacts dynamically to changing amounts and kinds of noise within the material.

Noise reduction can be applied for a range of problems. The results obtained may differ, however, depending on the source material and the origin of the problem. In many cases the results can be optimized through targeted use of the Level and Fine Tuning parameters.

Since a new setting may take a few seconds to go into effect, make changes slowly and in small steps, carefully auditioning each change.

**Select preset:** Choose from a number of premade parameter sets.

**Level:** Outdoor video recordings in which the subjects are far from the microphone frequently suffer from excess background noise. It may even be enough to obscure sounds of interest, such as the subjects’ voices. Under the same conditions, the operating noise of the camcorder itself, or the words of its operator, may be amplified to an off-putting degree. Experiment with the Noise reduction level until the best possible results for the source material have been achieved.

**AutoAdapt:** While this option is active, Noise reduction automatically and dynamically adapts to the type and amount of noise in the material. The **Fine tuning** option is ignored while **AutoAdapt** is selected.
**Fine tuning:** This controls the amount of correction. Its effect is only significant when lower Level settings are used, and it has no effect at all when **AutoAdapt** is active.

**Remove wind:** Select this check box to activate a filter that reduces wind and similar background noises in the current audio.

---

**Audio effects**

Audio effects are found in the **Library** panel under the **Effects > Audio effects**. One way to add an effect to your project is to drag it from the Library onto any audio clip (including video clips with synchronous audio) in the timeline. Another way is to select a timeline clip and in the **Editor** panel, choose **Effect > Add-ons > Audio effects**, and click an effect on the thumbnail bar.

![Audio effects in the Library.](image)

The overall interface for audio effects is exactly the same as that for video effects. The common features are not covered here. (See “Effects” on page 113.) A few audio effects, such as the Equalizer and the De-esser, double as correction tools. These are covered under “Audio Corrections” on page 181. Let’s now take a look at the other audio effects.

**Channel tool:** The basic action of this effect is to route your stereo audio signal. It allows you to connect either or both of the left and right input channels to either or both of the output channels. In addition, channel tool offers special-purpose presets, including phase reverse and voice removal – the ‘karaoke’ effect.

**Chorus:** The Chorus effect creates a richer sound by repeatedly reintroducing ‘echoes’ into the audio stream. By controlling properties such as the frequency with which the echoes recur, and the decay in volume from one repetition to the next, a variety of results is possible, including flanger-like sounds and other special effects.

**Equalizer:** Similar to the **Equalize** correction filter, **Equalizer** lets you set the **Gain** (represented as a dial) for a given frequency range (start of range is represented by the}
number to the left of the dial). For more information about equalizing audio, see “Equalize” on page 181.

**Grungelizer:** The Grungelizer adds noise and static to your recordings. It can make your clips sound as though you were hearing them on a radio with bad reception or a worn and scratched vinyl record.

**Leveler:** This effect helps compensate for a common problem in recording audio for video productions: the imbalance in the recorded volume of different elements in the original audio. For instance, your commentary as you shoot the video may be recorded at such a high level that it overpowers other sounds at the location.

The trick in using the Leveler is to find a target volume somewhere between that of the loud and soft audio in the original clip. Below that volume, Leveler increases the original level by a fixed ratio. Above the target volume, Leveler acts as a compressor, reducing the original level. With careful adjustment of the parameters, the internal balance of the audio can be significantly improved.

**Reverb:** The Reverb effect simulates the effect of playing back the source sound in a room of a given size and sound reflectivity. The interval between the arrival of the original sound at the listener’s ears and the first echoes is greater for a large room than a small one. The rate at which the echoes die away depends on both the room size and the reflectivity of the walls.

The presets for Reverb are named for the type of room they simulate, from the passenger cabin of a car all the way up to a huge underground cavern.

**Stereo echo:** This effect allows you to set separate delays on each of the left and right channels, with feedback and balance controls to provide a variety of interesting sounds.

**Stereo spread:** This effect allows you to decrease or increase the apparent width of the stereo listening field in an audio clip. Most often it is used to create a mix that sounds more open and spacious.

---

### Audio on the timeline

When you click the Audio Mixer button on the timeline toolbar, you can access the audio levels and stereo or surround positioning of individual clips, and edit levels on the tracks using audio keyframing. The Master Volume for all timeline audio appears at the bottom of the timeline header area.

### Surround sound

The Panner tool is fully surround-capable. For maximum flexibility, you can position any clip’s audio as desired in a two-dimensional listening field – from front to rear as well as left to right.
You can open the Panner popup by clicking the Panner tool button on audio track when Audio Mixer mode is active.

If you mix the audio for every clip as though for surround playback, you can still output a movie file with a stereo soundtrack using just the left-right balance information. If you further decide to output your project on DVD, the 5.1 surround-sound production will already be complete. For more information about the Panner tool, see “The Panner” on page 187.

**Timeline audio functions**

Along with the track management functions, the header area of the timeline is also home to a number of audio controls.

**Master playback level**

Below the timeline track headers is a master playback level indicator. As you preview your project, it shows the total output from all tracks as currently mixed.

![Master playback level](image)

*Below the timeline track headers is a master playback level indicator.*

**Audio mixer mode**

**Track level:** The upper slider sets the output level of the track as a whole. You can restore the default value by double-clicking the slider—no overall change is applied to the original volume of the clips on the track.

**Clip level:** The lower slider sets the level of the current clip at the scrubber position. If no clip is currently selected on the track, this slider is unavailable. The volume contour of a clip can be controlled with keyframes, as discussed immediately below. When keyframing is in use, the slider level causes new keyframes to be created or existing ones to be repositioned.
Click the diamond icon for the audio track to activate audio keyframing.

The Panner

This tool lets you regulate the apparent location of the sound source in relation to a listener within a ‘surround’ listening field. Like the clip volume tool it works with keyframes assigned to the clip, and so is active only when the timeline scrubber is positioned on an audio clip or a video clip with synchronous audio. The contour line for panning changes is drawn in blue.

For the purposes of timeline editing, all panning occurs in surround mode, so you only have to deal with a single version of the Panner controls. The surround-panned clips can be mixed down to other output configurations after editing of the project has been completed. This lets you work with a single set of panning decisions for all formats you might eventually produce.

Changes made with this tool apply to the current clip only. They stay with the clip even if you move or copy it to another track.

To open the Panner, click grid icon in the track header when Audio Mixer mode is active. This button is grayed if there is no clip on the track at the scrubber position. The sound source is denoted by a blue spot on a two-dimensional grid. The listener is situated in the center, facing forward.
Positioning the clip audio using the Panner in Dialog Mode. Note that the icons for the front corner speakers are translucent, indicating that they are not used in this mode. As adjusted here, the audio for the track will be heard coming from the right.

**Selection list**

The dropdown list at the top of the Panner window provides three methods for distributing the sound across the set of six surround speakers.

**5.1** is the best general purpose setting for natural sound reproduction. Use it for general atmospheric sounds, such as barking dogs, or cars passing by. The five main speakers are represented by icons in the work area. The sixth, the LFE (low-frequency effects) speaker, is too low-pitched to provide positional cues. Its level in the surround mix is controlled by a slider beneath the work area.

**Center channel off** is the preferred setting for an immersive music track.

**Dialog mode** combines the center speaker with the two at the rear. This combination is suitable for dialog involving multiple speakers.

**Panner work area**

The main body of the Panner window schematically depicts a listening area with a typical arrangement of loudspeakers. The cross icon in the center of the area indicates the position of the listener.

A blue control point sets the position of the sound source. The speaker symbols at the edge of the work area show your typical surround 5.1 speaker arrangement, with the screen at the top.

If you want to control the sound source position in one dimension, horizontal or vertical, use the slider at the bottom or right of the work area respectively.

**LFE channel:** Surround supports a special subwoofer channel (the ‘.1’ in ‘5.1’) that allows you to boost or cut the lowest frequencies for special effects. Control the LFE enhancement with
the slider under the work area. Since the ear is unable to pinpoint the location of these low-frequency sounds, the LFE is not assigned to a spatial position.

**Keyframe buttons:** The keyframe buttons at the bottom of the panel allow you to add, remove and navigate between keyframes. The Add symbol automatically switches to Delete if you are positioned on an existing keyframe’s position.

---

**ScoreFitter background music**

Pinnacle Studio’s ScoreFitter automatically creates background music in the category of your choice. Within that category, you select one of several songs, and within that song, any of a number of versions. The list of versions available also depends on the duration of background music you specify.

*The ScoreFitter window. Select a Category, Song, and Version, then click the Add To Movie button.*

To create music for a particular set of clips, select those clips before clicking the **Create song** button to open ScoreFitter. (To select your whole movie, use **Edit > Select All** or press **Ctrl+A**.) The total length of the selected clips will determine the initial setting for the music duration, but you can modify the value at any time by trimming the clip on the timeline or by editing the Duration counter in the tool.

In ScoreFitter, choose a category, song and version from the lists provided. Each category offers its own selection of songs, and each song its own selection of versions. Use the Preview button to audition the song while the tool is open.

Enter a name for the clip in the Name field and adjust its duration with the Duration counter, if desired. The music clip you create will be adjusted to fit exactly the duration you select.

When you have made your choice, click the Add to Movie button. Studio creates the new clip on the active track beginning at the current time index (as shown by the timeline scrubber and the preview frame in the Player).
**The Voice-over tool**

Recording a voice-over in Studio is as easy as making a telephone call. Just open the Voice-over tool, click Record and speak into a microphone attached to your computer.

You can narrate as you watch the movie play so that your words match the action on the screen. You can also use the tool as a quick way of capturing ambient music or home-made sound effects via your microphone.

Before you can record audio using the Voice-over tool, you will need to connect a microphone to the input jack of your PC sound board. Review the video scenes in your movie and decide where you want the voice-over to begin and end. When you are ready, open the Voice-over tool.

Select your starting point on the timeline of your project. You can do this by selecting a clip, playing the movie and stopping it at the desired point, or by dragging the timeline scrubber.

Position the microphone for use and try speaking a test phrase to check your recording level (see “Voice-over level” below). When you are satisfied, click the Rec button (which toggles to a Stop button during recording).

A three-second countdown is displayed, then your movie begins to run in the Player. Perform your narration, and click the Stop button when done.

Now you will be asked if you want to keep the recording. If you answer in the affirmative, the voice-over clip will be added to your Library and will also be placed automatically on the voice-over track on the timeline.

*The Voice-over tool, ready to go. Just click the Rec button, count to three along with the software, then start talking.*

**Additional controls**

**Voice-over level:** As you record, watch the peak level meter display to make sure that your microphone is generating a strong signal but not overmodulating. Watch this meter to make sure your recording levels get neither too high nor too low. The indicator changes color from green (0-70% modulation), through yellow, to red.
Filename: With this text field you can preset the file name used for voice-over audio files. The first file is given the name you specify; if you leave it unchanged, later files are given a numeric suffix – e.g. 'Voice-over (1)' – that increases with each take.

Location: Clicking on the folder icon lets you navigate to a new file system folder for storing voice-over clips.

Adjust the recording level slider as necessary to stay in the right range. The slider is located immediately below the peak meter. Generally, you should try to keep your audio peaking in the yellow (71-90%) and out of the red (91-100%).

Mute all audio: The existing sounds on your movie soundtrack are sometimes distracting when you are trying to record a voice-over. This check box allows you to switch off timeline audio completely during recording.

Using Audio Ducking to automatically adjust volume

Audio ducking is used to automatically lower the volume of one track so that you can hear another track better. For example, if you have a video project that includes music and voiceover, you can use audio ducking to automatically decrease the music volume when the narrator is speaking. You can adjust the threshold that triggers “ducking” and you can adjust by how much the volume of the background track will drop.

To apply Audio Ducking

1  In the Timeline, select the track that you want to “duck” (to selectively lower the audio level), and click the Audio Ducking button on the toolbar.
2  In the Audio Ducking dialog box, choose the main track that you want to hear from the Master Track box.
3  Adjust the following controls:
• **Ducking Level** — determines the volume decrease. Higher numbers result in a lower volume.

• **Threshold** — determines the master track volume level that will trigger a volume decrease for the other track(s). You will likely need to experiment with different settings to achieve the results you want.

• **Attack** — determines the time it takes to lower the volume to the **Ducking Level** setting after the **Threshold** is met.

• **Decay** — determines the time it takes to return to the regular clip volume from the **Ducking Level**

If you want to apply ducking to all non-Master audio tracks, enable the **Apply to entire Timeline** option. If you want to apply ducking to the selected track only, enable **Apply to selected clips**.

In this example, the top track is a voiceover track that was set as the Master Track. Ducking was applied to the music track on the bottom to selectively lower the music volume whenever the narrator was speaking on the voiceover track, as indicated by the blue waveform. The green line represents the volume level and shows where the volume changes occur.

### To remove Audio Ducking

• In the Timeline, right-click a track that has **Audio Ducking** applied, and choose **Remove Ducking**.
Disc projects

In a disc project, you can go beyond the old idea of creating a movie to be viewed in strict sequence from beginning to end. Now the audience themselves can decide which parts of the production to view, and in what order.

Disc authoring is the process of designing and creating the structure that allows this interaction. Pinnacle Studio provides automated features that make authoring easy while still giving you full control.

This section contains the following topics:
• MyDVD disc projects
• Author tab (legacy)
• Menu templates (legacy Author tab)
• Disc menus (legacy Author tab)
• Adding disc menus (legacy Author tab)
• Previewing disc menus (legacy Author tab)
• Menu editing on the timeline
• Timeline menu markers (legacy Author tab)
• Authoring tools (legacy Author tab)
• The Chapter Wizard (legacy Author tab)
• The Menu Editor (legacy Author tab)
• Menu buttons (legacy Author tab)
• The Disc Simulator (legacy Author tab)

MyDVD disc projects

You can output your Pinnacle Studio projects to disc by exporting to MyDVD. MyDVD is an easy disc authoring application that uses templates to help you create professional-looking disc projects that include menus, and music. For more information, see “Output to MyDVD” on page 241.

You can add chapter markers in Pinnacle Studio that will appear in your MyDVD project.
To create a disc project

1 Do one of the following:
   • Choose File > New > Disc to start a new disc project.
   • For an existing movie project, with the project open in the timeline, on the timeline toolbar, click the Open Author toolbar button.

2 Build your disc project using the same controls and techniques that you would for a movie project.

3 Click the Export to MyDVD button below the timeline toolbar to export your disc project.

To add chapter markers to a disc project

1 Ensure that your project is open in the Timeline and that the Open Author toolbar button is enabled.

2 Use the scrubber to move the to the frame where you want to add a chapter a marker.

3 On the timeline toolbar, click the Create Chapter Marker button.
   A marker appears in the bar below the timeline toolbar, above the timeline scrubber.

   ![Chapter Marker](image)

   If you want to rename the chapter, type a new name in the chapter box on the timeline toolbar.

   ![Chapter Name](image)

   If you want to delete a chapter marker, navigate to the marker using the arrow keys beside the chapter name, and click the Remove Chapter Marker button.

Author tab (legacy)

Although it is recommended that you export your disc projects to MyDVD, if you have used the Author tab in previous versions of Pinnacle Studio and want to re-enable this legacy feature, choose Setup > Control Panel > Legacy Options. At the bottom of the page, click the Enable button for the Legacy Authoring Mode.
Menu templates (legacy Author tab)

You can choose menu templates from the Library panel (only in the Author tab), by choosing the Disc Menus category from the Library navigation bar. You can preview menus and other media in the Player panel and edit menu interactions.

Next below these is the timeline toolbar, with all the controls from the Edit tab timeline, plus the additional controls necessary for creating disc menus. The area below the timeline toolbar is shared by three separate navigation tools: the Menu List, where the your project’s menus are stored, the Navigator, and the Storyboard.

Only one of the Navigator, the Storyboard, and the Menu List can be visible, or this area can be hidden altogether. The Navigation tool selector, near the left end of the timeline toolbar, controls this area. Under the navigation area is the timeline for the media that will be the primary content of your disc. All use the full width of the window.

Disc menus (legacy Author tab)

The essential feature that makes disc authoring possible is the menu. A particular disc may have one, a few or many menus, each consisting of a still image or a short video loop. Areas within the menus, called buttons, can be selected by the viewer to activate other content on the disc.

Some buttons cause playback to resume from specified locations, called chapters, on the timeline of your production. These chapter buttons often show a thumbnail frame or video.
loop as a clue to their content. If a return marker is encountered during playback, it will send the viewer back to the menu at that point.

Other buttons cause a transfer to another menu, or to another page of the same menu. Multipage menus, with each page displaying several chapter buttons along with automatically-managed navigation buttons, facilitate productions of almost any size. However, there is a limit of 99 on the total number of chapters and return markers allowed in a single production.

The Menu List

Unlike timeline clips, the menus in your production are not bound to a particular time offset. Instead, a disc player will loop the menu until user interaction is received.

Because menus exist ‘outside of time’, Pinnacle Studio provides the Menu List, a special area above the Disc Editor timeline to accommodate the menus in your project. Dragging a menu from the Library into the Menu List makes it available for use in your project.

Designing menu interactivity

A disc production may contain just one menu, or it may have many. Each menu contains graphically distinct areas, generically called ‘buttons’, that can be activated by the viewer, perhaps using the navigation keys on a DVD remote control.

The behavior of disc menu buttons can be set up using controls in the Disc Editor window. Alternatively, you can invoke the Chapter Wizard to create and configure a set of buttons automatically according to your chosen settings.

Activating a button either starts your movie playing back from a chosen point, or transfers control to another menu with its own buttons. The possible targets for menu buttons are:

- **A timeline location**: Upon activation, playback resumes from a chosen frame. The location, and the content found there, are referred to as a ‘chapter’ of your movie.
- **Another menu**: Buttons can link to any menu in the Menu List.
- **Another page of the same menu**: Multipage menus always include next and previous buttons for navigating between their pages.

Automatic page creation

As you insert new chapter links into a multipage menu, additional pages are created automatically as needed. These appear in the Menu List alongside those already in the project. A connector graphic links pages belonging to the same menu. To insert new linked chapters, use either the Insert Link button on the toolbar, or the Chapter Wizard.
Next and Previous: It is the presence of the special next and previous buttons that causes a menu to support the multipage behavior. To create a multipage menu from an existing main menu, simply add buttons of both these types. Likewise, deleting either or both of the next and previous buttons from a multipage menu removes the automatic features.

Multipage menus in the Menu List

The icons of multipage menus are connected in the Menu List by a special graphic. It shows that the menus are linked, which is to say that you can navigate from one page within the menu to another by means of the next and previous buttons.

Splitting and joining: To unlink neighboring menu pages from each other, click the connector graphic between them. The graphic is removed. Pages to the left of the mouse remain with the original menu, while those to the right form a new, separate menu (with a new background color for its menu icons). Click in the gap between neighboring multipage menus to regroup them into a single menu.

Sorting chapters: A time-saving tool meant primarily for multipage menus is the sort button that appears with the Chapter Wizard button to the right of the menu’s last page. When you have been working on a menu for a while – adding, deleting and rearranging chapters, perhaps even while editing the movie itself in parallel – you are likely to find that the chapter buttons are no longer in timeline order across the set of pages. Unless you want a custom order for some reason, the remedy is a single click on the sort button.
Adding disc menus (legacy Author tab)

The disc menus section of the Library contains a collection of menus for a variety of occasions and in a spectrum of visual styles. Each menu comprises a background picture, a text title, and a set of navigation buttons appropriate to the menu’s purpose.

To add a disc menu to your production, in the Library, choose the Disc Menus category, and drag a menu to the Menu List. To edit the actions assigned to the menu’s buttons, you can use the authoring tools provided on the timeline in conjunction with the Player, or get some automated help from the Chapter Wizard. To modify the appearance of a menu (or create one from scratch) you will use the Menu Editor.

Menu types

Each menu design in the Library has two variations: main and multipage.

Main menu: In most productions, the first menu seen by the viewer is of this type. Main menus usually contain buttons with the default captions Play Movie and Scene Selection; you can change these if you like. Although the buttons’ link targets are also up to you, it helps your audience if you stick to convention. For instance, the Play Movie button is normally configured to start playing back your movie from the beginning, and Scene Selection typically switches to a subsidiary menu, one with links to the ‘chapters’ of your movie.

Multipage menu: A scene selection menu often needs to provide more of these chapter buttons than will fit on a single screen. To solve this problem, Pinnacle Studio supports multipage menus, which have additional buttons just for navigation between menus. The behavior of these buttons is built in. A pair of next and previous buttons lets the view move between pages within the same menu; while a home button causes a transfer to the project’s first menu.

Tip: To display the main menus side-by-side with their matching multi-page menus in the Library, right-click in the gray area next to a menu and choose Sort by > Name.

Menu buttons

The number of chapter buttons per page varies from one menu design to another, so one criterion for selecting a menu is the number of clips you want it to handle. But if you want a different number of buttons on a particular menu, you can add or delete buttons in the Menu Editor, which is launched by clicking the Edit button on the Player. See “The Menu Editor (legacy Author tab)” on page 205 for details.

Menus with fewer buttons usually have more space for captions; those with many buttons will have to settle for abbreviated captions or none at all. Whether you need captions, and if
so whether they should be simple (“Chapter 1”) or descriptive (“Cutting the Cake”) is a matter of your authoring style and the content of your movie.

**Unlinked menus and buttons**

Only the first menu in the Menu List is automatically available to the user (and then only if there is any content on the timeline to serve as the initial chapter). Menus added later do not become part of your production’s menuing system until you link them with the first menu. The link may be indirect, involving one or more intermediate menus, but until it exists the menu is an unreachable island. Such a menu is indicated by the symbol \( \square \) in the bottom right-hand corner of its Menu List icon thumbnail.

A special indication is also given in the Player for menu buttons that have not yet been linked either to a timeline location (a chapter) or to another menu. A linked button shows which chapter (e.g. ‘C1’) or menu (e.g. ‘M1’) it connects to. An unlinked one shows a question-mark icon instead. (If the button indicators are not visible, click the show/hide chapter numbers check box below the Player.)

**Previewing disc menus (legacy Author tab)**

The Disc Editor, like the Movie Editor, includes a Player for previewing Library assets and timeline clips. For a general introduction to the Player, please see “Previewing edits in the Player” on page 43.

The special functions provided by the Player when viewing menus in the Menu List are described here. Clicking a menu in the Menu List puts the Player into Menu input mode and previews the selected menu. You can also switch to that mode directly while any menu is selected by clicking the Menu tab above the Player screen in the Disc Editor.

Special controls also appear at the bottom of the Disc Editor Player.

- **Menu Edit** button: Creating or modifying the design and layout of disc menus is the task of the Menu Editor.
With Menu selected as the Player input mode (top), the Player provides interactive zones on the preview screen for assigning chapter links. Here ‘C1’ shows a chapter link has been assigned to the Play Movie button; the ‘?’ over the Scene Selection button shows that it is not currently assigned.

**Show Link Numbers checkbox**: Check this box to cause link numbers to be displayed in the preview over every button in the menu. The link numbers match the format and color of the timeline chapter flags.

**Disc Simulator button**: This button invokes the Disc Simulator window where you can preview your project with full interactivity to make sure your menus are behaving as expected.

**Burn Disc button**: When you are ready to test your project on an actual disc, click this button (or Export at the top of the screen) to invoke the Exporter, which will guide you through the process of ‘burning’ your movie onto an optical disc.

### Link indicators

As seen in the illustration above, when a menu with unlinked chapter buttons is previewed, those buttons are indicated by red question marks rather than a chapter number. Except perhaps for an unused subset on the final page of a multipage menu, all the chapter buttons on your menus should link to your movie.

### Menu editing on the timeline

Developing a project for optical disc, such as DVD, in Pinnacle Studio’s Disc Editor gives you lots of opportunities for putting your creative stamp on the production.

Every aspect of a disc menu – the details of its visual appearance, the linking of its on-screen buttons, the precise timing of its ‘chapters’ – can be edited in Pinnacle Studio. For the visual
aspects, you will turn to the Menu Editor, but the linking of buttons and the timing of chapters are both controlled within the Disc Editor itself.

For an overview of the Disc Editor interface, please see “Disc projects” on page 193.

**Timeline menu markers (legacy Author tab)**

The chapter buttons on a disc menu can be individually linked to any point on your movie’s timeline. In the Disc Editor, those points are indicated on the timeline by chapter markers on the Chapter Track, which is a specialized timeline track that materializes above the other tracks when a first menu is added to your movie. (The track is removed again if all menus are deleted.) The caption of a chapter marker consists of the letter ‘C’ followed by the chapter’s sequence number in its menu.

Return markers, which mark automatic exit points from the timeline back to a disc menu, are also shown in the Chapter Track. The caption of a return marker is the letter ‘M’ with the sequence number of the target menu.

Regardless of the length of your production, you are limited to a combined total of 99 chapter buttons and return markers.

The color of chapter and return markers matches the Menu List icon color of the menu to which the markers are assigned. Markers can be repositioned on the timeline by dragging. See “Timeline editing of chapter and return markers” on page 203 for details.

Dropping a menu onto an empty Menu List causes a chapter marker to be inserted at the start of your movie’s first clip (provided it has one) as the target of the menu’s Play Movie button. A return marker, marking an exit back to the menu, is placed at the end of the movie.

**Authoring tools (legacy Author tab)**

In the Disc Editor, the timeline toolbar provides a number of authoring tools that you can use directly without switching windows or views.

Create link: This button links the currently-selected chapter button in the Player to the location of the timeline scrubber.
**Insert link:** This button facilitates work with multipage menus by moving all existing button links (starting at the currently selected chapter button in the Player) one position towards the end.

In a multipage menu, the act of inserting a link may begin a chain reaction by forcing an existing link onto the next page, a link from there onto the page following, and so on to the final page, which itself will be created if necessary.

**Remove link:** Clicking on this button will remove the link that exists between the button on the menu and the chapter marker on the Chapter Track. An ‘unlinked’ chapter marker will remain on the Chapter Track. This unlinked chapter can be manually linked by drag-and-drop to another button on the Menu Preview, or it may remain as an unlinked chapter, in which case, during playback, it will work to jump through your disc using the jump button on your remote control. You may also right-click on one or more chapter markers and choose Remove Selected Link.

**Button cycle:** By clicking on the left and right arrows of this control, you can scroll through available buttons and make them active for editing. Click on the button caption to edit it. Buttons also may be selected by clicking the button links in the Player when a menu is previewed.

**Set thumbnail:** Clicking this button generates a thumbnail image of the frame at the timeline scrubber position, and displays it on the menu button selected in the button cycle control if it is of the Thumbnail type. For more information about menu button types, please see “Menu buttons (legacy Author tab)” on page 206.

**Create unlinked chapter:** Unless the timeline scrubber is exactly positioned at a chapter or return marker, clicking this button will add a chapter marker to the Chapter Track, but will not link it to any menu. An unlinked chapter can also be created by double-clicking in the Chapter Track area just above the other timeline tracks.

The unlinked chapter can later be manually linked by drag-and-drop to a button on the Menu Preview if that’s what you want. However, an unlinked chapter also serves a useful purpose in its own right: during playback, it designates one of the points to pause at when browsing a DVD with the jump button on the remote control.

**Remove chapter:** When the timeline scrubber is positioned at a chapter, the Create unlinked chapter button takes on the opposite function, and a modified symbol. Clicking on it will remove both the chapter marker and the link that binds it to a menu, if it has one. You can also remove chapters with the Delete Selected Chapter context menu command when one or more chapter markers are selected. To remove the links from chapter markers, leaving them unlinked but still on the Chapter Track, use Remove Selected Links from the same menu.

**Create return:** Unless there is already a marker at the timeline scrubber position, this button will add a return marker to the Chapter Track.
A return marker is active during viewing only if playback commenced from the same menu the marker is associated with. (On the timeline, the marker color should match that of the associated menu’s icon in the Menu List.) When playback reaches the frame associated with an active return marker, it will jump back to the associated menu.

**Delete return:** If there is a return marker at the scrubber position, the Create return button converts to Delete return, with an appropriately changed symbol.

The Remove chapter button, and the Delete selected chapter context menu command, can both also be used to delete return markers.

## Timeline editing of chapter and return markers

Chapter and return markers are tied to particular frames on your timeline at which playback will be launched from a disc menu (chapters) or at which playback again gives way to the originating menu (returns). Both types of marker can be dragged with the mouse to change the location at which they take effect in the movie.

When you are previewing a menu, dragging a chapter marker from the Chapter Track to a button on the Player will relink the button. The reverse operation, dragging a button from the Player to a point on the Chapter Track, is an alternative method of creating a new chapter marker.

A project that contains one or more disc menus must have a return marker permanently positioned at the end of the Chapter Track. This guarantees that any chapter played on the disc will encounter a valid return. The final return marker can thus not be deleted.

### The Chapter Wizard (legacy Author tab)

When a multipage disc menu has been dragged from the Library into the Menu List, a Chapter Wizard button is displayed at the top right corner of the menu icon. Clicking on this button will open the Chapter Wizard window.

**Why use the Chapter Wizard?**

The Chapter Wizard provides a fast way to create chapters for your movie. Chapter markers will be added to the Chapter Track on the Disc Editor timeline to show where each chapter begins. With the Link chapters to menu buttons option (see below), each chapter will be represented by one chapter button on a series of automatically-generated menu pages; these pages are linked into a series by next and previous buttons.
By activating chapter buttons when the menu is viewed, the viewer is able to play the movie from any of the provided starting points.

The Chapter Wizard is great for setting up slide shows and scene selection menus. If you are archiving video to disc, you can use it generate a menu that will serve as a scene catalog. The series of menu pages created can be arbitrarily long. Its length depends on how many chapters are created and on how many chapter buttons are provided in the menu’s page design.

Incidentally, the Chapter Wizard does nothing that you could not do yourself using the available disc authoring tools within the Disc Editor (and they remain available for tweaking the generated menu afterwards). Its purpose is to speed your creative process by taking over much of the routine work that setting up a multipage menu entails.

Using the Chapter Wizard

The Chapter Wizard controls are grouped into three horizontal sections. When you have configured the controls to your satisfaction, click OK. The Chapter Wizard will carry out its work of creating new chapters for your production, complete with markers on the timeline and (by default) an automatically-generated set of menu pages with as many chapter buttons as necessary.

Place chapters at

This is the uppermost panel in the Chapter Wizard. The two options here can be used separately or together.

Optimal positions: When this box is checked, the Chapter Wizard creates chapters at a selected interval along the timeline, but will adjust the chapter to a nearby clip boundary.
when one is available. The desired average chapter length is specified in seconds. The initial value is based on the length of your movie. To adjust it, either click directly on the number and type, or drag horizontally within the text box.

**Timeline markers:** This option assumes that you have prepared timeline markers to indicate to the Chapter Wizard particular places in your movie to which a chapter link must be created.

**Apply to**

The second panel in the Chapter Wizard provides options that control the scope of the wizard’s operation.

**Whole movie:** Chapter markers will be created throughout the entire movie.

**Selection:** Chapter markers will be placed only within the range from the beginning of the first selected clip to the end of the final one.

**Options**

The third panel offers two final choices, which may be set independently.

**Link chapters to menu buttons:** When this option is selected, as many pages will be added to the menu as are needed to accommodate buttons for all of the created chapters. Without this option, the chapter markers are created on the timeline in the ‘unlinked’ state, and no menu pages are created.

If you want to link an unlinked marker to a menu button, drag it to the button while previewing the menu in the Player. Even if you leave it unlinked, the chapter marker will still serve as an available resumption point when the viewer is skipping through the disc with the jump button on the remote control.

**Return after every chapter:** Checking this option will add a return marker at the end of each chapter. By default, the markers are placed so that each chapter will play up to the start of the chapter following, then return to the originating menu. To change the menu that a return marker is linked to, drag the marker to the menu icon in the Menu List. Remember, however, that the return marker will only be active when playback was launched from the menu to which the marker is linked.

---

**The Menu Editor (legacy Author tab)**

The Menu Editor shares most of its controls and usage with the Title Editor (see “The Title Editor” on page 151). The present section focuses on features particular to the Menu Editor.
Starting the editor

To open a menu in the Menu Editor, either click the **Edit** button on the Player while previewing the menu, or double-click it in the Menu List.

As with the Title Editor, when the Menu Editor opens, one line of text is already highlighted. To edit it, just start typing. To start editing a different line, click inside its text box and highlight the characters you want to change. To stop editing text, click on an empty area of the window.

The button cycle

One feature that differs between the Menu Editor and the Title Editor is the button cycle, a control also present in the Disc Editor. In both cases it is located on the right side of the toolbar, just above the timeline. Click the left and right arrows on the control to step through the active buttons in the menu, and make one available for editing.

**Note:** If you only want to edit text for the buttons on your menu, you do not need to enter the Menu Editor at all; instead, edit the button name directly in the button cycle control of the Disc Editor.

Menu buttons (legacy Author tab)

Any visual element of your disc menu can be used as a ‘button’ that links to other content in your movie. Elements designated ‘Not a button’, on the other hand, have no linking behavior.

Button types

A menu button’s type is the only factor that determines its behavior. Its text and appearance should almost always be consistent with that behavior in a well-authored disc production, but they don’t affect it. Five button types are available.

**Normal:** This type of button lets your text, image or shape serve as a link to any chapter marker on your disc project timeline, or to a menu in your Menu List.

**Thumbnail:** This variation on the Normal button type allows a thumbnail from your timeline to be displayed on the button.

**Previous** and **Next:** These button types automatically handle navigation between the pages of multipage menus in the Menu List. During playback, the buttons are hidden automatically when their targets do not exist (on the first and last pages of the multipage set). Because their behavior is fixed, it is not possible to link these buttons to chapter markers.

**Root:** A button of this type links to the first menu in the Menu List. Its behavior cannot be changed.
Buttons for multipage menus

If you add both a Next and a Previous button to any menu, it can serve as a multipage menu. If either button type is absent, the menu cannot be used in the multi-page mode.

Button presets

Click the Buttons tab at the top of the Menu Editor to view the available categories of premade menu buttons. Select a button and it will appear in the middle of the preview area, where it can be dragged to the desired position.

The three categories reflect the button types discussed above. The Navigation category includes all buttons of the Previous, Next and Root types.

General Buttons: These images are intended for use with Normal buttons, which may be linked to any chapter marker on your timeline.

Navigation Buttons: These designs are meant for Next, Previous and Root buttons with hard-wired navigation.

Thumbnail Buttons: These include a thumbnail area where a timeline clip can be previewed.

Button settings

The Button Settings panel is to the right of the Menu Editor preview.

The Button Settings panel is part of the Menu Editor.

The Disc Simulator (legacy Author tab)

To preview your project after setting up its menus, click the play button at the bottom of the Player. This activates the Disc Simulator window.
When the Disc Editor Player is previewing a menu in your project’s Menu List, a button (bottom center) is provided for testing your project in the Disc Simulator.

Provided the project is built correctly, the simulator should open at the main menu, with ‘Play Movie’ and ‘Scene Selection’ links ready for the viewer to use.

To move from link to link within the preview, use the DVD navigation buttons on the bottom right or click the links directly in the preview.

Take the time to verify all the chapter and menu links your production includes. Every desired user interaction should be checked: slip-ups are frustrating for the viewer, and easily avoided.

In the Disc Simulator, you use a control set similar to that found on a DVD remote control. Menu interactions and playback can be fine-tuned and fully tested before you burn the project to disc.

Once you are happy with the project, it can be exported as a movie file, saved to a disc image file, or burned to a disc. See “The Exporter” on page 233 for more information.
Pinnacle Studio lets you incorporate many kinds of media into your video productions. When these are stored externally to your computer – on a camcorder tape, say, or a memory stick from your digital camera, or a cloud-based service – they must be transferred to local storage before you can use them.

The file-based assets you can use in Pinnacle Studio – including video, photographic and audio media, and Pinnacle Studio projects themselves – must be imported from a source such as a local hard drive into the Library before they can be used.

This section contains the following topics:

- Using the Importer
- Import sources
- The Mode area
- Compression settings for Capture Video
- Scene detection settings for Capture Video
- File name for imported files
- Selecting assets for import
- Selecting files for Import
- Customizing the browser
- Scan for assets
- Import from DV or HDV camera (Capture Video)
- Import from analog sources
- Import from DVD or Blu-ray Disc
- Import from digital cameras
- Stop motion
- Snapshot
- MultiCam Capture

**Using the Importer**

The very first step in importing is to open the Studio Importer by clicking the Import button at the top left of the screen.
The Importer consists of a large main area that includes source tabs along the top of the Importer, and a number of smaller areas. Your choice of input source in turn determines the rest of the Importer display. Above all, the set of controls and views offered in the main area for preview, browsing and selecting material depends on the chosen import type.

![Studio Importer](image)

Importing can be regarded as a four-step process:

1. Select the import source from the tabs along the top of the page.
2. Confirm or adjust the import settings.
3. Select material to import from the chosen source.
4. Initiate the import operation.

At this point, Studio begins transferring the requested audio, video and pictorial material from the source device to your hard drive (if necessary), using the locations set in the Import to area. The media are then immediately added to the Library. (See “The Library” on page 13.)

This transfer process is variously called ‘capturing’, ‘importing’ or ‘downloading’, depending on the media involved and the method of transfer. Because most audiovisual recordings now are stored in digital form from the start, transfers can typically be achieved with no loss of quality. Only when transferring from analog or tape-based sources (e.g. VHS, Hi8 or DV tape) is there still a ‘capture’ process, often involving conversion to digital form. The terms ‘import’ and ‘importing’ can be used to signify all methods of bringing images and sound into the Library for use in your productions.
Importing stereoscopic 3D content

Pinnacle Studio will recognize content as stereoscopic 3D and mark it as such for files with the following properties:

- **MTS**: MVC, SBS50, SBS100 (if H264 stream markers are present)
- **WMV**: Multistream, SBS50, SBS100, TAB50, TAB100 (if metadata tags are present)
- **MP4, MOV with H264**: SBS50, SBS100 (if H264 stream markers are present)
- **MPO**: Multistream
- **JPS, PNS**: SBS50, SBS100

If Studio has not correctly identified your 3D media, choose the correct setting from the Stereoscopic 3D dropdown in the Adjustments group of Corrections tools. Please see “Adjustments” on page 110 for details.

Import sources

The actual selection of material to be imported takes place in the main area of the Importer. Each import source uses the main area somewhat differently.

The photos, music and video footage or projects you want to import may reside on a variety of device types and technologies. The supported import sources include:

- All types of auxiliary file-based storage media, including optical drives, memory cards and USB sticks (see “Import from file” on page 217). Click the My computer tab to select individual files for import from drives connected to the computer.
- Click Scan For Assets to import all files of specific types from a set of one or more directories.
- DV or HDV video cameras using an IEEE-1394 (FireWire) connection. See “Import from DV or HDV camera (Capture Video)” on page 221. Devices are listed by name on the Import page by their device names (e.g. “DV Device”). Select the applicable one.
- Analog video cameras and recorders (see “Import from analog sources” on page 224). Any analog capture hardware on your system is listed by name (e.g. “Pinnacle Systems 710-USB”).
- DVD and Blu-ray discs. See “Import from DVD or Blu-ray Disc” on page 225.
- Digital still cameras. See “Import from digital cameras” on page 226.

Some sources are chosen from a sub-list of actual devices that appears when you click the main source entry.
Single-frame import

Studio provides two special modes for importing single frames, rather than continuous footage. These modes are:

- **Stop motion**: Create an animated film by importing one frame at a time from a live video source. See “Stop motion” on page 226.
- **Snapshot**: Import individual images from tape or from a live source like a webcam. See “Snapshot” on page 230.

Adjusting audio and video levels

To access the controls, select the source, then click the more button beside the source name. This opens the Input Levels window.

![Input Levels window](image.png)

*The Input Levels window lets you adjust a number of video and audio parameters. The Hue slider (fourth from left) is not used with PAL sources.*

Although you can also adjust these levels with the appropriate correction from the Edit tab, setting them correctly for capture can save you from having to worry about color correction later on.

Setting your audio options correctly as you capture will help in achieving consistent volume levels and quality.

Particular capture devices may offer fewer options than are shown and discussed here. For instance, with hardware that doesn’t support stereo captures, an audio balance control will not appear.

**Video**: Choose the type of video you are going to digitize by clicking the appropriate source button (Composite or SVideo). The five sliders allow you to control the brightness (video gain), contrast (ratio of lightest to darkest), sharpness, hue and color saturation of the incoming video.
• The hue slider can be useful for correcting unwanted color shifts in NTSC material; it is not available when capturing from a PAL source.
• The saturation slider regulates the ‘color saturation’ – the amount of color – in the image. (An image with zero saturation has only black, white and gray tones.)

**Audio:** The sliders on the right side of the panel let you control the input level and stereo balance of the incoming audio.

### Working with import folders and subfolders

Until you specify otherwise, the Importer uses the standard document folders for video, music and pictures within your Windows user account, and a default folder for your Pinnacle Studio projects.

The folders you choose for each asset type, whether default or custom, serve as base locations for your imported files. In order to manage your file-based assets effectively, you can also specify either a custom subfolder name or a method of automatically-generating a name based on either the current date or the creation date of the imported material.

For example, if you set your main video folder to “c:\vid”, and your subfolder naming method to “Current month”, any video you import will be transferred to a folder with a name like “c:\vid\2017-10”.

**Fill-level indicator:** This bar graph shows for each import destination how much room is left on the storage device. The first part of the bar represents space already occupied on the device. The colored extension shows how much room will be required by any currently-selected media files or project files awaiting import.

**Note:** If a destination device reaches 98 per cent full during import, the operation is halted at that point.

### To select an import folder and subfolder

1. From the **Import** tab window, in the **Save to** area, click the folder icon beside the **Save to** box.
2. In the **Choose folder** window, navigate to the folder you want, and click **OK**.
3. In the **Subfolder box**, choose one of the following options:
   - **No subfolder:** With this option, the files you import will be stored in the base folder.
   - **Custom:** When you choose this option, an in-place edit box appears. Enter the name of the subfolder in which to store your next import or imports of the asset type.
   - **Today:** Your imports will go to a subfolder named with the current date, in the format “2017-10-25”.
• **Creation date**: Each imported file will be stored in a subfolder named with the creation date of the asset, in the same format as above. When multiple assets are brought in as part of a single import operation, this may entail creating or updating multiple subfolders.

• **Current month**: This is the same as the Today option but without the day portion, e.g. “2017-10”.

**Note**: If you want to reset your folder and subfolder to the default settings, click the **Reset to Default** button.

## The Mode area

The Mode area of the Importer provides a place to adjust the options offered by several import sources.

### DV / HDV import options

The options for DV and HDV import are in three groups.

**Presets**: The Presets group offers two standard configurations for video and audio compression, and a custom setting that lets you fine-tune compression parameters. For more information, see “Compression settings for Capture Video” on page 215.

The fixed presets are:

• **DV**: This provides full-quality DV capture, using about 200 MB of disk space per minute of video.

• **MPEG**: MPEG compression produces smaller files than does DV, but requires more computational horsepower to encode and decode. This could result in slower performance on older computers.

**Scene detection**: When the scene detection feature is enabled, your footage is divided up on import into ‘scenes’ that can be displayed and manipulated separately in the Library. This greatly simplifies the task of locating material of interest during editing. For more information, see “Scene detection settings for Capture Video” on page 216.

**Stop at tape end**: This option tells Pinnacle Studio whether to automatically stop capturing if a blank area of tape is encountered. A blank area – one without timecode striping – indicates virgin tape. Provided you have avoided leaving any blank spots during shooting (by slightly overlapping neighboring shots), this option allows for unattended capture.

### Import options for analog media

The options for analog import are similar to those just discussed for digital sources.
Import options for file-based assets

Import Mode: This option determines whether the media file or project file is physically copied from the source location to the target folder of the local hard drive (as specified on the Import to area.) If Copy is selected, the file is copied. If Link is selected, the file is not copied and a link is created in the Library to the file in its original location.

It is strongly recommended that files on network drives be copied to the local hard drive.

Delete original: When this option is enabled, the original copies of the files you import will be deleted after copying. This option is handy if you are using the Importer to consolidate your assets and don’t want your hard drive cluttered with redundant copies.

Ignore duplicates: This option helps you deal with redundant media files or project files you already have, by telling the Importer not to import extra copies of files that may be differently-named but are apparently identical.

Import options for stop-motion capture

In stop-motion animation, a series of individual frames is captured from a live video source. Depending on your plans for the stop-motion sequence, you can instruct the Importer to integrate the individual frames into a movie (Stop Motion Project), or simply import each frame as a picture (Photo), or both.

Compression settings for Capture Video

The options provided for both DV / HDV and analog import include compression preferences. If you select either of the DV and MPEG presets, you can review the actual settings used. Editing the settings here automatically selects the “Custom” preset.

Because some options are contingent on others, not all will be visible simultaneously.

To choose Capture Video compression settings

1. From the Import tab, click Capture Video.
2. In the Settings area, choose an option from the Presets.
3. Click the arrow to the left of Presets to expand the settings area.
4. Choose any of the following Video Settings:
   • Compression Codec: Use this dropdown list to select the codec you want to use.
   • Framesize: This line shows the dimensions of the captured video.
   • Quality, Data rate: Some codecs present quality options in terms of a compression percentage (Quality), and others in terms of the required data transfer rate in KB/sec (Data rate).
Choose any of the following **Audio Settings**:
- **Record audio**: Clear this checkbox if you are not planning to use the captured audio in your production.
- **Compression**: This dropdown shows the codec that will be used to compress the incoming audio data.

### Scene detection settings for Capture Video

The options provided for both DV / HDV and analog import include access to this window for configuring scene detection preferences.

Automatic scene detection is a key feature of Studio when working with DV and HDV sources. As video capture proceeds, Studio detects natural breaks in the video and divides it up into scenes.

Scenes can be independently viewed and managed in the Scenes view in the Library.

Depending on which capture device you are using, automatic scene detection is carried out either in real time during capture, or as a separate step immediately after capture is completed.

### To choose scene detection settings

1. From the **Import** tab, click **Capture Video**.
2. In the **Scene detection** area, click **ON** if you want to use scene detection.
3. Click the arrow to the left of **Scene detection** to expand the settings area, and choose one of the following options:
   - **Automatic based on shooting time and date**: This option is available only when you are capturing from a DV source. Studio monitors the time stamp data on the tape during capture, and starts a new scene whenever a discontinuity is found.
   - **Automatic based on content**: Studio detects changes in the video content, and creates a new scene wherever there is a large change in the images. This feature might not work well if the lighting is not stable. To take an extreme example, a video shot in a nightclub with a strobe light would produce a scene each time the strobe flashed.
   - **Automatic every X seconds**: Studio creates new scenes at an interval you choose. This can be useful for breaking up footage that contains long continuous shots.
   - **Manually, by pressing spacebar**: Select this option if you want to monitor the entire capture process and decide for yourself where scene breaks should occur. Press the **Space** key each time you want to insert a scene break during capture.
File name for imported files

The **File Name** box is where you specify the names under which your imported media files or project files will be stored.

Each type of input source has a default filename assigned by Studio. For instance, the default filename when importing a Snapshot is “Snapshot”. To change it, click in the space and type the name you want.

The Importer never overwrites an existing file when importing. If a file with the same name as the target name already exists, a sequence number is added to the name of the incoming file.

When importing from file-based assets, additional file naming features are available. By default the naming formula for a file-based input is given symbolically as “[original].[ext]”, meaning that the original filename and extension are used.

Selecting assets for import

Each source supported by the Importer has its own appropriate set of controls for selecting the material to be imported. When you click the source type, the main area of the Importer configures itself appropriately with the controls you need.

Import from file

There are two methods for importing media files and project files from file-based storage media including local hard drives, optical drives, memory cards and USB sticks:
- Select the **My computer** tab to select specific asset files or groups of files for import.
- Select the **Scan For Assets** tab to select one or more folders and import all assets of the desired types that are found in those folders.

Selecting files for Import

When you select **My computer**, the job of selecting the files to import belongs to the folder and asset-file browser in the main area of the display.

The folder and file browser

The left hand column of the browser is a hierarchical view of all folders on all file-storage devices attached to your computer. These devices include hard drives, optical disc drives, memory cards and USB sticks.

Navigation in this “folder tree” is similar to that in Windows Explorer and other programs. Only one entry in the folder tree can be highlighted at a time. Any media files or project files
contained in that folder are immediately listed in the larger, right-hand division of the browser. You can preview files on the spot, and earmark those you intend to import by checking the box at the top right of corner of each file icon.

**Previewing media and project files**

**Previewing audio and video:** The file browser includes built-in previewing for all supported asset types. Click the play button in the center of video, audio, and project file icons to preview the assets they represent. For quick viewing, video files play back within the icon frame itself. Click anywhere on the icon to halt playback; otherwise the entire file is previewed.

![Horses.mp4](image)

**Full-screen photo preview:** To view a digital photo or other picture file at full-screen resolution, double-click its icon, or click the full-screen button in the toolbar beneath the browser.

**Scrub preview:** Audio, video and project file icons provide a scrubber control immediately below the file icon. Click and drag the scrubber knob to manually review any part of the file. The mouse pointer changes to a two-headed horizontal arrow when it is correctly positioned for scrubbing.

![Horses.mp4](image)

**Marking files for import**

To mark asset files one at a time for importing, click the checkbox at the top right corner of the file icon. This box is checked automatically when you browse to a new folder for all the files on display.
Click the checkbox to mark or unmark the file.

**Marking multiple files:** The browser also provides a method of checking or unchecking a group of highlighted files simultaneously. To highlight an individual file, simply click on its name or its icon; the highlighted state is indicated by an orange border. To highlight additional files, click icons in conjunction with either of the **Shift** and **Ctrl** keys, as follows:

- Click while pressing Ctrl to add or remove the highlighting from one file without affecting the others in the group.
- Click while pressing Shift highlights the clicked icon and all those between it and the previously clicked icon, inclusive. Highlighting is removed from any icons not within the range.

You can also highlight a range of icons directly with the mouse, by dragging out a rectangle that intersects the icons you want to include. Click the first icon and move to the last one before releasing the mouse button.

Having highlighted some icons you want to import, click the checkbox of any one of them to mark or unmark the entire group at once.

**Check All and Uncheck All:** Click these buttons along the bottom of the file browser to mark for importing either all or none of the asset files listed in the current folder. The buttons do not affect any files currently selected in other folders.

*Use the Check All button to mark all asset files in the current folder.*
Each time a file is added to or removed from the list of those to be imported, the file browser updates the count in the selection status indicator at the bottom right of the display.

**Customizing the browser**

Several controls allow you to configure the file browser appropriately for your display hardware and requirements.

**Close the folder tree:** To maximize the space for viewing files, click the left-pointing double-arrow icon at the top of the folder tree scroll bar. This collapses the folder tree to a vertical bar down the left-hand side. At the top of the bar is the right-pointing double-arrow that will reopen the tree. The name of the current folder is also shown.

**Filter the file list:** Another way to optimize your use of the file area is to limit the files shown to include only one asset type. This is the function of the asset filter dropdown at the bottom left of the browser. By default, all supported media file and project file types appear in the browser, but you can limit the view to picture files, audio files, video files or project files by your selection here. To see exactly which file types are included in a selection, hover on the item for a second or two to pop up the list.

![Filter dropdown showing supported file types](image)

*Hovering over the Audio files option brings up a list of file types from which audio import is supported.*

**Zoom slider:** A final tool for managing screen real estate is the zoom slider at the bottom right of the browser. Move the slider leftwards to reduce, or rightwards to increase, the size of the preview images in the file browser.

![Zoom slider](image)

**Full-screen photo:** To preview a selected photo on the full monitor screen, click the Full Screen button.

**Set preview volume:** To set the playback volume of audio and video clips for previewing, hover the mouse pointer in the area of the audio/mute button in the bottom bar of the file browser. A volume slider will appear beside the button. Drag the knob up and down to control the volume. Click the audio/mute button itself to toggle audio muting.
Scan for assets

When you select **Scan For Assets**, a hierarchical folder view is displayed, much like the one shown for **My computer**.

Since you are selecting folders rather than files to be scanned, the media files and project files contained in the folders are not shown. A checkbox appears next to each name in the folder tree, and four pop-up lists are offered on the toolbar.

These lists offer a menu of file types to import in each category: **Video**, **Photo**, **Audio** and **Projects**. By default, the file extensions on each menu are all checked, meaning that all the appearing file types will be included in the import operation. Uncheck the file extensions for any types that you do not wish to import.

To start importing, mark all the folders from which you want to import files. Use the file-type lists just discussed to narrow the range of incoming file types, if desired.

When selections have been made, click the **Scan and Import** button. This will import all files of the selected types in the chosen directories.

Import from DV or HDV camera (Capture Video)

To prepare for importing digital video, switch on your DV or HDV device in play mode, click **Capture Video**, and select your device in the Source drop-down menu above the preview area.

You will also need to make sure that your destination folder, compression presets, and other options are set up in the other panels the way you want them. (See “Import sources” on page 211.)

Previewing video

The video currently playing on the source device should now be visible in the preview area of the display. Along the right edge of the video preview is a scale showing the moment-by-moment audio level.
When a DV or HDV source is selected, the central area of the Importer provides controls for previewing and importing the taped material.

Below the preview image is a row of controls for automating capture by setting mark-in and mark-out points. For more information, see “Recording video and audio” on page 223.

Another row of controls, the transport bar, serves as your navigation console for the source device.

The transport bar for DV and HDV import, with (from left) jog controls and timecode readout, transport buttons, a shuttle control, and an audio button with a pop-out slider for controlling the preview volume.

The current timecode indicator shows your playback position according to the timecode recorded onto the tape when it was shot. The four fields represent hours, minutes, seconds and frames respectively. To the left of the indicator is a pair of arrow buttons; use these to jog the position one frame back or frame forward at a time.

From left to right, the transport buttons are play/pause, stop, rewind and fast forward. These buttons relay commands to your camera. Using them is equivalent to using the camera’s onboard controls, but typically more convenient.

Drag the orange needle on the shuttle control to the left or right to change the playback position in the reverse and forward directions respectively. The motor speed increases as you drag the needle further off center. When you release the needle, it homes to the center position and pauses playback.

Set preview volume: To set the playback volume for previewing, hover the mouse pointer in the area of the audio/mute button in the bottom bar of the file browser. A volume slider will appear beside the button. Drag the knob up and down to control the volume. Click the audio/mute button itself to toggle audio muting.
Mark-in, mark-out: The mark in and mark out timecode fields above the ends of the transport bar indicate the planned starting point and ending point of a video capture.

Note: DV and HDV sources are also suitable for snapshots.

Recording video and audio

The Importer supports two approaches to selecting a range of video to be imported.

In the manual approach, you simply watch the preview playback and press Start Capture at the start of the desired footage. When you reach the end of the segment, press Stop Capture. If you have continuous timecode on the source footage, and have set Stop at tape end to ‘Yes’ in the Mode panel, you can walk away and leave the Importer to switch off when the input is exhausted.

The automatic method of capture is good for setting the endpoints of your capture (the “mark-in” and “mark-out”) points with single-frame precision, and for unattended importing that should halt before the end of the recorded material.

Sometimes you may want to use set the mark-in time and leave mark-out blank. When you click Start Capture the Importer will locate your start time then capture until you tell it to stop (or at tape end).

You can also set a mark-out time and leave the mark-in time blank. When you click Start Capture import will begin immediately, and end automatically at the mark-out point.

Entering a duration and entering a mark-out time are equivalent. Whichever you specify, the Importer calculates and displays the other one automatically.

Note: Before starting the import operation, verify that the settings in the Settings area and other settings (see “Import sources” on page 211) have been configured correctly.

To capture manually with the Start Capture and Stop Capture buttons:

1 Make sure that the mark-in and mark-out points are not set. If needed, use the button associated with the field to clear it with one click.
2 Manually start playback of the source tape before the desired starting point of the capture.
3 Click the Start Capture button when the starting point is reached. The button caption changes to Stop Capture.
4 At the end of the segment click the button again. The captured material is stored in the Library.
5 Manually halt playback (unless automatic shutoff is in effect as noted above).

To capture automatically by setting mark-in and mark-out points:

1 Use the time counter controls to set the mark-in and mark-out values – the start and end points of the desired footage.
   To set the mark-in point, either enter a value directly into the start field, or navigate to the desired point and click the Start button. A similar approach can be used to set the mark-out point.

2 Click Start Capture. Studio positions the source device to the mark-in point and automatically begins recording.

3 When the mark-out point is reached, import is terminated and the source device is stopped.

4 The captured material is stored in the Library.

Import from analog sources

To record analog video (e.g. VHS or Hi8) you need a converter that connect to your computer and that has the required video and audio connections. This is also the case when recording from analog sound sources, such as a record player. Currently supported devices include Pinnacle products such as 500/510-USB, 700/710-USB and DVC 100, and webcams based on DirectShow technology.

To prepare for importing from an analog source, switch on the device and select it by name in the Source drop-down menu above the preview area. Also choose the applicable input (e.g. “Video Composite” or “Video SVideo”). If you wish to tweak the incoming analog signal prior to digitization, click the more button beside the Source drop-down menu. This provides access to the Input Levels window. (See “Adjusting audio and video levels” on page 212.)

Before starting the capture, make sure that your destination folder, compression presets, and other options are set up in the other panels as you want them. (See “Import sources” on page 211.)

To capture from an analog source:

1 Verify that the input device is connected (e.g. “Video S-Video”).

2 Start the playback device just before the point at which you would like capture to begin.
   Video and audio previewing should now be active. (If not, check the cabling and the converter installation.)
3 Click the **Start Capture** button to start recording. The button caption changes to **Stop Capture**.

4 At the end of the segment click the button again. The captured material is stored in the Library.

5 Halt the source device.

### To capture for a specified duration:

1 Verify that the correct input is connected (e.g. “Video S-Video”).

2 Enter the desired capture duration in the Duration time-counter control below the video preview.

3 Start the playback device just before the point at which you would like capture to begin. Video and audio previewing should now be active. (If not, check the cabling and the converter installation.)

4 Click the Start Capture button to start recording. The button caption changes to Stop Capture.

5 The capture operation will stop automatically after the desired duration has been captured. You may also stop the capture manually by clicking the Stop Capture button.

### Import from DVD or Blu-ray Disc

The Importer can import video and audio data from DVDs and BDs (Blu-ray discs).

**Note:** Blu-ray authoring is not included by default. To add it, choose **Help > Purchase Blu-ray**, and follow the steps to complete the purchase. If you have already purchased Blu-ray authoring, but need to reactivate it, see “Restore purchase” on page 254.

### To import from a disc

1 From the **Import** tab, click **DVD**.

2 To begin, insert the source disc in its drive and select it in the Source drop-down menu above the preview area.

   If you have more than one optical drive, choose the correct device among those listed.

   **Note:** Copy-protected media cannot be imported.

3 Before starting the capture, make sure that your destination folder and file name are set the way you want them (see “Import sources” on page 211).

   **Note:** Because large files can be involved when importing from optical discs, selecting the correct import directory is important. In particular, ensure that the designated storage location has sufficient space available (see “Import sources” on page 211).
Import from digital cameras

Like optical disc drives, the media on digital cameras is accessed through the computer’s file system. The camera may appear on the source list as a removable disk drive. Previewing, selecting and importing are the same as for ordinary file-based assets (except that the folder view starts in the closed position).

Stop motion

The Stop Motion function of the Studio Importer lets you create animated films by stitching together frames grabbed from a live source, such as a video camera, webcam or DSLR. The result of your Stop Motion import will be a collection of captured images, and a project file created from the images.

To prepare for Stop Motion import, make sure the camera is switched on and connected to your computer, then select the Stop Motion tab from the Import tab from panel of the Studio Importer. (See “Import sources” on page 211.) Before starting to capture, make sure that your destination folder, options and file name are set up in the other panels the way you want them.

If your source equipment is functioning correctly, you should have a live preview in the central area of the Importer window.

When you are ready to capture an image, you can click the Capture Frame button. A thumbnail of the grabbed frame is added to the Image Tray at the bottom of the window. Since this is a stop motion sequence, after each image is captured you will generally make small changes to the scene you are shooting in order to create the illusion of motion from frame to frame.

To make your task of gauging the movement easier, you can use alignment tools (line, grid, or circles). You can also use Onion Skin Mode, a mode that uses a ghosting effect whereby...
successive frames are shown simultaneously in translucent layers so that the differences can be clearly seen.

The number of images shot so far and the duration of the video (based on the number of images, rounded off) are displayed to the right below the control bar.

You can also import images that you have already captured for stop motion by clicking the Import File button below the control bar.

**Project Settings**

You can choose from the following settings for your stop motion project:

- **Aspect Ratio**: Set to **Standard** (4:3) or **Widescreen** (16:9)
- **Resolution**: Set to **NTSC Standard** or **PAL Standard**
- **Frame Rate**: Higher frame rates result in better quality, but require more image captures.
- **Image Duration**: Set the duration for each image you capture according to frames. The higher the number, the less images you need to capture, but the results might be less smooth.

**The Stop Motion control bar**

This bar provides transport and other functions for Stop Motion import. From left to right:

- **Video** and **Frames** indicators: These let you switch between previewing the live video feed and previewing the captured frames in the Image Tray. You can review – and if necessary replace – particular frames without having to undo other work.
- **Auto Capture**: The **Auto Capture** button toggles the feature on (orange icon) or off (white icon). Click the arrow for **Auto Capture** to specify the settings (**Capture Interval** and **Duration**).
- **Navigation buttons**: These buttons are for previewing your animation. They let you play, go to start, go back one frame, or go forward one frame. A **Loop Play** button lets you cycle the animation continuously.
- **DSLR Capture**: These optional controls can be used when you have a compatible DSLR connected to your computer (at this time most Canon DSLRs are supported). The **DSLR Capture** icon is orange when your DSLR camera connected. The arrow button lets you access the **DSLR Settings** dialog box. Here you can control the DSLR. This ensures consistent results across frames. The settings vary somewhat according to your camera and camera mode. It is recommended that you set your camera to Manual mode.
- **Auto Focus (AF), Manual Focus (MF) and Show Focus**: These optional controls can be used to adjust the focus for your camera in Pinnacle Studio when you have a compatible DSLR camera connected to your computer (at this time most Canon DSLRs are supported). Your camera lens needs to be set to AF to use these onscreen focus controls.
• **Onion Skin Mode**: The **Onion Skin Mode** button toggles the feature on (orange icon) or off (white icon). Click the arrow for **Onion Skin Mode** to specify the settings. The first slider (**Original-Onion skin**) shows the difference in transparency between the original and successive frames. The **Frames** slider controls the number of frames, in addition to the current one, that will display onscreen. Experiment to find the settings that work best for your movie.

![Onion Skin Mode settings](image)

The number of images shot so far and the duration of the film (based on the number of images, rounded off) are displayed to the right below the control bar.

**Using the Image Tray with Stop Motion**

When you click Capture Frame (button displays below the Stop Motion control bar), the Image Tray opens and displays the images that you capture. You can view the start time for each image (time displays above the thumbnail). You can click a thumbnail to choose the frame. You can delete the frame by clicking the red trash icon above the thumbnail. You can also insert a frame to the right of the selected thumbnail by clicking Capture Frame. Note: You must be in Video mode to capture frames (click Video on the left side of the control bar).

![Image Tray](image)

**Alignment tools**

Gauging movement in stop motion projects can be tricky. In addition to the Onion Skin Mode described above, you can use the following tools:

• **Line**: Drag across the screen to set a line with nodes that mark intervals. Look for the pink node to find the suggested alignment for your next capture.

• **Grid**: Displays a grid overlay onscreen

• **Circles**: Displays a circle pattern onscreen

![Alignment tools](image)

The interval for the nodes, grid lines, or circles is determined by the Time across setting. The value (seconds) determines how many suggested captures to make, as indicated by the space between intervals. You can use the alignment tools to create smooth even motion, or
to help you gauge how much you need to move the subject to speed up or slow down the movement.

Exporting the animation

When you have added all the frames you want to the animation, click one of the following options:

- **Export to Library**: Converts the frames to an .axps file and imports both the .axps file and the collection of images to the Library. Similar to an .axp file, an .axps file is a project file that lets you easily reopen the project in the Stop Motion mode of the Importer so that you can continue to work on the project at another time. It references the project files.
- **Edit in Timeline**: Imports the frames to the Library and add the project to the Timeline (Edit mode) for further editing.

How to create a stop motion project in Pinnacle Studio

The steps below guide you through a basic workflow for a stop motion project. Before you start, it’s best to have all your materials ready and have your shooting area set up with the lighting you need. If you are using a DSLR that is supported in Pinnacle Studio, set your camera to **Manual** mode. A tripod is recommended.

**To create a stop motion project**

1. If using an external camera to capture your stop motion project, ensure that the camera is plugged into your computer and is on, ready to capture photos. Set the camera to manual mode.
2. In Pinnacle Studio, click the **Import** button (to the right of the **Author** button). The Studio Importer window opens.
3. Click **Stop Motion**. Supported cameras that are connected to the computer and switched on are listed below Stop Motion. Click a camera name and do one of the following:
   - On your camera, manually choose the best settings for your stop motion scene and adjust the focus (can set the lens to MF to focus manually).
   - If you have a compatible camera (most Canon and Nikon DSLRs are supported), in the control bar below the preview area, click the arrow beside the **Camera** button. In the **DSLR Settings** dialog box, choose your camera from the drop-list, and choose the settings for your camera, using the Preview screen as a guide. Make any adjustments you want and click **OK**. You can then focus the camera manually or set the lens to AF mode, and in Pinnacle Studio, enable **Show Focus** to display the onscreen controls. Click **Auto Focus** or **Manual Focus**. For **Auto Focus**, drag the rectangle to the area of
focus. The camera will automatically adjust the focus. For **Manual Focus**, click the plus or minus symbol on the preview screen until the subject is in focus.

4 Choose your **Project Settings**, and if you want to change the default destination for your project files, in the **Save to** area, navigate the location you want.

5 When you know what kind of motion you want to make, you can choose from different types of alignment tools and set the **Time across** setting (value is time marked in seconds).

6 When you have the subject set up, click **Capture Frame**.

7 Move your subject the way you want, and continue capturing an image for each movement. If you are making a series of simple movements, you can set up **Auto Capture**.

8 When you are ready to review the frames, on the control bar, click the Play button to review the movie. To reactivate the **Capture Frame** button if you want to add more frames, click **Video** in the control bar.

9 When you are finished, click the **Import to Library** or **Edit in Timeline** button.
   
   If you want to save the project without exporting to the Library, click the **Save** button beside **Project Name**. You can click the **Open** button (beside **Save**) to access the saved project.

### Snapshot

The Snapshot function of the **Import** tab is used to record individual frames (still images) from cameras or players connected to the system. To prepare, make sure the source device is switched on, then from the Import tab, click **Snapshot**, and choose the device from the Source drop-down menu above the preview area.

Before starting the capture, make sure that your destination folder and file names are set up in the other panels as you want them. For more information, see “Import sources” on page 211. Now start your camera, or roll your tape, and start monitoring the embedded preview display in the central area of the Importer window. Click the full-screen button at the right-hand end of the transport bar to preview on the full monitor screen.

When you want to capture an image as it goes by, click the **Capture Frame** button.

A thumbnail of the grabbed frame is added to the Image Tray at the bottom of the window.
Capturing snapshots in the Importer. While previewing live or taped video in the central area of the window, use the Capture Frame button to grab still images. Grabbed frames accumulate in the Image Tray at the bottom of the window until you click the Import Captured Frames button to transfer them to the Library.

Capture as many additional frames as are required. The Importer adds each one in turn to the collection growing in the Image Tray. In the course of capturing, you can change tapes, re-aim your camera, and so on as you see fit. The source video doesn’t need to be uninterrupted as long as there is signal present when you actually click the Capture Frame button.

**Using the Image Tray**

For on-the-spot review of a frame you have already grabbed, click the thumbnail of any but the most recent frame in the Image Tray. This switches the preview display from the video source to the captured file, and activates the File indicator. You can also activate the indicator by clicking it directly.

Click any thumbnail in the Image Tray to review images already grabbed.

To delete a captured frame, select it in the Image Tray, then click the trash-can icon that appears in the top right corner of the thumbnail.

To switch back to previewing video after reviewing files in the Image Tray, click the Live indicator beneath the preview display.
Importing the frames

When you have grabbed all the frames you want from the video source, click the Import Captured Frames button. The Importer adds the grabbed images to the still images section of the Library.

MultiCam Capture

MultiCam Capture is video capture software that makes it easy to capture yourself, make a screen recording, and present demos or products—all at the same time. Plug in your cameras, press record, and let MultiCam Capture transform your computer into a capture hub that synchronizes all sources automatically for professional results.

To use MultiCam Capture in Pinnacle Studio

1. In Pinnacle Studio, click the Import tab.
2. Click MultiCam Capture.
   Note: You might need to scroll to find the MultiCam Capture option if your application window isn’t set wide enough to show all the options.

   The MultiCam Capture application launches.

3. Follow the instructions for the MultiCam Capture application to prepare for your project (click the question mark icon, then the Help tab to view the user guide).
4. In the Save As area, ensure that you mark the Pinnacle Studio Project check box, and capture your project.
5. In Pinnacle Studio, go to the Library Project Bins category to find your project.
6. Right-click the project and choose Open in Multi-Camera Editor. For more information on the Multi-Camera Editor, see “Multi-Camera Editing” on page 259.
One of the great things about digital video is the large and growing number of devices that can make use of it. Studio lets you create versions of your movie for whatever video viewers your audience will be using, from hand-held DivX players and mobile phones to HDTV home theaters.

This section contains the following topics:

- Exporting your project
- Export options and settings
- Output to disc or memory card
- Output to file (Format or Extension)
- Output to Web
- Output to a device
- Output to MyDVD
- Export to animated GIF
- Exporting movies with transparency to alpha channel video

Exporting your project

When you have finished editing your project, open the Exporter by pressing clicking the Export tab at the top of the screen. With a few clicks you can tell the Exporter everything it needs to know to output your movie or asset in the format that best fits your requirements.

**Note:** To export directly from the Library without using the Exporter, please see “Exporting directly from the Library” on page 22.

The Exporter will ensure that your project is complete before it is exported. If there is any missing media, your project cannot be exported until the media is either relinked or deleted from the project. For more information, see “Missing media” on page 16.
The Export tab lets you access output options as needed for the chosen output type. The name of the project appears above the Player, while the estimated file size and remaining space is provided below the preview area.

To export from the Export tab

1. Set the **Destination** for your exported files by clicking the browse button and choosing a location.
2. In the **File Name** box, type a file name.
   If you want to set some automatic post-export actions, click **After Export Actions** and choose the options you want.
3. Do one of the following:
   - To export the project using the timeline settings, enable the **Same as Timeline** check box.
   - To choose new settings for export, from the dropdown menu on the left, choose **Format**, **Extension**, **Device**, or **Web**.
4. From the dropdown menus that appear for your export project, choose the options you want. **Presets** are available in most cases, or you can customize the settings by clicking the **Edit Preset** button. You can then click the **Save Preset** button to save your custom settings as a new preset.
5. If you want to export only a section of the movie, use the trim controls in the playback control area of the player window.
6. Click **Start Export** to export your project.
Export options and settings

Preparing your movie for output

Before your movie is completely ready for output some preprocessing will usually be required. In general, Pinnacle Studio will need to ‘render’ (generate video frames in the output format) any transitions, titles, disc menus and video effects you’ve added to your movie. Any files generated during the rendering process are stored in the auxiliary files folder, whose location you can set in the application settings window.

Create between markers

For output to file or to the Cloud, you have the option of exporting only a selected portion of your movie. In the Exporter Player area, adjust the trim markers to indicate which part of the movie you want to export.

Set the Mark In and Mark Out calipers to export a segment of the timeline.

Output to disc or memory card

For information about creating discs, see “Disc projects” on page 193. Whether or not you have a disc burner, Studio can also create a ‘disc image’ – a set of files containing the same information as would be stored onto the disc – in a directory on your hard drive. The image can subsequently be burned onto a disc or transferred to a flash memory card. Please note that if you activate the Author tab in Pinnacle Studio, a Disc page is added to the Export tab.

Note: Blu-ray authoring is not activated by default. To activate it, choose Help > Purchase Blu-ray.
SD card, Memory Stick and Built-In Media

AVCHD 2.0 disc structures can be written to flash memory cards, such as SD cards or Memory Sticks, or even to devices with built-in media support (e.g. camcorders with AVCHD 2.0 support).

Output to file (Format or Extension)

Choose whichever format matches the needs of your audience and the details of their viewing hardware.

The size of the output file depends on both the file format and the compression parameters set within the format. Although compression settings can easily be adjusted to produce small files, heavy compression comes at the expense of quality.

The detailed settings for most formats can be adjusted by choosing the Custom preset and clicking the Advanced button. Other presets load settings designed for typical situations.

If you are exporting a stereoscopic 3D project, an S3D menu will appear, offering various 3D formats, or the option of exporting your project in 2D.

As a convenience after output has completed, the Exporter provides shortcuts for opening Windows Media Player and the QuickTime Player. To view your output file as soon as you have created it, click the icon representing the player of your choice.

Below is a list of some of the formats.

3GP

Pinnacle Studio can generate movies in this widely-used file format using your choice of MPEG-4 or H.263 video compression, along with AMR audio compression. The format is adapted to the comparatively modest processing and storage capabilities of mobile phones.

The list of presets for this file type offers two frame sizes in either encoder. Choose Small, at 176x144, or Very Small, at 128x96.

Audio only

Sometimes a movie’s soundtrack can stand alone without visuals. Live entertainment footage, and video recordings of interviews and speeches are instances in which an audio-only version might be desirable.

Pinnacle Studio lets you save your soundtrack in wav (PCM), mp3 or mp2 format.

Click the preset that best meets your needs; or choose Custom, then click the Advanced button to open the Advanced Settings panel.
Transport Stream (MTS)

Transport Stream (MTS) may contain video in MPEG-2 or H264/AVC compression. Its applications include HD playback on AVCHD-based camcorders, AVCHD disc, or Blu-ray disc. Click the preset that best meets your needs; or choose Custom, then click the Advanced button to open the Advanced Settings panel.

AVI

Although the AVI file type for digital video is itself widely supported, the actual coding and decoding of video and audio data in an AVI file is performed by separate codec software. Studio supplies a DV and an MJPEG codec. If you wish to output your movie as an AVI in some other format, you can use any DirectShow-compatible codec installed on your PC, as long as that codec is also installed on the PC that will play your movie.

Click the preset that best meets your needs; or choose Custom, then click the Advanced button to open the Advanced Settings panel.

DivX

This file format, based on MPEG-4 video compression technology, is popular for video files disseminated over the Internet. It is also supported by a range of DivX-compatible hardware devices, from DVD players to portable and handheld units.

Click the preset that best meets your needs; or choose Custom, then click the Advanced button to open the Advanced Settings panel.

DivX Plus HD

This file format, based on H264 video compression technology, is popular for HD video files disseminated over the Internet.

Click whichever of the quality presets matches your needs; or choose Custom, then click the Advanced button to open the Advanced Settings panel.

Flash Video

Studio supports output in Flash Video (flv) format, version 7. Virtually all current web browsers are able to display this popular format, which has been widely adopted by social networking sites and news sites.
Click the quality preset that matches your needs; or choose Custom, then click the Advanced button to open the Advanced Settings panel.

**Image**

A frame of your video project can be exported as an image, a JPG, TIF or Custom. If you select the **Custom** option, use the Advanced button to open the Advanced Settings panel.

You can also choose **GIF** to create an animated GIF file. For more information, see “Export to animated GIF” on page 242.

**Image sequence**

A section of your video project can be exported as a series of images, one per frame. The video selected must be at least one second long. Each second of video will generate between 25 and 60 images, depending on the frame rate setting.

The images can be TIF, JPG, TGA, or BMP, in a variety of sizes. If the project is in stereoscopic 3D, you will be offered S3D formats for output.

**QuickTime Movie (MOV)**

This is the QuickTime file format. It is particularly suitable when the movie will be played on the QuickTime player.

The presets provide a variety of size and encoding options.

**MPEG**

**MPEG-1** is the original MPEG file format. MPEG-1 video compression is used on VideoCDs, but in other contexts it has given way to newer standards.

**MPEG-2** is the successor format to MPEG-1. Whereas the MPEG-1 file format is supported on all Windows 95 and later PCs, MPEG-2 and MPEG-4 files can only be played on PCs with appropriate decoder software installed. Several of the MPEG-2 presets support HD (High Definition) playback equipment.

**MPEG-4** is another member of the MPEG family. It offers image quality similar to MPEG-2 but with even greater compression. It is particularly suitable for Internet use. Two of the MPEG-4 presets (QCIF and QSIF) create ‘quarter-frame’ video sized for cell phones; two others (CIF and SIF) create ‘full-frame’ video suitable for handheld viewers.

**Custom presets:** With all MPEG variants, Custom lets you configure movie output in detail by clicking the Advanced button to open the Advanced Settings panel.
Real Media

Real Media movie files are designed for playback on the Internet. Real Media movies can be played back by anyone around the world who has the RealNetworks RealPlayer software, which is a free download from www.real.com.

Click the **Advanced** button to configure your output with the Advanced Settings panel.

Windows Media

The Windows Media file format is also designed for streaming Internet playback. The files can be played on any computer where the Windows Media player – a free program from Microsoft – is installed.

Click the **Advanced** button to configure your output with the Advanced Settings panel.

Output to Web

The Pinnacle Studio Exporter lets you share your movie creations with your social network on Facebook, with your professional peers on Vimeo, and with potentially the entire world on YouTube.

Storing your media and projects on the Cloud means they are also accessible from your smartphone or tablet, and can easily be transferred between computers for collaboration and convenient access.

If you are not already logged in to the provider’s site, a log-in page will appear.

**Facebook**

After logging in to your Facebook account, you can enter a new Title, or Description for your movie, and select Format and Privacy settings from the dropdown menus.

**Vimeo**

After logging in to your Vimeo account, you can modify the movie’s Title, Description and Tags. Choose the Format you prefer from the dropdown menu.

**YouTube**

After logging in to your YouTube account, you can enter a new Title, Description, or new Tags. Choose your Format and Privacy settings from dropdown menus.
After uploading

When the upload is finished, you have the option of opening a web browser to view your creation, or returning to Studio. For Facebook, YouTube and Vimeo, your file must be processed before it can be viewed online, and so may not be immediately available.

Output to a device

Studio can create movie files that are compatible with a range of devices, including the ones listed below.

• Apple
• Microsoft Xbox and Xbox One
• Nintendo Wii
• Sony PS3 and PS4
• Sony PSP

If you are exporting a stereoscopic 3D project, you will be offered the 3D formats compatible with the selected device.

Apple

Studio supports exporting files that are compatible with popular Apple devices like iPod, iPhone and iPad, and Apple TV as well.

The file format used for iPod and iPhone compatible devices is based on MPEG-4 video compression technology. The combination of powerful compression with a small 320x240 frame size produces very small output files relative to the more expansive formats. The three quality presets select different data rates, each providing a different balance of quality and file size.

Apple TV as well as iPad compatible files are based on the H.264 video compression standard. Output frame size is either 960x540 for Apple TV (first generation) or 720p (later generations).

Microsoft Xbox and Xbox One

Microsoft Xbox presets allow you to create files for full-screen playback on your Xbox. Two formats are available: DivX SD based on MPEG-4 video compression technology, and WMV HD.
The Exporter

Nintendo Wii

Pinnacle Studio can generate files for playback on your Nintendo Wii with the support of both AVI and FLV output formats.

Sony PS3 and PS4

You can export files to your PlayStation by selecting the Sony PS3 or Sony PS4 export type. Studio supports the following file formats: Full size, which is in DivX file format at 720 x 400, and HD 1080/60i.

Sony PSP

Studio allows you to export files which are compatible with the popular Sony PlayStation Portable devices. Output files are based on MPEG-4 video compression technology. As with the iPod-compatible type, the combination of powerful compression with a small 320x240 frame size produces very small output files relative to other formats.

Output to MyDVD

MyDVD is an easy disc authoring application that uses templates to help you create professional-looking disc projects that include menus, and music. For more information about MyDVD, see the Help available in the MyDVD application.

MyDVD opens automatically when you export to a MyDVD project. You can also open MyDVD by clicking the Pinnacle MyDVD shortcut on your desktop or by searching for Pinnacle MyDVD on your Start screen or Start menu.

To access export options for MyDVD projects, you must choose Export to MyDVD from the Edit tab timeline.
To export to a MyDVD file

1. After you create and edit your project in the timeline of the Edit tab, click the Open Author Toolbar button on the timeline toolbar.
   
   If you want to add any chapters before exporting, use the chapter controls on the timeline toolbar. For more information, see “To add chapter markers to a disc project” on page 194.

2. Click the Export to MyDVD button above the track headers.
   
   The Export tab becomes active.

3. In the Export Settings area, choose the settings you want and click Start Export.
   
   The project is rendered and Pinnacle MyDVD opens your project file.

Export to animated GIF

You can use precise tools in Pinnacle Studio to create animated GIFs. Animated GIFs are simple, Web-friendly animated files that are typically under 10 seconds long. Although traditionally used for simpler graphics due to their limited color palette (256 colors), the color range can be optimized for a broader range of images (Pinnacle Studio uses dithering to optimize color). GIFs also support transparency.

In Pinnacle Studio, the easiest way to create a quick animated GIF is to use markers in the Export tab to precisely choose the portion of the project (a single video, or a more complex project) that you want to convert to GIF. Then, choose the settings that will produce the size and quality you need, and export. Any titles or effects that you have added to that portion...
of the project will be exported to the final GIF file. The resulting single file comprises of a series of GIF images that produce the animation.

**To export to an animated GIF**

1. After you create and edit your project in the timeline of the **Edit** tab, click the **Export** tab.
2. Set the **Destination** for your exported files by clicking the browse button and choosing a location.
3. In the **File Name** box, type a file name.
4. Ensure that the **Same as Timeline** check box is not marked.
5. From the dropdown menus, moving from left to right, choose **Extension**, then 
   * .gif, and **Image**.
6. From the **Preset** dropdown menu, choose the option you want. You can customize the settings (including **Image Size**, **Frames/sec**, **GIF Quality**, and **Loop Play**) by clicking the **Edit Preset** button. You can then click the **Save Preset** button to save your custom settings as a new preset.
7. To export only a section of the project, use the trim controls (**Mark In** and **Mark Out**) in the playback control area of the player window.
8. Click **Start Export** to export your project.

**Note:** The **Estimated file size** displays below the player window. Adjust the settings and length to ensure that the final file size is suitable for where you want to host the animated GIF file.
Exporting movies with transparency to alpha channel video

Alpha channel video supports transparency, allowing you to save animated logos, lower-third graphics, and other objects and animations as video files that you can share and reuse as overlays in other video projects. For example, if you create a series of videos, you can overlay the start of each video with an animated title that identifies you or your company as the creator of the series. Pinnacle Studio uses the CineForm MOV format for alpha channel support.

The black area represents the transparent area in this alpha channel video.

To export to an alpha channel video

1. After you create and edit your project that has transparent areas in the timeline of the Edit tab, click the Export tab.
2. Set the Destination for your exported files by clicking the browse button and choosing a location.
3. In the File Name box, type a file name.
4. Ensure that the Same as Timeline check box is not marked.
5. From the dropdown menus, moving from left to right, choose Format, then CineForm.
6. From the Preset dropdown menu, choose an MOV option. You can customize the settings (including Size, Frames Per Second, and Quality) by clicking the Edit Preset button . You can then click the Save Preset button to save your custom settings as a new preset.
7. To export only a section of the project, use the trim controls (Mark In and Mark Out) in the playback control area of the player window.
8. Click Start Export to export your project.
Pinnacle Studio’s central configuration window is called the Control Panel.

To begin, on the Pinnacle Studio main menu, select **Setup > Control Panel**. When the Control panel appears, choose a page from the directory on the left side of the window.

![Control Panel window](image)

*The Pinnacle Studio Control panel is a central configuration window for the application.*

The pages of Control panel settings are described here in turn.

This section contains the following topics:

- Legacy Options
- Audio device
- Event logging
- Export and Preview
- Import settings in the Control Panel
- Keyboard settings in the Control Panel
- Project settings
Legacy Options

The Legacy Options page includes Watchfolders and Legacy Authoring Mode settings.

Watchfolders

Watchfolders are folders on a hard drive or other storage medium that are monitored by Pinnacle Studio. When the contents of a watchfolder change, the Library is automatically updated.

When you use watchfolders, a Library Media branch is added to the Asset Tree in the Library. You will also see a Library Media branch if Pinnacle Studio detects a library from a previous version of Pinnacle Studio (you must enable watchfolders if you want to continue populating this branch).

You can create as many watchfolders as you wish and optionally set them up to watch for only one media type (video, image or audio) instead of all three, the default.

To designate a folder on your system as a watchfolder, click the Enable button, and then the Add Folder button below the watchfolders list, and navigate to the folder you wish to add. To cancel watchfolder behavior, select the folder in the list and click the Remove Folder button.

Click the Apply button to direct the Library to update its catalog in light of the watchfolder changes.

Legacy Authoring Mode

You can enable or disable the legacy Author tab for Pinnacle Studio. The Author tab provides disc authoring features and provides access to Library Disc Menus content. Click the Enable button to restore the Author tab.

Audio device

This setup page provides the parameters available for recording devices (such as microphones) that are connected to the computer. Click the device name to access the Windows settings dialog for the device.
Event logging

Messages are logged in this window during certain operations, such as importing a number of files. You can check here for details about any problems that may have occurred during these operations.

Export and Preview

These settings affect the representation/display of video.

Quality: These options control the quality of video previewing throughout the application.
- **Best Quality:** Provides previewing at full resolution – the resolution at which the project will ultimately be exported. Under this option there may be dropped frames during playback on slower systems.
- **Balanced:** At this setting, the recommended one for ordinary use, some quality optimizations are omitted for the sake of a faster preview. In most cases the difference is barely noticeable.
- **Fastest Playback:** The preview is optimized in favor of processing efficiency, which may be helpful on a slower system.

**Show full-screen preview on:** Select the computer monitor (if more than one is available) on which you want the full-screen preview to be displayed.

**Show external preview on:** Select from a list of available devices and signal outputs (if any).

**External preview standard:** Select the TV standard of the connected video monitor.

Playback Optimization

**Optimization threshold:** The optimization threshold determines how much rendering is done when you preview your project. It can be set anywhere from Off (0) to Aggressive (100). Whether a particular timeline 'slice' will be rendered depends on the amount of computation needed to prepare the effects and transitions that are used, and on the value of the optimization threshold. If this value is set all the way to Aggressive, Pinnacle Studio will prerender all transitions, titles, disc menus and effects even when the output would have been previewable; this can considerably delay playback.

If **optimization threshold** is set to Off (zero), on the other hand, the yellow and green markings that indicate rendering progress are not displayed; instead, all effects are played back in real time. However, this can result in reduced playback quality (lost frames, 'jerky' playback) if the number and complexity of effects outstrips the available processing capacity of the system.
Render while play: When the Automatic setting is used, the application decides on the basis of system information whether real-time rendering can be done during playback. If the Off setting is used, rendering is disabled during playback but resumes when playback is stopped.

Third-party Codecs: Lets Pinnacle Studio use third-party codecs that are installed on your computer so you can work with additional video formats. Note: Some third-party codec packs might cause crashes or errors in Pinnacle Studio.

Hardware Acceleration

When activated, this feature shifts part of the processing load from the CPU to auxiliary hardware, such as the GPU (Graphics Processing Unit) of your graphics card. The level of support for hardware acceleration depends on the type of CPU and graphics card on your computer.

- Most NVidia cards support the CUDA architecture. When this is accessible, the GPU is used to assist with H.264 decoding.
- Machines equipped with a recent Intel CPU having the Intel Quick Sync Video feature can use it for rapid decoding and encoding of H.264 and H.264 MVC material.

To choose Hardware Acceleration type

2. In the Hardware Acceleration area, choose an option from the Type dropdown.

Stereoscopic

Default 3D Viewing Mode: This setting selects the default for stereoscopic 3D content throughout Pinnacle Studio. See 3D viewing mode switcher for more information. Please see “Choosing what to display in the Library” on page 29 for more information.

- Left eye or Right eye: The preview for stereoscopic content can be set to show only its left or right eye view.
- Side By Side: In Side By Side preview mode, you can monitor the individual 2D images for both sides at the same time.
- Differential: Rather than the image content itself, the differences between the left and right frames are displayed. Identical areas show as neutral gray.
- Checkerboard: Right and left eye views alternate in adjacent cells of a 16x9 grid.
- Anaglyph: An Anaglyph stereoscopic preview is suitable for viewing with red-cyan stereoscopic glasses.
- 3D TV (Side by Side): This mode is to be used with a 3D – capable second monitor or projector.
• **3D Vision** If your system is 3D Vision capable and stereoscopic 3D is turned on in your driver settings, any stereoscopic content will be previewed in 3D Vision by default.

**No stop when activating 3D Vision:** This setting is available when Studio is run on a PC with a 3D Vision-capable system which has stereoscopic 3D turned on in the driver setting. By default, the No stop when activating 3D Vision setting is set to off. When turned on, playback will automatically stop wherever a 3D Vision preview is being activated or deactivated during playback.

---

**Import settings in the Control Panel**

The default options for the Pinnacle Studio Importer may be set here; however, you can adjust or override them in the Importer at the time of importing.

**Folder options:** View or set the default storage locations for media and projects that are to be physically copied during import; unlike linked imports, including the Library’s Quick Import feature, which simply link to existing files without relocating them. The folder locations are initially set to the user’s music, video and images folders as configured in Windows, and to the default folder for saving Studio projects.

After locating and selecting the folder you want to serve as the base folder, you can optionally set up a subfolder:

- **No subfolder:** With this option, the files you import will be stored in the base folder.
- **Custom:** When you choose this option, a Custom Project Subfolder box will appear. Click it to enter a name for the Subfolder for that media type.
- **Today:** Your imports will go to a subfolder named with the current date, in the format “2017-10-25”.
- **Creation date:** Each imported file will be stored in a subfolder named with the creation date of the asset, in the same format as above. When multiple assets are brought in a single import operation, this may mean creating or updating multiple folders.
- **Current month:** This is the same as the Today option but without the day portion, e.g. “2017-10”.
- **Scene detection:** This sets the default detection method for scene detection. “Scene detection settings for Capture Video” on page 216.
- **Stop motion:** This sets the default import method for the frames you capture with the Stop Motion feature. See “Stop motion” on page 226.

---

**Keyboard settings in the Control Panel**

Studio provides both an extensive default set of keyboard shortcuts and a means of customizing them. The Keyboard page of the Control Panel lists all commands to which shortcuts can be applied, together with their currently-assigned shortcuts where applicable. The commands are grouped by section.
To add a keyboard shortcut:

1. Select the target command.
2. Click in the **Press shortcut keys** edit box.
3. Press the keys for the desired shortcut. If the shortcut is currently already in use, the **Shortcut currently used** by dropdown list will show any conflicting commands.
4. Click the **Assign** button to assign the entered shortcut to the selected command.

Adding a shortcut does not delete associations between a particular keyboard sequence and other commands it gives access to. In fact, it is possible for different commands to use the same shortcut provided they occur in different contexts. For instance, **Ctrl**+**L** is the default shortcut for two commands, **Timeline > Lock Track** and **Media Editor > Rotate Left**; which one is activated depends on what part of Pinnacle Studio you are currently using.

To delete a shortcut:

1. Select the target command.
2. Choose the shortcut to delete from the Shortcuts for selected command dropdown list.
3. Click the **Remove** button.

Restoring defaults

Controls are also provided that allow you to restore the default keyboard configuration either for the currently-selected command (the **Reset Current** button) or for all commands at once (the **Reset All** button).

Project settings

On this page of the Pinnacle Studio Control Panel, you can select your default settings for new projects, titles and transitions.

**New movie project format:** Select a resolution (such as PAL or HD 1920x1080i), as the default for every newly created timeline. Alternatively, let the first clip placed on the timeline define the format for the project with the option Detect format from first clip added to project. The format for the current timeline may be changed at any time while editing, by using the timeline settings located at the left end of the timeline toolbar.

**Detect format from first clip:** Detects the format from the first clip added to the project. If the format cannot be detected, the New movie project format is applied.

**Default durations:** Set the default durations of titles, images, and transitions when they are first brought to the timeline. (Once there, of course, the clip length can be trimmed as required.)
Ruler zooming: When this option is checked, dragging horizontally on the time-ruler zooms the timeline in and out. In this mode, you will need to drag directly on the scrubber handle to scrub or to reposition the playhead. When ruler zooming is turned off, you can click anywhere on the ruler to move the playhead. In either case, zooming may also be performed by using any of:

- The Plus and Minus keys on the numeric keypad
- The Navigator at the top of the timeline
- The scrollbars under the previews

Activate trim mode by clicking near cuts: Turn this on to launch trim mode by clicking. If this setting is off, trim mode can be activated with the Trim Mode button on the timeline toolbar.

Montage scaling: Sets the default method for fitting content to the montage templates: None (no scaling), Fit, or Crop.

Startup Page

You can determine which workspace tab displays when you launch the application. By default, the Welcome tab is open.

Storage locations

This page allows you to set where to save media and projects you create with Pinnacle Studio. You can separately specify locations for each of the following file types:

- Studio Movie Projects
- Studio Disc Projects
- Titles
- Menus
- Template
- Restore Project
  - This folder is used both for project packages that have been unpacked for further work and for projects imported from Studio for iPad.

- Render Files
  - This folder is for the temporary files produced while rendering items requiring intensive computation, such as video effects.

The changes made here apply only to future file operations; any existing files remain in their current locations.
Delete render files: You can delete render files to save space without concern over permanently losing data. Note, however, the files will be recreated the next time your project needs to be rendered.

Reseting Pinnacle Studio

You can restore your version of Pinnacle Studio to its default state (sometimes called “factory default”). All customizations will be lost, but saved projects are not affected.

To reset Pinnacle Studio to the default state

1. Save any open projects that you want to keep.
2. Click Setup menu > Control.
3. Click Reset in the directory to display the Reset to Default Settings page.
4. Click the Reset button, and then click OK and restart the application.

Restore purchase

You can restore purchases that you have made through Pinnacle Studio. For example, purchases need to be restored if you move Pinnacle Studio to a new system.

To restore purchases made in Pinnacle Studio

1. Click Setup menu > Control.
2. Click Restore Purchase in the directory to display the Restore purchase page.
3. Click the Restore button, and click OK.
MultiCam Capture Lite

Record computer actions and mouse movement by using the MultiCam Capture Lite screen capture feature in Pinnacle Studio. This feature lets you create videos that require visualization in a few easy steps. You can also define the capture area for more emphasis and focus or integrate voice-overs. You can capture audio from your computer system and microphone and capture Webcam footage. You can then import your footage and use the standard editing tools or the MultiCam Editor. For more information, see “Multi-Camera Editing” on page 259.

This section contains the following topics:
• Starting a screen capture project
• Recording your screen

Starting a screen capture project

To open the Screen Capture window

• Click the MultiCam Capture Lite program icon or select MultiCam Capture Lite from the programs list in Start menu.
Workspace

You can control the recording as well as choose settings for your recordings in the Settings window.

The Source window lets you choose between capturing your computer screen, your webcam, or both. You can also choose settings for your sources.

Recording your screen

Before taking the actual screen capture, make sure to configure the settings of the video first.

To configure your video

1 In the Settings window, specify the following details:
   - Project Name — Enter a name for your project. This will be used in the video filenames.
• **Save To** — Lets you specify the location where you want to save the video file.  
**Note:** Screen captures are saved to your Documents folder (…”Documents/Pinnacle Studio Screen Capture/23.0) by default. Click ➤ to add a new folder and change the location where the file is saved.  
• **Save As** — Enable the Video Files check box, the Pinnacle Studio Project check box, or both.

**To record your screen capture**

1. In the Source window, choose the settings you want on the Settings tab.  
2. In the Settings window click **Start / Resume Recording** to start the screen capture.  
   All activities inside the specified capture area are recorded. Screen capture starts after the countdown.  
   **Note:** You can press F10 to stop and F11 to pause or resume the screen capture.  
3. In the Settings window **Stop Recording** to finish your screen capture.  
   **Note:** The screen capture is added to the custom folder that you have specified and you can add it to the Pinnacle Studio Library.
Multi-Camera Editing

The **Multi-Camera Editor** lets you create professional-looking video compilations from footage of events that have been captured on different cameras, from different angles.

The easy multi-view workspace lets you edit on the fly, as the video clips play back simultaneously—up to six cameras. With a simple click, you can switch from one video clip to another in the same way a broadcast studio switches from one camera to another to capture a different angle or element of a scene.

Footage can be captured on a wide range of video recording devices, such as action cameras, drone cameras, DSLRs, or smartphones. You can also include audio captured independently on a microphone.

*Number of cameras depends on the version of the software you have.*

This section contains the following topics:
- The Multi-Camera Editor workspace
- Basic steps in multi-camera editing
- Importing video and audio clips into the Multi-Camera Editor
- Synchronizing video and audio clips in multi-camera projects
- Choosing an audio source for your multi-camera project
- Editing multiple clips to create a multi-camera compilation
- Adding picture-in-picture (PIP) in the Multi-Camera Editor
- Managing multi-camera source files
- Saving and exporting your multi-camera project
- Using Smart Proxy for a faster, smoother editing experience

**The Multi-Camera Editor workspace**

The image below identifies the main features of the Multi-Camera Editor.
Toolbar, playback, and other controls

The controls found in the workspace are listed below.

The main toolbar includes the following controls:

- **Camera Number** — Lets you set the multi-view pane to show four or six cameras, depending on your version of the software.

- **Source Sync Type** — Lets you synchronize the clips. For more information, see “Synchronizing video and audio clips in multi-camera projects” on page 262.

- **Main Audio** — Lets you select a preferred audio source. For more information, see “Choosing an audio source for your multi-camera project” on page 263.

- **Split Clip** — Lets you split a clip into segments. For more information, see “To split a clip in the Multi-Camera Editor” on page 266.

- **Set/Remove Marker** — Lets you add markers on the Camera tracks for editing purposes, such as audio synching.

- **Rotate Left** and **Rotate Right** — Let you rotate clips in the Camera tracks before you add them to your Multi-Camera track or your PIP track. Note: Only unlocked tracks can be rotated.

- **Transition** and **Duration** — Lets you apply a transition between clips in the Multi-Camera track and set the duration for the transition. For more information, see “To add a transition between multi-camera segments” on page 266.

The main preview pane includes the following controls:
Playback bar with Home, Previous Frame, Play, Next Frame, and End buttons.

Loop — Lets you play the selected track continuously by looping back to the start when it reaches the end.

Set Volume — Lets you adjust the audio volume for playback.

Timecode control — Lets you view and set the time/frame that appears in the main preview pane and where the scrubber is set in the timeline. Click the arrows or a click number value to set a time/frame.

The timeline includes the following controls:

Source Manager — Lets you add and remove clips. For more information, see “Managing multi-camera source files” on page 267.

Show/Hide Audio Waveform View — Lets you view the audio waves for Camera and Audio tracks.

Lock/Unlock — Appears on individual tracks. Locking tracks is recommended after you synchronize them.

Include/Exclude from Synchronization — Lets you determine which tracks are included in the synchronization process.

Mute/Unmute — Lets you turn the audio off (mute) or on (unmute) for the selected audio track.

Zoom to Timeline — Located in the lower left corner of the timeline, this control lets you expand or compress your project so you can view the whole project in the timeline.

Zoom Level slider — Drag the slider or click the Zoom in (plus sign) or Zoom out (minus sign) to change the zoom level for your project. This is particularly helpful when editing individual segments in the Multi-Camera track.

The following general controls appear in the upper-left corner of the application window:

Settings — Lets you access the Proxy Manager and Save As. For more information, see “Using Smart Proxy for a faster, smoother editing experience” on page 268 and “To save your multi-camera project” on page 268.

Undo and Redo — Lets you undo or redo most actions.

Basic steps in multi-camera editing

The following steps provide a basic overview of the multi-camera editing process.

1. Import the video and audio clips that you want to use into the Pinnacle Studio Library.
2. Choose the clips in the Library and import them into the Multi-Camera Editor, using a special import window that lets you assign the clips to “Camera 1”, “Camera 2”, etc.
3. Synchronize the clips across the timeline. You can do this automatically if all the clips have audio, but there are a range of methods you can use for synchronization.

4. Choose the audio you want to keep (if you are using the original audio). You can choose a separate audio track as well.

5. Start building your multi-camera compilation. You can play all the clips simultaneously, and in the multi-view pane, click the “Camera” that you want to show. You can switch clips as many times as you like. The selected footage displays in the main preview pane. You can then review your project in Multi-Camera track and fine-tune it.

6. Exit the Multi-Camera Editor to further refine and output the project using Pinnacle Studio.

   Important! It’s recommended that you finish your multi-camera editing before you exit the Multi-Camera Editor. Changes that you make to your project in another editor might not be supported if you re-open the project in the Multi-Camera Editor. This means that some changes will be reverted.

**Importing video and audio clips into the Multi-Camera Editor**

The first step in creating a multi-camera project is to import your clips into the Multi-Camera Editor. In most cases, this will be a selection of clips from the same event that have been imported to the Pinnacle Studio Library.

You can work with up to six video clips at one time and include up to two independent audio clips.

**To import video clips into the Multi-Camera Editor**

1. In the Pinnacle Studio Library, select all the clips you want to use.

2. On the timeline toolbar, click the Multi-Camera Editor button.

3. In the Multi-Camera Import window, type a name in the Project Name box.

4. Verify the clips in the project clip list in the right pane.
   - If you want to reorder the clips, drag a clip to a new position in the list.
   - If you want to add more video or audio clips, choose the track you want in the Library pane, and drag it to the project clip list.
   - If you want to remove a clip, right-click a clip and choose Remove.

5. Click OK.

**Synchronizing video and audio clips in multi-camera projects**

You can synchronize your video and audio clips so that they are all aligned to the same moment in time. The easiest way to do this is to let the Multi-Camera Editor analyze the audio for each of the clips and sync the clips automatically. If your recordings are planned,
you can use a special audio signal, such as clapping your hands (similar function to using a clapper board in professional shoots). Some events have natural audio cues that help the sync process, such as music performances or sporting events with a start signal.

You can also synchronize the clips by using markers, shooting time, or you can adjust them manually by dragging the clips in the timeline to the timecode you want. For example, you could use a common visual element, such as a flash to sync videos manually. These methods are helpful if your video footage doesn’t include audio or the audio waveforms within the clips are difficult to sync, or you simply prefer to align the clips manually.

In some cases you might need to use a combination of the synchronization options, depending on your source footage.

**To synchronize video and audio clips in the Multi-Camera Editor**

1. After importing your clips to the **Multi-Camera Editor**, choose one of the following options from the **Source Sync Type** drop-list on the toolbar:

   - **Audio** — Click the **Sync** button next to the drop-list to synchronize the clips in the timeline. Note: Your video clips must include audio to use this option.
   - **Marker** — Select a clip in the timeline, play the clip or scrub to the position you want by using a visual cue, and click the **Set/Remove Marker** button on the toolbar to add a marker. After a marker has been added to each clip, click the **Sync** button on the toolbar to align the clips according to the markers.
   - **Shooting Date/Time** — Click the **Sync** button to synchronize the clips according the shooting date and time as indicated by the metadata recorded by the camera. Note: The clocks must be in sync on the cameras to get accurate results.
   - **Manual** — In the timeline, drag each clip to the position you want by using a visual cue.

   **Note:** If there are clips that you want to exclude from the synchronization process, click the **Exclude from Synchronization** button on the corresponding track. Click the button again (**Enable for Synchronization**) to include the track.

   **Tip:** After you synchronize your clips, you can use the **Lock** buttons on the individual tracks to ensure that the tracks stay synchronized during the editing process.

**Choosing an audio source for your multi-camera project**

After you import and synchronize your clips in the **Multi-Camera Editor**, you can make some decisions about the audio for your project. For example, if you have four video clips, and they all include audio, it is recommended that you listen to each clip individually, and choose the one that has the best sound quality. You can also choose to use a separate audio clip.
Other options let you use the audio from all clips, none of the clips, or switch audio (Auto) when you switch cameras, a choice you might make to take advantage of the audio captured with sport or other action footage.

By default, the audio for **Camera 1** is selected.

**To choose an audio source for your multi-camera project**

1. With your clips displaying in the Multi-Camera Editor timeline, on the toolbar, click the Main Audio box and choose a Camera or Audio clip. Click Play to listen the quality of the audio for each clip.

2. Choose the Camera or Audio clip that you want to use for your project. The audio from all other tracks will be muted.

Other options include:
- **Auto** — Switches the audio to match the clip that you are playing
- **None** — No audio is included in the multi-camera project. You can add your audio in Pinnacle Studio, after you leave the Multi-Camera Editor.
- **All Cameras** — Plays audio from all clips, simultaneously

**Tip:** If you plan to edit the audio in Pinnacle Studio after you exit the Multi-Camera Editor, please note that the setting you choose in Main Audio determines what tracks will be available as audio tracks in Pinnacle Studio.

**Editing multiple clips to create a multi-camera compilation**

After you import and synchronize your clips in the Multi-Camera Editor, and choose your audio settings, you can start editing your clips to create a multi-camera compilation. The multi-view pane in the Multi-Camera Editor helps make this task fun and easy. Much like a DJ switches and blends tracks to create a new music compilation, the Multi-Camera Editor lets you visually switch between video tracks and blend them together with transitions.

If you notice that playback is slow or lacks smoothness, you can check the Smart Proxy settings. For more information, see “Using Smart Proxy for a faster, smoother editing experience” on page 268.

After you build your basic compilation using the multi-view pane and the main preview pane, you can fine-tune your project in the Multi-Camera track and take advantage of editing features, such as transitions and a clip splitting tool. Note that some types of edits, such as rotating a clip, must be done in the individual Camera tracks before you add the clips to your compilation in the Multi-Camera track.
To create a multi-camera compilation

1. With your clips in the Multi-Camera Editor timeline, click the Play button below the main preview pane. Footage from all cameras can be viewed simultaneously in the multi-view pane.

2. To start building your project, as the videos play in the multi-view pane, click the preview for the camera that you want to show. The footage from the selected camera displays in the main preview pane.

3. To switch cameras, click a different camera preview in the multi-view pane. You can switch cameras as many times as you like. You can review your project in the Multi-Camera track.

   The Multi-Camera track in the timeline displays the camera segments in your compilation.

   If you want to adjust the zoom level for the Multi-Camera track, drag the zoom level slider in the lower left corner of the timeline.

4. After you have completed a first pass using the multi-view pane, you can refine the timing for a switch in the Multi-Camera track by playing your project or scrubbing to the position that you want to edit, clicking a camera segment and dragging the edge until the frame where you want the switch to occur appears in the main preview pane.

   To switch a segment in the Multi-Camera track to a different Camera, right-click the segment and choose a different Camera from the context menu or click the camera preview in the multi-view pane.
To add a transition between multi-camera segments

1. In the Multi-Camera track, click a segment.
2. On the toolbar, click the Transition button [ ]. The button has a yellow outline when active and a transition icon (“AB”) appears in the timeline. If the button is grayed out, gently drag the edge of a segment by a small amount to reactivate the button.
   A Crossfade transition is applied by default.
3. On the toolbar, type a time in the Duration box for the transition.

   Tip: You can add black or blank segments to your project. You can change a segment that is already in the Multi-Camera track to a black or a blank by right-clicking the segment and choosing Black or Blank. You can apply a transition between a video segment and a Black segment. To add a black or blank segment while playing your project, instead of clicking a camera preview in the multi-view pane, click the Black (B) or Blank (O) swatch to the right of the camera previews.

To split a clip in the Multi-Camera Editor

1. In the timeline, select a clip in the Multi-Camera or PIP track and click Play or drag the scrubber to the position where you want to make the cut.
2. Click the Split Clip button.

   Note: Splitting a clip is useful when you want to replace part of a segment with a different camera, essentially adding another switch.

Adding picture-in-picture (PIP) in the Multi-Camera Editor

You can add a picture-in-picture (PIP) effect to your multi-camera project. PIP lets you play a video in one area of the screen while the main video plays in the background.
The image above illustrates the concept of picture-in-picture (PIP).

To add a picture-in-picture (PIP) effect to your multi-camera project

1. After you create your multi-camera compilation in the Multi-Camera track, click the Play button or scrub to the position in the Multi-Camera track where you want to add a PIP effect.
2. In the timeline, click the circle on the PIP track to activate the track.
   The circle will have a red fill when active.
3. In the multi-view pane, click the preview for the Camera you want to use.
   The segment is added to the PIP track.
4. To set the end point for the segment, in the PIP track, click the end of the segment and drag it to the position you want in the timeline.
5. To choose a corner for the PIP, click the Change PIP Position button on the PIP track and choose the position you want.
   The PIP position can be seen in the main preview pane.

Managing multi-camera source files

You can use the Source Manager to add and remove video and audio clips from tracks in your multi-camera project. You can also view information about the clips, such as the duration of the clip, clip location, and you can lock or unlock tracks.

To add, remove or manage clips with the Source Manager

1. In the upper left corner of the timeline, click the Source Manager button.
2. In the Source Manager dialog box, do any of the following:
   • Click the Lock/Unlock button for a track to unlock a track for editing or to lock a track to prevent editing.
• To add a clip to a track, select a track, click the Add Clips button, navigate to the clip you want to add, and click Open. The clip appears in the numbered list for the track.
• To delete clips from a track, select a track, in the list of clips for that track, mark the check box next to the clips that you want to delete, and click the Delete button.

**Saving and exporting your multi-camera project**

When you finish building your multi-camera project, you can save it so that it can be edited, exported, and shared from Pinnacle Studio.

**Important!** It's recommended that you finish your multi-camera editing before you exit the Multi-Camera Editor. Changes that you make to your project in another editor might not be supported if you re-open the project in the Multi-Camera Editor. This means that some changes will be reverted.

**To save your multi-camera project**

• Click the OK button at the bottom of the window to save your project to the current name (as indicated in the upper-right corner of the window). This also closes the Multi-Camera Editor.

If you want to rename your project, before you exit, click the Settings button, choose Save As, and type a name in the Project name box.

Your multi-camera project appears in the Pinnacle Studio Library.

To open your multi-camera project (.mcam) in Pinnacle Studio, in the Edit workspace, drag your multi-camera project from the Library to the Timeline. By default, the project appears as a composite clip. To expand the clip to work with individual tracks, right-click the clip in the Timeline and choose Edit Movie.

**Using Smart Proxy for a faster, smoother editing experience**

The main purpose of Smart Proxy is to provide a more fluid editing and previewing experience when working with large, high resolution video files.

Smart Proxy creates lower resolution working copies of larger source files. These smaller files are called “proxy” files. Using proxy files speeds up editing of high resolution projects (for example, projects that have HDV and AVCHD source files).

Proxy files are source-dependent rather than project-dependent. In other words, proxy files can be shared among different projects.

When you render a video project, the original, high-quality video source files are used.
You can use the **Smart Proxy Manager** to enable or disable **Smart Proxy**, change the default resolution threshold that enables **Smart Proxy**, and access the **Smart Proxy File Manager** and **Smart Proxy Queue Manager** to manage existing and future proxy files.

### To enable or disable Smart Proxy

- Click the **Settings** button > **Smart Proxy Manager** > **Enable Smart Proxy**.
  
  **Note:** The **Smart Proxy** feature is enabled by default if the computer’s hardware can support the feature.

### To set the resolution threshold and location for Smart Proxy files

1. Select **Settings** > **Smart Proxy Manager** > **Settings**.
2. In the **Smart Proxy** dialog box, set a resolution threshold for the creation of proxy files and choose a proxy folder.

### To manage proxy files

1. Select **Settings** > **Smart Proxy Manager**, and choose one of the following options:
   - **Smart Proxy File Manager** — Lists the source and proxy files. You can use this manager to delete proxy files you no longer need.
   - **Smart Proxy Queue Manager** — Lists source files for which proxy files will be generated (according to the current settings)
You can use the **3D Title Editor** to create three-dimensional titles and objects for your movie projects. You can control the look of the text as well as how it moves across the screen. For example, you can create a metallic gold title that spins on and off screen or you can create a stone-textured title where each letter or word scales and moves independently. You can also use preset objects or create your own 3D objects.

For information about standard (2D) titles, see “The Title Editor” on page 151.

This section contains the following topics:

- 3D Title Editor workspace
- Creating and editing 3D titles
- 3D objects

### 3D Title Editor workspace

The **3D Title Editor** window consists of the following components:

1. **Presets panel**
2. **Player panel**
3. **Settings panel**
4. **Timeline panel**
5. **Object List (Layers)**
6. **Timeline toolbar**

*Areas of the 3D Title Editor: 1. Presets panel; 2. Player panel; 3. Settings panel; 4. Timeline panel; 5. Object List (Layers); 6. Timeline toolbar*
1 **Presets panel**: Lets you get started quickly with ready-made Text Objects and styles, including lighting, camera, and material options.

2 **Player panel**: Lets you view your 3D text and work interactively with it to set position, orientation, and more. Use the playback controls to preview your 3D title.

3 **Settings panel**: Customize your text by choosing settings for Text, Color, Texture, Bevel, Opacity, Lights and more.

4 **Timeline panel**: Lets you add, edit, and remove keyframes for the text object properties. You can also add and delete text object layers, access the **Object List**, and use the tools and controls on the Timeline toolbar. The scrubber in the Timeline panel is synchronized with the **Player panel**.

5 **Object List**: If you have multiple text objects in your project (separate words or letters, for example), you can choose which object you want to display in the timeline by using the Object List drop-down menu above the keyframe headers. The name of the layer is determined by the text that you type in the Text Settings box.

6 **Timeline toolbar**: Lets you type specific values for keyframes and switch between **Move**, **Rotate**, and **Resize** modes so you can make interactive changes in the Player panel. You can also add or delete text object layers from the timeline.

---

### Creating and editing 3D titles

Here are the basic steps for creating a 3D title:

1. Choose a preset text object or work with the default text object.

2. Modify the settings for the text object to get the look you want.

3. In the Timeline panel, start setting keyframes so you can apply changes to the style and movement of the text.

4. Preview your project in the Player panel, adjusting settings and keyframes to get the effect you want.

5. Click **OK** to return to the main application, where your 3D title appears on the timeline.

Experimenting is a good way to learn what is possible in terms of text styles and movements.

---

### To create a 3D title

1. In Pinnacle Studio, do one of the following:
   - Click the **Create 3D Title** button in the timeline toolbar.
   - In the **Library** panel, choose the **Title > 3D Title** category, drag a title to the timeline, and double-click it.

   The **3D Title Editor** opens.

2. In the **Settings** panel, replace the default text by typing your text in the **Text Settings** box.
If you want to have more than one text object (so you can apply different properties to letters or words), in the Presets panel, choose Objects > Text Objects, and click a preset thumbnail for each object that you want to add, using the Text Settings box to type the final text for each object. At any point, you can select a specific text object for editing by clicking the object in the Player panel.

3 In Text Settings area of the Settings panel, format the text by using any of the spacing, alignment, font, and size options.

4 To determine the properties for your title in the starting position, in the Timeline panel, click the name of the property that you want to adjust and do one of the following:
   • For Position, Orientation (Rotate), and Scale (Resize), drag in the Player panel or for precise settings, type values in the X, Y, and Z boxes on the Timeline toolbar.
   • For Color and Opacity, in the Settings panel, adjust the settings in the Color and Opacity areas.

   If you want to adjust the Texture, Bevel, Lights, or Camera settings for the title, adjust the settings in the corresponding area or in the Presets panel, choose presets from Scene and Object Style. These settings do not have keyframes.

5 In the Timeline panel, set any additional keyframes (for example your end point keyframes), and set the properties you want for each keyframe.

   If you simply have a start and end keyframe, a gradual change is applied between the two keyframes. Set more frequent keyframes for faster changes.

6 Use the playback controls in the Player panel to preview your 3D title.

7 When you are finished editing your 3D title, click OK to close the 3D Title Editor window. Your title is inserted in the Timeline.

3D objects

You can add 3D (three-dimensional) objects to your video projects in the same way that you can add 3D text.

To add a 3D object

1 In Pinnacle Studio, click the Create 3D Title button in the timeline toolbar. The 3D Title Editor window opens.

2 Do one of the following:
   • In the Presets panel on the left, open the Objects section and choose an object from one of the following categories:
     • Extruded Objects
     • Lathe Objects
   • In the Timeline, click one of the following buttons on the toolbar:
     • Add Graphic
• Add Lathe
• Add Geometric

3 In the Settings panel, adjust the settings you want.

If you want to perform advanced editing to the shape of the object, click the Edit Object button, and in the editor window that appears, use the tools available to modify the shape of the object.

4 Modify the object’s properties and movement the same way you would for 3D text. For more information, see “Creating and editing 3D titles” on page 272.
Pinnacle Studio includes a collection of color adjustment tools that let you correct the color in video clips or let you get creative with color grading to achieve a specific mood or look. The color controls available in Pinnacle Studio depend on the version of the application you have.

This section contains the following topics:

- Using the Color controls
- Tone Curve
- HSL Tuning
- Color Wheel
- Video scopes

**Using the Color controls**

When you making color adjustments, you have access to the Color Grading view in the Player panel.

In addition to creating your own creative look, you can import LUT profiles (lookup table).

In many cases, you can achieve good results using the **Basic** controls, but the other color correction and color grading tools offer more precise control. Sometimes it is a matter of preference, sometimes it is a matter of one tool providing an easier way to get a specific result.

**Video Scopes**

Video scopes offer a way of evaluating the tone and color of your video clip by displaying the color data for the clip in different visual representations. Because the information is data-based, scopes can help you adjust color and tone without relying solely on the color calibration of the screen that you’re working with. For more information about Video scopes, see “Video scopes” on page 278.

**To access color correction and color grading controls**

1. Select a clip in the Timeline.
2 Open the Editor panel, click Color, and choose one of the following options:
   - Basic
   - Tone Curve
   - HSL Tuning
   - Color Wheel

To apply a LUT Profile

1 Select a clip in the Timeline.
2 Open the Editor panel, click Color > Basic.
3 At the bottom of the Basic Settings area, click the drop-down menu beside LUT Profile, and choose a LUT profile or click Browse and navigate to the file you want to apply.

Tone Curve

The Tone Curve lets you perform color and tonal corrections by adjusting either individual color channels or the composite (RGB) channel.

The x-axis of the graph represents the original tonal values (from highlights on the right, to shadows on the left); the y-axis of the graph represents the adjusted tonal values (from dark/less color at the bottom, to light/more color at the top).

The diagonal line on the graph is what you adjust to create your “curve”. Moving the curve up and to the left lightens the clip and increases the color in any channel; moving the curve down and to the right darkens the clip or decreases the color of a given channel. If you have a clip with a blue cast, for example, you can decrease the blue in the image by selecting the Blue channel and moving the curve down and to the right.

You can add one or more nodes to the curve, to give you more precise control over the areas that you want to adjust.

To adjust color and tone with Tone Curve

1 Open the Editor panel, click Color > Tone Curve.
2 Below the curve graph, select one of the following color channel options:
• **RGB** — lets you edit the red, green, and blue channels in a combined histogram
• **Red** — lets you edit the red channel only
• **Green** — lets you edit the green channel only
• **Blue** — lets you edit the blue channel only

3 Drag points on the graph to adjust the relationship between the **Input** levels (the brightness of the original pixels) and the **Output** levels (the brightness of the corrected pixels).

4 If you want to add a point to the curve, click along the line where you want to add the point.
   
   **Note:** At any point you can reset the curve by clicking **Reset All**.

---

### HSL Tuning

HSL (Hue, Saturation, Lightness) is a powerful color adjustment tool that lets you interactively adjust colors in a clip. This lets you target specific colors.

---

*The interactive control (white cursor) on the Color Grading view in the Player panel lets you drag in the image to adjust specific colors. The original source clip colors appear on the left.*

---

### To adjust color with HSL Tuning

1 Open the **Editor** panel, click **Color > HSL Tuning**.

2 Click one of the following tabs:
   
   • **Hue**
   • **Saturation**
   • **Lightness**

3 Do one of the following:
   
   • Click the interactive color tool, in Player panel ensure that the **Color Grading** view is displayed, and drag across a color in the clip that you want to adjust. Dragging to the left, moves the corresponding sliders to the left; dragging to the right, moves the corresponding sliders to the right.
   • Adjust the individual sliders to set the values you want.
**Note:** You can return to the original clip settings by clicking **Reset All**. You can also reset an individual slider by double-clicking the label for the slider.

### Color Wheel

The Color Wheel feature lets you adjust the tone of your image by adjusting the slider next to the Color Shift (applies to all areas of the image), Highlights, Midtones, or Shadows wheel. The wheels let you adjust the colors for specific areas of exposure in the image. For example, you could apply a blue cast to the shadow areas of video clip.

### To adjust the tone or color of a clip with the Color Wheel

1. Select a clip in the Timeline.
2. Open the **Editor** panel, click **Color > Color Wheel**.
3. To adjust the brightness of the clip, drag the slider to the left of the **Color Shift** (entire image), **Highlights**, **Midtones**, or **Shadows** wheel. Dragging the slider up increases brightness for the corresponding areas of the selected video frame. Dragging the slider down decreases brightness.
4. To adjust color, drag the color indicator circle (in the middle of the color wheels) to set a color for the corresponding areas. For example, to remove a blue color cast from dark areas of a video clip, drag the color indicator for the Shadows wheel towards the yellow side of the circle.

### Video scopes

Pinnacle Studio offers the following video scopes to help you evaluate the color and tone information in your video clips. As you make color adjustments, the information on the scopes changes, so you can evaluate the impact of the change in the Color Grading view in the Player panel or by using the color data depicted in the video scope.

#### Waveform

A waveform scope displays the chrominance in a video clip using a graph where the vertical axis represents intensity, from zero at the bottom to 100% at the top.
A Waveform scope shows the distribution of colors from zero intensity at the bottom to 100% intensity at the top

**Vector - Color (Vectorscope)**

Vectorscopes have been used by video professionals for a wide range of purposes, including evaluating if the color intensity of video footage was within standard broadcast range. The circle of the color vector scope displays chrominance (color intensity), from zero intensity at the center of the circle, to 100% intensity towards the edge of the circle. The circle is divided into color areas, making it easy to see the color dispersion for the currently selected frame in the video clip. Small grids towards the edge of the circle are used to mark the intensity limit — pixels that appear beyond the targets are not considered broadcast safe.

**Selective Vectorscope**: This feature is often used to identify and correct skin tone in a video. By using a brush to select skin tones in a video frame, you can use the vectorscope to ensure that the skin tones are aligned along the skin tone line.

**Histogram**

A histogram lets you display the tonal and color range of a video. Evaluating the distribution of pixels for a selected frame in your video lets you determine if there is a color cast or in the case of underexposed footage, it can help you determine if there is enough image data in the shadow areas to correct the imbalance.
The histogram displays the distribution of pixels for the clip, from dark (shadows) to light (highlights) along the horizontal axis.

**RGB Parade**

The RGB Parade scope lets you view the red (R), green (G) and blue (B) components of your video clip in a graph, where the vertical axis represents zero intensity (bottom) to 100% intensity (top).

To display a video scope

1. Select a clip in the Timeline.
2. Open the Editor panel, and click Color.
3. Enable the Show Video Scope check box at the top of the panel.
4. From the drop-down menu, choose one of the following videoscopes:
   - Waveform
   - Vector - Color
   - Histogram
   - RGB Parade
To use Selective Vectorscope to display and correct skin tone

1. Select a clip in the Timeline.
2. Open the Editor panel, and click Color.
3. Enable the Show Video Scope check box at the top of the panel.
4. From the drop-down menu, choose Vector - Color.
5. Below the vectorscope, click Selection Brush.
6. In the Color Grading preview, drag the brush across the areas of skin. The colors selected by the brush display on the vectorscope.
7. Use any of the following controls below the vectorscope to adjust the selected area:
   - Eraser: In the preview, drag over the area you want to remove from the selection.
   - Brush Size: Drag the slider to adjust the diameter of the Selection Brush or Eraser.
   - Clear Selection: Use this button to clear all brushstrokes and redo your selection.

8. Using the Skin Tone Line as a guide (skin tones should fall along the line), make any color adjustments.
9. When you are finished adjusting the colors, click Clear Selection to deactivate Selective Vectorscope mode (yellow Selective Vectorscope is Active label disappears) and to return to viewing all clip colors in the vectorscope.
Appendix A: Troubleshooting

Before you begin troubleshooting, take some time to check your hardware and software installation. To review the system requirements, see “System requirements” on page 313.

Update your software: We recommend installing the latest operating system updates for Windows.

Free space: Make sure you have 10 GB or more on your boot drive for paging.

Check your hardware: Ensure that all installed hardware is functioning normally with the latest drivers, and is not flagged as having a problem in Device Manager (see below). If any devices are flagged you should resolve the issue before starting the installation.

Get the latest drivers: We also highly recommend installing the latest drivers for your graphics card. Each time it is launched, Pinnacle Studio verifies that cards support DirectX.

Opening Device Manager: The Windows Device Manager, which lets you configure your system’s hardware, has an important role in troubleshooting.

The first step in accessing Device Manager is to right-click on My Computer, and then select Properties from the context menu. This opens the System Properties window. The Device Manager button is listed on the left panel.

Ensure that all installed hardware is functioning normally with the latest drivers, and that nothing has been flagged in Device Manager with the yellow exclamation mark icon indicating an error condition. In the case of a driver problem that you cannot resolve yourself, contact the device manufacturer or your computer vendor for assistance.

This section contains the following topics:
- Contacting support
- Forums
- Compatibility with past content
- Capture hardware compatibility
- Serial number information

Contacting support

Learn about all of your support options on our website:
www.pinnaclesys.com/support
Most common issues are already documented in our Knowledgebase and we encourage you to use this option first. To search the support Knowledgebase effectively, please include the name of the product in your query.

**Forums**

Please visit our discussion forums to join the conversation on Pinnacle Studio. Scroll down the forum list to find the forum in your language:

go.pinnaclesys.com/forums

**Compatibility with past content**

Much, but not all, of the additional creative content from previous versions Pinnacle Studio can be used directly in the current version of Pinnacle Studio, as can many content offerings from third-party providers. Some of these are included in the product itself. A few of the third-party content packages require a paid upgrade to work with Pinnacle Studio. For some others, no compatible version has been released. For more information, visit the Knowledgebase available from www.pinnaclesys.com/support.

**Capture hardware compatibility**

Pinnacle Studio has been tested and found to work successfully with a wide variety of video capture hardware. However, some older devices are not supported.

**Supported hardware**

The following capture devices will work with all versions of Pinnacle Studio.

**USB-based**

- 710-USB
- 510-USB
- 700-USB
- 500-USB
- MovieBox Deluxe
- DVC-90
- DVC-100
- DVC-101
- DVC-103
- DVC-107
- DVC-130 (no 64-bit drivers available)
- DVC-170 (no 64-bit drivers available)
PCI-based
- 700-PCI (Pinnacle Studio Deluxe 2)
- 500-PCI (Pinnacle AV/DV)
- Any 1394 card

Unsupported hardware

The following list of hardware came with older versions of Studio and is no longer in warranty or supported.
- DC10
- DC10 Plus
- MovieBox® DV
- Dazzle® DVC 80, 85
- Linx
- MP 10
- S400

Serial number information

For a product that you downloaded, the serial number is shown on the confirmation page at the end of the ordering process, and in the confirmation email sent at that time.

If you own a physical copy of the product, the serial number is shown on either the inside or the outside of the DVD case, if one is included; and on the outside of the paper sleeve otherwise.

If you have lost your serial number and have registered your software, visit http://apps.pinnaclesys.com/cdb/register/getserialnumbers.aspx.

General troubleshooting

Here are some further avenues to explore if you are having trouble running the application.

1. **Restart the computer**: Unstable software behavior of undetermined cause can often be fixed by resetting the system. This is almost always a good place to start when troubleshooting.

2. **Wait a few minutes**: If Pinnacle Studio still won’t launch, wait a few minutes to let it finish launching. On some computers it may take a little while for the launch to complete.

3. **Update Studio**: When troubleshooting any problem, it is always best to use the latest version of the software if possible.

4. **Disconnect capture hardware**: If possible, unplug any capture hardware and try launching Pinnacle Studio again. If you can’t launch with your webcam plugged in, try it...
unplugged, and vice-versa. You may have to set the webcam up in the same way every time you launch Studio.

5 **Download and reinstall hardware drivers:** During the Studio software launch process we do check that you have a DirectX compatible graphics and sound card. Download and reinstall the latest version of the driver for the graphics card that is on your system. If you need assistance with this step, please contact the graphics card manufacturer.

6 **End background tasks:** There are a couple ways to accomplish this. One is to use start-up management software to assist in eliminating unnecessary programs that launch on Windows start-up. Many shareware and freeware programs of this type have been created. Use an Internet search engine such as Google or Yahoo to search for ‘startup managers’. We don’t endorse any particular one, but recommend you try a couple to see which one works best for you.

   Alternatively, you can also use the Microsoft System Configuration Utility (msconfig), which is part of Windows, to disable start-up programs.

   Whichever route you take, we recommend disabling all programs and then re-enabling them one at a time until the conflicting program is located.

7 **Reinstall:** If all of the above fail, you may want to try uninstalling Pinnacle Studio from the Control Panel "Programs and Features" list. Once it is uninstalled, reinstall Pinnacle Studio and try launching again.
To shoot good video, then create from it an interesting, exciting or informative movie, is something anyone with a little basic knowledge can achieve.

Starting from a rough script or shooting plan, the first step is to shoot your raw video. Even at that stage, you should be looking ahead to the editing phase by making sure you will have a good set of shots to work from.

Editing a movie involves juggling all your fragments of footage into some kind of harmonious whole. It means deciding on the particular techniques, transitions and effects that will best express your intent.

An important part of editing is the creation of a soundtrack. The right sound – dialog, music, commentary or effect – can work with the visuals to create a whole greater than the sum of its parts.

Pinnacle Studio has the tools you need to create professional-quality home video. The rest is up to you – the videographer.

This section contains the following topics:
- Creating a shooting plan
- Editing a video project
- Rules of thumb for video editing
- Soundtrack production
- Giving your project a title

Creating a shooting plan

It is not always necessary to have a shooting plan, but it can be very helpful for large video projects. The plan can be as simple or as complex as you like. A simple list of planned scenes might be enough, or you might also want to include some notes regarding detailed camera directions or prepared dialog. The really ambitious can go all the way to a full-fledged script in which every single camera angle is described in detail along with notes about duration, lighting and props.
Draft of a simple shooting plan

<table>
<thead>
<tr>
<th>No.</th>
<th>Camera angle</th>
<th>Text / Audio</th>
<th>Duration</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Jack's face with helmet, camera zooms out</td>
<td>“Jack is driving his first race...”. Noise of engines in the background.</td>
<td>11 sec</td>
<td>Tue. 06/22</td>
</tr>
<tr>
<td>2</td>
<td>On the starting line, driver’s perspective; low camera position.</td>
<td>Music is played in the hall, noise of engines.</td>
<td>8 sec</td>
<td>Tue. 06/22</td>
</tr>
<tr>
<td>3</td>
<td>Man with a starting flag is accompanied into the scene to the start position. Camera stays, man goes out of the scene after start.</td>
<td>“Let’s go...”. Carry out the start, add starting signal.</td>
<td>12 sec</td>
<td>Tue. 06/22</td>
</tr>
<tr>
<td>4</td>
<td>Jack on the start position from the front, camera follows, shows Jack up to the bend, now from behind.</td>
<td>Music from the hall no longer audible, fade up same music from CD over noise of engines.</td>
<td>9 sec</td>
<td>Tue. 06/22</td>
</tr>
</tbody>
</table>

Editing a video project

Using varying perspectives

An important event should always be shot from varying perspectives and camera positions. Later, during editing, you can use the best camera angles alone or in combination. Make a conscious effort to tape events from more than one camera angle (first the clown in the circus ring, but then also the laughing spectator from the clown’s point of view). Interesting events can also take place behind the protagonists or the protagonists may be seen in a reverse angle. This can be helpful later when trying to establish a sense of balance in the movie.

Close-ups

Don’t be stingy with close-ups of important things or persons. Close-ups usually look better and more interesting than long shots do on a television screen, and they work well in post-production effects.

Long shots / Semi-long shots

Long shots provide the viewer with an overview and establish the scene of the action. However, these shots can also be used to tighten longer scenes. When you cut from a close-up to a long shot, the viewer no longer sees the details, and it is thus easier to make a
chronological jump. Showing a spectator in a semi-long shot can also provide visual relief from the main action, and the opportunity of a transition away from the action if desired.

**Complete actions**

Always shoot complete actions with a beginning and an end. This makes editing easier.

**Transitions**

Cinematic timing requires some practice. It is not always possible to film long events in their entirety, and in movies they often have to be represented in severely abbreviated form. Nonetheless, the plot should remain logical and cuts should almost never call attention to themselves.

This is where the transition from one scene to the next is important. Even if the action in neighboring scenes is separated in time or space, your editorial choices can make the juxtaposition so smooth that the viewer bridges the gap without conscious attention.

The secret to a successful transition is establishing an easily-felt connection between the two scenes. In a plot-related transition, the connection is that of successive events in an unfolding story. For example, a shot of a new car might be used to introduce a documentary about its design and production.

A neutral transition doesn’t in itself imply a story development or a change of time or place, but can be used to smoothly connect different excerpts from a scene. For example, cutting away to an interested audience member during a podium discussion lets you then cut back unobtrusively to a later point in the same discussion, omitting the part between.

External transitions show something apart from the action. For example, during a shot inside the marriage registry, you might cut to the exterior of the marriage registry, where a surprise is already being set up.

Transitions should underscore the message of the film and must always fit the respective situation, in order to avoid confusing viewers or distracting from the actual story line.

**Logical sequence of action**

The shots strung together during editing must interact appropriately in relation to the action. Viewers will be unable to follow the events unless the story line is logical. Capture viewer interest from the very beginning with a fast-paced or spectacular start and maintain that interest until the very end. Viewers can lose interest or become disoriented if scenes are strung together in a manner that is illogical or chronologically false, or if scenes are too hectic.
or short (under three seconds). There should be some continuity of motif from one scene to the next.

**Bridging the gaps**

Make an effort to bridge the gaps from one filming location to another. You can use close-ups, for example, to bridge chronological jumps, zooming in on the face, then back out after a few seconds onto a different scene.

**Maintain continuity**

Continuity – consistency of detail from one scene to the next – is vital in providing a satisfying viewing experience. Sunny weather does not fit with spectators who opened their umbrellas.

**Tempo of cuts**

The tempo at which a film cuts from one scene to the next often influences the message and mood of the film. The absence of an expected shot and the duration of a shot are both ways of manipulating the message of the film.

**Avoid visual disjunctions**

Stringing together similar shots in succession may result in visual disjunctions. A person may be in the left half of the frame one moment and in the right half of the frame the next, or may appear first with and then without eyeglasses.

**Do not string together pan shots**

Pan shots should not be strung together unless they have the same direction and tempo.

**Rules of thumb for video editing**

Here are some guidelines that may be helpful when you come to edit your movie. Of course, there are no hard and fast rules, especially if your work is humorous or experimental.

- Do not string together scenes in which the camera is moving.
- Pans, zooms, and other moving shots should always be separated by static shots.
- Shots that follow one another should be from different camera positions. The camera angle should vary by at least 45 degrees.
- Sequences of faces should always be shot alternately from varying angles of view.
• Change perspectives when shooting buildings. When you have similar shots of the same type and size, the picture diagonal should alternate between front left to rear right and vice versa.
• Make cuts when persons are in motion. The viewer will be distracted by the ongoing motion and the cut will go almost without notice. In particular, you can cut to a long shot from the middle of the motion.
• Make harmonious cuts; avoid visual disjunction.
• The less motion there is in a shot, the shorter it should be. Shots with fast movements can be longer.
• Long shots have more content, so they should also be shown longer.

Ordering your video sequences in a deliberate manner not only permits you to produce certain effects, but even enables you to convey messages that cannot or should not be shown in pictures. There are basically six methods of conveying messages through cuts. Let’s look at each in turn.

**Associative cuts**

Shots are strung together in a certain order to trigger associations in the mind of the viewer, but the actual message is not shown. Example: A man bets on a horse race and, in very next scene, we see him shopping for an expensive new car at a car dealership.

**Parallel cuts**

Two actions are shown in parallel. The film jumps back and forth between the two actions; making the shots shorter and shorter until the end. This is a way of building suspense until it peaks. Example: Two different cars drive from different directions at high speed toward the same intersection.

**Contrast cuts**

The film purposely cuts unexpectedly from one shot to another, very different shot, in order to point up the contrast to the viewer. Example: A tourist lying on the beach; the next shot shows starving children.

**Substitutionary cut**

Events that cannot or should not be shown are replaced by other events (a child is born, but instead of childbirth, the blossoming of a flower bud is shown).
Cause and effect cuts

Shots are related by virtue of cause and effect: without the first shot, the second would be incomprehensible. Example: A man fights with his wife and, in the very next shot, is seen sleeping under a bridge.

Formal cuts

Shots that vary in content can be strung together if they have something in common – the same shapes, colors, or motions, for example. Examples: A crystal ball and the earth; a yellow raincoat and yellow flowers; a falling skydiver and a falling feather.

Soundtrack production

Soundtrack production is an art, but it is an art one can learn. Of course, it is no easy task to create a superb narration, but short, informative comments are often very helpful for the viewer. Whatever narration there is should sound natural, expressive and spontaneous, not wooden or stiff.

Keep comments brief

A general rule applicable to all commentary is that less is more. Pictures should speak for themselves, and things that are evident to viewers from the pictures require no comment.

Preserve original sounds

Spoken commentary should be mixed with both the original sounds and the music in such a way that the original sounds can still be heard. Natural sound is part of your video footage and should not be cut away altogether if at all possible, because video without natural sound can easily seem sterile and lacking in authenticity. Frequently, however, the recording equipment captures noises from aircraft and cars that do not appear in the scene later. Sounds such as these, or loud wind noises, which can be distracting or annoying, should be masked, filtered or replaced with appropriate narration or music.

Select appropriate music

Appropriate music adds a professional finishing touch to your movie and can do a lot to reinforce the message of a video. The music selected, however, should always be appropriate to the message of the film. This is sometimes a time-consuming matter and a challenge, but greatly appreciated by the viewer.
**Giving your project a title**

The title should be informative, describe the contents of the movie, and arouse interest. If it’s also a striking turn of phrase, so much the better.

When it comes to presentation, the Title Editor gives almost unlimited scope for creative visuals. It’s one place in your production where you’re not tied to the reality of actual footage, so you can let your fancy run free.

Of course, the ultimate goal is to communicate, so some basics almost always hold true. For instance, a concise title in a large, legible font is likelier to get its message across than one that is over-decorated or too long.

**Title colors**

The following combinations of background and text are easy to read: white with red, yellow with black, and white with green. Exercise caution with very white titles on a very black background. Some video systems are unable to handle contrast ratios in excess of 1:40 and are unable to reproduce such titles in detail.

**Time on screen**

As a rule of thumb, a title should be displayed long enough to be read twice. Allow about three seconds for a title with ten letters. Allow an additional second of on-screen time for every five additional letters.

**‘Found’ titles**

Besides postproduction titles, natural titles like directional signs, street signs or title pages of local newspapers also create interesting possibilities.
Multimedia terminology contains computer and video terminology. The most important terms are defined below.

**4K:** A video resolution that is approximately 4,000 pixels in width. It is also known as Ultra High-Definition or Ultra HD. The term is used to refer to all screen standards that are at least 3840 x 1080 pixels.

**360:** 360 video is an interactive type of video that lets the viewer look in any direction by changing the viewing angle during playback. 360-degree videos are captured on special cameras or cameras attached to multi-directional mounts.

**720p:** A high-definition (HD) video format with a resolution of 1280x720 and progressive (non-interlaced) frames.

**1081i:** A high-definition (HD) video format with a resolution of 1440x1080 and interlaced frames.

**ActiveMovie:** Software interface by Microsoft for the control of multimedia devices under Windows. See DirectShow, DirectMedia

**ADPCM:** Acronym for Adaptive Delta Pulse Code Modulation, a method of storing audio information in a digital format. This is the audio encoding and compression method used in CD-I and CD-ROM production.

**Address:** All available saving positions in a computer are numbered (addressed). By means of these addresses each saving position can be occupied. Some addresses are reserved for the exclusive use of particular hardware components. If two components are using the same address, this is called an “address conflict”.

**Aliasing:** An inaccurate display of an image due to the limitations of the output device. Typically, aliasing appears in the form of jagged edges along curves and angled shapes.

**Anti-aliasing:** A method of smoothing out jagged edges in bitmap images. This is usually accomplished by shading the edges with pixels intermediate in color between the edge and the background, making the transition less apparent. Another method of anti-aliasing involves using higher resolution output devices.

**Aspect ratio:** The ratio of width to height in an image or graphic. Keeping the aspect ratio fixed means that any change to one value is immediately reflected in the other.
AVI: Audio Video Interleaved, a standard format for digital video (and Video for Windows).

Batch capture: An automated process that uses an Edit decision list (EDL) to locate and recapture specific clips from a videotape, usually at a higher data rate than the clip was originally captured.

BIOS: Acronym for Basic Input Output System, which refers to basic input and output commands saved in a ROM, PROM or EPROM. The essential task of the BIOS is the control of input and output. When the system is started, the ROM-BIOS carries out some tests. See Parallel port, IRQ, I/O.

Bit: Abbreviation of “BInary digiT”, the smallest element of a computer’s memory. Among other things, bits are used to store the color values of pixels in an image. The more bits used for each Pixel, the greater the number of available colors. For example:
- 1-bit: each pixel is either black or white.
- 4-bit allows 16 colors or gray shades.
- 8-bit allows 256 colors or gray shades.
- 16-bit: allows 65,536 colors.
- 24-bit: allows about 16.7 million colors.

Bitmap: An image format made up of a collection of dots or “pixels” arranged in rows. See Pixel.

Blacking: The process of preparing a videotape for insert editing by recording video black and continuous control track on the entire tape. If the recording deck supports timecode, continuous timecode will be recorded simultaneously (also called “striping”).

Brightness: Also “luminance”. Indicates the brightness of video.

Byte: One byte corresponds to eight bits. With one byte, exactly one alphanumeric character can be displayed (i.e. a letter, number).

CD-ROM: Mass storage media for digital data, such as digital video. CD-ROMs can be read from but not written (recorded) onto; ROM is an acronym for Read-Only Memory.

Channel: Classifications of information within a data file to isolate a particular aspect of the file. For example, color images use different channels to classify the color components in the image. Stereo audio files use channels to identify the sounds intended for the left and right speakers. Video files use combinations of the channels used for image and audio files.

Clip: In Pinnacle Studio, any media element used on the timeline of a movie or disc project. Clip media include videos, audio files, photos, titles, and Montage.
**Clipboard**: A temporary storage area shared by all Windows programs, used to hold data during cut, copy, and paste operations. Any new data you place onto the clipboard immediately replaces the existing data.

**Closed GOP**: See GOP.

**Codec**: Contraction of compressor/decompressor – an algorithm that compresses (packs) and decompresses (unpacks) image data. Codecs can be implemented in either software or hardware.

**Color depth**: Number of bits delivering the color information for each pixel. A 1-bit color depth allows $2^{1}=2$ colors, an 8-bit depth allows $2^{8}=256$ colors, and a 24-bit depth allows $2^{24}=16,777,216$ colors.

**Color model**: A way to mathematically describe and define colors and the way they relate to each other. Each color model has its own strengths. The two most common color models are RGB and CMYK.

**Color saturation**: Intensity of a color.

**Complementary color**: Complementary colors are opposite in value to primary colors. If you were to combine a color with its complement, the result would be white. For example, the complementary colors of red, green and blue are cyan, magenta and yellow respectively.

**COM Port**: A serial port located on the back of your computer for attaching a modem, plotter, printer or mouse to the system.

**Composite video**: Composite video encodes luminance and chrominance information into one signal. VHS and 8mm are formats that record and play back composite video.

**Compression**: A method for making files smaller in size. There are two types of compression: lossless and lossy. Files compressed with a lossless scheme can be restored unchanged from their original state. Lossy schemes discard data during compression, so some image quality is sacrificed. The loss of quality may be negligible or severe depending on the amount of compression.

**Cropping**: Choosing the area of an image to be displayed.

**Data rate**: The quantity of data transmitted per unit time; for example, the number of bytes read from or written to a hard drive per second, or the amount of video data processed per second.

**Data transfer rate**: The measurement of the speed at which information passes between the storage device (e.g. CD-ROM or hard drive) and the display device (e.g. monitor or MCI...
device). Depending on the devices used, some transfer rates may offer better performance than others.

**DCT:** Discrete Cosine Transformation – part of JPEG image data compression and related algorithms. The brightness and color information is saved as a frequency coefficient.

**DirectShow:** System extension by Microsoft for multimedia applications under Windows. See ActiveMovie.

**DirectMedia:** System extension by Microsoft for multimedia applications under Windows. See ActiveMovie.

**DirectX:** A bundle of several system extensions developed by Microsoft for Windows 95 and its successors to make possible video and game acceleration.

**Dissolve:** A transitional effect in which the video is faded from one scene to the next.

**Dithering:** Increasing the number of apparent colors in an image by the application of color patterns.

**Decibel (dB):** A unit of measurement of the loudness of sound. An increase of 3 dB doubles the loudness.

**Digital8:** Digital videotape format that records DV-coded audio and video data on Hi8 tapes. Currently sold only by Sony, Digital8 camcorders and VCRs can play both Hi8 and 8mm cassettes.

**Digital video:** Digital video stores information bit by bit in a file (in contrast to analog storage media).

**DMA:** Direct Memory Access.

**Driver:** A file containing information needed to operate peripherals. The video capture driver operates a video capture board, for example.

**DV:** Digital videotape format for recording digital audio and video on ¼”-wide metal evaporated tape. Mini-DV tapes hold up to 60 minutes of content, while standard DV tapes can hold up to 270 minutes.

**ECP:** “Enhanced Compatible Port”. Enables accelerated bi-directional data transfer via the parallel port. See EPP.

**Edit decision list (EDL):** A list of clips and effects in a particular order that will be recorded to your output disc or file. Studio allows you to create and edit your own edit decision list by adding, deleting and reordering clips and effects in the Movie Editor and the Disc Editor.
**EPP**: “Enhanced Parallel Port”. Enables accelerated bi-directional data transfer via the parallel port. See ECP.

**EPROM**: “Erasable Programmable Read-Only Memory”. Memory chip that after programming retains its data without power supply. The memory contents can be erased with ultraviolet light and rewritten.

**Fade to/from black**: A digital effect that fades up from black at the beginning of a clip or down to black at the end.

**Field**: A frame of video consists of horizontal lines and is divided into two fields. The odd lines in the frame are Field 1; the even-numbered lines are Field 2.

**File format**: The organization of information within a computer file such as an image or word processor document. The format of a file is usually indicated by its “file extension” (e.g. doc, avi or wmf).

**Filters**: Tools that alter data to produce special effects.

**FireWire**: Apple Computer’s trademarked name for the IEEE-1394 serial data protocol.

**Field**: A frame of interlaced video consists of horizontal lines and is divided into two fields. The odd lines in the frame are Field 1; the even-numbered lines are Field 2.

**Frame rate**: The frame rate defines how many frames of a video sequence are played in one second. The frame rate for NTSC video is 30 frames per second. The frame rate for PAL video is 25 frames per second.

**Frame size**: The maximum size for displaying image data in a video or animation sequence. If an image intended for the sequence is larger than the frame size, it must be cropped or scaled to fit.

**Frequency**: The number of repetitions in a periodic process (like a sound wave or an alternating voltage) per unit of time. Usually measured in repetitions per second, or Hertz (Hz).

**GOP**: In MPEG compression the data stream is first divided into “Groups Of Pictures” – sections of several frames each. Each GOP contains three types of frames: I-Frames, P-Frames (pictures) and B- Frames.

**GOP size**: The GOP size defines, how many I-Frames, B-Frames and P-Frames are included in one GOP. For example, current GOP sizes are 9 or 12.

**Hardware codec**: Compression method that uses special hardware to create and play back compressed digital video sequences. A hardware codec may offer better encoding speed
and image quality than a codec implemented completely in software. See Codec, Software codec

**HD:** High Definition video. Most HD formats in use have a resolution of either 1920x1080 resolution or 1280x720 resolution. A substantial difference exists between the 1080 and 720 standards: the larger format uses 2.25 more pixels per frame. This difference substantially increases requirements for processing 1080 content in terms of encoding time, decoding speed, and storage. The 720 formats are all progressive. The 1080 format has a mixture of progressive and interlaced frame types. Computers and their displays are inherently progressive, whereas television broadcasting has been based on interlaced techniques and standards. For HD terminology, we indicate progressive with the letter ‘p’ and interlaced with the letter ‘i’.

**HDV:** A format for the recording and playback of high-definition video on a DV cassette tape. has been established as the ‘HDV’ format. Instead of the ‘DV’ codec, HDV uses a flavor of MPEG-2. There are two varieties of HDV: HDV1 and HDV2. HDV1 is 1280x720 resolution with progressive frames (720p). The MPEG transport stream is 19.7 Mbps/s. HDV2 is 1440x1080 resolution with interlaced frames (1080i). The MPEG transport stream is 25 Mbps/s.

**Hi8:** Improved version of Video8 using S-Video recorded on metal particle or metal evaporated tape. Because of higher luminance resolution and wider bandwidth, the result is sharper pictures than Video8.

**HiColor:** For images, this normally means a 16-bit (5-6-5) data type that can contain up to 65,536 colors. TGA file formats support images of this type. Other file formats require prior conversion of a HiColor image into TrueColor. For displays, HiColor normally refers to 15-bit (5-5-5) display adapters that can display up to 32,768 colors. See Bit.

**Huffman coding:** Technique used in JPEG and other data compression methods in which seldom occurring values receive a long code, while frequently-occurring values receive a short code.

**IDE:** “Integrated Device Electronics” – a hard-drive interface that combines all drive control electronics on the drive itself, rather than on the adapter connecting the drive to the expansion bus.

**IEEE-1394:** Developed by Apple Computers and introduced as FireWire, this is a serial data transmission protocol with rates up to 400 Mbits/sec. Sony offers a slightly modified version for transmitting DV signals named i.LINK, providing transmission speeds up to 100 Mbits/sec.
**Image**: An image is a reproduction, or picture of something. The term is often applied to digitized pictures, consisting of pixels, that can be shown on a computer display and manipulated by software.

**Image compression**: Method of reducing the amount of data required to store digital image and video files.

**Interlaced**: The screen refresh method used by television systems. The PAL TV image consists of two interleaved image halves (fields) of 312½ lines each. The NTSC TV image consists of two image halves of 242½ lines each. The fields are displayed alternately to produce a blended image.

**Interleave**: An arrangement of audio and video to promote smoother playback and synchronization or compression. The standard AVI format equally spaces audio and video.

**I/O**: Input/Output.

**IRQ**: “Interrupt Request”. An “interrupt” is a temporary break in the main processing stream of a computer so that housekeeping or background tasks can be performed. Interrupts can be requested by either hardware (e.g. keyboard, mouse) or software.

**JPEG**: Joint Photographic Experts Group, and the standard developed by them for compressing digital frames based on DCT.

**Kbyte (also KB)**: One Kbyte (kilobyte) contains 1024 bytes. The “K” here stands for the number 1024 (2¹⁰), and not 1000 as in the metric prefix.

**Key color**: A color whose display is suppressed so that a background image can show through. Most commonly used when overlaying one video sequence on top of another, allowing the underlying video to display wherever the key color appears.

**Keyframe**: A video frame for which the value of a particular parameter of a video or audio effect is specified. During playback the animation of effects is accomplished by adjusting parameters smoothly from one key-framed value to the next. Animating effects by means of keyframes is often called ‘keyframing’.

**LPT**: See Parallel port.

**Luminance**: See Brightness.

**M1V**: (File extension for) an MPEG file that contains video data only.

**Mbyte (also MB)**: One Mbyte (megabyte) corresponds to 1024 Kbytes – 1024 x 1024 bytes.

**Mark In / Mark Out**: In video editing, the mark in and mark out times refer to the starting and ending timecodes that identify the portions of clips to be included in the project.
**MCI:** Media Control Interface. Programming interface developed by Microsoft recording and playing back audio and video data. It is also used to connect a computer to an external video source such as a VCR or laser disc.

**Modulation:** The encoding of information upon an empty carrier signal.

**Motion-JPEG (M-JPEG):** A Video for Windows format, specified by Microsoft, for encoding video sequences. JPEG compression is used to compress each frame individually.

**MPA:** (File extension for) an MPEG file that contains audio data only. M1V, MPEG, MPG

**MPEG:** Motion Picture Experts Group, and the standard developed by them for the compression of moving images. Compared to M-JPEG, it offers 75-80% data reduction with the same visual quality.

**MPG:** (File extension for) an MPEG file that contains both video and audio data.

**MPV:** (File extension for) an MPEG file that contains video data only.

**Non-interlaced:** Describes an image refresh method in which the complete image is generated as a single field without skipping lines. A non-interlaced image (most computer monitors) flickers much less than an interlaced image (most TVs).

**NTSC:** National Television Standards Committee, and the color TV standard created by them in 1953. NTSC video has 525 lines per frame and 60 image fields per second. It is used in North and Central America, Japan and other countries. See PAL, SECAM.

**PAL:** “Phase Alternation Line”, a color TV standard developed in Germany and used throughout most of Europe. PAL video has 625 lines per frame and 50 image fields per second. See NTSC, SECAM.

**Parallel port:** Parallel port data is transmitted via an 8-bit data line. This means that eight bits (one byte) can be transmitted at once. This kind of transmission is much faster than serial transmission, but is not appropriate for long-distance connections. Parallel ports are often named “LPTn”, where n is a number (e.g. “LPT1”). See Serial port.

**Pixel:** The smallest element of a monitor image. The word is an abbreviation of “picture element”.

**Port:** Electrical transfer point for the transmission of audio, video, control or other data between two devices. See Serial port, Parallel port.

**Primary colors:** The colors that are the basis of the RGB color model: red, green, and blue. It is possible to create most other colors on a computer screen by varying the blend of these primaries.
QSIF: Quarter Standard Image Format. An MPEG-1 format specifying a resolution of 176 x 144 under PAL and 176 x 120 under NTSC. See MPEG, SIF.

Quantization: One part of the JPEG image data compression strategy. Relevant details are represented precisely, while details that are less relevant for the human eye are represented with less precision.

Raster: The area of a video display that is covered by sweeping the electron beam of the display in a series of horizontal lines from upper left to lower right (from the viewer’s perspective).

Redundancy: This trait of images is exploited by compression algorithms. Superfluous information can be eliminated during compression and restored without loss during decompression.

Resolution: The number of pixels that can be displayed on the monitor horizontally and vertically. The higher the resolution, the more details can be displayed. See Pixel.

RGB: Red, Green and Blue: the primary colors in additive color mixing. RGB designates the method used in computer technology of encoding image information in pixels, each containing some combination of the three primaries.

ROM: Read Only Memory: Memory storage that, having been programmed once, retains its data without requiring electrical power. See EPROM.

Run Length Encoding (RLE): A technique used in many image compression methods, including JPEG. Repeating values are not stored separately but with a counter to indicate how many times the value occurs in succession – the length of the “run”.

Scaling: Adaptation of an image to a desired size.

SCSI: Small Computers System Interface. SCSI was long preferred as the hard drive interface for some high-performance PCs because of its high data rate. Up to eight SCSI devices can be connected to a computer at the same time.

SECAM: “Séquentiel Couleur à Mémoire”, a color TV transmission system used in France and Eastern Europe. Like PAL, SECAM video has 625 lines per frame and 50 image fields per second. See NTSC, PAL.

Serial port: Data transmitted via a serial port is processed one bit at a time; that is, “serially” – one after another. The transmission rate is much slower than that of a parallel port, where parallel data lines allow multiple bits to be sent simultaneously. Serial ports are named “COMn”, where n is a number (e.g. “COM2”). See Parallel port.
**SIF:** Standard Image Format. An MPEG-1 format specifying a resolution of 352 x 288 under PAL and 352 x 240 under NTSC. See MPEG, QSIF.

**Single frame:** A single frame is part of a series or sequence. When this series is viewed at sufficient speed, the illusion of a “moving picture” is created.

**Software codec:** Compression method that can create and play back compressed digital video sequences without special hardware. The quality of the sequences depends on the performance of the complete system. See Codec, Hardware codec.

**Still video:** Still images (or “freeze-frames”) extracted from video.

**S-VHS:** Improved version of VHS using S-Video and metal particle tape to deliver higher luminance resolution, resulting in sharper pictures than VHS. See VHS, S-Video.

**S-Video:** With S-Video (Y/C) signals, the brightness (luminance or “Y”) and the color (chrominance or “C”) information are transferred separately using multiple wires, avoiding modulating and demodulating the video and the resulting loss of picture quality.

**Timecode:** Timecode identifies the position of each frame in a video sequence with respect to a starting point (normally the beginning of the shot). The usual format is H:M:S:F (hours, minutes, seconds, frames), e.g. “01:22:13:21”. Unlike a tape counter (which can be “zeroed” or reset at any point in a tape), timecode is an electronic signal written onto videotape, and is permanent once it is assigned.

**Transition:** A bridging effect between adjacent video or audio clips, ranging from a simple “cut” to a showy animated effect. Common transitions like cuts, fades, dissolves, wipes, slides and audio cross-fades are part of the language of film and video. They can convey passages of time and changes of viewpoint concisely – and often subliminally.

**TrueColor:** The name indicates an image with enough color resolution to appear “true to life”. In practice, TrueColor normally refers to 24-bit RGB color, which allows about 16.7 million combinations of the red, green and blue primary colors. See Bit, HiColor.

**TWAIN driver:** TWAIN is a standardized software interface allowing graphics and capture programs to communicate with devices that supply graphical data. If the TWAIN driver is installed, the capture function of a graphics application can be used to load images directly from your video source into the program. The driver supports 32-bit programs only and captures images in 24-bit mode.

**VCR:** “Video cassette recorder”.

**VHS:** “Video Home System” – Popular video standard for home VCRs. Half-inch tape is used to store “composite” signals incorporating both brightness and color information.
**VISCA:** Protocol used with certain devices for controlling external video sources from computers.

**Video8:** Analog video system using 8mm tape. Video8 recorders generate composite signals.

**Video CD:** CD-ROM standard that uses MPEG compressed videos.

**Video decoder:** Converts digital information into analog video signals.

**Video encoder:** Converts analog video signals into digital information.

**Video for Windows:** A Microsoft Windows system extension that can record digital video sequences to files on a hard drive and subsequently play them back.

**Video scan rate:** Frequency with which the video signal is scanned onto an image display. The higher the video scan rate, the higher the image quality and the less noticeable the flicker.

**WAV:** (File extension for) a popular file format for digitized audio signals.

**White balance:** In an electronic camera, this is the adjustment of the amplifiers for the three color channels (red, green and blue) so that white areas of the scene do not show a color cast.

**Y/C:** Y/C is a color signal with two components: brightness information (Y) and color information (C).

**YUV:** The color model of a video signal where Y delivers the brightness information and U and V the color information.
Appendix D: Keyboard shortcuts

The tables below display the default hotkey assignments in Pinnacle Studio. Keys can be individually remapped in Setup. The defaults can also be restored there, either individually or for all the shortcuts at once. For more information, see “Keyboard settings in the Control Panel” on page 251.

The terms Left, Right, Up and Down in the tables refer to the arrow (cursor) keys.

## General shortcuts

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+4</td>
<td>Close focused window</td>
</tr>
<tr>
<td>Ctrl+5</td>
<td>Open Title Editor (from Movie Editor)</td>
</tr>
<tr>
<td>Ctrl+6</td>
<td>Open Exporter</td>
</tr>
<tr>
<td>Ctrl+I</td>
<td>Open Importer</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Save project, title or menu</td>
</tr>
<tr>
<td>Alt+F4</td>
<td>Close application</td>
</tr>
<tr>
<td>Shift+F10</td>
<td>Access context menu</td>
</tr>
<tr>
<td>Ctrl+Z</td>
<td>Undo</td>
</tr>
<tr>
<td>Ctrl+Y</td>
<td>Redo</td>
</tr>
<tr>
<td>Ctrl+A</td>
<td>Select all</td>
</tr>
<tr>
<td>Shift+Ctrl+A</td>
<td>Deselect all</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copy to clipboard</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>Paste from clipboard</td>
</tr>
<tr>
<td>Ctrl+X</td>
<td>Cut to clipboard</td>
</tr>
<tr>
<td>End</td>
<td>Go to end</td>
</tr>
<tr>
<td>Home</td>
<td>Go to beginning</td>
</tr>
<tr>
<td>Alt+Enter</td>
<td>Play using full screen</td>
</tr>
<tr>
<td>Esc</td>
<td>Exit full-screen viewing, or close</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete without copying to clipboard</td>
</tr>
<tr>
<td>Double-click</td>
<td>Open appropriate editor (Media, Titler, Project, Montage etc.)</td>
</tr>
<tr>
<td>F1</td>
<td>Open context sensitive help</td>
</tr>
</tbody>
</table>

## Library shortcuts

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+N</td>
<td>New collection</td>
</tr>
<tr>
<td>Numbers 1-5</td>
<td>Rate selected clip(s)</td>
</tr>
<tr>
<td>Number 0</td>
<td>Remove rating from selected clip(s)</td>
</tr>
<tr>
<td>Page Up</td>
<td>Scroll up a page</td>
</tr>
</tbody>
</table>
### Library shortcuts

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Down</td>
<td>Scroll down a page</td>
</tr>
<tr>
<td>Arrow keys</td>
<td>Navigate thumbnails—up, down, left, right</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete selected clip and / or media</td>
</tr>
<tr>
<td>F7</td>
<td>Show / hide tagging interface</td>
</tr>
</tbody>
</table>

### Playing and transport shortcuts

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spacebar</td>
<td>Play and pause</td>
</tr>
<tr>
<td>Shift+Spacebar</td>
<td>Loop playback</td>
</tr>
<tr>
<td>Alt+Enter</td>
<td>Play using full screen</td>
</tr>
<tr>
<td>Esc</td>
<td>Exit full-screen viewing</td>
</tr>
<tr>
<td>J</td>
<td>Fast reverse (hit multiple times for faster playback)</td>
</tr>
<tr>
<td>K (or Shift K)</td>
<td>Pause playback</td>
</tr>
<tr>
<td>L</td>
<td>Fast forward (hit multiple times for faster playback)</td>
</tr>
<tr>
<td>Shift+L</td>
<td>Slow forward (hit multiple times for slower playback)</td>
</tr>
<tr>
<td>Shift+J</td>
<td>Slow reverse (hit multiple times for slower playback)</td>
</tr>
<tr>
<td>Right (or X)</td>
<td>Step forward 1 frame</td>
</tr>
<tr>
<td>Left (or Z)</td>
<td>Step back 1 frame</td>
</tr>
<tr>
<td>Shift+Right (or Shift+X)</td>
<td>Step forward 10 frames</td>
</tr>
<tr>
<td>Shift+Left (or Shift+Z)</td>
<td>Step backward 10 frames</td>
</tr>
<tr>
<td>D (or Page up) (or Ctrl+Left)</td>
<td>Jump backward to cut</td>
</tr>
<tr>
<td>F (or Page down) (or Ctrl+Right)</td>
<td>Jump forward to cut</td>
</tr>
<tr>
<td>Ctrl+I</td>
<td>Jump to mark in</td>
</tr>
<tr>
<td>Ctrl+O</td>
<td>Jump to mark out</td>
</tr>
<tr>
<td>. (period)</td>
<td>Jump to next marker</td>
</tr>
<tr>
<td>, (comma)</td>
<td>Jump to previous marker</td>
</tr>
</tbody>
</table>

### Importer shortcuts

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>Stop Motion: Capture Frame (when capture frame is open)</td>
</tr>
<tr>
<td>Right</td>
<td>Expand folder in tree</td>
</tr>
<tr>
<td>Left</td>
<td>Collapse folder in tree</td>
</tr>
<tr>
<td>Arrow keys</td>
<td>Navigate up, down, left, right</td>
</tr>
<tr>
<td>Ctrl+A</td>
<td>Check all</td>
</tr>
<tr>
<td>Ctrl+Shift+A</td>
<td>Uncheck all</td>
</tr>
<tr>
<td>F4</td>
<td>Start Import</td>
</tr>
</tbody>
</table>
## Edit tab shortcuts

<table>
<thead>
<tr>
<th>Key(s)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A (or I)</td>
<td>Mark in</td>
</tr>
<tr>
<td>S (or O)</td>
<td>Mark out</td>
</tr>
<tr>
<td>Shift+I</td>
<td>Clear mark in</td>
</tr>
<tr>
<td>Shift+O</td>
<td>Clear mark out</td>
</tr>
<tr>
<td>Shift+U</td>
<td>Clear mark in and out</td>
</tr>
<tr>
<td>Scroll Lock</td>
<td>Audio Scrub On/Off</td>
</tr>
<tr>
<td>E (or Home)</td>
<td>Go to start</td>
</tr>
<tr>
<td>R (or End)</td>
<td>Go to end</td>
</tr>
<tr>
<td>P</td>
<td>Toggle Magnetic Snapping</td>
</tr>
<tr>
<td>; (semicolon)</td>
<td>Split clip(s) at scrubber position</td>
</tr>
<tr>
<td>M</td>
<td>Add/Delete marker</td>
</tr>
<tr>
<td>. (period)</td>
<td>Jump to next marker</td>
</tr>
<tr>
<td>, (comma)</td>
<td>Jump to previous marker</td>
</tr>
<tr>
<td>Ctrl+. (period)</td>
<td>Open Marker list</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete selected clip(s) from timeline</td>
</tr>
<tr>
<td>Double-click on</td>
<td>Open media editor for clip</td>
</tr>
<tr>
<td>clip in timeline</td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>Send preview clip to the primary track on the timeline (at scrubber position)</td>
</tr>
<tr>
<td>H</td>
<td>Swap Preview between timeline and source</td>
</tr>
<tr>
<td>Ctrl+5</td>
<td>Open Title Editor</td>
</tr>
<tr>
<td>F5</td>
<td>Show/Hide Audio Mixer</td>
</tr>
<tr>
<td>F7</td>
<td>Create Song</td>
</tr>
<tr>
<td>Numeric pad +</td>
<td>Zoom in the timeline</td>
</tr>
<tr>
<td>Numeric pad -</td>
<td>Zoom out the timeline</td>
</tr>
<tr>
<td>[ (left bracket)</td>
<td>Zoom out on the timeline</td>
</tr>
<tr>
<td>] (right bracket)</td>
<td>Zoom in on the timeline</td>
</tr>
<tr>
<td>Ctrl+[</td>
<td>Fit timeline to window</td>
</tr>
<tr>
<td>Ctrl+]</td>
<td>Show every frame (zoom in)</td>
</tr>
<tr>
<td>Alt</td>
<td>Provides the alternate behavior when editing on the timeline (insert/overwrite)</td>
</tr>
<tr>
<td>T</td>
<td>Trim Mode On/Off</td>
</tr>
<tr>
<td>Right</td>
<td>Trim 1 frame right (with trim open)</td>
</tr>
<tr>
<td>Left</td>
<td>Trim 1 frame left (with trim open)</td>
</tr>
<tr>
<td>Shift+ Right</td>
<td>Trim 10 frames right (with trim open)</td>
</tr>
<tr>
<td>Shift+ Left</td>
<td>Trim 10 frames left (with trim open)</td>
</tr>
<tr>
<td>Ctrl+Click on trim</td>
<td>Add second trim point to the same track</td>
</tr>
</tbody>
</table>
**Edit tab shortcuts**

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift+Click on trim</td>
<td>Open similar trim point on all tracks</td>
</tr>
<tr>
<td>Tab</td>
<td>Cycle focus on open trim points</td>
</tr>
</tbody>
</table>

**Editor shortcuts**

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numbers 1-8</td>
<td>Choose an effects category</td>
</tr>
<tr>
<td>Double-click slider</td>
<td>Return slider to default</td>
</tr>
<tr>
<td>Alt+Enter</td>
<td>Play using full screen</td>
</tr>
<tr>
<td>Esc</td>
<td>Exit full-screen viewing</td>
</tr>
</tbody>
</table>

**Title Editor shortcuts**

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift+Left</td>
<td>Expand character selection left</td>
</tr>
<tr>
<td>Shift+Right</td>
<td>Expand character selection right</td>
</tr>
<tr>
<td>Shift+Ctrl+Left</td>
<td>Same as Shift+Left (expand by word)</td>
</tr>
<tr>
<td>Shift+Ctrl+Right</td>
<td>Same as Shift+Right (expand by word)</td>
</tr>
<tr>
<td>Ctrl+B</td>
<td>Toggle bold</td>
</tr>
<tr>
<td>Ctrl+I</td>
<td>Toggle italic</td>
</tr>
<tr>
<td>Ctrl+U</td>
<td>Toggle underline</td>
</tr>
<tr>
<td>Ctrl+A</td>
<td>Select all</td>
</tr>
<tr>
<td>Ctrl+D</td>
<td>Deselect all</td>
</tr>
<tr>
<td>Spacebar</td>
<td>With timeline area selected: Start and stop playback</td>
</tr>
</tbody>
</table>
Appendix E: The installation manager

The Pinnacle Studio Installation Manager looks after the job of installing Pinnacle Studio and any additional content included in your purchase of the application.

This section contains the following topics:

• Before you begin installing
• Upgrade Installation
• Launching the Installation Manager
• Registration
• Supporting installations
• The installation Welcome Screen
• Common controls
• Installing plugs-ins and bonus content
• System requirements

Before you begin installing

For a trouble-free installation of Pinnacle Studio, we recommend a number of preparatory steps.

Begin by confirming that your computer meets the minimum system requirements for the product. Note that some operations, such as AVCHD encoding, have more stringent requirements. For more information, see “System requirements” on page 313.

Next, ensure that your Pinnacle Studio serial number is available. For a downloaded copy of the application, you will find this information in your order confirmation mail; you can also retrieve it from your customer account. If you obtained your copy of Pinnacle Studio on disc, the serial number will be found on the DVD sleeve. We recommend that you keep a record of your serial number in a safe place.

On some systems, it may be advisable to disable antivirus protection before installing Pinnacle Studio.

Note: Pinnacle Studio can be installed on a system containing a previous installation: both versions will coexist.
Upgrade Installation
If a qualifying previous version of the software is currently installed on the computer, the Installation Manager will automatically recognize its presence and permit the upgrade.

Launching the Installation Manager
If you bought Studio from an Internet store as a downloadable file, the Installation Manager will start when you run the executable program you downloaded. (Even before you do so, consider making a copy of the downloaded files to a back-up location like a DVD or an external hard drive.)

If you bought Studio on a DVD disc, the Installation Manager will autostart on most systems when that disc is inserted. If it does not launch automatically on your computer, please locate and run the file “Welcome.exe” in the root directory of the DVD.

Registration
Your first launch of the Installation Manager begins by displaying an input form for activating and registering your product. Registering makes it possible to streamline product support for problems like losing your serial number.

Supporting installations
The application requires a number of Windows software components, including the .NET Framework, to be present on your system. The Installation Manager determines automatically if the components are available, and installs them if necessary. Such supporting installations require additional time, but the main Pinnacle Studio installation will resume as soon as they have completed, even if the system was restarted in the process.

The installation Welcome Screen
The Welcome Screen lets you choose between two styles of installation:

**Standard Installation** installs the application and all available plug-ins. It is recommended for most users.

**The Customized Installation** option lets you choose to install only a subset of the add-ons available.

Common controls
Some controls are available under either installation method:

- The Change installer location button lets you specify the folder that contains the installation files you want the Installation Manager to handle. You will only need to use it
if you have moved the installation files after first use. The button opens a folder browser that lets you point the Installation Manager to the new location.

• The links provided under Learn while installing give access to information on just about any Studio-related topic.

**Installing plugs-ins and bonus content**

As described above, the Installation Manager can optionally install a rich variety of content in addition to the Pinnacle Studio application itself. In a Standard Installation, all available add-ons and plug-ins are installed. In a Customized Installation, you can choose exactly which items to install.

Even if you elect not to install particular content items during the initial installation of the application, you may return to the Installation Manager at any time to update your installation.

**System requirements**

In addition to your Pinnacle Studio software, an efficient editing system requires certain levels of system performance as noted below.

Remember too that while specifications are important, they do not tell the whole story. For instance, the proper functioning of hardware devices can also depend on manufacturer-supplied driver software. Checking the maker’s web-site for driver updates and support information can often be helpful in solving problems with graphics cards, sound cards and other devices.

**Operating system**

A 64-bit operating system is recommended if you are planning to edit HD material.

**RAM**

The more RAM you have, the easier it is to work with Pinnacle Studio. You will need at least 1 GB of RAM to achieve satisfactory operation, and we highly recommend 2 GB (or more). If you work with HD or AVCHD video, the recommendation rises to 4 GB.

**Motherboard**

Intel Pentium or AMD Athlon 2.4 GHz or higher – the higher the better. AVCHD editing demands a more powerful CPU. The minimum recommendation ranges up to 2.66 GHz for
editing 1920- pixel AVCHD video. A multi-core system like Core i7, Core i5 or Core i3 is recommended.

**Graphics card**

To run Studio, your DirectX-compatible graphics card needs:
• For typical use, at least 128 MB of onboard memory (256 MB preferred).
• For HD and AVCHD, at least 256 MB (512 MB preferred).

**The hard drive**

Your hard drive must be capable of sustained reading and writing at 4 MB/sec. Most drives are capable of this. The first time you capture, Studio will test your drive to make sure it is fast enough. Video files are often quite large, so you also need a good amount of available hard drive space. For instance, video in the DV format fills 3.6 MB of hard drive space per second of footage: a gigabyte every four and a half minutes.

For capture from video tape, we recommend using a separate hard drive to avoid competition between Pinnacle Studio and other software, including Windows, for use of the drive.

**Video capture hardware**

Studio can capture video from a variety of digital and analog sources:
• All types of auxiliary file-based storage media, including optical drives, memory cards and USB sticks.
• Files from drives connected to the computer.
• DV or HDV video cameras using an IEEE-1394 connection.
• Analog video cameras and recorders.
• DVD and Blu-ray discs.
• Digital still cameras.
Legal Notice

Pinnacle Studio™ 23 User Guide
Copyright 2019 Corel Corporation. All rights reserved.

Product specifications, pricing, packaging, technical support and information ("specifications") refer to the retail English version only. The specifications for all other versions (including other language versions) may vary.

Corel patent information: www.corel.com/patent

INFORMATION IS PROVIDED BY COREL ON AN "AS IS" BASIS, WITHOUT ANY OTHER WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY QUALITY, SATISFACTORY QUALITY, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, OR THOSE ARISING BY LAW, STATUTE, USAGE OF TRADE, COURSE OF DEALING OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS OF THE INFORMATION PROVIDED OR ITS USE IS ASSUMED BY YOU. COREL SHALL HAVE NO LIABILITY TO YOU OR ANY OTHER PERSON OR ENTITY FOR ANY INDIRECT, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFIT, LOST OR DAMAGED DATA OR OTHER COMMERCIAL OR ECONOMIC LOSS, EVEN IF COREL HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR THEY ARE FORESEEABLE. COREL IS ALSO NOT LIABLE FOR ANY CLAIMS MADE BY ANY THIRD PARTY. COREL'S MAXIMUM AGGREGATE LIABILITY TO YOU SHALL NOT EXCEED THE COSTS PAID BY YOU TO PURCHASE THE MATERIALS. SOME STATES/COUNTRIES DO NOT ALLOW EXCLUSIONS OR LIMITATIONS OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.

© 2019 Corel Corporation. All rights reserved. Corel, the Corel logo, the Corel Balloon logo, Pinnacle Studio, Dazzle, and MovieBox are trademarks or registered trademarks of Corel Corporation and/or its subsidiaries. All other product names and any registered and unregistered trademarks mentioned are used for identification purposes only and remain the exclusive property of their respective owners.

Please respect the Rights of Artists and Creators. Content such as music, photos, video and celebrity images are protected by the laws of many countries. You may not use other people's content unless you own the rights or have the permission of the owner.